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 Quick Start Guides 
 
InSite-Lite QuickStart Tutorials 

InSite-HF QuickStart Tutorials 

 
 

1.1 InSite-Lite Quick Start Example 
 
Please copy and paste the tutorial folder in the installation path, C:\Program Files\ASC\Insite-Lite, 

to a folder where you can read and write. Please follow through this tutorial in the following order using the data and PCF 
file provided. Please note these files are only included in the installation of InSite-Lite version. 

 
 
 

1.1.1 Step 1 - Project Setup 
 
The first step when working on a project in InSite is the import or creation of a sensor array with channel numbers 

matching those in the harvested or imported seismic waveform data files. 
 
In this example, the .pcf file is already set with the correct sensor array and this step can be skip.  The following details 

are for information only and working on a fresh project. 
 

1. In InSite's 'Data Visualiser' click ‘Project->Edit Default Arrays-> Receivers’. Alternatively, 

the same Dialog can be called clicking on 

 
 
 
 

 
Figure 1-1: Array Input and Edit Button 

in the main toolbar in Data Visualiser 
 
 
 

2. the array can be imported from a ready-made .sen or .csv file following the format described in later sections by 

clicking Import from File. Alternatively, each sensor can be manually added by clicking Add and 

completing the properties menu. 
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Figure 1-2: Array Input and Edit Dialog 

 

 
 

Figure 1-3: Array Input and Edit Dialog 
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1.1.2 Step 2 - Data Import 
 
 
InSite-Lite can import a variety of data formats. 
 
In this step, we just import triggered SEGY format data. Notice that the tutorial SEGY data are triggered event data. 
 
 

1. Create an empty folder ESF under the same directory as the SEGY folder. 
 

2. Click ‘Project -> Import and Manage Data...’ Make sure the Import Directory and the ESF 

Storage Directory are set correct (see figure below) 

 

3. Select the root of the file tree and click ->Import->, all .sgy files will be imported to InSite and stored as 

ESF files in the specified ESF folder. 

 
 
Note: there are 50 events imported into InSite-Lite 
 
 

4. Right-click on any one event and select View Waveforms. You will notice that some first arrivals were 

already picked. The free version of InSite-Lite does not have automatic first arrival picking. In the next step, 
we will manually pick or re-pick the first arrivals and locate events using homogeneous model. 
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1.1.3 Step 3 - Microseismic Waveform Processing 
 
 
Once we have setup the monitoring array and imported waveforms, we are ready to process microseismic events. 
 
InSite provides 3 ways of processing: 
 

• Automatic processing or batch processing: the procedures are defined in the auto-processor by users. 
 

• Online processing: process the data while triggering. In online processing, procedures are not specified by users 

and determined by the type of data automatically. 

 

• Manual processing: each step of processing is conducted by users. In this step, we will introduce the automatic 

processing and manual processing. 

 
Adjusting processing parameters: 
 

• Right-click on one event that was not located successfully. In the example shown below, event 5 is not 
located. 

 

 

 

Figure 1-4: Some events are not located in the triggering and online processing step 

 

• The reason is that the auto-picking algorithm failed to pick the P-wave arrival. See the figure below. 
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Figure 1-5: Incorrect pick 
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To adjust the first arrivals, users could either use Draw P Arrival Pick Moveout or Draw S 
Arrival Pick Moveout or Add P Arrival Pick or Add S Arrival Pick to manually adjust 
the first arrivals. Shortcuts Shift + A and Shift + D are used frequently. 

 
 
 

 
Figure 1-6: Manual pick 



1. Quick Start Guides  

 

7 

 

• Click the location button to relocate the event. This event is thus relocated manually. You may want to repeat 

this procedure for all other events. Tips: you can repick all first arrivals only without click the locate button. 

The full version of InSite includes the autoprocessor to batch processing all events. For the batch 

processing, the details can be found at Auto-Processing . 

 

• Other parameters can also be adjusted. For example, the source vector time window, auto-picking parameters, 

or parameters in locater. 

 

• This step gives you some flavour about how tedious the processing can be. Advanced locating method such as 

source scan has been developed to automate this process to a certain degree. However, at the end of the day it 

is the sole responsibility of the processor to ensure the quality and the reliability of the processing outcome. 

 
 

1.1.4 Step 4 - 3D Visualiser 
 
InSite provides comprehensive 3D visualisation to assist interpretation of fracture propagation. See 3D Visualiser 

for details. In this tutorial we will explore two functions including displaying events by different colour and size scales and 
play events as a function of time. 

 
Display events by different colour and size scales 
 

• Enter the 3D visualiser and click Properties. In the tab of Events, display the event by sphere symbol 

type, and colour scale by time and size scale by signal-to-noise ratio (see figure below). Now 

you will be able to tell when and where a good quality event is located. For automatic processing, this is a 

good trick to emphasize good quality events to reveal major failure zones.  
 

 
 

Figure 1-7: 3D visualiser 

 

• Now switch to the Time tab and set the parameters following the figure below. Click OK.  
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Figure 1-8: Set parameters to play events by time 

 

• Click Play Events button to start. The events will appear on screen as a function of time. The historical events 

will be displayed in transparent mode and the active events are in solid mode. This is a very useful tool to understand the 

time and space patterns of the microseismicity. 

 
A few other functions that are worth of mentioning include (see figure below):  
 
1. Treatment Curves: you can import engineering data such as those from hydraulic fracture treatment, e.g. well head 

pressure, proppant concentration, etc. Those parameters can be displayed as a 2D chart (Step 7 Parameter analysis 

and 2D charting see "2D charts") and also be used to scale or colour events. Find more details at Treatment Curve 

 
2. Uncertainty: Since v3.15, you can evaluate the uncertainty using Bayesian Posterior probability by giving the 

uncertainty in arrival time, velocity model and source polarization. Find more details at Uncertainty Analysis 

 
3. Calculate stimulated volume: two ways of calculating the rock volume stimulated by fractures, one is to fit a box to 

the event cloud and the other is by tightly fitting an isosurface. Find more details at Stimulated Volumes. 

 
4. Array Analysis: this function can be used to quantify the sensitivity and the location accuracy of the employed 

acquisition geometry. This information can be used to assist interpretation of microseismic cloud. Find more 

details at Array Analysis. 
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Figure 1-9: Additional functions available for interpretation 

 
 

1.1.5 Step 5 - Data and results Export 
 
By this time, you have exported 3D visualisation figures and 2D charts for display purpose. In this section, you will 

export quantitative information such as waveform and event catalogue for further data processing. InSite support a 
variety of data format such as ASCII format like ATF and binary format like SEGY, SEGD, SEED/miniSEED etc. 

Export waveform 
 

• To export waveform for one event, enter Waveform-Moveout by clicking the global button and make sure 

View->Export Bar has been selected. 

• Click ATF to export the displayed waveform to a file in ASCII format. In the same folder as the ESF file, you will 

find a number of ATF files each corresponding to one channel. 

• Clicking MSEED will export the waveform in miniSEED format. In the same folder as the ESF file, you will find a 

new file with same file name as the ESF file but ends with .miniseed.  

Note: This way is to export the observed waveform to the corresponding file format. If waveform is filtered, or 
rotated to P-SH-SV coordinate, the processed waveform will be stored instead of the original raw file. To export raw 
waveform or processed waveform, you can use the auto-processor. See AutoProcessing for details. 

Export Catalogue 
 
Microseismic catalogue can be exported with different level of details. Make sure you are in Data Visualiser; 

the drop-down menu from Export shows different ways of exporting catalogue information. See the Export sub-menu 

for details. 

• Export CSV Event Data File is the most common function. It exports parameters such as time, location, magnitude 

etc for each event. Please export a file and review the content in it. You can open CSV file by EXCEL. 

• Export CSV Instrument Data File has more details than Event Data file. Each pair of source and receiver is stored 

in one row and the additional information include picked and theoretical arrival time, ray polarization, etc. 
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1.2 InSite-HF Quick Start Example 
 
Please copy and paste the tutorial folder in the installation path, C:\Program Files\ASC\Insite-HF to a 

folder where you can read and write. Please follow through this tutorial in the following order using the data and PCF file 
provided. Please note these files are only included in the installation of InSite-HF version 

 
 

1.2.1 Step 1 - Project Setup 
 
First, we will turn on "Real time" mode to use the wizard. Note that this tutorial is not suitable for InSite -Lite. 
 

 

 

Figure 1-10: Turn on the real time mode to enable the access to the setup wizard 

 

• Import Geometry using Frac-manager 
 
Let's make sure you have all the files needed to complete this step. Under folder WellObjects, you will find:  
 
 
1. Monitoring well path (Monitoring_Wellpath.csv) 

 
2. Monitoring instruments (Monitoring_Receivers.csv) 

 
3. Treatment well path (Treatment_Wellpath.csv) 

 
4. Well logs from treatment well (Treatment_Gamma.csv, Treatment_PVel.csv, Treatment←› 

_S - Vel.csv) 

 
5. Perforation shot location (Treatment_Perfs.csv) 

 

6. Well Objects Files.csv contains Treatment well packers, plugs, sleeves locations, and site formation 

boundaries. 
Import Well paths Both monitoring well and treatment well paths can be imported in the similar way as shown in 

the figure below 
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Figure 1-11: Import the CSV file with the well track 

 

When done, click the next> button. 

 

• Import Tools 
 
Now we import the tools (geophones) to the corresponding well (monitoring well). 
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Figure 1-12: Import the CSV file with geophone positions measured as MD 

 

When done, click the next> button. 

 

• Import Perforation shot position 
 
 
The perforation shots that are measured by MD can be imported to the treatment well path. 



1. Quick Start Guides  

 

13 

 

 
 

Figure 1-13: Import the perforation shots to the treatment well 

 

When done, click the next> button. 

 

• Import Well logs 
 
The well logs (P vel, S vel and Gamma) measured along either treatment well or monitoring well can be imported 

from CSV files. 
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Figure 1-14: Import well logs to the corresponding well 

 

When done, click the next> button. 

 

• Import Well Objects 
 
The well objects, packers, sleeves etc can be imported to the project for visualisation purpose. 
 



1. Quick Start Guides  

 

15 

 
 

Figure 1-15: Import well objects to the corresponding well 

 

When done, click the next> button. 

 
 

• Add stages (optional) 
 
 
Stages can be added in this interface if needed. This tutorial will add a stage at a later time. 
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Figure 1-16: Add stages for data acquisition and processing 

 
When done, click the Exit Setup button and you will see the previously imported objects are listed in a tree 

structure as shown below. 
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Figure 1-17: The imported objects are listed in a tree structure 

 
The imported objects are now visible in 3D visualiser for review.  
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Figure 1-18: The imported objects are visible in 3D visualiser 

 

• Import Geometry: the simple way 
 
 
Use Array Editor Dialog to import sensor array when Frac-manager is unavailable. The geophone coordinates and 

its orientation must be calculated before importing as default receiver array.  
 
 
 

1.2.2 Step 2 - Data Import and Harvesting 
 
In this step, we will harvest (trigger/leach) continuous data stream and store the discrete events as ESF files. The 

function used here is named "streamer leach". Note this function is not available in InSite-Lite. 
 
 

• Set processing parameters 
 

Follow the 3 steps outlined in the figure below to set the processing parameters in Processing Setting -> Autopicking, 
Source Vectors and Channel processing tabs in the tutorial PCF file. 
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Figure 1-19: Enter the processing parameters to the tutorial PCF 

 

• Set location parameters 
 
 
In order to trigger and locate events at the same time, we set the locating parameters as shown in the figure below. 

You can access the interface from Processing Setting -> Locater. 
 

 
 

 

Figure 1-20: Enter the locater parameters to the tutorial PCF 
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• Set harvesting parameters 
 
Create two new folders ESF and BSF at the same level as Raw Data. Set the harvesting parameters shown below. 

The detail of this interface can be found in Streamer Leach. Please make sure the directories for raw data, ESF and BSF 
are correct. Specificaily the raw data directory should be your_path\to\QuickStart\Tutorial - 

_1.1\Raw Data\, the ESF directory should be your_path\to\QuickStart\Tutorial_1.1\ESF\ 

and the BSF directory should be your_path\to\QuickStart\Tutorial_1.1\BSF\. 

 
 

 
Figure 1-21: Enter the harvesting parameters to the tutorial PCF 

 

• Start leaching 
 
Once the processing, locating and harvesting parameters are set, we are ready to trigger events that meet the triggering 

criteria. 
 
Click Start Leaching Data. A message will pop up reporting the number of new files detected. Usually here 

first time users would see some strange issues due to inappropriate setting. Please double check if the folders exist, delete  
all data already in the PCF file and click Manage BSFs to make sure the information is empty as shown below. If not, 

please delete the BIF file and click reset. Refer to BSF ESF and Waveform Settings for more details. 
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Figure 1-22: Make sure there is no information in this Dialog 

 

• Leaching result visualisation 
 
Leaching can be performed in the background. After you start leaching successfully, you can minimize the leaching 

interface and switch to 3D visualiser to view the results in real time as shown below. 
 
 

 
 

Figure 1-23: Events will be located in real time 
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1.2.3 Step 3 - Velocity model calibration 
 
InSite provides two different methods for velocity calibration: 
 

• Layered velocity model calibrated by known shots. This method is normally used in field-scale microseismic 

monitoring. 

• Time-dependent velocity model calibrated by ultrasonic survey. This method normally used in laboratory acoustic 

emission monitoring. 

 
In this tutorial, we demonstrate the first method. The workflow of the second method can be found in Velocity 

Surveying. 
 
First of all, we need to import calibration shot. The perforation shot ESF file is provided in the tutorial directory and the 

component in PCF file is named perf. Select this component and right-click on the event (not the component) and select 
View Waveforms. 

 
 
 

 
 

Figure 1-24: Select to view the waveforms to double-check the ESF file is recognized 

 
 
If you see an error message saying the waveform is not available, delete the perf component and follow the figure 

below to import the ESF file. Note the perf ESF file is stored under 
path_to\Tutorial_1.1\Solution\perf\. 
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Figure 1-25: Import per shot 

 
 

We now need to create a stage. Enter frac-manager by clicking Setup global button, in the right lower panel Stage 

Data View right-click and select Add New Stage... from the pop-up menu. Note that the items in this menu 

are ordered in the operation order. We will later select Add Calibration (Reference) Downhole 

Array..., Add Calibration Shot... and so on. 
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Figure 1-26: Create a stage 

 
Now we are ready to calibrate a layered velocity model. 
 

• Manual calibration of layered velocity model 
 

Right-click on Calibrate Velocity Model from Calibration Shots... in Frac Manager as 

shown in the figure below. 
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Figure 1-27: Calibrate velocity menu 

 
 

As this is the first model we will create, we click Select Layers Graphically, as shown below 

 

 
 

Figure 1-28: Open the velocity calibration interface 
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Manually add layers based on the well logs. The details can be found in Use of Sonic Logs to Pick an Initial Velocity 

Model 

 
Save this model as the initial velocity we will use for velocity calibration. 

 
Display the sonic logs and manually adjust the value of each layer to make sure the theoretical arrivals match the 
waveform for both P and S waves. See Manual Calibration for more description. To display the theoretical overlay, a 
few methods one can use. Set a user defined position as the perforation shot position in 3D visualiser see Overlay 
bars in Event View Button bar Operations or set the event type to be shot and enter the shot position by right-click 
on the event -> Edit Event Properties. 

 
It is recommended to adjust only the layers covered by the ray paths and leave other layers not changed. In addition, try 

to make the velocity value close to the sonic logs as much as possible. 

Once satisfied with the match between the theoretical arrival and the waveform, save the model and move onto the 

automatic velocity calibration.  

 

Automatic calibration of layered velocity model 

 
Enter the same interface as shown in  

Figure 1-27. 

 
Select the velocity that has been calibrated manually in the previous step. Note, manual calibration is not a requisite for 

automatic velocity calibration. 

 
Set parameters for each layer following the section of Automatic Calibration. 

 
Click start will launch the calibration. The total computing time will depend on the number of layers. We recommend use 

automatic calibration for 3 to 4 layers. 

 
Upon completion, the theoretical arrivals and the picks will be displayed on multiple popup windows. 

 

1.2.4 Step 4 - Microseismic Waveform Processing 
 
Once we have calibrated the geophone orientation and a velocity model, we are ready to process microseismic 

events. 
 
You may remember in Step 2, we did triggering and online processing at the same time. The processing parameters 

may not be optimal and in this step, we need to fine tune some processing parameters for better result. 
 
InSite provides 3 ways of processing: 
 

• Automatic processing or batch processing: the procedures are defined in the auto-processor by users. 

• Online processing: process the data while triggering. In online processing, procedures are not specified by 
users and determined by the type of data automatically. 

• Manual processing: each step of processing is conducted by users. In this step, we will introduce the 
automatic processing and manual processing. 

 
Adjusting processing parameters 
 

Right-click on some event that was not located successfully. In the example shown below, event 3 is not located. 
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Figure 1-29: Some events are not located in the triggering and online processing step 

 
 

The reason is that the auto-picking algorithm failed to pick the P-wave arrival. See the figure below. 
 

 

 

Figure 1-30: Incorrect auto-pickings 

 

To adjust the first arrivals, users could either use Draw P Arrival Pick Moveout or Draw S Arrival 

Pick Moveout or Add P Arrival Pick or Add S Arrival Pick to manually adjust the first arrivals. 

Shortcuts Shift + A and Shift + D are used frequently. 
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Figure 1-31: Manual picking options 

 
Click the location button to relocate the event. This event is thus relocated manually. You may want to repeat this 

procedure for all other events. Tips: you can repick all first arrivals only without click the locate button. At the end, you 

can use autoprocessor to batch processing all events. For the batch processing, the details can be found at Auto-

Processing. 

 
Other parameters can also be adjusted. For example, the source vector time window, auto-picking parameters, or 

parameters in locater. 

 
This step gives you some flavour about how tedious the processing can be. Advanced locating method such as source scan 

has been developed to automate this process to a certain degree. However, at the end of the day it is the sole responsibility 

of the processor to ensure the quality and the reliability of the processing outcome. 

 
 

1.2.5 Step 5 - Source mechanisms 
 
InSite provides two advanced methods to calculate source mechanisms: moment tensor inversion based on 

amplitude and composite moment tensor mechanism inversion. The former is useful with adequate azimuthal 
coverage and the latter is designed for single borehole monitoring or similar scenarios where azimuthal coverage is 
limited. In this step we will introduce both methods briefly. 

 

• Full moment tensor inversion 
 
InSite provides a full module to do moment tensor inversion. The details can be found at Source Mechanism Tool. The 

full moment tensor is inverted based on the amplitude recorded by single component (uniaxial) or three-component 
(triaxial) sensors. 

For triaxial sensors, you can manually pick P, SH and SV amplitude in tri-axial view by rotating the waveform to Event-

Defined Rotation. Here we use the automatic picking from the batch processing: Tools -> Launch Auto-

Processor. Add Autopick of P, SH, SV amplitudes (Req locations) (see Auto←› Processing 

and figure below) and then click Start. 
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Figure 1-32: Use autoprocessor to automatically pick P, SH and SV amplitude 

 

Set the moment tensor parameters under the Mechanisms tab as in figure below. See Parameter Setting Interface 

for details. 
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Figure 1-33: Set the parameters for moment tensor inversion 

 

Click the Source Mechanism button in the processing bar to calculate the moment tensor. The following Dialog 

will pop up with computation result. 
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Figure 1-34: View the moment tensor result 

 

Click the Mechanism global shortcut to enter the beachball view or click View Mechanism button. The Visualiser 

interface will be displayed. 

 
For uniaxial sensors, if Allow Amplitude Picking is not enabled in the Autopicking tab, you must manually 

pick the amplitude for P and/or S wave (see the figure below) and follow the same procedure. 
 
 

 

Figure 1-35:Pick amplitude of P-wave from uniaxial sensor. Note SH and SV-wave amplitude can be picked in a 
similar way 

We can calculate the moment tensor for all events Tools->Launch Auto-Processor, add Get Source 

Mechanism, and click Start. After that enter 3D visualisation, change display symbol to Beachball and you should see 

events are displayed in 3D beach balls. 
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Figure 1-36: 3D Beachball display 

 

• Composite moment tensor inversion 
 
Due to the limited azimuthal coverage from a single borehole, large uncertainty is expected from the moment tensor 

calculated in the above method. Here we show how to compute composite moment tensor by assume all events have the 
same failure mechanism. In practice, you may group events by time and space and perform multiple composite moment 
tensor inversion for each group. 

 
 

1 Enter 3D visualiser and select MSDFN Generator. 

2 Accept the default parameter setting, click Run. 
 

3 The button Show Amp. Ratio becomes activated. Click it 

 
4 You will see the panel for manual adjustment. For details, please see here)  

 
5 Click Save Global button and enter 3D visualiser to view events by beachball. 
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Figure 1-37:3D Beachball display using MSDFN. Note the difference from full moment tensor inversion  

 

1.2.6 Step 6 - 3D Visualiser 
 
InSite provides comprehensive 3D visualisation to assist interpretation of fracture propagation. See 3D Visualiser 

for details. In this tutorial we will explore two functions including displaying events by different colour and size scales and 
play events as a function of time. 

 

• Display events by different colour and size scales 
 

Enter the 3D visualiser and click Properties. In the tab of Events, display the event by sphere symbol type, and 

colour scale by time and size scale by signal-to-noise ratio (see figure below). Now you will be able to tell 

when and where a good quality event is located. For automatic processing, this is a good trick to emphasize good quality 

events to reveal major failure zones. 

 
 

 
 

Figure 1-38: Colour scale by time, size scale by signal-to-noise ratio 

 
• Now switch to the Time tab and set the parameters following the figure below. Click OK. 
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Figure 1-39: Set parameters to play events by time 

 

Click Play Events button to start. The events will appear on screen as a function of time. The historical events will 

be displayed in transparent mode and the active events are in solid mode. This is a very useful tool to understand the time 

and space patterns of the microseismicity. 

 
 
A few other functions that are worth of mentioning include (see figure below):  
 

1. Treatment Curves: you can import engineering data such as those from hydraulic fracture treatment, e.g. well head 

pressure, proppant concentration, etc. Those parameters can be displayed as a 2D chart (Step 7 Parameter analysis 

and 2D charting see "2D charts") and also be used to scale or colour events. Find more details at Treatment Curve 

 
2. Uncertainty: Since v3.15, you can evaluate the uncertainty using Bayesian Posterior probability by giving the 

uncertainty in arrival time, velocity model and source polarization. Find more details at Uncertainty Analysis 

 
3. Calculate stimulated volume: two ways of calculating the rock volume stimulated by fractures, one is to fit a box 

to the event cloud and the other is by tightly fitting an isosurface. Find more details at Stimulated Volumes. 

 
4. Array Analysis: this function can be used to quantify the sensitivity and the location accuracy of the employed 

acquisition geometry. This information can be used to assist interpretation of microseismic cloud. Find more 

details at Array Analysis. 
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Figure 1-40: Additional functions available for interpretation 

 

1.2.7 Step 7 - Parameter analysis and 2D charting 
 
InSite provides extensive options to plot source parameters in figures. For thorough review on 2D charts please refer to 

the chapter of Parameter Visualiser in the help manual. In this tutorial, we will demonstrate only a few 2D charts. 
 
Event Parameter Histogram 
 

• From the global button Charts -> Add, then select Event Parameter Histogram and click OK. 

 

• Double-click the item will plot the histogram. Select Edit -> Properties to change the settings. 

 
Event Parameter Scatter Chart 
 

• From the Parameter Visualisation Launcher interface, select Add -> Event Scatter Chart 
and set the parameters to be signal to noise ratio and location magnitude as shown below. b-Value Chart 

• From the Parameter Visualisation Launcher interface, select Add -> Event Scatter Chart 
and set the parameters as shown below. Double click the item will launch the plot. 
 
From version 3.15, all images can be exported as bitmap figures. For details about all other 2D charts, please refer 

to the chapter of Parameter Visualiser. 
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1.2.8 Step 8 - Data and results Export 
 
By this time, you have exported 3D visualisation figures and 2D charts for display purpose. In this section, you will 

export quantitative information such as waveform and event catalogue for further data processing. InSite support a 
variety of data format such as ASCII format like ATF and binary format like SEGY, SEGD, SEED/miniSEED etc. 

 
Export waveform 
 

• To export waveform for one event, enter Waveform-Moveout by clicking the global button and make sure 

View->Export Bar has been selected. 
 

• Click ATF to export the displayed waveform to a file in ASCII format. In the same folder as the ESF file, you will 

find a number of ATF files each corresponding to one channel. 

 
• Clicking MSEED will export the waveform in miniSEED format. In the same folder as the ESF file, you will find a 

new file with same file name as the ESF file but ends with .miniseed.  

 
Note: This way is to export the observed waveform to the corresponding file format. If waveform is filtered, or 

rotated to P-SH-SV coordinate, the processed waveform will be stored instead of the original raw file. To export raw 
waveform or processed waveform, you can use the auto-processor. See AutoProcessing for details. 

 
Export Catalogue 
 
Microseismic catalogue can be exported with different level of details. Make sure you are in Data Visualiser; 

the drop-down menu from Export shows different ways of exporting catalogue information. See the Export sub-menu 

for details. 
 

• Export CSV Event Data File is the most common function. It exports parameters such as time, location, magnitude 

etc for each event. Please export a file and review the content in it. You can open CSV file by EXCEL. 

 

• Export CSV Instrument Data File has more details than Event Data file. Each pair of source and receiver is stored 

in one row and the additional information include picked and theoretical arrival time, ray polarization, etc. 
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 Introduction 
 

Principal Features 

Technical support 

Installation 

Disclaimer 

Quick Start Workflow 
 
 

2.1 Principal Features 
 
Welcome to InSite Seismic Processor. This software has been designed to allow the user to inspect, analyse and  

process seismic data in an intuitive way while providing access to a full range of advanced tools for manipulating the data. 
 

• All features are accessed from a single WINDOWS program making the software user-friendly and easy to install. 

• The data management system allows the user to easily input, navigate and manipulate a complex seismic 

data set. 

• The software is designed to be versatile so that it can import any waveform file format into the management 

system. This results in it being independent of the hardware acquiring the data.  Any seismic data can then be 

processed using the same algorithms. 

• InSite is "scale independent" allowing the same processing functions to be applied to data recorded over 

millimetres as data recorded over kilometres. 

• InSite has a very simple file structure that wraps all parameters. This removes the need for any text 

configuration or data-storage files. InSite then allows the user to export the required data into accessible 

ASCII formats. 

• InSite provides functionality for both Active and Passive "Events" within the same dataset, thus allowing data from 

a complete seismic experiment to be stored, managed and processed in a structured manner. 

• InSite consists of a number of tools each designed to carry out a set of related processing and/or visualisation 

functions. 

• The modular structure means that users do not have to purchase the entire package but can choose the tools that 

are applicable to the data they are processing and the type of results they aim to achieve. Additional tools can  

be purchased at a later date as they are required or become available. 

 

InSite projects can be shared with team members or clients for full 3-D visualisation and manipulation of located 
Seismic/MS/AE events using the free distributable InSite-Lite available at appliedseismology.co.uk 
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Tool Name Main Processing Functions Main Visualisation Functions 
Data-management Raw data input. ESF/PCF in- put/output. 

Management of data structure. Navigation around 
the data set and between tools. Ex- porting of text 
file formats. 

Visualisation of data structure with 
event parameters 

Waveform Processing Waveform phase picking algorithms (automatic and 
manual processing). Waveform filtering algorithms. 
Waveform frequency analysis. Waveform moveout 
visualiser plotting waveform stacks and theoretical 
and real arrival time curves. 

Visualisation of waveforms and 
frequency spectra. Waveform 
moveout visualiser. 

Advanced Waveform 
Processing 

Advanced user functionality for manually picking 
phase information on triaxial and quadriaxial 
instruments. Rotation of instrument waveforms to 
different coordinate systems. Single station location 
from a triaxial instrument. Fitting of spectral models 
to rotated dis- placement spectra. Production of 
Sonograms and Polarisograms using the FFT and 
MEM spectral analysis methods. 

Visualisation of waveforms, 
hodograms and displacement spectra 
for triaxial and quadriaxial 
instruments. Visualisation of 
sonograms for all instrument types. 
Visualisation of polarisograms for 
triaxial and quadriaxial instruments. 

Location Hypocentral location algorithms. Relative location 
using waveform cross-correlation. Source parameter 
algorithms. Event collapsing algorithm. 

Three-dimension visualisation of 
locations. 

Advanced Location Source Location inversion using complex media. 
Media velocity structure is defined using a one-
dimensional velocity structure with horizontal layers. 
WaveBuilder algorithm constructs travel-time grids 
using dynamic wavefront construction. Fast 
sweeping method models travel time grids by solving 
Eikonal equation for a 3D heterogeneous isotropic 
velocity model. 

 

3D Visualiser Display of the event locations in a 3D scene, 
allowing rotating, panning, magnifying and flying 
through the scene. 

‘Hot planes’ and ellipsoids can be inserted to 
analyse lineations (fractures) and mobilized 
volumes. 

Boreholes and 3D objects (tunnels/surfaces) can 
be imported. 

A playback mode shows the time-dependency of 
events. Objects have time dependency to visualise 
site evolution. 

Display of density planes within the 
3D scene. 

High performance accelerated 
graphics for 3D scenes. Density plane 
can be created and manually moved 
through volume of interest. Colour 
and size scaling of events by a range of 
parameters. Balls from Itasca's PFC 
models can be imported into the 
scene. 

Mechanism Moment tensor inversion algorithms. Fault Plane solution based on P- wave 
arrival polarities. Visualisation of 
source mechanisms using lower-
hemisphere and Hudson T-k plots. 

Velocity Velocity analyses using time-of- flight. Waveform 
cross-correlation algorithms for high precision travel 
time and velocity calculations. 

 

Leach Tools Automatically capture data from an acquisition 
system and import into InSite’s data management 
framework. Modular structure for extension to 
different acquisition hardware. Real-time processing 
functions supplying results for instant visualisation. 
Multithreaded framework for efficient software 
algorithms. 

Dialog boxes provide control functions 
and feedback on data capture and 
processing. 

InSiteDB Allows users access to a centralised database over a 
Local Area Network. ATL/DCOM technology allows 
efficient communication between 'client' and 
'server' instances of InSite. Data transferred over the 
network and instantly imported into the user’s 
project. 

Dialog boxes provide control functions 
for the user to select any events from 
the remote database. 



1. Quick Start Guides  

 

39 

 
 

 
 

Frac Manager Integrated studio to manage all data for a 
microseismic project and guide geophysicists 
through the processing flow. Calibration shot 
analysis for instrument orientation and velocity 
analysis. 

Dialog boxes provide control 
functions. 

Stream Visualiser Allows users to view entire continuous data streams, 
plotting either waveforms or sonograms. 

Waveform and sonogram visualisers 
with Dialog boxes providing control 
functions. 

S-wave Location Tool Calculation of waveform source vector from the S-
wave plane polarisation for events with noisy or 
poorly defined P-wave arrivals. 

 



2.4 Disclaimer  

 

40 

 

 

2.2 Technical support 
 
Should you require any assistance with this software, or if you have any comments or suggestions please contact us at: 
 
POSTAL ADDRESS: Applied Seismology Consulting Ltd. Suite 2, Observer House Abbey Lawn, Shrewsbury SY2 

5DE. United Kingdom 
E-MAIL: asc-support@appliedseismology.co.uk 

       WEB www.appliedseismology.co.uk 
T: +44 (0)1743 384 171 
 
 
 

2.3 Installation 
 
The software is distributed via our website ( appliedseismology.co.uk). To download the software, go to the ‘Support’ 

section of ASC’s website and click on the version of InSite you require. Click on the download button to begin downloading 
the installation file. Note: InSite is protected by either a USB dongle or by CopyMinder, to enquire about purchasing InSite,  
please contact us at asc-support@appliedseismology.co.uk or through the contacts page on our 

website: appliedseismology.co.uk. 
 

To install the software, double-click on the installation file named InSite-Setup-X.Y.Z-ARCH.exe, where 

X.Y.Z is the version number and ARCH is the architecture, either 32bit or 64bit (recommended). Figure 2-1 shows 

the installation program. There may be a warning about an unknown publisher. Please click yes to proceed. 

 
1. In the InSite Setup Wizard window press Next. 

2. Read the InSite Licence Agreement and press I agree to confirm. 

3. Read the CopyMinder user details and policy and press Next to confirm. 

4. Setup will check for Visual C++ redistribute and install if necessary when pressing Next. 

5. Choose whether to install for anyone using the computer or just me. 

6. Select the Installation folder where InSite should be downloaded. By default this is set to C:\Program 

Files (x86)\ASC\InSite\ for 32 bit operating systems and C:\Program 

Files\ASC\InSite\ for 64 bit. This can be changed by either typing in the destination or browsing to 

the appropriate directory. Click 'Next'. 

7. Select to enable or not the user access control (password protection for Administrator and other users)  

 
8. Confirm the Installation by clicking 'Next' on the following screen. 

 
9. The InSite software, drivers for the dongle, and CopyMinder files, will now install. 

 
10. Press 'Finish' on the final screen to complete installation. 

  

mailto:asc-support@appliedseismology.co.uk
http://www.appliedseismology.co.uk/
http://www.appliedseismology.co.uk/
mailto:asc-support@appliedseismology.co.uk
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Figure 2-1: Screen capture of the InSite Seismic Processor installation program. 

 
 
Once the set-up procedure is complete the software can be run by double-clicking on the InSite icon. A short-cut 

is already set up on the desktop. 
 

 
 

Figure 2-2: From left to right are InSite, InSite-HF, InSite-Geo, and InSite-Lab Icon. 

 
 

2.3.1 Using InSite with a USB Dongle 
 
 
If you have been supplied with a USB dongle, when starting the program, a message may be displayed after an 

installation that reports the dongle cannot be found. The user should remove the dongle from the PC and re-insert after 
a few seconds, at which point Microsoft Windows will automatically install the dongle drivers. If the Found New 
Hardware Wizard (Figure 2-3) starts with the question "Can Windows connect to Windows Update to search for 
software", then the user should select 'No, not this time' and click 'Next'. If it is the first installation then the Wizard may 
request the user locates the USB drivers, which can be found in the InSite installation directory. 
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Figure 2-3: The Found New Hardware Wizard in Microsoft Windows. 
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For version 3.8 and older, you can check your permissions by clicking the Help option, then About InSite ( Figure 
2-4). 
From version 3.9, the dongle permissions are not displayed due to the increased number of modules.  
 
 

 
Figure 2-4: The About InSite window for dongle protection. 
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2.3.2 Using InSite with a Network Dongle 
 

2.3.2.1 Installing and configuring DinkeyServer 
 
You need to provide the Network Administrator with the Dinkey Dongle Network Server. It is named 

DinkeyServer.exe but you can rename it if you wish. It is specific to your SDSN, so will only serve products that 

belong to you. To install DinkeyServer simply copy it to a directory on the machine that the Net dongle is attached to. This 
can be any machine on the network - it does not have to be a network server. To configure DinkeyServer first run it and 
then select the appropriate options from the configuration dialog: 

1. Choose to run DinkeyServer as an Application or as a Service (daemon under Linux). A Service starts automatically 

when the machine is booted and does not require a user to be logged in for it to run. Starting DinkeyServer as a 

Service is the recommended setting for general use. An application requires a user to be logged-on for it to run. 

This may not always be the case on server machines. You may want to start DinkeyServer as an application if you 

want to test it. 

2. The Network Configuration section allows you to configure the network settings that DinkeyServer will use. In 

Automatic mode, DinkeyServer will automatically choose the settings based on the best defaults combined with 

any existing configuration settings. This is the recommended setting. Custom mode allows you to manually specify 

the IP address and port that DinkeyServer will listen on. 

 
 
Under Linux if you want your daemon to automatically start when you boot up then you will need to create an init script 

to do this. 
 
Note - Under Windows if you choose to run DinkeyServer as an application and want to have it start automatically when 

the user logs in, then you must create a shortcut to DinkeyServer in that user's 'Startup' folder and specify the appropriate  
command-line parameters to make DinkeyServer start automatically. 

 
Note - DinkeyServer will list the Product Codes for each Net dongle attached to the computer.  
 
To start DinkeyServer click the "Start" button. It will then either run as an application and launch the viewer screen or  

install itself as a service and run in the background. You will need to have Admin Rights to install a service. 
 

2.3.2.2 Using DinkeyServer 
 

2.3.2.2.1 The DinkeyServer Viewer 
 

When DinkeyServer is running as an Application, it will display the Dinkey←› Server Viewer. This utility displays the status 

of DinkeyServer, the Product Codes it is serving, and the network users currently connected to it. A DinkeyServer icon 

will appear in the Windows System Tray. 

Y 
ou can also open the server's log file using this utility. The log file records important events during the running of the 

server and may need to be viewed to diagnose problems. 
 
When DinkeyServer is running as a Service, it will not display the viewer because Services cannot display Graphical 

User Interfaces (GUIs). However, you can still use the DinkeyServer Viewer by running DinkeyServer.exe with the 
/viewer command-line parameters. 
 

2.3.2.2.2 Command Line Parameters 
 

 DinkeyServer can accept several command-line parameters which control its behaviour. These are as follows: 

 

Command Description 

/s Configures DinkeyServer to install/run as a Service. 

/a Configures DinkeyServer to run as an Application. 

/q Quiet mode. Only displays errors. 

/u Uninstalls the DinkeyServer Service and terminates the DinkeyServer viewer. 

/t Stops the DinkeyServer service and terminates the DinkeyServer viewer. 

/showconfig Displays the configuration information (e.g listen address, port). Linux only.  
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/viewer Just display the DinkeyServer Viewer. 

/logfile Just open the DinkeyServer logfile. 

/listen=IPADDRESS Sets the IP Address on which DinkeyServer accepts connections (replace 

"IPADDRESS" with your chosen IP Address). You would only need to set this if your 

machine has more 

than one IP address. 

/port=PORT Sets the port on which DinkeyServer listens for connections (replace "PORT" with your 

chosen port number). 

/? Displays a help window documenting these command-line parameters. 

 
Note: under Linux instead of using / for parameters you use - for short parameters and – for longer parameters. e.g.-s 

and –viewer. 
 

2.3.2.2.3 General Notes 
Like any Service, DinkeyServer can be controlled through Windows Services Management (Control Panel 

Administrative Tools Services). 
 
If you remove or add a dongle to the machine running DinkeyServer then you need to restart DinkeyServer in order for 

it to be detected. 
 
If you have multiple network cards installed on your machine then the protected program may fail to automatically 

detect DinkeyServer (this can also be caused by virtualisation software, such as VMWare, installing "virtual" network 
adapters onto your system). In this case try disabling ones that don't connect to the LAN on which DinkeyServer runs.  

 
If you update a network dongle using DinkeyChange (e.g. increase the number of network users) while DinkeyServer is 

running then DinkeyChange will notify DinkeyServer which will instantly update itself. In this case there is no need to restart 
DinkeyServer. If you reduce the number of network users, then DinkeyServer will terminate some clients if the number of 
current network users exceeds the new limit. 

 

2.3.2.2.4 Firewalls 
Failure to correctly configure your firewall(s) could result in DinkeyServer being inaccessible by client machines.  
 

• Your firewall must allow both TCP and UDP traffic through to DinkeyServer. 
 

• Your firewall must allow DinkeyServer to accept incoming connections on the IP Address and Port that you 

chose when setting up DinkeyServer. 

 
• Clients (your protected software) auto-detect DinkeyServer by performing a multicast to 239.255.219.183 and 

whichever port you configured DinkeyServer to listen on. Your firewall must not block traffic destined for this 

address/port. 

 
• Under Windows the listen address and port DinkeyServer is using can be found by choosing Server Server 

details from the viewer menu. 

 
Like most server software, DinkeyServer accepts incoming connections by "listening" on a given IP Address and port. If 

the machine which runs DinkeyServer also runs firewall software (either the Windows Firewall or a third-party firewall) 
then the firewall software will need to be explicitly told to allow the incoming connections to get through to DinkeyServer. 
i.e. you must add DinkeyServer as an exception to the Firewall to do this). 

 
Likewise, if a firewall exists on a machine between the machine running DinkeyServer and the client machines then this 

will need to be configured too. 
 
Note - sometimes anti-virus programs can also include a firewall as part of the package. 
 

2.3.2.2.5 Log File 
DinkeyServer maintains its own log file in which it records various important events during its execution. While the 

server is running, all events are recorded to this log file rather than being displayed on-screen. The most common reason 
for needing to view the log file is to begin diagnosing a problem. 

 
You can view the logfile by running DinkeyServer with the /logfile command-line parameter. Alternatively, you can view 

it from the DinkeyServer Viewer (Windows only). 
 

The logfile is actually stored on disk in the "All Users" profile under the DinkeyServer/<SDSN> directories 
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(where <SDSN> is your Software Developer's Serial Number). 

 

2.3.2.2.6 Overriding DinkeyServer Autodetection 
In very rare cases the customer may be using a network that does not properly support UDP broadcast and so your 

protected program will not be able to auto-detect DinkeyServer on the network. Or, you may want to specifically tell your 
client-side protected software where to look for DinkeyServer. 

 

This is possible by creating a <prodcode>.ini file (where <prodcode> is the product Code of your protected 

program). This file should be in the same folder as your protected program (if you use the Shell Method) or the same folder 
as the protected runtime module, e.g. dpwin32.dll, if you use the API method. For Linux and Mac OS X operating 

systems the file is called <PRODCODE>.conf (the product code must be upper case) and is located in the 

/etc/ddpro folder. You will need to be root to create or modify this file. 

 
This file takes the following format: 

00 

[ddpro] 

server=<ip address> :<port> OR server=<machine name> :<port> autodetect=FALSE 
 

Where the server key indicates either the ip address of the machine where DinkeyServer is located or the machine 
name and <port> indicates the value of the port you chose in DinkeyServer. You can also optionally indicate whether you 
would like our code to try to auto-detect the server if DinkeyServer was not found given the ip address and port you 
specified. The default value for this is FALSE. e.g. 
 
00 
[ddpro] server=192.168.1.4:32768 

autodetect=FALSE 
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2.3.3 Using InSite with CopyMinder 
If you have been supplied with a license key, you will be prompted to enter the key when running the 

software for the first time. There are two types of activation depending on whether your computer has 
access to the internet. 

 
 

2.3.3.1 Normal activation 
 
If your computer has internet access, InSite will contact the CopyMinder server to verify the license key. 

InSite requires periodic access to the CopyMinder servers to verify the legality of the software. A log of all 
activity is kept in log file, called "InSIte.exe.cm.log" which can be found in the folder 
C:\Users\$USERNAME\App←› Data\Roaming\ASC\License\INSITE\Win32\cm. 

Full details of CopyMinder's privacy policy can be viewed here: 
http://www.copyminder.com/privacy.php. Your license key and permissions can be 

viewed by clicking the help option then about "About InSite" (Figure 2-5). 
 
 

2.3.3.2 Manual activation 
 
If your computer does not have access to the internet, a manual activation can be performed by selecting 

"Manual Activation", where InSite will provide an "Installation Code", which is to be entered into the 
CopyMinder activation website ( http://www.copyminder.com/activate.php), along with 

your license key. Once verified, copy the manual activation code and enter it into InSite to activate it. Once 
InSite has been activated via manual activation, it will never attempt to contact the CopyMinder servers. Your 
license key and permissions can be viewed by clicking the help option then about "About InSite" (Figure 
2-5). 

 
Figure 2-5: The About InSite window for CopyMinder protection. 

  

http://www.copyminder.com/privacy.php
http://www.copyminder.com/activate.php


2.4 Disclaimer  

 

48 

 

2.3.4 User access control 
 
User access to InSite can be controlled choosing the option during installation (Figure 2-6). This will 
allow to set a password-protected Administrator account on first execution of InSite (Figure 2-7). Please 
note that the first account set after installing InSite will have Administrator rights and InSite should be 
first executed by a person with these rights. For security, make sure that the installation program is only 
accessible to administrators as reinstalling InSite will override and reset this option. 
 
 

 
Figure 2-6: Enable the setup of user control in InSite during installation. 

 
 

 
Figure 2-7: Setting up Administrator account during installation of InSite. 

 
When the option is selected during the installation, InSite will request a user login to run. The File menu 
will include different user control options for Administrator and Standard users as shown in Figure 2-8 
and Figure 2-9. 
 
The Administrator account is set on first execution of a fresh installation of InSite by adding a password. 
Passwords for InSite user accounts must follow the following format: 

• Minimum of four (4) characters. The Administrator can change the minimum length of the 
password once inside the program using the ‘User Management’ dialog 

• Password must include as a minimum: 
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o One lower case letter 
o One upper case letter 
o One number 
o One special character (symbol): !,“,#,$,%,&,’,(,),*,+,-,.,,,/,:,<.=,>,?.@.[,\,],^,_,{,|,},~ 

 
InSite Administrator has the option to add new users or reset users passwords by clicking the ‘User 
Management’ option in the file menu. This will launch the dialog window shown in Figure 2-10. Adding a 
new user will launch the window shown in Figure 2-11, with the option to set user name and temporary 
password. 
 
The Administrator can customise the following user account settings: 

• Minimum password length: minimum number of characters for user accounts passwords. The 
value must be between 4 and 100. 

• Password expiry period: number of days after which users must change their password. The value 
must be between 1 and 1000. 

• Maximum login attempts: number of attempts after which the user account is temporarily 
blocked. Setting the value to 0 disables this option. 

• User Disabled Duration: number of minutes the user account is blocked after a the maximum login 
attempts have been exceeded. The value must be an integer between 1 and 1000000. 

 
 
Standard users have the option to switch user (Figure 2-12) and change their password (Figure 2-13).  

 
Figure 2-8: User control options for Administrator user in InSite’s File menu. 
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Figure 2-9: User control options for Standard user in InSite’s File menu. 

 

 
 

 
Figure 2-10: User management menu for Administrator users. 
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Figure 2-11: Adding a new user to InSite. 

 

 
Figure 2-12: Switching users in InSite. 

 
 
 

 
 

Figure 2-13: Changing user’s password in InSite. 
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2.4 Disclaimer 
 
This technical manual and software are sold to you AS-IS and Applied Seismology Consulting Ltd. makes no warranty as 

to its accuracy or use. We accept no responsibility for any inaccuracy, bug, error, omission or nonconformity of this 
software. Applied Seismology Consulting Ltd. accepts no liability for any damage directly, indirectly or consequentially 
arising from use of this product. 

 
Applied Seismology Consulting Ltd. reserves the rights to this document and the software it describes. No part may be 

reproduced or transmitted by any means without the prior written consent of Applied Seismology Consulting Ltd. 
 
It is understood that, by installing and using this software, the user agrees to be bound by these terms.  
 
 
 

2.5 Quick Start Workflow 
 
The typical workflow of processing seismic, microseismic (MS) and acoustic emission (AE) data is summarized in this 

section. For beginners, it is recommended to quickly review the settings following the steps in the workflow to familiarize 
themselves with the essential functions. The hyperlinks are provided for convenient navigation. 

 

 
 

Figure 2-14: The typical workflow of processing microseismic and acoustic emission data. 

 
 

1. Project setup: Use Array Editor Dialog or Shot Transmitter Dialog to import sensor array or source array if 

active sources are used, respectively. 

2. Data import and harvesting: Use Data Management Dialog to import your data. Multiple data formats are natively 

supported by InSite. If your data format is currently not supported, please contact us at asc-

support@appliedseismology.co.uk. 

3. Trigger classification: This is a complex task requiring certain experience to group triggered events to default 

type of "shot", "event", and "noise". See the event type. For triggering, see details in Leach. 

4. Shots: Seismic events that are generated by active/controlled source can be referred as shots, e.g., calibration 

shots in hydraulic fracturing, blasting in mining, ultrasonic pulses in AE setting. For hydraulic  fracturing 

projects, see calibration shots. For AE monitoring project, see Automatic Extraction Functions as one example 

of extracting active source from recordings. There are many applications after extracting shots. For example, 

geophone calibration, velocity calibration. 

5. Noise: classifying a triggered event as noise is subjective as it depends on the processor's confidence on low 

mailto:asc-support@
mailto:asc-support@
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quality signals. The rule of thumb is that an event without visible coherent waveform can be considered 

as noise. For low quality signals with barely observable coherent waveform, the source scan method might 

be an option to increase the size of the catalogue. Note that noise is dynamic, and the processors shall be 

aware of the trend of the noise for quality control purpose. The advanced waveform processing tools could 

be useful. 

6. AE/MS Event: Triggered waveforms with signal-to-noise ratio above one can be confidently classified as 

events. The following steps can be followed to process the data. 

7. Velocity model: the guidance of velocity model calibration can be found at Automatic Velocity Calibration. For 

laboratory AE data, please refer to Velocity Surveying Workflow. 

8. Auto-processing: the autoprocessor is to batch process all events. See Autoprocessing 
 

9. Manual check: Experienced data processors would agree that even when the first arrivals are picked with high 

accuracy and confidence, the location can only be as accurate as the velocity model. As a result, manual 

checking is a critical quality control step. After batch processing, switch to the 3D visualiser and filter out 

events that are located in a reasonable region and manually process the rest "problematic" events. 

10. Waveform picking: For automatic or semi-automatic picking of first arrivals, please see autopicking. The draw 

arrival picks is another nice trick you can use to speed up the process. 

11. Event location: For quick overview of all locater Dialog, please refer to Locater. Some details may also be 

found in Advanced Location Tools. 

12. Source parameters/mechanisms: See Source Parameters for a quick overview of all source parameters that 

InSite can calculate. 

13. Catalogue analysis and results output: See tasks 14, 15 and 16 below. 

14. 3D Visualiser: 3D visualiser is to explore the spatial-temporal pattern of the MS/AE data. See 3D Visualiser. 

15. Parameter analysis and charting: After all events are processed, a variety of 2D charts can be displayed and 

saved for publication or reporting purpose. See Parameter Visualiser. 

16. Uncertainty analysis: this is a special module built in the 3D Visualiser to enhance interpretation of the 

catalogue. See Uncertainty Analysis. 

17. Export: See tasks 18, 19, and 20. 

18. Waveforms: Finally, we are at the stage to share our results or to prepare for advanced customized processing. 

There are two ways to export waveform. One is to do it manually for each event using the menu bar on Event 

View. The other method is do it automatically for a group of events (see Autoprocessing). 

19. 3D View: To export 3D view, the user can use a screen capture built in (see Scene Sub-Menu ), or a third party 

screen capture software. 

20. Catalogue: Almost all processed results and parameters can be exported to ASCII format (see The Export sub-

menu the "The Export Submenu" for details). 

 
 

2.5.1 Feasibility study - Array design 
Before any processing effort, array design shall be performed to quantify the sensitivity and accuracy of the pro- posed 

acquisition geometry. 
 

2.5.2 Quality check 
Quality check is an advanced topic. As a rule of thumb, when the spatial-temporal pattern or the source parameters 

are not expected, before declaring a new discovery, processors must double check their processing settings starting from 
the very beginning, data harvesting. Usually, the geophone must be rotated again, or the velocity must be calibrated with 
more or less active sources. Sometimes the autopicking parameters must be adjusted for data acquired on different time. 
We at ASC provide comprehensive quality check services on vendor processed results to make sure the interpretation is 

not biased. For more details, please contact  asc-support@appliedseismology.co.uk for more information. 
 
 
 

mailto:%20asc-support@appliedseismology.co.uk
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 Navigation 
 

Start Page 

Global Button Bar 

Hot Keys 
 

3.1 Start page 
 
This page provides a quick way to get started using InSite, either by creating a new project, or opening an existing 

project by launching a Windows browser or by using the most recently used projects list ( Figure 3-1). 
 
 

 
 

Figure 3-1: InSite start page. 

 
 

 

3.2 Global Button Bar 
 
The global button bar allows for quick access to the main visualisers, tools, and options. The bar can float, or it can be 

docked in the top, bottom, left, or right of the window (Figure 3-2). 
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Figure 3-2: Global button bar in the left and bottom dock positions 



56 4. Data Management Structure  

 

3.3 Hot Keys 
All major visualisers, options, and tools can be launched with keyboard shortcut keys. The default hot keys are shown 

in Table 3.1. For a full list of default hot keys see the Hot Keys chapter. 
 

Table 3.1 Hot keys for major visualisers, options, and tools. 

 

Visualiser/Tool Command 

Data visualiser Ctrl+A 

Waveform visualiser Ctrl+Shift+W 

Waveform moveout 
visualiser 

Ctrl+W 

3D visualiser Ctrl+L 

Mechanisms visualiser Ctrl+M 

Stream visualiser Ctrl+G 

Frac manager Ctrl+Alt+F 

Processing properties Ctrl+Q 

Triggering (Leaches) Ctrl+Alt+L 

Parameter visualiser Ctrl+Alt+C 

AE Dashboard visualiser Ctrl+D 

Stream Dashboard Ctrl+E 
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 Data Management Structure 
 

Introduction 

Principal Data File Formats 

Advantages of the InSite Management System 

Data Identifiers 

Loading Data into InSite 

Data Access and Backup 

Tools Permissions 

Active and Passive Events 
 
 

4.1 Introduction 
 
Seismic data sets are often large and complex, involving data from a variety of different sensors collected over periods 

of minutes, days, weeks, months or even years. Alternatively, data may be collected by a temporary, portable seismic array 
that is deployed to a new position after a certain time period. Regardless of the nature of the dataset, the ability to obtain 
rapid access to any part of that data and inspect, process and analyse it is a key feature of this software. In order to take 
advantage of these powerful features, the user requires a good understanding of how the data is structured in  InSite. 

 
Figure 4-1 shows how the data is organised within a particular project. To allow easier management of a complex data 

set, a project can be split up into a number of components. Each component is a sub-set of the data, containing a number 
of events. These are often associated in some way, such as for a particular phase of an experiment, on a particular day, or 
particular year etc. The user has complete control over how the events are grouped into the components and events 
can be swapped between components if this is required. 
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Figure 4-1 The InSite Data Management Structure. 

 
If the event contains waveform information, then this is managed as a list of "Channels". As well as the waveform data, 

each channel contains all information associated with the waveform, such as the sensor information, configuration 
parameters, arrival picks etc. 

 

4.2 Principal Data File Formats 

• Project Configuration Files (PCFs) 

• Event Storage Files (ESFs) 
 
All the information used by InSite is contained within 2 file formats. These are:  

• Project Configuration Files (∗.PCF) 

• Event Storage Files (∗.ESF) 

Once a project is set up and these files are defined, access to any part of the dataset is straightforward. Depending on 
the tools that are being used the user may require access to only one of these file types to carry out a specific task. The 
details of these file types are given below. 

 
 

4.2.1 Project Configuration Files PCFs 
 
The PCF contains all the information used by InSite to define the current project, including a complete 'map' of the 

dataset and the settings the user has defined for processing and visualising the data. The data map includes a list 
of all the components associated with that project as well as information associated with the events within those 
components (Figure 4-1). For each event, parameters such as date and time, location, magnitude and other source 
parameters are stored. 
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4.2.2 Event Storage Files ESFs 
 
An ESF contains all the information required by InSite for an individual event. This allows the data for any event to 

be inspected and analysed independently of all other information. The ESF includes: 
 

1. Event data such as Number, Date, Time and, where appropriate (i.e. for velocity survey data) the 

transmitter/source details. 

 
2. The waveforms. This includes all channels for each sensor associated with a particular event. 

 
3. Waveform properties such as sampling interval. 

 
4. Receiver information associated with each waveform. 

 
5. Processed results from each waveform such as Phase picks and Phase velocities. 

 
6. Processed results from the event such as location, magnitude and source mechanism. 

 
The data included in parts 1 and 6 above are also contained within the PCF. The structure of the PCF and ESF files 

and their relationship is summarised in Figure 4-1. 
NOTE: An ESF is only produced when waveform data is imported. If no waveform data is imported, then all the 

Event information is stored within the PCF. 
 
 

4.3 Advantages of the InSite Management System 
 
The management structure inside InSite is a 'pure object-orientated' approach. This means that each Waveform is an 

independent entity within each Event. All parameters associated with that Waveform are stored collectively (termed here 
as a "Channel"). The same applies as the user ascends the data management tree: Events are individual entities within 
Components, and Components are individual entities within a Project. The system is a custom-designed data base that 
contains all the information concerning a particular seismic experiment, from the raw waveform data through to the final 
results. Built onto this data management structure is the ability for the user to  perform high level processing of the data 
and to visualise the results obtained. 

 
The flexibility within the data management system means that InSite has some useful advantages.  
 

• Each Channel stores its own receiver information within the Event. This means that the sensor array can be 

varied from one Event to the next and that an array can consist of a variety of different instrument types. 

 
• Each Channel contains a Waveform that can be sampled at a different rate or have a different length to the next 

Channel within the Event. 

 
• The data from a particular Component, Event or Channel can be quickly located and accessed, so it is very 

easy to navigate around the complete data set. 

 
• An Event can be independently processed without any other information, as the ESF contains all the param- 

eters required. 

 
• The dataset can be managed on the computer, and backed-up, very easily as all the information is stored in 

the set of ESF files. 

 
• The results can be easily managed, sorted and exported as the user can just choose the Events that fit some 

given criteria. 
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4.4 Data Identifiers 
 
In order to uniquely identify any particular 'piece' of data, the following rules are observed:  
 

• The name that the user assigns to a component is a unique identifier for that component. It is not possible to have 

more than one component with the same name within any single project file. 

 
Important: Do not use an "underscore" (_) in the name as this is a special character that InSite uses in file name 

construction. 

 
• The event number is a unique identifier within each component. Two events within a single component cannot 

have the same number. Two events in different components can have the same number (even if they are in the 

same project), as they are uniquely defined by the component that contains them. 

 
• The channel number (often assigned during acquisition as the channel on which it was recorded) is a unique 

identifier within each event. If several instruments record an event, then each channel must have a different 

number. 

 
 

4.5 Loading Data into InSite 
 
A variety of file formats can be read into InSite. The methods for importing data into InSite are described in detail in 

the Data section. 
 
Figure 4-2 shows the typical processing flow applied to full-waveform data. Subsequent chapters describe 

individual processing and visualisation tools. 
 

 
 

Figure 4-2: The typical processing flow when using InSite to process full-waveform seismic data 
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InSite also accepts visualisation of event data where waveforms are not necessary as the data has been previously 

processed in other software. In this case, it is simply a matter of importing the event parameters into the data 
management system and visualising the results. (Figure 4-3) 

 
 

 
 

Figure 4-3: The typical processing flow when using InSite with pre-processed seismic data. 

 
 
 

4.6 Data Access and Backup 
 
Data access is summarised by Figure 4-4. Where waveforms exist for an event, InSite produces an Event Storage 

File (ESF). When the software needs to obtain the waveforms for processing, or any parameters associated with the 
waveforms such as phase arrival times, then it will access the ESF in the specified data directory. The ESF is a stand-
alone data file that contains all parameters required to process that event. For large projects this means that a large 
set of ESFs are produced on the user's computer. It is important that the user backs up these ESFs if it is important to 
retain the waveforms and parameters associated with them. Once all events with waveforms have been converted to 
ESF format then the original data need no longer be accessed, however the user should always retain this data for 
future use. 

 
For an event where waveform data does not exist then no ESF is produced as all the required parameters are 

stored in the Project Configuration File (PCF). This allows InSite to import, manage and visualise pre-processed event 
results in an identical fashion as event data obtained from processing within InSite. 

 
There is an auto-backup feature enabled by default. The PCF is automatically saved every 5 minutes or every 30 

minutes during heavy CPU usage. The auto-backup is automatically turned off in autoprocessing to protect the process 
integrity. In the situation of abnormal exit of InSite, you will be prompted to load the backup file when opening the 
project if the backup is newer than the file. The auto-backup can be disabled from the File menu. 

 
An InSite project can be saved as a Demo project. This will allow the project to be opened and viewed using the 

Insite Demo and Viewer programs. To save a project as a Demo project ensure the 'Demo Project' option beneath the 
'Project' tab in Data Visualiser is ticked before saving as usual. 

 
 

Figure 4-4: Data access during an InSite Project. 
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4.7 Tools Permissions 
 
InSite is split into a number of tool packages each used to carry out a set of related functions.  Some of these tools are 

optional, as they would not, in general, be required for certain applications. The user is not obliged to purchase the full 
package; rather they may purchase only those tools they require for their work. Additional tools can be purc hased at a 
later date as they are required and become available. 

 
To operate the tools the software obtains a set of permissions either from the hardware "Dongle" connected to the 

parallel or USB port of the user's computer or using a license key for use with CopyMinder. Without this dongle or 
CopyMinder, no permissions are available. When the software is provided with restricted permissions (i.e. some of the 
tools are unavailable) then some functions and user operations are missing from the software or are disabled in the menus 
and button-bars. For convenience, this manual is written for a user with total permissions. There may therefore be some 
sections that are not applicable to all users and some screen captures that appear different to that observed in the  
software. 

 

4.8 Active and Passive Events 
 
"Seismic" experiments often provide both Active and Passive data. Active data is provided by a synthetic (man -made) 

source with a known spatial and temporal location. Processing the waveforms then provides transmission velocities and 
amplitudes through the experiment that can be used to infer changes in rock properties and/or used to calibrate results 
from Passive data. Active data can be transmitted over millimetres in laboratory rock samples, to kilometres in regional 
surveys. Passive data is obtained from the release of seismic energy from within the rock, often due to movements on 
fractures of different scales. Processing of this data can provide insights into the temporal and spatial extent of the 
fractures and the mechanisms by which the seismic energy is released. 

 
InSite wraps both the active and passive data using the same management structure, although the two are delimited 

by "Setting the Event Type". This discriminator determines which configuration parameters and processing functions can 
be applied to the data. 
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 Data Visualiser 
 

Key Features 

Visualiser Interface 

Visualiser Menu Systems 

Setting Sensor Arrays 

The Data Management Dialogue 

Event Properties 

Channel Properties 

Receiver Properties 

Configuration of Processing Properties 

Importing Event Parameters 

Event Discrimination Functions 

Moving Events Between Components 

AutoProcessing 

The InSite Leach 

The InSite Calendar Map 

Summary of Processing Results 
 
 

5.1 Key Features 

 

• Visualisation of the data base of seismic event parameters contained within the InSite Project. 

• Management of events by splitting into user-defined sub-sets (components) similar to organising files into folders. 

• Provides easy navigation of the data set and provides an interface into the other visualisation tools. Navigation is 

through point and click operations and allows an event recorded 10 years earlier to be as accessible as one 

recorded yesterday. 

• Manages the storage of seismic events into ESFs (Event Storage Files). A single ESF is produced for each 

event and contains all information associated with the event including waveforms, sensor information, 

processed waveform parameters, event header information and event results. 

• Manages the storage of the PCF (Project Configuration File) that contains a map of the data set and all project 

configuration parameters, such as the default sensor information, processing properties and scene drawing 

objects. 

• Manages the import of raw seismic data and conversion to ESFs ready for data visualisation and processing. 

Once imported the raw data files are not necessary for the operation of InSite and can be stored as a safe 

backup. 

• Manages the construction and update of the default sensor arrays (receiver and/or shot locations). The sensor 

locations are applied to each event when it is imported and can be updated at any time. 

• Provides access to Dialog-based configuration parameters used in each event. 

• Manages the configuration of processing parameters used in manual and automatic processing. 

• Each event can be defined as an 'Earthquake', a 'Shot' or 'Noise', or the user can create their own user event 

labels. This allows users to discriminate between data easily. 
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• Events can be 'Enabled' or 'Disabled' from the processing and visualisation functions. 
 

• Events can be moved easily between components. Unwanted data can be easily deleted from the project 

but can also be easily re-imported. 

 

• Provides access to the Auto-processor Dialog that batch processes user-selected data. 
 

• Events can be 'filtered' in the data set (automatically enabled or disabled) depending on their processed event 

parameters. The filtering limits are user set. 

 

• Events and components can be sorted in the visualiser by their parameters. 
 

• Provides access to the 'InSite Leach' (an additional optional tool) that interfaces to acquisition hardware and 

performs automatic data capture and on-line event processing. 

 

• Provides access to the 'Calendar Map' that allows the user to visualise the event data by date and time 

irrespective of the user's component organisation. 

 

• Provides access to the InSite distributed-software system allowing a user to transfer data between projects over 

a Local Area Network. 

 

• Manages the export of data to text files so as to transfer data to other software or for use in an event parameter 

backup system. 

 
 

5.2 Data Visualiser Interface 
 
The interface is shown in Figure 5-1. There are two panes. The left pane contains the Component List. The right pane 

contains the Event List in the active Component. A Component can be activated by clicking on it with the left mouse button. 
More than one Component can be selected by using a combination of Shift, Ctrl and left-mouse clicks, similar to those used 
in Microsoft Windows File Explorer. 

 

 
 

Figure 5-1: A screen capture of the Data Visualiser 

 
 
 

5.2.1 Component List 
The Component List contains the following data columns: 
 

• Name 
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• Enabled (Yes  , No        ) 

• Date, Time 

• NE (Number of Events in the Component) 

• NLocE (Number of located Events in the Component) 

• NEnabled (Number of enabled Events in the Component) 

• Colour (Component Colour) 
 
Clicking on any of the headings will sort the list according to those values in ascending order. Note that this sorting may 

take a noticeable length of time if the Project contains a large number of Components.  
 

5.2.2 Event List 
 
The Event List contains the following data columns. Further information on the results visualised here can be found 

in Event Data. 
 

• Type (Event , Shot , Noise  , User Event type       

• Event Number 

• Date, Time, Local Time, Label 
 

• Enabled (Yes  , No       ) 

• Source location position in North, East, Down 
 

• Location Units (x1.0m) 

• Location Magnitude 
 

• Waveforms included in Event (Yes  , No        ) 
 

• DB (Event included in database: Yes  , No    ) 

• NPT (Number of P-wave picks on Event) 

• NST (Number of S-wave picks on Event) 

• NLT (Total number of arrival picks used in location) 

• NIT (Total number of independent sensors used in location) 

• NLR (Total number of P-wave source vectors used in location) 

• NLQ (Total number of S-wave source vectors used in location) 

• LResid (Location RMS Residual) 

• LError (Location RMS Error) 

• AngRes (RMS Angular Residual) 

• IMag (Instrument Magnitude) 

• SNR (Signal to Noise Ratio - mean of P and S SNR for all traces in the event) 

• S.Mom (Seismic Moment) 

• MMag (Moment Magnitude) 

• Energy (Radiated Seismic Energy) 

• S:P (S-wave to P-wave Energy Ratio) 
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• Radius (Source Radius) 

• App.S. (Apparent Stress) 

• Static.S. (Static Stress Drop) 

• P.fc. (Average P-wave Corner Frequency) 

• S.fc. (Average S-wave Corner Frequency) 
 

• SM (Source Mechanism evaluated and Type: No  , Shear  , Exotic  ) 

• NA (Number of amplitudes used in source-mechanism inversion) 

• ISO, DC, CLVD components 

• R.Mom. (Relative Seismic Moment evaluated from the Source Mechanism) 

• A.Resid. (The RMS Amplitude Residual from the Source Mechanism) 

• Cond.No. (The Condition Number from the Source Mechanism) 

• Clust.ID. (Cluster ID Number) 

• P SNR. (Mean Average P-wave Signal to Noise Ratio Ratio - maximum amplitude in the P FFT window to the 

maximum amplitude in the noise window) 

• S SNR. (Mean Average S-wave Signal to Noise Ratio Ratio - maximum amplitude in the S FFT window to the 

maximum amplitude in the noise window) 

• RMS Noise. (Root Mean Squared Noise) 
 

• Auto Func P.(Mean Average Auto Picking Function for P-waves) 
 

• Auto Func S. (Mean Average Auto Picking Function for S-waves) 
 

• Confidence. (Confidence Number) 
 

• Mean P/SH (Mean P/SH amplitude ratio) 
 

• Mean P/SV (Mean P/SV amplitude ratio) 
 

• Mean SV/SH (Mean SV/SH amplitude ratio) 
 

• Mean P Resid (Mean P wave arrival time residual) 
 

• Mean S Resid (Mean S wave arrival time residual) 
 

• Radial Distance (Radial distance from the event to the well tra k - requires link to Frac Manager stage) 
 

• LErr.N. (Event location error in North direction). Calculated from location uncertainty isosurface. 
 

• LErr.E. (Event location error in East direction). Calculated from location uncertainty isosurface. 
 

• LErr.D. (Event location error in down direction). Calculated from location uncertainty isosurface. 
 
Clicking on the column headers will sort the list according to those values. The list can be sorted either by ascending or 

descending order. Note that this process may take a noticeable length of time for a Component containing a large number 
of Events. 
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5.3 Visualiser Menu Systems 
 
There are four primary menu systems in the Data Visualiser. 
 

1. Global Button Bar 
 

2. Button Bar 
 

3. Frame Menus 
 

4. Component List Menu 
 

5. Event List Menu 
 
Some options may be deleted from the menus depending on the permissions the user has purchased  
 
 

5.3.1 Global Button Bar 
 
The global button bar provides quick access to the main visualisers and Dialog 
 

 
Figure 5-2: Global Button Bar 

 
 

Table 5.1: Description of global button bar operations in the Data Visualiser View. Button labels A to J are 
referenced in the above figure (Figure 5-2). 
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5.3.2 Button Bar 
 

The button bar operations are described in  

 and  

Table 5.2. 

Button Name 
Description of Button 

Operations 
Reference 

A MS Catalogue Switch to Data Visualiser Data (Data Visualiser) 

B Setup Launch frac manager Frac Manager 

C Waveforms Switch to waveform visualiser Waveform Processing 
Tools 

D Waveform-
Moveout 

Switch to waveform moveout 
visualiser 

Waveform Moveout 
View Waveform 

Moveout View 

E 3D Visualiser Switch to 3D visualiser 3D Visualiser 

F Mechanisms Switch to mechanism visualiser Mechanism Tool 

G Stream Switch to stream visualiser Stream Visualiser 

H AE Dashboard Switch to acoustic emission 
dashboard 

Dashboard Visualiser 

I Stream Dashboard Swtich to stream dashboard Stream Dashboard 

J Processing 
Settings 

Launch processing parameters 

Dialog 

Configuration of 
Processing Properties 

K Triggering Launches the leach Dialog Leach Tool 

L Charts Launches parameter visualiser 

Dialog 

Parameter Visualiser 

Button Name 
Description of Button 

Operations 
Reference 

A New Open a new PCF file. N/A 

B Open Open an existing PCF file, 

launching a file browser. 

N/A 

C Save Save the PCF file. N/A 

D Import and Manage Data Launch the Data Management 

Dialog. 

Data Visualiser 

E Processing Properties Launch the Processing Proper- 

ties Dialog. 

Configuration of Processing 
Properties 

F Default Receiver Array Launch the Default Receiver 

Array Dialog. 

The Default Array Editor 

G Default Shot/Transmitter Array Launch the Shot/Transmitter 

Dialog. 

The Shot/Transmitter Properties 
Dialog box 

H Filter Events Launch the Event Filter Dialog. Event Filtering 

I Auto-processor Launch the Auto-processor 

Dialog. 

Auto-Processing 

J CSV File Export Exports the CSV file. CSV Event File Export (Appen- 

dices section 2.19) 

K Real-time Mode Set project to real-time mode  

L Auto Column Automatically adjust the column 

width sizes such that no text in 

the data view is truncated. 
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Figure 5-3: Button Bar 
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Table 5.2: Description of button bar operations in the Data Visualiser View. Button labels A to K are referenced in 
the above figure 

 
 
 
 
 
 

Button Name 
Description of Button 

Operations 
Reference 

A New Open a new PCF file. N/A 

B Open Open an existing PCF file, 

launching a file browser. 

N/A 

C Save Save the PCF file. N/A 

D Import and Manage Data Launch the Data Management 

Dialog. 

Data Visualiser 

E Processing Properties Launch the Processing Proper- 

ties Dialog. 

Configuration of Processing 
Properties 

F Default Receiver Array Launch the Default Receiver 

Array Dialog. 

The Default Array Editor 

G Default Shot/Transmitter Array Launch the Shot/Transmitter 

Dialog. 

The Shot/Transmitter Properties 
Dialog box 

H Filter Events Launch the Event Filter Dialog. Event Filtering 

I Auto-processor Launch the Auto-processor 

Dialog. 

Auto-Processing 

J CSV File Export Exports the CSV file. CSV Event File Export (Appen- 

dices section 2.19) 

K Real-time Mode Set project to real-time mode  

L Auto Column Automatically adjust the column 

width sizes such that no text in 

the data view is truncated. 
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5.3.3 Frame Menus 
 

5.3.3.1 The File sub-menu 
 
 
 

 
Figure 5-4: The File sub-menu 

 
 

• New Project - starts a new Project. 
 

• Open Project - opens an existing Project. 
 

• Save - saves the current Project. 
 

• Save As - saves the current Project, after prompting for a new name. 
 

• Auto Save - automatically saves the current Project at a certain time interval (None or every 1, 5, 10, 15, 30 

minutes, hourly, 6, 12, or 24 hours). 

 
• Auto Backup – enabled by default, regularly saves a backup pcf file (Data Access and Backup) 

 
• Import VVF Data - quick method of loading events from vvf type file. 

 
• AutoImport VVF - when this option is checked, the C:\ drive is scanned for vvf files in folders titled 'Well A' or 

'Well B'. The vvf is then autoimported into InSite and the original document is  deleted. 

 
• Edit Hot Keys - opens the edit hot key dialog 

 
• Export Report - export a text report summarising the project setup and settings 
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• Exit - closes InSite and automatically saves the current Project. 
 

• Exit Without Saving - closes InSite without saving the current project (prompts for confirmation). 
 

 
5.3.3.2 The View sub-menu 

 

 
Figure 5-5: The View sub-menu. 

 
The View menu allows the user to navigate between the tools that have graphical user interfaces (visualisers) associated 

with them. 
 

5.3.3.3 The Project sub-menu 
 

 

Figure 5-6: The Project sub-menu 

 
 
The Project sub-menu contains the principal operations required to configure a Project. 
 

• Edit Default Arrays - opens the Edit Default Array Dialog box for Editing the receivers or Shots/Transmitters 

(Setting Sensor Arrays). 

• Import and Manage Data - opens the InSite Data Management Dialog (The Data Management Dialog). 

• Configure Export Directory - Specify the export directory for auto-writing waveforms (e.g. ATF, SEGY, SEG2, 

and residual locations) (Figure 5-7). 

• Import Processing Parameters Files - opens a Dialog to allow the user to select which parameter to import to 

update current processing parameters (Figure 5-8). 

• Import Travel Time Data - Import travel time grid files created using the Fast Sweeping Method used by the 

Complex (Travel Time Grid Method) velocity model (Locater). 

• Processing Properties - opens the Processing Properties configuration sheets. 

• Real-time Mode - sets project to real-time mode. 
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• Compress ESFs - compresses the ESF files to reduce their size. 

• Disable Waveforms - provides the option to disable viewing of waveforms for all the events in the project. 

• Enable Waveforms - provides the option to enable viewing of waveforms for all the events in the project. 

• Split SEG-Y Files - opens a Dialog allowing the user to split large SEG-Y files into smaller sections. The only 

user-set parameters are input and output directories. 

• Split SRM Files - opens a Dialog allowing the user to split large SRM files into smaller sections. The only user-set 

parameters are input and output directories. 

 

 
Figure 5-7: Configure Export Directory Dialog 

 
 

 

Figure 5-8: Import Processing Parameters Menu 
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5.3.3.4 The Tools sub-menu 

 
Figure 5-9: The Tools sub-menu. 

 
 
The Tools sub-menu contains a number of functional services that can be launched.  

• Launch Auto-Processor - opens the Auto-processing Dialog Box 

• Launch InSite Leach - opens the InSite Leach enabling on-line data acquisition. 

• Launch Calendar Map - opens the InSite Calendar Map. 

• Launch Event Filter - opens the Event Filter Dialog Box. 

• Launch Wave Builder - opens the WaveBuilder Dialog Box for ray tracing functions. 

• Launch Fast Sweeping Method Builder - opens the Fast Sweeping Method Dialog Box for traveltime 

calculations (Travel Time Grid Method). 

• Launch Lookup Table Builder - opens the Lookup Table Generation Dialog Box for traveltime calculations 

(Travel Time Grid Method). 

• Launch Frac Manager - opens the Frac Manager Tool used in ASC's Hydrofracture services. 

• Launch Event Server - opens the Event Server Dialog Box. 

• Launch Event Download - opens the Event-download Client Dialog Box. 

• Launch InSiteDB Events - launches a Dialog box to control the connection to a database of seismic event 

information. 

• Launch InSiteDB Measurements - launches a selection box to control the graphical display of information from 

the database. 

• Launch Self-Test Utility 

• Launch Parameter Visualiser - launches the Parameter Visualiser. 

• Launch CSV Auto-import - launches the CSV auto-import Dialog. 

• Launch File Splitting Dialog 
 
 

• Launch Split SRM Files Dialog 
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• Launch Split SEED/miniSEED Files Dialog (Split SEED/miniseed for Streamer Leach) 
 

• Launch SRM to HDF5 Converter Dialog Files Dialog 
 

• Launch Calibration Shots Guide - launches the calibration shot guide 
 

• Launch Noise Detection Dialog 
 

• Launch Structural Analysis Tool - launches the Structure analysis tool. 
 

• Launch Array Analysis Tool - launches the Array modelling tool. 
 

5.3.3.5 The Events sub-menu 
 

 

Figure 5-10: The Events sub-menu. 

 
 
The Events sub-menu contains a number of general functions that can be applied to the data set.  
 

• Refresh Project From ESFs - accesses each ESF (associated with every Event that contains waveform data) 

and updates the Project's data displayed in the Data Visualiser (and contained in the PCF). This is only 

required if the user believes that the Project is no longer synchronised to the ESFs (e.g. if there has been a 

system crash). 

 
• Update Events from CSV - updates event data for existing events in the project from a CSV file. 

 
• Update Instruments from CSV - updates instrument data for existing events in the project from a CSV file. 

 
• Enable All Events - enables every event and component in the project (Enable and Disable Functions). 

 
• Disable all - allows the user to disable particular event types from the Project (Enable and Disable Functions). 

 
• Import LOG - allows the user to import a LOG file giving additional information on each event (Appendices 

section 2.2). 

 
• Auto-extract Surveys - a function that automatically sorts active events into surveys and then extracts them into 

individual components ready for processing (Automatic Extraction Functions) 

 
• Move All ESFs - moves all ESFs to a new directory (Moving Events Between Components). 

 
• Backup All ESFs - makes a copy of all of the ESFs in a new directory (Moving Events Between Components). 

 
• Purge All ESFs - deletes all ESFs in the component directories which are no longer referenced in the project 

(Moving Events Between Components). 

 
• User Event Types - allows the user to create, edit and delete their own event type labels (Setting the Event Type) 

in addition to the defaults of 'Event', 'Shot' and 'Noise'. 
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5.3.3.6 The Export sub-menu 
 

 

Figure 5-11: The Export sub-menu. 

 
 
The Export sub-menu allows the user to export data into standard ASCII formats that can be stored for later reference 

or imported into other software. These files are described in Table 5.3.  
 

Table 5.3: Data File Formats exported by InSite 

 

Export Type Description Reference 

Event Parameters File (EPF) Contains event parameters in a tab 

delimited file allowing the data to be 

easily read into mathematical 

processing software such as MS 

Excel. 

Appendices section 2.13 

CSV Event Data File Contains event parameters in a 

comma delimited file allowing the 

data to be easily read into 

mathematical processing software 

such as MS Excel. 

Appendices section 2.19 

CSV Instrument Data File Contains instrument parameters in a 

comma delimited file allowing the 

data to be easily read into 

mathematical processing software 

such as MS Excel. 

Appendices section 2.20 

VVF (Very Versatile Format) 

Event Data File 

Contains event parameters in a data 

format that can be easily read into 

customised data processing 

software. 

Appendices section 2.7 

Waveform Pick Results (PED) Contains a chosen data parameter 

from every channel in every event. 

Appendices section 2.14 

Trigger Parameters (TRF) Contains a report on every event 

including date and time, and the 

RMS and peak amplitudes on each 

channel. 

Appendices section 2.12 

Mechanism Axes (DIP) Contains mechanism orientation 

data in a format for import into 

plotting software 

Appendices section 2.15 

Survey Column Format (DCF) Contains a table of ray path data 

from surveys in the project. 

Appendices section 2.16 

Survey Stereonet Format (SSF) Contains data from a single survey 

for plotting on a lower-hemisphere 

stereonet. 

Appendices section 2.17 
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Export Type Description Reference 

Processing Parameters File (PPF) Contains all data processing 
parameters 

 

Waveform Parameters File 
(CSV) 

Contains the waveform parameters 

for every trace in a comma 

separated value format 

Appendices section 7.4 and 
2.24 

 
 
 

5.3.3.7 The Help sub-menu 
 
 

 

Figure 5-12: The Help sub-menu. 

 
The Help sub-menu contain documentation and information about the version of InSite currently being used.  
 

• Contents - view the Contents of the InSite User Manual (The Help sub-menu). By selecting the different tools, 

the appropriate section can be found. (Figure 5-13) 

 
• Index - titles of each section in the InSite User Manual listed alphabetically. 

 
• Search - allows the user to search the titles of each section in the InSite User Manual. 

 
• Technical Appendices - Opens the Appendix to the InSite User Operations Manual. A window opens and the 

pages can be negotiated by Contents, Index, and Search. 

 
• CopyMinder Update Permissions - Update the software permissions should the user's license be updated. This 

option only appears if using CopyMinder, dongle users won't see this. 

 
• About InSite - opens the About InSite Dialog Box. This gives the release version number, the user's 

identification (read from the software key) and the permissions the user has enabled in the software. 
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Figure 5-13: Help system in InSite. The three tabs can be used to navigate between Contents, Index, and Search 
modes. 
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Figure 5-14: Help system in InSite. The three tabs can be used to navigate between Contents, Index, and Search 
modes. 
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5.3.4 Component List Menu 
 

 

Figure 5-15: The Component List Menu. 
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Right-click on a Component in the Component List. Note that some of the functions can be applied to a set of 

selected Components. 
 

• Import and Manage Data - opens the InSite Data Management Dialog. 
 

• Enable Component - enables the Component to processing functions (Event Discrimination Functions). 
 

• Disable Component - disables the Component from processing functions (Event Discrimination Functions). 
 

• Rename Component - allows the user to change the name of the Component. 
 

• Add Empty Component - adds an empty Component into the Project for data management. 
 

• Delete Component - deletes the Component from the Project. 
 

• Choose Component Colour - allows the user to change the colour of the events from the Component in the 3D 

Visualiser. 

• Choose Component Symbol - allows the user to change the type of symbol used for events from the Component 

in the 3D Visualiser. 

• Merge selected components - merges two or more selected components (Moving Events Between 
Components). 

 
• Stack selected components - stack two or more selected components similar to (Create A Super Stage). The only 

difference is that the event time in the "stacked component" created in this way is not shifted. 

• QC Comparison - pair events from two different catalogues based on time for quality control purpose (future 

release). 

• Update Receivers in All Events - updates the receiver array details in each Event from the Default Receiver Array 

(Updating Sensor Information). 

• Update Shot/Transmitters in All Events - updates the shot/transmitter details in each Event from the Default 

Shot/Transmitter Array (Updating Sensor Information) 

• All Events are Type (Event/Shot/Noise/User Event Type) - changes the type discriminator assigned to all events in 

the selected Components (Setting the Event Type). 

• Update Local Attributes in Component 

– Updates the local time variable for each event using the local time offset information on the Event 

Initialisation tab of the Processing Properties Dialog. 

– Updates radial distance for each event (Pumping Data) 

• Import Event Parameters - allows event parameters to be imported into an existing Component. 

• Enable All Events in Component - runs through each event in the Component and enables it for processing. 

• Cancel Locations in All Events - runs through each event in the Component and cancels the location data. 

• Delete Disabled Events in Component - runs through each event in the Component and deletes it if it is disabled. 

• Auto-process all Enabled Events in Component - launches the auto-processor to select operations to perform on 

enabled events in selected component(s) only. 

• Export selected components to CSV (Events) - launches a Dialog (Figure 5-16) to allow the user to select which 

information to write to csv file for enabled and/or located events in the selected component. This method allows 

export of event and instrument parameters. 

• Export selected components to CSV (Instruments) - writes a csv file with instrument parameters for enabled events 

in the selected component. 

• Export selected components to VVF - writes a vvf file for enabled events in the selected component to file.  This 

method allows export of event and instrument parameters. For further information, see the Technical Appendices 

section 2.7. 
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• InSiteDB Operations - provides options to update information to/from a database (InSiteDB Transfer 
Operations). 

• Frac Manager Operations - allows data to be linked to Frac Manager information. 

• AE Dashboard - Export Arrival Times - Export VS1 and VS2 velocity picks for all the events in the component 

(Acoustic Emission Monitoring Dashboard). 

 

 

Figure 5-16: Export to CSV menu. 
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5.3.5 Event List Menu 
 

 
Figure 5-17: Event List Menu. 

 
This is launched by right-clicking on an Event in the Event List. Note that some of the functions can be applied to a set 

of selected Events. 
 

• Edit Event Properties - displays the Event Properties Dialog box (Setting Sensor Arrays). 

• View Waveforms - opens the Waveform Visualiser with the active Event. 

• View Mechanism - opens the Mechanism Visualiser with the active Event. 

• Event Type - changes the type discriminator assigned to the active Event. 

• Enable Event - enables the Event to processing functions (Enable and Disable Functions). 

• Disable Event - disables the Event from processing functions (Enable and Disable Functions). 

• Delete Event - deletes the Event from the Component and Project. 

• Move Event - the ESF files associated with the Event(s) are moved to a different component (Moving Events 
Between Componen 

• Copy Event - copy Events from one component to another or within the component itself (Moving Events 
Between Components). 

• Merge Selected Events - merges two or more highlighted events into a single event, padding the waveforms to a 

common start and end time. The user selects the component the merged event will be stored to. Each instrument 

in the events is treated as a separate instrument in the final combined array. 

• Cancel Event Location - cancels the location data associated with the Event. 

• Auto-process Event - launches the auto-processor to select operations to perform on selected events in selected 

component only. 

• Export to CSV (Instruments) - writes a csv file with instrument parameters for selected enabled events in the 
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selected component. 

• Update Receivers in Event - updates the receiver array in each Event from the Default Receiver Array (Updating 

Sensor Information). 

• Update Shot/Transmitter in Event - updates the shot/transmitter in each event from the Default Shot/←› 

Transmitter Array (Updating Sensor Information). 

• Update Local Time Offset in Event - updates the local time variable in the event using the local time offset 

information on the Event Initialisation tab of the Processing Properties Dialog. 

• Flag Event - highlight an event, and the component it belongs to, in the Data Visualiser. 

• Set Active - sets a located event as 'active' so it will plot with the active symbol in the 3D Visualiser. 

• Lock/Unlock - controls whether an event's picks/location can be altered. 

• InSiteDB Operations - provides options to update information to/from a database (Database Tool). 

• Set Vmax in all event traces. Allows traces to be cleared of clip marker if the gain was set too low in the channel  

properties before import (The Channel Properties Dialog box) 

 

5.4 Setting Sensor Arrays 

• The Default Array Editor 

• Updating Sensor Information 

• Treatment of Multi-channel Sensors 

• The Instrument Properties Dialog box 

• The Channel Properties Dialog box 

• Edit Multiple Receiver Properties 

• The Shot/Transmitter Properties Dialog box 

• Import from SEED and dataless SEED File 
A sensor array is required for the following reasons: 

• The locations of the default sensors (receivers and shots) are indicated on the 3D 3D Visualiser. 

• The configuration parameters associated with the sensors in each event are required for many waveform 

processing functions. 

There are two types of sensor that can be defined: 

1. Receiver: A receiver is associated with each channel in each event and defines where the waveform information 

was recorded and with what settings. The receivers associated with an event are defined collectively as the receiver 

array. Every event can have its own receiver array. 

2. Shot/Transmitter: A shot is associated with each active event within a component and defines the location at which 

the energy for that event was emitted. Each event can have its own shot information. 

There are two methods of setting receiver information in the events: 

• The settings associated with a particular event can be edited in the Channel Properties Dialog Box after the event 

information has been imported. This method requires the receiver array for each event to be set up independently 

- a laborious task if there are more than a handful of events all with the same receiver settings, but  a useful process 

if the sensor array is different for each event. 

• In many cases, all of the events have the same (or quite similar) receiver array settings. There is therefore a Default 

Receiver Array that acts as a pool of receiver information. If channel data is read in that does not have receiver 

information, then this is automatically copied from the Default Receiver Array (using waveform channel number = 

receiver channel number). The user can also update the event's receiver array from the Default Receiver Array 

using the Component and Event List menus. 

 
 
As InSite automatically looks for receiver information when importing raw waveform data then it is important to set up 
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the Default Receiver Array before importing data. 
 
Many field projects result in the receiver array changing with time as receivers malfunction or are moved around the 

monitoring volume. As each event in InSite records its own independent receiver array properties then these situations can 
be easily considered by editing the Default Receiver Array as the changes occur. The receiver array in  events previously 
imported will not be changed unless actively updated by the user. 

 
The Default Shot/Transmitter Array operates in a similar fashion to the Default Receiver Array. Shot/Transmitter 

information is indexed using the Event Number (i.e. event number = shot/transmitter number). It is therefore 
recommended that active Events are moved into separate Components for each survey where the Event Number is equal 
to its position in the array. The Shot/Transmitter properties are not obtained for newly imported data until the data is first 
processed, so as to allow active Events to be safely moved between Components and their event numbers to be changed. 

 
 
 

5.4.1 The Default Array Editor 
 
The Default Array Editor displays all the sensors that are configured within the array (either receivers or 

shots/transmitters) (Figure 5-18). Sensors can be added, edited and deleted. Editing a sensor displays the Instrument 
Properties Dialog box. The sensor array can also be imported/exported from/to a SEN file (Technical Appendices section 
2.1), a CSV file (Technical Appendices section 2.21), an station XML file or a SEED or dataless SEED format. For shallow 
co-located receivers on the surface, users can stack co-located receivers as a single receiver. The receiver’s layer 
velocity is used to calculate a shift for each receiver being stacked. Stacking is not recommended for other array 
configurations. 

 

 
Figure 5-18: The Edit Default Receiver Array Dialog box. 
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1. Import sensor array from a file 

2. Add a sensor 

3. Edit a sensor 

4. Delete a sensor 

5. Stack waveforms from selected 

6. Unstack waveforms from selected 

7. Check orientation of the array (X direction from Y, uphole/downhole, axis order, and orthogonality) 

8. Export sensor array to a file 

9. Enable/disable sensors within the selected group 
 

5.4.2 Updating Sensor Information 
It is important to note that each event has its own receiver properties for each channel. These are independent from 

the Default Receiver Array. The receiver settings for any particular event can be viewed from the Event Properties Dialog 
box. The channel settings can then be accessed from here. 

 
After importing raw waveform data into InSite's data management system, it may be necessary to update the receiver 

array associated with a large number of events in the Project. This also applies to the shot/transmitter properties associated 
with active Events. To enable this, the Component List and Event List drop down menus (sections 4.2 and 4.3.5, respectively) 
have options that allow the user to update the chosen set of Events or Components from the Default Receiver Array.  

 

5.4.3 Treatment of Multichannel Sensors 
A receiver must be set for every channel that has a waveform. Groups of channels are linked together into multi - 

channel sensors, termed "Instruments", and this system allows up to four channels to be linked together. When  'Add' is 
pressed on the Default Receiver Array Dialog, a new instrument is added to the array, initially with a single channel. 
Additional channels may be added through the Instrument Properties Dialog. 

 
This instrument setup does not require the waveforms from an instrument to be acquired on subsequent channel 

numbers as every channel is individually set. It also allows processing of not only triaxial or uniaxial sensors, but also biaxial 
(perhaps a triaxial with one channel malfunctioning) and quadriaxial (Figure 5-19). 
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Figure 5-19: Multi-channel sensors are configured by setting a group of receivers to the same Instrument Number. 

Each receiver has a unique axis label as an identifier. Instruments can contain up to four channels from any 
channel number in the array. 

 
The user can select how the channels are processed and visualised (in the Waveform Visualiser) from the Event 

Initialisation Property Sheet in the Processing Properties. There are two modes available: 
 

• Channel - processes the event using no grouping of channels. This is the simplest approach allowing the user to 

quickly look at waveforms in the data without having to configure the Instrument structure. This is also the  

recommended mode when using an array of purely uniaxial sensors. 

 
• Instrument - processes the event by grouping the channels into instruments. This allows complex configurations 

of sensors to be used and allows processing of multi-channel sensors for advanced source parameters. 

 
The Channel and Instrument modes allow InSite to provide roles of varying complexity to the user. If the user is briefly 

investigating waveform data from a simple sensor array, in order to gauge the data's quality, then the channel mode is 
adequate. If the user has a complex array, or wishes to obtain detailed source information, then the software should be 
configured for instrument processing. 

 
 

5.4.4 The Instrument Properties Dialog box 
The Instrument Properties Dialog box (Figure 5-20) allows the user to modify any of the settings associated with an 

instrument used for data acquisition. An instrument can contain up to four acquisition channels and the channel numbers, 
associated with the instrument being edited, correlate with acquisit ion channels. The Instrument Properties Dialog box 
contains fields, which may be edited, that are common (by definition) to all channels belonging to that instrument. 
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Figure 5-20: The Instrument Properties Dialog box. 
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The acquisition data type defines what particle motion the receiver responded to. The options are volts, 

displacement, velocity or acceleration. 
 
The instrument location must be defined in a North-East-Down (NED) co-ordinate system. (Figure 5-21) 
 

 
Figure 5-21: Definition of a receiver location and orientation 

 
 
Flags are available for the user to select what instrument information is used in the location and source parameter 

algorithms when processing. The orientation or amplitude scaling of certain instruments may not be known, and in 
this case the user may only wish to use arrival time information from an instrument. 

 
Static station corrections may be configured, either to compensate for timing errors on an instrument or for lateral 

velocity variations, anisotropy and uncertainties. 
 
Channels belonging to the instrument can be added, edited or deleted using buttons at the bottom of the 

Instrument Properties Dialog and highlighting the required channel in the list box. This will launch the Channel 
Properties Dialog (Figure 5-22). 

 
 
 

5.4.5 The Channel Properties Dialog box 
 
The Channel Properties Dialog box allows the user to modify any of the settings associated with a channel used 

for data acquisition (Figure 5-22). 
The channel number associates the receiver being edited with an acquisition channel. Channels grouped together  

as a multi-channel instrument are differentiated using the axis label (X, Y, Z, A) and axis orientation. 
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Figure 5-22: The Channel Properties Dialog box. 

 
See Receiver Properties for full description. 
 
 
 
 
 

5.4.6 Edit Multiple Receiver Properties 
 
The properties of more than one receiver can be simultaneously updated from the Default Receiver Array Dialog. 

The user should highlight the instruments to be edited in the default receiver array and press the 'Edit' button. This 
launches a Dialog allowing the user to change the properties of the selected instruments. The user can enable/disable 
channels, change the amplitude or frequency response parameters, alter the response type, sensor diameter and 
distance units. (Figure 5-23) 
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Figure 5-23: Editing properties of multiple instruments. 
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5.4.7 The Shot/Transmitter Properties Dialog box 
 
The Shot/Transmitter Properties Dialog box (Figure 5-24) allows the user to modify any of the settings associated 

with a shot/transmitters used for data acquisition. A shot/transmitter is set for each event in a component. The event 
number associates the given properties to a particular event in the component. 

The shot/transmitter location and orientation are defined in the same manner as a receiver (The Instrument 
Properties Dialog box). 

 
 

Figure 5-24: The Shot/Transmitter Properties Dialog box. 

 

9.2.2 Import from SEED and dataless SEED File 
 
Importing sensor array information from CSV, SEN, Seg2, SEED or Dataless SEED format is done by the "Import 

from file" button. If using SEED or Dataless SEED you will see the following option to select which reference 
ellipsoid is used for the conversion from latitude/longitude to coordinate in north and east, respectively. You will 
also be asked whether you wish to perform deconvolution automatically on reading. This removes the instrument 
response from the waveforms. You can turn off the automatic deconvolution in the Channel Processing tab. 

 
 

 
 

 

Figure 5-25: Options when importing sensor information from SEED or Dataless SEED. 
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Once a SEED file is imported you can view or delete the headers information from the PCF using the new 
options available in the Edit Default Receiver Array Dialog box. These two buttons are invisible if users are 
importing stations from file format other than SEED or dataless SEED or becomes invisible after deleting SEED 
headers. 

 

 

 

Figure 5-26: Updated view of the Edit Default Receiver Array Dialog box when SEED files have been imported 

 

9.2.3 Import from XML station File 
 
Sensors can be configured directly importing an XML station file provided by the seismic network 

management system. For a description of the station XML file format please visit 
https://docs.fdsn.org/projects/stationxml/en/latest/index.html . When importing the file you will see the 
following option to select which reference ellipsoid is used for the conversion from latitude/longitude to 
coordinate in north and east, respectively.  

 

https://docs.fdsn.org/projects/stationxml/en/latest/index.html
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Figure 5-27: Options when importing sensor information from SEED or Dataless SEED. 

 
 

5.5 The Data Management Dialog 
This Dialog box (Figure 5-28) allows the user to import data into InSite. A number of data formats (Table 3.1) 

are currently recognised. 
 
Below is a set of recommended steps that the user should take to perform an import process. During the import 

process the data are automatically added as new Components. Each Component Name is produced from the data file 
name using one of the following methods: 

 
1. Files with an InSite naming structure give the Component Name as part of the file name immediately 

preceding the first _ (underscore) character, e.g. component_0001.esf. 
2. The Component Name is taken directly from the base name of the file character string preceding the '.' 

character, e.g. component.rdb. 
3. The Component Name is taken from the directory name in which the files reside, e.g. 

\component\rcbuff01.dat. 
 
InSite is designed so that the user can have a structured data storage system on their hard drive. Any 

waveform or event parameter files to be imported into InSite, other than the ESFs that are being directly 
accessed by the Project, are termed as "Raw" data. After the import process, InSite will have produced an 
ESF for every Event imported that contains waveform data. The raw data is then no longer needed for routine 
use of the software and should be stored in a safe place. For Events that have no waveform data, perhaps 
because they've already been processed elsewhere, the data is stored directly in the PCF (see Principal Data File 
Formats for further explanation of the InSite data files ESF and PCF). 

 
 



5.1 Data Visualiser 95  

 

 

 

Figure 5-28: The InSite Data Management Dialog 

 
In order to import and manage data the user must tell InSite where the data resides on the user's PC by choosing 

two data directories: 
 

• Import Directory 

• ESF Storage Directory 
 
The Import Directory is the location of the raw data. The data can be contained either immediately in this directory 

or in a sub-directory. This allows the user to structure how the data is stored. For instance, all data from one day may 
be stored in their own directory. 

 

...\MyData\day1\day1_0001.esf ...\MyData\day2\day2_0001.esf ...\MyData\day3\day3←› 

_0001.esf 

 
By selecting MyData as the Import Directory, InSite will then allow the user to import all data from within all sub- 

directories, so making it easy for the user to import large amounts of data very easily.  
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Table 5.4: Data types currently recognised by InSite. Component name is obtained from one of the above 
methods. 

 

Data Type Description 
Format 

Reference 

Compon
ent 

Name 

Channel/receiv

er properties 

set 

from data file 

ESF 

InSite's Event Storage Files are 

accessed directly by InSite. 

Event Storage 
Files 

1 All 

ESF External 

Import 

InSite's Event 

Storage Files are copied and 

imported into InSite 

Event Storage 
Files 

1 All 

RCBUFF 

Queens University and ESG 

Canada Inc. Hyperion system 

format. 

N/A 3 None 

ATF 

InSite's ASCII Trace Files allow 

import and export of wave- forms 

for external 

use 

Appendices 

section 2.8 

1 p, s, g, Vmax 

GIGA 

As RCBUFF but for the Ultrasonic 

Giga- recorder system. 

N/A 2 None 

STWIF 

Client waveform 

data file 

N/A 2 None 

WFT 

Waveform storage files 

recorded by Nicolet Digital 

Oscilloscopes. 

Appendices 

section 2.9 

1
, 
2 

Vmax 

SEGY 

File developed by the Society of 

Exploration Geophysicists for 

storing geophysical data. It is an 

open standard and is controlled by 

the non-profit SEG Technical 

Standards Committee. More 

information on the import of 

SEGY files can be found on the 

[Frequently Asked Questions] 

page. 

N/A 2 p, s, g, Vmax 

SEG-2 

File format developed by the 

Society of Exploration 

Geophysicists for storing 

geophysical data. It is an open 

standard and is controlled by the 

non-profit SEG Technical 

Standards Committee. 

N/A 2 p, s, g, Vmax 

SEG-D 

File developed by the Society of 

Exploration Geophysicists for 

storing geophysical data. It is an 

open standard and is controlled by 

the non-profit SEG Technical 

N/A 2 p, s, g, Vmax 
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Standards Committee. 

MIRF 

Media Independent Recording 

file recorded by the Avalon 

monitoring system. 

N/A 2 p, s, g, Vmax 

GCF 

Güralp’s Com- 

pressed Format recorded by 

Güralp’s sensors. 

N/A 2 N/A 

Seisan 

Standard format N/A 2 N/A 

RDB 

Event parameter data file from 

Queens University and ESG 

Canada Inc. 

Appendices 

section 2.3 

2 N/A 

PUN 

Event parameter data file stored 

by HYPO71 event location 

program 

Appendices 

section 2.5 

2 N/A 

SDR 

Client event parameter file. N/A 2 N/A 

SRC 

Event parameter data file from 

Queens University and ESG 

Canada 

Inc. 

Appendices 

section 2.4 

2 N/A 

VVF 

InSite's Very Versa- tile File 

format. Allows open source 

import and export of data to 

other software. 

Appendices 

section 2.7 

2 N/A 

EPF 

Contains event parameters in a tab 

delimited file allowing the data to 

be easily read into mathematical 

processing software such as MS 

Excel. 

Appendices 

section 2.13 

2 N/A 

CSV 

Contains event parameters in a 

comma delimited file allowing 

the data to be easily read into 

mathematical processing 

software such as MS Excel. 

Appendices 

section 2.19 

2 N/A 

SAC Binary 

Contains event data in a 

binary SAC file. 

N/A 2 N/A 

MiniSEED 

Contains event data in 

MiniSEED format. Each 

channel's waveform data is 

stored in a single MiniSEED 

file. 

N/A 2 All 
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PFC 

Contains event data in a PFC 

file created using Itasca's PFC 

software. 

Appendices 
2.23 

2 All 

BDF 

Continuous or triggered 

waveform data acquired using 

Elsys’ data acquisition systems 

 2  None 

 
 
The ESF Storage Directory is where InSite stores the ESFs during the import process and where it will access 

ESFs when needed. InSite can be configured so that it automatically stores data from different Components in 
separate sub-directories. This is recommended when importing large numbers of Events with waveforms so that 
the number of files stored in a single directory does not become too large (large numbers of files reduces the 
efficiency in accessing the files). 

 
As InSite only reads the raw data, the Import Directory can be on a read-only device such as a CD-ROM. 

However, the ESF Storage Directory must be on the local hard drive of the user's PC. During the import process 
InSite automatically converts all raw waveform data into ESF format ready for processing. For some data types 
the user has the option to switch this off. Instead, a list of available Events is created in InSite from the raw data 
and the ESF is only produced when the user first accesses each Event for processing. This is ideal for situations 
where the user just wishes to browse the data, for example, as a quality control check or for particular data. The 
drawback is that the raw data must remain available for reading after the import process has been completed. 

 
The Data Types "ESF" and "ESF External Import" use the same format of files, however the latter imports the 

data from the Import Directory and stores new ESFs in the ESF Storage Directory. This is useful if the user has 
existing ESFs that shouldn't be changed by further processing or has ESFs on a CD awaiting data processing. 
The Data Type "ESF" reads in ESFs from the ESF Storage Directory and accesses these directly when 
necessary. This is useful if the user has ESFs for processing that have been previously processed by InSite. 

 
 

5.5.1 Data Import steps 

1. Choose what type of data (Table 5.4) is to be imported and select this in the Data Type Drop-down Box. 

Complete the Data Properties Dialog if applicable for the data type used to make additional settings. 

(Figure 5-28) 

2. Select the location of the data. The data can either be on a local drive (e.g. a hard drive, CD-ROM or 

other device attached to the PC), or on a remote PC on a Windows Local Area Network. Select the Import 

Directory by clicking on the Browse Button. 

3. Choose where InSite should store any created ESFs. Select the ESF Storage Directory by clicking on 

the Browse Button. If the ESFs for each imported Component should be stored together in separate 

sub- directories, then select the flag. 

4. Navigate the data tree shown in the Available Data Pane to find the data for import. Data directories and files  

that can be selected will be shown in the Data Selection Pane (all data shown is automatically selected). 

5. Select different parts of the data if necessary (either directories - if all of the data in that directory is to be 

imported - or individual files). The Shift and Ctrl keys are available to aid in selecting different parts of the 

data set (similar to Windows Explorer). 

6. Click on the Import Data Button. The data will be automatically imported and displayed as Components in 

the Project Component Pane. 

 
Note: For SEGY and BSF data, if the import fails due to missing receivers, the required receivers are displayed 

in the error message. 
  



5.1 Data Visualiser 99  

 

 

Table 5.5: Description of controls on the InSite Data Management Dialog. 

 

Dialog Item Description 

A Data Type Drop-down box 

B Import Directory - directory where files that are to be imported are stored, or the directory 

immediately above this in the directory structure. 

C Automatic Waveform Conversion Flag - unselect this to stop InSite from automatically 

converting waveform data to ESF format (only available for some data types).  

D ESF Storage Directory - directory where InSite is to store ESFs created in the import 
process. 

E ESF sub-directory flag - select this to store ESFs in a sub-directory of the ESF Storage 

Directory 

F Available Data Pane - a navigable tree of valid data directories and data files in the Import 

Directory (ESF Storage Directory if "ESF" data type is selected). A valid data directory is a 

sub-directory that contains valid data files. 

G Data Selection Pane - a list of valid data directories or data files that can be imported. 

H Data Properties - certain data types have variables that can be adjusted which are 
located here. 

I Component Properties - the properties of the selected component in the Project 

Components Pane. This allows the directory, where ESF files for that component are 

stored, to be directly changed 

J Available disk space indicator for the ESF Storage Directory - InSite will stop importing 

data and produce an error if the Disk Space Critical Level is reached. 

K Project Components Pane - a data tree of Components existing in the project, updated 

after every import process. 
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∗ 

 

 
Figure 5-29: RCBUFF data files are being imported in this example. The RCBUFF files are stored in 439 

different directories. Top-left shows some of these directories in Windows Explorer. Top-right shows InSite's 
Data Management Dialog when one of these directories is selected as the Import Directory - the user can 
select the RCBUFF file and import the data. The bottom-right shows the case when the directory above is 

selected. InSite searches for all sub-directories containing valid data and displays them so that the user can 
then select as many directories as required and import the data. 

 
 

5.5.2 Additional Import Settings 
For several data types the user has options for additional settings. 

a. If the type of data is SEGY or SEG2 then a Dialog will be launched that allows the user to configure 
the waveform scaling to be used (Figure 5-30). If the user selects to 'Apply Receiver Scaling on Import' 
the sensitivity and gain values from the default receiver array are used to update the imported 
waveform amplitudes. The default behaviour if the 'Apply Weighting Factor on Import' box is checked 
is to apply the weighting factor from trace header field at byte 169 following the SEGY revision 1 
standard. The 'Waveform Data range' can be set as 'Pre-scaled Amplitude', where the imported data 
are assumed to be in volts, or a bit sample range, where the imported data are converted to volts 
using the counts range specified by the bit sampling chosen by the user and the maximum volts range 
from the default receiver array. Checking the option for SEGY from Sercel reads the trace number and 
sub-second start time fields from the SEGY headers following the Sercel convention instead of SEGY 
revision 1 standard. The millisecond is from byte 169-170 and the microsecond is from byte 171-172. In 
addition, the descaling factor from byte 207-210 and the descaling power from byte 211-212 are used 

to compute the descaling factor, i.e., descaling factor 10∧(-descaling power). Checking to 'Apply 
Weighting Factor on Import' when the Sercel type is selected reads and applies the descaling factor 
from the Sercel file SEGY header, otherwise applies the descaling factor from byte 169. Note in situations 
when user can only import their SEGY not acquired by Sercel tools using Sercel format is likely due to the 
missing of trace number. InSite reads trace number from trace header at byte 3,4,5,6 for regular SEGY and 
from byte 7,8,9,10 for Sercel Segy format. 
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b. If the type of data is GCF then a Dialog will be launched that allows the user to configure the file and folder 

structure in which the data is stored (Figure 5-31). The option to use this Dialog information must 

be checked ('Use format string for GCF import') and the corresponding SENTABLE.txt file set to option 5. 

The correct radio button for whether a file is written per instrument (multi-channel) or per channel should 

be selected. The format string should be given following the rules given in Guralp's SCREAM! manual. The 

format specifier can contain the following characters: 

 
• YYYY or YY denoting the year 

• JJJ or RRR denoting the Julian day 

• MM or MMM denoting the month in numeric or alphabetic format 

• DD denoting the day 

• HH denoting the hour 

• NN denoting minutes 

• SS denoting seconds 

• I denoting the instrument (this should relate to the sentable.txt instruments) 

• T, E and A for stream ID, serial number etc. These are not used by InSite 

• C to indicate the component (e.g. Z, N or E) 
 

c. If the data of data is MiniSEED then a dialog will be launched that allows the user to configure the file 
structure in which the data is stored. (Figure 5-33). The format string should be given following the rules 
below: 

 
• YYYY denoting the year 

• JJJ denoting the Julian day 

• DDD denoting the Julian day 

• MM denoting the month (if Julian day not specified) or minute 

• DD denoting the day of the month 

• HH denoting the hour in 24-hour format 

• NN denoting the minute 

• SS denoting the second 

• ? followed by a number of S characters denoting station code (e.g. ?SSSS would correspond to a 

station code 4 characters in length) 

• L denoting the record number 
• C denoting the channel number (may be omitted as the header inside the file contains this 

information). The length of each field should match the length of the field in the folder or file names, 
apart from  

 

d. To import BDF data from rock or material deformation and fracturing tests acquired using Elsys 

systems containing ultrasonic surveys, the variables shown in the ‘BDF Settings’ dialog (Figure 5-34). 

The values entered in the dialog must match those used during the acquisition (using the AE-amp 

application). 

e. If the type of data is CSV then a Dialog will be launched that allows the user to select to import all 

events to a single component, regardless of their component in the CSV file (Figure 5-32). The user 

should select this option and give a new component name. For this option the CSV file should have 

the same format as InSite exported CSV file (see Appendices section 2.19). 

 
f. To import a catalogue from a third party, it is recommended to store the parameters ini CSV format 
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and use the second option “Select CSV file before import”. As shown in Figure 5-35, users are 

required to match the external field with InSite parameters. Note that when source mechanism is 

provided, InSite keeps its own way of calculating source parameters to avoid “self-conflicting” 

information. There are 3 ways of importing source mechanism, i.e., by moment tensor (m11, m12, 

m13, m22, m23, m33), by angles (strike, dip, rake, tensile opening), or by fault planes (normal and slip 

vectors). Importing moment tensor only is preferred. For the other 2 methods, InSite will convert it back 

to moment tensor and store the source mechanism in the form of moment tensor in the PCF file. Note 

that for double couple sources, the correspondence between moment tensor to angles and fault 

planes is not unique due to the ambiguity between the fault plane and the auxiliary plane. 

 

g. The external source mechanisms can be visualised in 3D scene in terms of DFN Plane/Disk or Beach 

balls (see Scene Properties). 

 
 

Figure 5-30: SEG2 and SEGY import Dialogs. Apply Receiver Scaling is to apply the gain and sensitivity to the 
raw amplitude. Apply Weighting Factor is to apply the weighting factor in SEG/SEG2 file header to the raw 
amplitude. Sercel SEGY file header stores additional gain and sensitivity information, thus Use SEGY Format 

from Sercel is to correct the amplitude from Sercel instruments. 

 

 
Figure 5-31: GCF import Dialog. 

 

 
Figure 5-32: CSV import Dialog. Users are allowed to assign certain columns from a CSV file to InSite internal 

parameters. Select CSV fields before import is recommended for InSite incompatible CSV file format. 
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Figure 5-33: MiniSEED import dialog. The filename format string is to skip certain characters in the filename 

before and/or after the characters for year (YYYY), month (MM), day(DD), hour(HH), minute(NN), and 
second(SS). For example, to extract the date and time from file named 

“XYZ_103214_20171001_025802.msd”, the string could be as simple as “sss_ssssss_YYYYMMDD_HHNNSS”. 
Characters like “?”, “L”, “C” are not required but can be used to make the string format more informative. 

 

 
Figure 5-34: Additional settings for the import of BDF files containing ultrasonic surveys. The values of the 
variables must match those used during the acquisition using Elsys systems. 

 

 
Figure 5-35: To import a catalogue to InSite. The external field can be matched with InSite parameter by the 

dropdown menu. Note that when source mechanism is provided, InSite keeps its own way of calculating 
source parameters to avoid “self-conflicting” information. Among 3 ways of importing source mechanism, 
i.e., moment tensor (m11, m12, m13, m22, m23, m33), angles (strike, dip, rake, tensile opening), and fault 

planes (normal and slip vectors), importing moment tensor only is preferred. For the other 2 methods, InSite 
will convert back to moment tensor and store the source mechanism in the form of moment tensor in the 

PCF file. 
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5.6 Event Properties 
The Event Properties Dialog box (Figure 5-36) allows the user to change the properties associated with a 

particular Event. From here, the channels contained within an Event can be viewed and the properties for a 
particular Channel can be accessed via the Channel Properties Dialog box. The Channels Pane shows information 
associated with each channel such as the sampling used and receiver properties. 

 
 

Figure 5-36: The Event Properties Dialog box. 

 
 
 

5.7 Channel Properties 
The Channel Properties Dialog box (Figure 5-37) allows the user to change the properties associated with a 

particular Channel. 
 
Properties that can be changed include the following: 
 

• Waveform Sampling Time and Time Units. 

• The Pre-signal Points. This is the length (in data points) of the Pre-signal Window - the window of 

waveform data for Signal-to-noise calculations and DC offset corrections. If no P-pick has been 

performed, then the Pre-signal Window is a window of data stretching from the start of the waveform. If 

there is a P-pick the Pre- signal Window is a window of data stretching backwards (in time) from this point. 

The value should therefore be produced from an estimate of when the signal should arrive on the waveform 

- if a pre-trigger length has been used during data acquisition then the Pre-signal Points should be less than 

this. The Pre-signal Points need to also be large enough to sufficiently sample the background noise. If the 

Pre-signal Points are greater than the number of data points in the waveform before the P-pick then the 

entire waveform up to the P-pick is used. As an example, the recommended Pre-signal Points for a 

waveform of length 4096 is 200. (Figure 5-38) 
 

• The receiver settings for this channel, as displayed in the Receiver Properties Dialog Box. Note that these 

receiver settings are only for this channel in the event. Any changes made do not affect the Default Receiver 

Array as these are completely independent settings. 

 
• Parameters used in active surveys. These are explained in Event Initialisation. 
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Figure 5-37: The Channel Properties Dialog box. 

 
 

 
 

Figure 5-38: Definition of the Pre-signal Window. Pre-signal points define the length of window (in data 
points) from either the start of the waveform (if no P-wave pick) or immediately preceding the P-wave pick. 

The Pre-signal window is used in Signal-to-Noise calculations and in correcting for a DC offset. 
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5.8 Receiver Properties 
 
The Receiver Properties Dialog box allows the user to change the properties associated with the channel sensor (Figure 

5-39). 
The channel number associates the receiver being edited with the acquisition channel. Channels can be grouped 

together as a multi-channel instrument using the instrument number and axis (X, Y, Z, A). The acquisition data type 
defines what particle motion the receiver responded to. The options are volts, displacement, velocity or acceleration.  

 

𝑊𝑖 = 𝑝 
𝑉𝑖

𝑠 ∙ 𝑔
 

 
 

The waveform amplitude Wi is given by the equation where Vi is the waveform voltage (raw-data amplitude) at 

data point i, p is the receiver polarisation (+1.0 or -1.0), s is the receiver sensitivity and g is the receiver gain. 
The receiver gain is a ratio depending on the amplification applied to the acquired data (e.g. 40dB is x100).  
 
 
 

 
 

Figure 5-39: The Receiver Properties Dialog box. 

 
The receiver sensitivity depends on the sensor specification and the resulting amplitude type. For instance, a 

sensitivity = 5.0 volts/m·s−2 will then result in the correct acceleration being used. The sensitivity can have the 

following units depending on what units the waveform amplitudes should be in: volts/m·s−2 (acceleration), 

volts/m·s−1 (velocity), volts/m (displacement), volts/volts (a simple scaling ratio if the raw data is already in one of 

the previous types or if the data is just a voltage). 
 
The "Full-scale Voltage" ( Vmax) is the voltage range that the acquisition system acquired the signal at. This can be an 

amplitude range if the imported raw data is not scaled to volts and the appropriate receiver sensitivity is used. Analogue-
to-digital conversion electronics operate by sampling an analogue signal between Vmax volts. For example, a system may 
use 16-bit sampling between ±10V. The resulting data will then be in the form of a 16bit (2 byte) integer scaled between 0 
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(-10V) and 65535 (+10V). When the raw waveform data is imported as integers (depends upon the data type used) it is 
automatically scaled to fit across the voltage range. If the full-scale voltage is subsequently changed in the receiver 
properties, the waveform is re-scaled to the new settings (e.g. a reduction of full-scale voltage by half will reduce the 
waveform amplitude by half). If a receiver is not set when the data is imported the waveform is automatically scaled to the 
default setting of Vmax = ±1.0 . When a receiver is then set with the appropriate full-scale voltage the waveform will be re-
scaled. 

 
The Clipping Amplitude is the maximum waveform amplitude recordable by the acquisition electronics. Clipping 

Amplitudes are important in certain waveform processing algorithms, e.g. the automatic source parameter algorithm 
removes clipped data from the calculations. The Clipping Amplitude, is given by: 

 

𝑊𝑚𝑎𝑥 =  
𝑉𝑚𝑎𝑥

𝑠 ∙ 𝑔
 

 
 

The user must ensure that the appropriate values of Vmax, p, s and g are used for each receiver so that the waveform 
amplitude used in processing functions is correct. These amplitudes should be checked in the Waveform Visualiser before 
doing extensive processing. 

 
For certain raw data formats, the scaling parameters are explicitly set in the data file. In these cases, the scaling 

parameters are not copied from the Default Receiver Array but instead are set from the file information.  
 
The receiver location must be defined in a North-East-Down (NED) (Figure 5-21). The three-dimensional receiver 

orientation vector, v is defined pointing along the longitudinal axis of the sensor. Using unit vectors, a transducer 
orientated due north would be given direction cosines (i, j, k)=(1,0,0), and similarly for a transducer orientated directly 

upwards (0,0,-1). A transducer orientated Northwest with a 60◦ plunge would have the vector (0.354, -0.354, 0.866). 

 
 
 

5.9 Configuration of Processing Properties 
 
The Processing Properties are contained on a Property Sheet obtained from within the Project sub-menu, or using a 

button on the Waveform Visualiser button bar (Frame Menus). This contains a number of Property Pages providing 
configuration parameters for each of the processing functions available in InSite. In a new Project the parameters are 
initially set to default values. Many of the processing functions rely on the configuration parameters being correctly set 
before attempting processing. The user should therefore ensure this is the case. The software is designed to make it easy 
for the user to try a set of configuration parameters on the data, adjust these and re- process. In this way the user can 
investigate how accurately the data is being processed, and the effect of varying their configuration parameters on the  
results. 

 

5.9.1 Event Initialisation 
 
The Event Initialisation Property Sheet contains some basic parameters used to configure an event's waveform data 

during display in the Waveform Visualiser, or for use in processing algorithms. (Figure 5-40) 
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Figure 5-40: The Event Initialisation Property Sheet. 

 
 

• The user can select whether to process the waveforms by either of the following methods: 

– Channel - each channel is processed individually 

– Instrument - channels are grouped together as instruments (Treatment of Multi-channel Sensors) 

• Sort By Label - sort instruments/channels lexicographically by their label, otherwise they are sorted by number. 

• The Channel-view Width-to-Height Ratio changes the aspect ratio of each view box in the Waveform Visualiser. 

• Waveform Columns sets the number of columns of view boxes in the Waveform Visualiser. 

• Waveform Response Type allows the user to select which ground motion is to be used when processing the 

waveforms. The options are as follows: 

– Set from sensor - the response type defined on the Receiver Property Sheet. 

– Acceleration, Velocity or Displacement - the waveforms are all processed with a consistent ground motion. 

This is achieved by integrating or differentiating the waveforms to the appropriate ground motion, 

depending on a channel's pre-defined receiver response (The Instrument Properties Dialog box). This is useful 

if receivers of differing response are used in the array (e.g. a mixture of accelerometers and geophones). In 

order to overcome frequency artefacts induced during the integration or differentiation the waveforms 

should be automatically bandpass filtered (Channel Processing) during the operation. Before performing 

automatic processing, the user should check the quality of the waveform data provided by these functions 

using the Waveform Visualiser. 

• Use Imperial Distance Units sets the distance units to feet rather than metres. When clicked, a prompt will ask if 

values should be converted in the following dialogs: autopicking, optimised picking, locater, and relative 

location. Note that only the unit is switched, and the numbers are not changed. The source parameters are 

always in SI unit regardless of the Imperial Distance Units setting. 
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• Display Non-Seismic data allows non-seismic data to be viewed in the Waveform Visualiser. 

 
• Local Time Offset allows the user to define the offset of local time from the waveform time stamp (read from the 

waveform file header). This can be positive or negative and should be entered using the following edit boxes as 

integer hours, integer minutes and seconds including decimal. 

 
• Default Channel Settings allow the user to change some properties that are automatically applied to each channel 

as they are imported into the software. 

 
– Sampling Time and Time Units are applied to pick results to calculate arrival  times. 

– Pre-signal Points is used in calculating the signal to noise ratio and a correction for a DC-offset 

(Channel Properties). 

– Spline Sampling is a sampling time used to interpolate between data points on the waveform. This is used 

in the cross-correlation algorithms. 

– Waveform T0 Point is used for Active Events to set the time of initiation of energy from the source. 

– P-time and S-time Corrections are used to correct processed arrival times (see Technical Appendices 

section 6.6). 

– Noise window - define how the automatic noise window is created 

* “Pre-signal” – noise window is from start of the waveform to the size of the pre-signal value 

* "Pick - pre-signal" - noise window is from the pick and extends back to the size of the pre-signal value 
 

* "Half pick" - noise window is centred around half the pick index value and size is determined by the 
P or S wave FFT front/back window lengths 

 
• By setting the flag "Automatically update Channel Settings when reading an ESF" the user can apply the 

Default Channel Settings to all channels in an event when they are read from an ESF for visualisation or 

processing. This is useful when a large number of channels are to be changed using all the same properties. 

To change individual channels the user should edit the The Channel Properties Dialog box. 

 
• The Project File Directory is an optional default directory the user can set for input or output of text files. 
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5.9.2 Auto-picking 
 
The Auto-picking Property Sheet contains input parameters used in the waveform auto-picking functions to 

automatically obtain P and S-wave phase arrivals. (Figure 5-41). 
 
 
 

 
Figure 5-41:The Auto-picking Property Sheet. 

 
Three different methods can be used to obtain auto-picks. These are RMS Amplitude, Envelope Method and AIC 

Method. An additional option, External File, allows the user to load a file that contains different RMS Amplitude picking 
parameters for each instrument. 

Several flags on the auto-picking sheet provide extra controls on the way in which phases are picked:  
 

• Pick P-wave from S-wave: Allows the user to select a time window, in advance of the S-wave pick, in which to pick 

the P-wave. If no S-wave pick exists, the window limits are not applied. 

– Max. time back from S: time, in working time units, prior to the S-wave at which to start searching for the 

P-wave. 

– Min. time back from S: time, in working time units, prior to the S-wave at which to stop searching for the P-

wave. 

• Autopick S-waves before P-waves: The S-waves are picked, using the auto-picking settings, first. If permitted P-

waves are then picked, ensuring that the P-wave can only occur prior to the S-wave. (By default, the P-wave is 

picked first, after which the S-wave is picked ensuring that the S-wave pick occurs later than the P-wave.) 

• Reverse S-wave picking: When using the 'Use first peak in the auto-pick function', the auto-pick function is searched 

from the back (latest time) of the trace. (By default, the auto-pick function is searched forward from the earliest 

to latest times). 

• Allow S-wave pick in whole trace: If unchecked and no P pick exists, the S-wave pick is permitted to occur in 
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the second half of the trace only (this was always the case in previous versions of InSite). If checked and no P-

pick exists, the S-wave is permitted to occur at any time in the trace. If a P-pick exists, the S-wave is permitted 

to occur at any time after the P-pick. 

 
 
 

5.9.2.1 RMS Amplitude Method 
The RMS auto-picking algorithms operate by first calculating an auto-picking function using a moving window approach. 

At each waveform data point, i, two windows are generated: a front window and a back window. The value of the auto-

picking function, Fi, is calculated by this equation where Aj is the amplitude, NF is the length of the Front-window in 

data points, NB is the length of the Back-window in data points and n=2. 
 

 
The auto-picking function represents a difference in energy contained in the front window compared to the back 

window. It can be viewed for a particular channel in the Waveform Visualiser [section] 5.6). Peaks occur in the function 
where waveform signals suddenly increase in amplitude relative to data behind it.  These peaks can then be used to estimate 
the arrival time of the different phases. The P-wave arrival can often be picked with high certainty as it emerges from just 
a background noise level. S-wave arrivals often emerge out of the P-wave coda (higher amplitude than the background 
noise) and so tend to have more uncertainty in their picking. 

 
The following options are also available on the Auto-picking Property Sheet in order to tune the algorithm to the data. 

• Use Analytic Envelope in RMS runs the auto-picking function on the analytic envelope of the data rather than the 

raw waveform amplitudes. 

• Use Optimised Picking can be checked if the user wishes to use optimised picking algorithms (see the Frac Manager 

Manual). 

• The user can carry out auto-picking by either of the following methods: 

– RMS Amplitude - picking function using the RMS. 

– Envelope Method - similar method used as for the RMS but the Envelope function is used. 

– AIC Method - Autoregressive (AR) modelling to provide improved estimates of the pick position. 

• The user can choose how the maximum peak in the auto-picking function is obtained. The options include the 

following: 

– Use first peak in the auto-pick function - the algorithm looks for the first peak in the auto-picking 

function that is greater than the given threshold level. On finding a peak in the autopicking function above 

the threshold, the function continues to search for a further time period equal to the front-window length 

to find subsequent peaks. This is to account for any local minima that occur in the picking function. 

– Use max peak in the auto-pick function - the algorithm searches the entire auto-picking function and 

finds the maximum peak above the given threshold level. 

• When a Min. Peak to Peak Amplitude is set then the algorithm checks that the signal has sufficient amplitude to 

warrant a pick. This allows the user to discard picks automatically from waveforms when signals are below a 

desired level. 

• Allow Automatic Amplitude Picking performs an automatic pick of the arrival's peak amplitude. This operation 

scans forward through NF data points (the length of the auto-picking front window) looking for a peak in the 

waveform. If there is more than one peak, then the maximum is picked. A signal:noise ratio for this amplitude is 

also generated by dividing the amplitude by an RMS noise value calculated from in a pre-signal window before the 

arrival. 

• Use Velocity Window Picking is a useful option for picking Active Events. The algorithm only generates an 

autopicking function for a section of the waveform. The start and end points of this section are calculated knowing  

the signal T0 on the waveform and signal minimum and maximum velocities through the medium – a 

homogeneous-isotropic medium is assumed between the shot/transmitter location and the receiver location for 
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the channel being processed. This option is particularly useful in scenarios where noise appears on the waveforms 

before the signals of interest. 

• Use Waveform Visualiser Window allows the user to define a window within an event waveform to be used for 

phase auto-picking. 

• Autoprocess Source Vectors allows source vectors to be automatically calculated during the autopicking where 

applicable. Additional settings, for S-wave source vectors, are available through the Dialog launched using the 

Further Source Vectors button. 

• Linearity Threshold is the minimum linearity (in percent) that will be accepted when rotating the P-wave 

arrivals into the source vector orientation. The linearity represents the effectiveness of the P-wave rotation, 

thus source vectors with lower linearity can be regarded as having higher uncertainty. 

• Rotation Back Window and Rotation Front Window set the window, in sample points, around the P pick that is 

used to calculate the P-wave rotation. 

• Normalise Picking Functions finds the maximum peak in the auto-picking function and then normalizes all values 

to this maximum 

– thus, producing a function that has a maximum of 1.0. It should be noted that if the user defines an auto-

picking threshold in the range 0.0 to 1.0, then using this operation will mean that a pick on the waveform is 

always produced; as there will always be a maximum in the auto-picking function above the threshold. 

• Fix Rotation Window to Pick forces the source vector window to sit around the phase pick when calculating source 

vectors automatically. The default behaviour is for the window to be moved within the limits of the FFT window  

(Channel Processing tab) until a maximum linearity is achieved. 

 
The autopicking function behaves differently depending on whether the user is processing the event by Channel or by 

Instrument (Treatment of Multi-channel Sensors). 
 

• In Channel mode the algorithm processes each channel individually using the amplitude from the waveform 

samples, Aj = Wj . 

• In Instrument mode the algorithm uses the RMS waveform generated from the M channels where 1≤M≤4). 

The RMS waveform is calculated using this equation where Wim is the waveform amplitude on channel m 

at point i. 
 

 
When processing for S-wave arrivals the automatic picking algorithm only examines the section of waveform starting 

from the P-wave pick. If no P-wave pick exists, then the algorithm starts at the centre of the waveform. This is so as to 
minimise the likelihood of picking the P-wave instead of the S-wave arrival. 

 
A peak-to-peak amplitude is also calculated for the waveform portion being auto-picked. This is useful in velocity 

window picking mode as it is then the maximum signal in the window defined by the two input velocities.  
 

5.9.2.2 Envelope Method 
This algorithm operates in the same way as the [RMS Amplitude Method] used in InSite but uses a different Envelope 

function. The envelope function is based both on the waveform and the derivative of the waveform. The function is also 
scaled relative to its variance which allows picking to be done for a fixed threshold, which in theory can be optimised for a 
wide range of data. 

 
 

5.9.2.3 AIC Method 
To use the AIC method, the Auto-picking Property Sheet is used (Figure 5-42), but in addition the AIC Picker Settings 

Dialog, shown below, is important. If this method is selected, up to four windows may be displayed in the Channel Auxiliary 
box of the Waveform Visualiser to display the functions associated with this picking method (Channel View Structure). 
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Figure 5-42: AIC Picker Settings Dialog Box. 

 
Type of picking: 
 

• AIC_MIN - calculates an AR-AIC picker algorithm (Physics of Earth and Planetary Interiors) 

• AIC_STA_LTA - calculates AIC_MIN but with short term average minus long term average windowing 

• AIC Simple - calculates a simple AIC for the entire waveform (Appendices 7.6) The following options, specific 

to the AIC picker, have been provided in InSite. 

• AR Model Order - assuming random noise, higher model orders do not provide a better fit of the data (since 

the current value does not depend on past values). For the signal, higher order models could be more 

accurate. 

• Front Window - size in sample points of the window before the arrival. 

• Back Window - size in sample points of the window after the arrival. 
 
A method has also been implemented that allows the user to initially autopick an arrival and refine this pick position 

using the AIC method. The original pick could have been made with the RMS, envelope or AIC picker methods.  
 

• Refine P Pick - select this to refine the P Pick after initially auto-picking using the method selected in the Auto-

Picking Properties Sheet. 

• Refine S Pick - select this to refine the S Pick after initially auto-picking using the method selected in the Auto-

Picking Properties Sheet (Auto-picking). 

• Front Offset - offset in sample points of front window before the existing pick. 
 

• Back Offset - offset in sample points of back window after the existing pick. 
 
The AR-AIC Picker uses Autoregressive (AR) modelling to provide improved estimates of the pick position.  
The basic method can be described as follows: 
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1. A window near the beginning of the waveform, which is estimated to be in the noise region, is used to derive a  

forward auto regressive model. This AR model is then used to project a predicted waveform. 

 
2. Similarly, a later window which is estimated to be in the signal region, is used to derive a backward AR model. 

Again, this AR model is used to (back-) project a predicted waveform. 

 
3. The combined Akaike Information Criterion (AIC) is then applied to these two time series. The assumption is that 

the forward model describes the noise behaviour, while the backward model describes the signal behaviour.  For 

each possible partition point between these two models, an error function is calculated 

 
4. If the two models describe their regions well, then this error function is minimised at the optimal partition point. 

 
 

5.9.2.4 External File 
 
To use the External File option to define different RMS Amplitude picking parameters, the AIC Picker Settings Dialog 

must be used to browse to the location of the external file. The external file should have '.cpk' as the file extension. The 
format of the file is shown in Figure 5-43, and has following columns: 

 
Instrument number / channel number / active flag / P-wave back window / P-wave front window / P-wave threshold / 
S-wave back window / S-wave front window / S-wave threshold 

 
There needs to be a line for each instrument, but not for each channel; the channel and status (active flag) columns are 

for future developments. The remaining columns should be filled with the P-wave and S-wave picking parameters. 
 

 
Figure 5-43: Example of the instrument picking pile (.cpk). 

5.9.2.5 CCR Method 
This method requires the configuration of Cross Correlation in the CCR tab, using the ‘Referenced to a Master Event’ 

method and selecting one processed event as the reference event. This method will select a pick based on maximum 
similarity with the picks in the reference event, using a CCR window defined in the CCR menu. The method is only 
recommended for datasets where events share similar source mechanism and are expected to originate from a similar area 
in space. 

 
 

5.9.3 Source Vectors 
 
The source vector parameters are shown in Figure 5-44. 
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Figure 5-44: Source Vector dialog 

 
 
The 'Use S-wave SV' check-box should be selected if source vector information from the S-wave is required for use in 

the source location algorithm. The method of analysing the S-wave particle motion is the same as that used for the P-wave 
particle motion, so the user is required to set the front and back window lengths around the phase pick. Two methods may 
be selected: 

 
• Linear S-wave polarisation: assuming the S-wave particle motion to have a high linearity, the principal direction of 

S-wave particle motion is taken to be perpendicular to the plane containing the S-wave ray vector (Appendices 

7.1.2). 

 
• Elliptical S-wave polarisation: assuming the S-wave particle motion to be elliptical, the eigenvector associated with 

the smallest eigenvalue is taken to be the S-wave ray vector. 

 
" Fix Rotation Window to Pick " forces the source vector window to sit around the phase pick when calculating source 

vectors automatically. The default behaviour is for the window to be moved within the limits of the FFT window  (Channel 
Processing tab) until a maximum linearity is achieved. 

 
The linearity threshold should be set when using the linear S-wave polarisation method. As for the P-wave, this is the 

minimum linearity (in percent) that will be accepted when rotating the S-wave arrivals into the source vector orientation. 
 
The maximum plunge setting is also for use with the linear S-wave polarisation method. In this case, and for a 

single, sub-vertical, linear monitoring array, S-wave polarisation measurements with very high plunge (SV waves) 
provide no constraint on event azimuth and location results would be unreliable. The maximum plunge prevents the 
polarisation information from being stored. 

 
Array polarisation settings are only used when source vectors at all receivers should are similar, which creates an array 

composite source vector which is used to eliminate erroneous time samples. 
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5.9.4 Spectral Picker 
 
The spectral auto-picking algorithm in InSite automatically processes phase arrivals from spectrogram information. In 

the 'standard auto-picking algorithm' in InSite an auto-picking function is generated from the waveform amplitudes using 
a "Moving-window Technique" - a variation on the STA/LTA (Short Term Average/Long Term Average) method to produce 
a function with amplitude peaks where phase arrivals are positioned on the waveform. In the 'advanced autopicking 
algorithm' a similar auto-picking function is produced using averages of the spectral information contained in the 
spectrograms. The information to be used is defined by the user in an auto-picking equation. 

 
The algorithm can be applied to all types of instrument irrespective of the number of channels, but it should be noted 

that if parameters derived from the polarisogram (polarization, azimuth or plunge) are requested in the user-defined auto-
picking equation (see below) then only triaxial or quad instruments are processed - instruments with 1 or 2 channels are 
given a 'null' auto-function consisting of all zeros. 

 
 
 
 

 
 

Figure 5-45: The Spectral Picker Property Sheet. 

 
To use the spectral auto-picking algorithm rather than the standard auto-picker click on Use Spectral Picking Equation. 

The 'Spectral Picker' Property Sheet is shown in this Figure 5-45. The property sheet and picking functionality can only be 
accessed if the user has permissions for the Advanced Waveform Tool. The functionality can also only be applied in 
Instrument processing mode (set from the [Event Initialisation] tab in Processing Properties). See the Technical Appendices 
section 7.3 for detailed information about the algorithms used. 

 
The spectrogram processing parameters are described below: 
 

• Spectral Estimation Method - whether an FFT (Fast Fourier Transform) or MEM (Maximum Entropy Method) 

is used to evaluate the spectra. 

• GateLength - the length of window that is stepped through each waveform. 



5.1 Data Visualiser 117  

 

∗ 

• GateType - whether the gate is backward, centred or forward looking. 

• TaperType - the type of amplitude taper that is defined to each waveform window. 

• StepSize - the length (in waveform data points) of each step through the waveform. 

• Frequency Range - the range of frequencies that are displayed on each spectrogram plot (defines the Y-axis 

limits). 

The recommended approach to selecting these parameters is to use the Advanced Instrument Visualiser to choose the 
'best' qualitative settings. The parameters used in the spectral auto-picking can be automatically updated from the 
visualiser by clicking on the Parameters from AIV button. 

• The spectral coefficients must be defined in the range 0.0 to 1.0. A coefficient of 0.0 will have the effect of 

removing that spectral function from the auto-picking equation if the respective variable is defined there. 

 
a, b, c, d, e relate respectively to pol, azm, plu, son, rms. 

• The "Do Azimuth Variance" or "Do Plunge Variance" options select the use of variance in the spectral function, 

rather than the mean. The default setting is to use the variance. 

 
• The spectral picking equation (see below) and the values of optional constants to be used in the equation.  Click 

on Validate and Store to save the auto-picking equation to the software settings. 

Variables that can be used in the spectral auto-picking equation are: pol, azm, plu, son, rms, const1, const2, const3, 

const4, const5; and any of the operators: (parentheses), +, -, ∗, /. 

 
• The Apply Moving Window Function applies Moving Window Technique to the final auto-picking function that is 

generated using the equation. The window sizes are defined on the Auto-picking tab. 

 
• The Normalise Picking Function normalizes the final auto-picking function to its maximum value. 

 
The auto-picking equation defines which of the spectral functions (Auto-picking) to use in the final auto-picking function 

and how the spectral functions are combined. The equation is constructed by combining the variables pol , azm, plu, 

son and rms- relating respectively to polarization, azimuth, plunge, sonogram and RMS signal separated by the 
standard computational operators ( ), +, -, and /, being respectively parentheses, addition, subtraction, multiplication and 
division. It is therefore possible to define an auto-picking function of the form shown: 

 

𝐹 =  𝑝𝑜𝑙 + 𝑎𝑧𝑚 + 𝑝𝑙𝑢 + 𝑠𝑜𝑛 + 𝑟𝑚𝑠
𝐹 =  𝑝𝑙𝑢

𝐹 =  𝑝𝑜𝑙 + 
𝑎𝑧𝑚

𝑝𝑙𝑢
+ 𝑠𝑜𝑛 ∙  𝑟𝑚𝑠

 

 
The text string containing the user-input equation is evaluated into a computation of the variables and operators. 

Standard operator precedence is used in this algorithm (i.e. a multiplication will be performed before an addition). In order 
to save the equation to the software settings the user must click on the Validate and Store button. A check of the equation 
is then performed to ensure that all variables and operators are valid. If successful, a Dialog box (Figure 5-46) is shown to 
the user using some test values for the variables. 

 
During processing of the auto-picking function it may be possible that one of the variables has a value of zero; if a 

division by zero occurs in the equation then the answer is evaluated to zero. 
 
A further five optional constants are also provided for use in the equation: const1 , const2 , const3 , const4 , 
const5 . 

Thus, an auto-picking function of the form shown in the equation as an example can be defined by the user. 

𝐹 =  
𝑝𝑜𝑙

(𝑐𝑜𝑛𝑠𝑡1 + (𝑎𝑧𝑚 − 𝑐𝑜𝑛𝑠𝑡2)(𝑎𝑧𝑚 − 𝑐𝑜𝑛𝑠𝑡2))
 

 
 
An optional normalisation operation can be applied in either the standard or spectral auto-picking algorithms. The 

operation finds the maximum peak in the auto-picking function and then normalizes all values to this maximum - thus 
producing a function that has a maximum of 1.0. It should be noted that if the user defines an auto-picking threshold in the 
range 0.0 to 1.0, then using this operation will mean that a pick on the waveform is always  produced; as there will always 
be a maximum in the auto-picking function above the threshold. 
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Figure 5-46: Dialog box showing test values for variables used in spectral autopicking. 
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5.9.5 Cross-correlation 
 
 
The cross-correlation algorithm is described in the Technical Appendices section 6.1. The Cross-correlation Properties 

Sheet allows (Figure 5-47) the user to configure the input parameters for the algorithm. 
 
 

 
Figure 5-47: The Cross-correlation Properties Sheet. 

 
There are two modes of operation for the Cross-correlation (CCR) algorithm. 
 

• Referenced to a Master Event - this allows the algorithm to be used to compare the waveform arrivals from any 

one event to the arrivals from a chosen "Master Event". This generates a set of CCR arrival times that can then be 

used to locate the processed event very accurately with respect to the Master Event (Source Location). This 

function is useful when studying clusters of events. The user must select the appropriate Reference Component 

and Reference Event. 

• Referenced to a Survey (Master Component) - this allows processing of Active Events by comparing waveform 

arrivals from Event N in any one component with Event N in the chosen "Master Component". The events must be 

sorted such that both events originate from the same shot/transmitter source N. The user must select the 

appropriate Reference Component that will be used. 

 
The remaining configuration parameters are explained in Table 5.6. The method uses the construction of windows of 

waveform data (Trace Windows) around the arrivals to be processed. It is important to test the windowing methods used 
when processing the data, as the windowing procedures have a great effect on the quality of the results. The options 
available allow the processing to be tuned to the quality of waveform data available and the differences in arrival times 
expected. 
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Table 5.6: Configuration parameters for the Cross-correlation algorithms. 

 

Parameter Description Reference 

Window Construction 
Method 

Defines the construction method for the Trace 
windows. 

Appendices section 
6.4 

Window Comparison 
Method 

Defines how the Trace windows are to be compared 

between the Reference and the Processed event. 

Appendices section 

6.4 

Back-window Length Length, in data points, of the window behind the 
pick. 

Appendices section 
6.4 

Front-Window Length Length, in data points, of the window in front of the 

pick. 

Appendices section 

6.4 

Rise-time Multiplier Multiplier to apply to the rise-time window length. Appendices section 

6.4 

Power to raise waveform Defines whether to raise the waveform to a power, 

and what power this should be. 

Appendices section 

6.4 

Fit a Spline Function Defines whether to fit a spline to the waveform. Appendices section 

6.4 

Obtain absolute waveform Defines whether to convert the waveform to 
absolute values. 

Appendices section 

6.4 
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5.9.6 Channel Processing 
 
The Channel Processing Property Sheet (Figure 5-48) controls parameters when processing individual channels. In 

particular, this includes configuring the waveform filtering, setting up automatic waveform windows for Fast -Fourier 
Transforms (FFTs) and applying a phase rotation to the waveforms. 

 

 
Figure 5-48: The Channel Processing Property Sheet. 

 
Waveform filtering either applies a recursive, time-domain IIR filter, a user defined frequency or time domain filter or 

it applies Butterworth bandpass filter (Kanasewich, 1981) to the waveform data. 
 

• Filter automatically on reading: filter is applied automatically to every waveform when read from the  ESF. 

• Filter using sensor settings: builds the filter using the frequency settings for the particular receiver. These are 

configured on [The Channel Properties Dialog box]. 

• Default Filter Parameters: either frequency, pole, ripple and number of passes values for the filter or a specified 

filter file that contains either a time or frequency domain filter. These are applied consistently to each channel if 

the Filter using sensor settings option is not used. 

 
Waveform parameters settings: 
 

• Threshold - value the signal must cross in order to count as a threshold crossing 
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• Search mode - define the way crossing a searched for: 

– Absolute - consider threshold crossings for both the positive and negative signal values 

– Positive - consider only positive signal values 

– Negative - consider only negative signal values 
 
Automatic - determine the sign of the signal peak and only consider signal values of the same sign 
The Filter Type can be set to a recursive filter of one of four types: lowpass, high-pass, bandpass or band-stop. 

Alternatively, it can be set for an Imported User-defined Filter or to the Original InSite Butterworth Bandpass Filter. Perform 
deconvolution automatically on reading: this removes the station response automatically when importing or triggering 
waveforms from miniSEED files. 
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If one of the recursive, time-domain IIR filter options is the selected "Filter Type", then when the filter is built, the low 

and/or high cut-off frequencies must be in the range 0 < f < fNyquist where fNyquist is the Nyquist Frequency (fsampling/2 

) for the channel being processed. The "% Ripple in Passband" option controls the frequency roll-off of the filter. When the 
percentage is set to zero, the filter designed is of Butterworth type. When the percentage is greater than zero the filter 
designed is Chebyshev Type 1, which has a faster frequency roll-off compared to the Butterworth design but at the expense 
of the specified ripple in the passband. The "Filter Order" option controls the number of poles in the filter and can be set 
between 1 and 10. A greater number of poles gives a steeper roll-off. The filters can be designed with either odd or even 
numbers of poles; they are all created by cascading stages of Sallen-Key pairs plus a single pole for odd orders. The 
bandpass and bandstop filters, because they are created from combinations of high and lowpass filters, actually have 
twice the number of specified poles. The "2-pass" checkbox option allows the user to run the filter as causal (1-pass, 
checkbox unticked) or acausal (2-pass, checkbox ticked), depending on whether onset time (causal) or zero-phase (acausal) 
filtering is most appropriate. 

 
If the "Original InSite Butterworth Bandpass Filter" option is the selected "Filter Type", then when the filter is built, 

the low and high cut-off frequencies must be in the range 0 < f < f Nyquist where f Nyquist is the Nyquist 

Frequency ( 
fsampling ) for the channel being processed. The filter applied is a recursive Butterworth bandpass filter 

from Kanasewich (1981) with 8 poles in the Complex plane, and applied in the forward and reverse directions, so as 
to have zero-phase cut-off frequencies at -6dB and a roll-off of about 96dB per octave. 

 
If the "Imported User-Defined Filter" option is the selected "Filter Type", then a filter file (FLT) needs to be selected. 

The browse button to the right of the "Frequency Filter File" text box, when pressed, displays a file Dialog which allows the 
user to select a filter file. The filter file can either define a time or a frequency domain filter. See the Technical Append ices 
section 2.18 for more information on filter files. 

 
The user can select to apply a second filter simultaneously with the first.  For the second filter, the user is restricted to 

the choice of: bandpass and band-stop recursive (time-domain, IIR) filters or the Original InSite Butterworth Bandpass Filter. 
 
When applying filters, the user also has the option of specifying exactly which channels will be filtered by launching the 

Filter Settings Dialog (Figure 5-49) using the Settings button. For each filter type, the left-hand panel auto-populates with 
information from the project's default receiver array, and the user then has the option to select to filter all channels in the 
default receiver array or select channels from the list. If the events in the project contain different channels to those found 
in the default receiver array, the user has the option to set the minimum and maximum channel numbers in the field at the 
bottom of the Dialog and select to 'Set Channels' to populate the right-hand panel for each of the filters. Again, the user 
has the option to select to filter all channels or select ones from the list. If any channels are selected in this Dialog that are 
not contained in events, the channel number is ignored and does not generate an error. 

 
 

 
 

Figure 5-49: The Filter Settings Dialog. 
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5.9.7 FFT Properties 
 
 

 
Figure 5-50: FFT Properties dialog 

The Automatic FFT Window Configuration parameters are used to build FFT windows around the P and S-wave picks in 
the Waveform Visualiser. These can then be used to perform frequency analyses of the arrivals. The user can manipulate 
the size of the windows after they have been constructed. 

 
Automatically trim FFT to sensor settings when displaying sets the minimum and maximum axes in the FFT view ( Fast 

Fourier Transform Processing) to the frequency response of the receiver, as configured on the Receiver Properties Dialog 
Box. 

 
FFT auto process export - select the FFT type to export when 'Export FFT' is performed in the AutoProcessing auto-

processor: 

• Event - entire waveform 

• Instrument - entire waveform 

• Instrument - P wave 

• Instrument - S wave 

• Channel - entire waveform 

• Channel - P wave 

• Channel - S wave 
Phase rotation filtering allows the user to apply a phase rotation to the waveform: 

• Apply phase rotation filter on reading - filter is applied automatically to every waveform when read from the ESF. 
• Phase Rotation Angle - the user can set the automatic phase filter to apply any integer phase rotation angle 

between −180◦ and +180◦. 
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5.9.8 Locater 
This Locater Properties Sheet defines configuration parameters for the source location and advanced location 

algorithms. There are currently four source location algorithms that can be used (described further in the Technical 
Appendices section 6.1): 

 
• Geiger Algorithm 

• Simplex Algorithm 

• Collapsing Grid Search Algorithm 

• Source Scan Algorithm 
 
 

5.9.8.1 Configuring the Source Location Algorithm 
 
The parameters are shown in Figure 5-51. The recommended configuration procedure is as follows. 
 

1. Select the algorithm to use. There are four options: a) Geiger Routine, b) Simplex Routine, c) Simplex into Geiger, 

d) Collapsing Grid Search Routine, e) Source Scan. The Simplex into Geiger routine performs a Simplex algorithm 

to produce a location within the 'best' misfit minima, and then runs the Geiger algorithm starting at this position. 

This allows a more thorough uncertainty analysis to be obtained than using just a Simplex Routine  alone. 

2. Click on the Algorithm Settings button to display the configuration parameters for the selected algorithm (Figure 

5-52). See below and the Technical Appendices (section 3.1) for a description of these parameters and their use 

in the source location algorithms. 

3. Select the velocity model to use. Click on the Velocity Model Settings button to display the configuration 

parameters (Figure 5-53) for the model (see the Technical Appendices section 3.1). 

4. Select the phase types to use. There are two options: a) P-wave Arrivals Only, b) Both P and S-wave Arrivals. 

5. Distance Units (e.g. 1 = 1metre, 0.01 = 1cm). The units the source locations are displayed in 

6. Working Time Units (e.g. 1 × 10−6 = 1microsecond). The units the time residuals are displayed in. 

7. Minimum P-wave Arrivals. The minimum number of P-wave arrivals times required for a source location to be 

performed. 

8. Minimum S-wave Arrivals. The minimum number of S-wave arrivals times required for a source location to be 

performed. 

9. Maximum Residual (e.g. =100 in 'working time units'). After successive iterations of the location routine to a 

solution (a 'Pass'), the time residuals are calculated and analysed for any values above the 'Maximum 

Residual' value. If there are values that exceed the criteria, the P- or S-wave arrival time with the largest 

residual is dropped, and another 'Pass' is started in order to iterate to a new solution. Once there are no 

values that exceed this criterion, the solution is taken to be final. For auto-processing, a recommendation is 

to make the maximum residual slightly less than the lowest expected Tp-Ts time. 

10. Display theoretical times for all instruments forces the arrival times for all instruments to be calculated and 

displayed. Default behaviour is for theoretical arrival times to only be calculated and displayed for instruments 

used in the final location run. 

11. Set the Starting Position. The user must set the starting position for the routine to iterate from. There are options 

to start from: the centroid of the array (mean of sensor locations), the position of the sensor with the earliest pick 

(arrival time), or a user defined position (which should be entered in the North, East and Down spaces below in 

User Defined). 

 

12. Write information to Report File (RPT). Specifies whether the user wishes to write a report file and the directory 

where this is written. 
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13. Calculate Automatic Source Parameters. Choose this for the source parameters to be automatically calculated 

when locating. 

14. Always calculate source vector at the start of manual location. Chose this to automatically calculate source vectors 

when manually locating an event. 

15. Enable parallel processing when running the location algorithms. 
 

 

Figure 5-51: The configuration parameters on the Locater Properties Sheet. 
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Figure 5-52: The configuration parameters on the Location Algorithm Properties Dialog box. 

 
1. Residual weighting to apply to P-wave arrivals 

 
2. Residual weighting to apply to S-wave arrivals 

3. Fractional change in error space across simplex at which to stop algorithm 

4. Initial size of simplex object used in location 

5. Normalisation constant to use (1 or 2) 

6. Use outlier identification procedure before residual test 

7. User P-wave and/or S-wave source vectors for locating events 

8. Use S wave picks in traces without a P-wave arrival pick 

9. Minimum source vectors to use in order to produce a location 

10. Constrain locations with 180deg ambiguity to a preferred orientation (azimuth)  

11. Use a depth geometrical bias in search algorithm. 

12. Central depth given the maximum weight in location algorithm (when using the geometrical constrain) 

13. Error factor multiplication constants to use in outlier identification 

14. Source locations are restricted to the X-Y plane 

15. Maximum residual angle that will be accepted for instrument to be used 

16. Minimum weight applied to positions outside of the preferential depth defined by the geometrical constrain. A 
Guassian distribution weight is applied with maximum at the ‘Initiation depth’ . 

17. Dimension (in location units) at which to stop the algorithm 

18. Step size dimension (in location units) to iterate through 

19. Maximum condition number limit to allow location 
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20. Northing, Easting and Depth range of starting grid 

21. Initial size of grid cells along North, East and Depth directions 

22. Location resolution at which to stop collapsing 

23. Collapsing buffer: Number of old cells forming new collapsing grid  

24. Enable the exclusion of volumes in the grid search using a voxel file 

25. Browse for the .csv file with voxels defining the exclusion volume in the grid search 

26. Restrict the grid search to the nodes within an object defined in the 3D visualiser. Click invert to exclude the points 
within the objects from the grid search 

27. Time window size for autofunctions for both P and S wave 

28. The maximum number of iteration used in source scan 

29. Apply conventional collapsing grid search after source scan location 

30. The half dimensions along North, East and Down centred at the source scan location 

31. The maximum particles (initial possible solutions in multidimensional space) used in source scan 

32. Similar to 19, the initial size of grid cells along North, East and Depth directions 

33. Similar to 20, the number of old cells forming new collapsing grid 
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Table 5.7: Velocity models available for use in the location algorithms. 

 

Velocity Model Description Reference 

Homogeneous-Isotropic Assumes a homogeneous- 

isotropic medium (half space) with 

direct rays between source 

and receiver. 

Appendices section 3.1 

Time Dependent Homogeneous-› 

Isotropic 
As above but each time span 

contains its own Homogeneous-› 

Isotropic model. 

Appendices section 3.1 

Transversely Isotropic Assumes a transversely-isotropic 

medium (i.e. there is an axis of 

symmetry along a fast or slow 

direction) with direct rays between 

source and receiver. 

Appendices section 3.1 

Time Dependent Transversely 

Isotropic 

As above but each time span 
contains its own Transversely 
Isotropic model. 

Appendices section 3.1 

Complex (Wave Builder) Uses travel-time grids calculated 

by InSite's WaveBuilder Algorithm. 

This velocity model can only be 

used with the Collapsing Grid- 

search Algorithm. 

Advanced Location Tools 

Complex (Tian Raytracing) Models travel times using a two-

point ray tracing for a horizontally 

layered velocity model. 

Advanced location (Tian 

Raytracing Overview) 

Complex (Travel Time Grid 

Method) 

Uses travel time grids calculated by 

the fast sweeping method. This 

velocity model can only be used 

with the Collapsing Grid-search 

Algorithm. 

Advanced location Travel Time 

Grid Method 

Complex (VTI Tian Raytracing) Models travel times using 1 

dimensional Vertically Transversely 

Isotropic horizontally layered 

model. 

Advanced location (VTI Tian 

Raytracing Overview) 

Complex (VTI Raytracing) Models travel times using 3 

dimensional Vertically Transversely 

Isotropic horizontally layered 

model. 

Advanced location (VTI Tian 

Raytracing Overview) 

 
 
 

5.9.8.2 Location Algorithm Properties 
Depending on the location algorithm selected in the Locater Properties Sheet, different settings are required displayed 

in the Location Algorithms Properties Sheet. 
 
For Simplex, Grid Search and Geiger Algorithms: 

• P-wave weighting - relative weighting of the P-wave arrival errors. 

• S-wave weighting - relative weighting of the S-wave arrival errors. For Simplex and Grid Search Algorithms: 

• LPNorm - power to raise the travel time residuals. 

• Use outlier identification - identifies outliers and removes from calculations to create a more stable solution. 
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• Arrival Error Factor - the factor that an arrival error has to be greater than the mean error to produce an outlier. 

• Use P or S Source Vectors - the source vector is obtained during automatic or manual picking by rotating the 

waveform information recorded on a triaxial instrument into the "ray coordinate" system. 

• Restrict to X-Y Plane - restrict the location algorithm to using just azimuths on the X-Y plane to give a "bearing" 

for the event at each receiver, and then use arrival times to determine a distance. The X-Y plane is defined by 

the X, Y component of the geophones. For example, the X-Y plane is horizontal in vertical wells and vertical in 

horizontal wells. 

• Minimum P or S Source Vectors - the minimum number of source vectors which are required in order for a location 

to be valid. For an instrument to contain a source vector it must have a phase pick, must meet the Linearity 

Threshold defined in the auto-picking or source vectors properties sheet, and the source vectors used in a location 

must all be within an angular residual defined by the user (see below). 

• Source Vector Weight - relative weighting of source vectors applied in the error space calculation. 
 

• Max. Ang. Residual - is the Maximum Angular Residual which is a limit on the difference between the measured 

and theoretical source vectors. 

 
 
To apply a geometrical constraint to the Simplex and Grid Search Algorithms: 
 

• Perform Depth Constraint (Gaussian) - apply a Gaussian weighting factor to the depth search when running the 

location algorithm. This is used to provide an additional constraint when a velocity model leads to a non-unique 

location misfit space. 

 
• Initiation Depth - set the peak depth of the Gaussian curve close to the expected location depth. 

 
• Depth Standard Dev. - the width of the Gaussian curve is set via the user defined standard deviation and thus 

controls the severity with which the depth constraint is applied. 

 
• Minimum Weighting - controls the weighting of the background level (where the peak of the Gaussian curve has 

amplitude 1.0) and is a second control of the severity of the depth constraint. 

 
For Geiger Algorithm Only: 
 

• Tolerance - the fractional change in error space across the Geiger at which the location algorithm stops iterating.  

 
• Step size - used in the time derivative calculation, as a rule of thumb this should typically be set to a few tenths. 

 
• Maximum Iterations - this represents the maximum number of iterations before a final source location is 

calculated. This is intended for the rare situation in which there is no convergence and the Geiger algorithm 

would continue in an infinite loop. 

 
• Condition No. Limit - this number gives an idea of the robustness and reliability of the inversion process, related 

to how well conditioned the set of linear equations is. It is recommended a higher number is used initially to ensure 

data is not excluded. 

 
For Simplex Algorithm Only: 
 

• Tolerance - the fractional change in error space across the simplex at which the location algorithm stops iterating.  

 
• Start Size - the size of the first search volume used in the Simplex Algorithm. 

 
Grid-Search Algorithm Only: 
 

• Northing - range over which the first grid is set-up in the northing direction. 
 

• Easting - range over which the first grid is set-up in the easting direction. 
 

• Depth - range over which the first grid is set-up in the depth direction. 
 

• Cell Dimensions - resolution of the grid in the initial run. 
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• Desired Resolution - resolution at which the final location is required. 

 
• Collapsing Buffer - size of the new (collapsed) grid in old cells. 

 
The grid-search box can also be manipulated in the 3D Visualiser: right-clicking on the grid search box opens a menu; 

selecting 'Properties' launches a Dialog that allows the user to alter the position of the grid search box (Figure 5-54). 
 
 

 
Figure 5-53: Dialog Box to adjust the Grid Search Box in 3D Visualiser. 

 
Advanced Location Algorithm Settings: 
 

• Preprocess Locations - select whether to optimise the advanced location routine by working only with events that 

locate using a homogeneous-isotropic model. 'Use Homogeneous-Iso and Feed All Picks' uses all the picks in the 

event and 'Use Homogeneous- Iso and Feed Valid Picks' uses only the picks in the event that are valid. 

• Select whether to import the velocity model from a CSV file or through the Frac Manager and browse to make 

the model selection. 

• Include head waves in Tian raytracing - select whether to include head waves in the Tian raytracing calculation. 

• Parallel Dipping Layers - strike and true dip of parallel dipping layers, optional in Tian two-point ray-tracing 

algorithm. Northing and easting coordinates must be given to define where the depth given in the input text file 

(.csv) is applicable. 

 

5.9.8.3 Source Location Operations 
There are two different source location operations that can be performed. 
 

1. The most common approach is to use P and/or S-wave arrivals measured (picked) directly from the wave- forms. 

These can be provided by either manual or automatic picking methods. The arrival times are input directly into the 

location algorithm. 

2. An alternative approach - termed Master-event location - uses travel-time difference measured between wave- 

form arrivals on a processed event compared to waveform arrivals on a reference event. The aim of the approach 

is to generate more precise travel times for the processed event by removing picking uncertainties. It should be 
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cautiously applied to only events that have very similar character and are believed to locate as a cluster. By 

processing all the events in the cluster the user is able to determine much smaller structural variations in the 

source locations. The travel time differences are calculated using the cross-correlation algorithm. The user should 

ensure this algorithm is adequately optimised for the data before proceeding with the location.  

 

 
 

Figure 5-54: The Medium Properties Dialog Box. Please refer to the text for details. 

 
 

1. P-wave velocity 

2. S-wave velocity 

3. P-wave anelastic attenuation 

4. S-wave anelastic attenuation 

5. Anisotropy factor 

6. Azimuth of axis of symmetry from North 

7. Plunge of axis of symmetry down from the horizon 

8. Time dependent velocity model file path 

9. Select whether to optimise advanced location routine by working only with events that locate using a 

homogeneous-isotropic model 

10. Select whether velocity model will be defined in external file or built using Frac manager 

11. Browse for velocity model input file or to model defined using Frac manager 

12. Select whether head waves are included 

13. Define strike and dip of parallel velocity layers if not horizontal and define northing and easting where depth 

given in input file is applicable 

14. Define strength and orientation of velocity anisotropy assuming transverse isotropy 
 

5.9.8.4 Location Magnitude 
A Location Magnitude is calculated for each successfully located event on all sensors that have been used in the location 

algorithm. It is designed to be a simple estimate of relative magnitudes between a set of events recorded on the same 
array. It does not apply amplitude correction due to attenuation and thus does not require advanced waveform processing 
required in the source parameter algorithms and so is applicable to ANY waveform data that is used for  location. 
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The Location Magnitude, ML, is calculated using the. WRMSm is the RMS Waveform Amplitude calculated on 

each sensor, m, dm is the ray path length calculated between the source location and the sensor's location.  

• For Channel Processing each sensor is uniaxial so WRMSm is taken directly from the waveform on that channel. 

• For Instrument Processing each sensor can be multi-channel so WRMSm is the mean of the RMS Waveform Amplitudes 

calculated on all channels in that instrument. 

 

 
 
 

 

5.9.9 Source Parameters 
Source parameters are automatically calculated for each event at the end of the source location process. The algorithms 

are described in the Technical Appendices section 4.1 and the configuration parameters are shown in Figure 5-55. 
The following source parameters are calculated: 
 

• Instrument Magnitude 

• Seismic Moment 

• Moment Magnitude 

• Radiated Seismic Energy 

• S-wave to P-wave Energy Ratio 

• Source Radius 

• Apparent Stress 
 

• Static Stress Drop4.9.9 
 

• Average P-wave Corner Frequency 
 

• Average S-wave Corner Frequency 
 
In order for these to be calculated effectively the user must ensure the following criteria are met:  
 

1. Sensors must respond to acceleration, velocity or displacement so that the waveforms can be converted to the 

required response type. 

2. Processing must be performed in Instrument mode (Treatment of Multi-channel Sensors). 
 

3. The appropriate flag must be set on the Locater Property Sheet to enable processing. (Figure 5-51) 
 

4. Only the Instrument Magnitude can be calculated on non-triaxial sensors. The remaining parameters require three 

channels of data on a fully operational triaxial sensor (Technical Appendices section 4.1). 

 

5. Local Magnitude equation is defined in the dialog shown in Figure 5-56, launched from the ‘Local Magnitude Settings’ 

button. Depending on the region and type of instrument used, factors can be adjusted as well as the amplitude 

(measured from the vertical, horizontal or any single component) used in the calculation. It also allows to select whether 

to use hypocentral or epicentral distance in the calculation. The magnitude will be calculated as the Mean of the 

amplitudes calculated for each station. The mean can be trimmed to remove outliers. 

6. Only channels recorded on triaxials used in the final source location are then used in the Source Parameter 

algorithm. Source parameters are averaged over these sensors. The Minimum number of instruments to use 

defines how few sensors can be adequately utilised to calculate the parameters. If fewer sensors are available, 
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then the algorithm does not produce a result. 

7. During waveform integration and differentiation, a band-pass filter is applied. This uses the settings on the Channel 

Processing Property Sheet (Figure 5-37), so these must be adequately configured for the data before processing. 

The user should check the effect of the filter using the Waveform Visualiser. The acceleration, velocity and 

displacement waveforms can be visualised by selecting the appropriate response from the Event Initialisation 

Property Sheet. 

 

 
 

Figure 5-55: The Source Parameters Properties Sheet. 
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Figure 5-56: Local Magnitude equation configuration dialog. 

 
The spectral model can be fit using two different methods: 
 

1. Simplex - Generalisation of a tetrahedral region of space to n dimensions. This is fast and efficient method 

of calculating the spectral model, although may not be optimal. 

 
2. Grid Search - Finds the optimal spectral model by using every combination of low frequency plateau, corner 

frequency, and attenuation (if not specified) in the fit algorithm. This is a brute force approach but finds the best 

fitting model. 

 
 
 

5.9.10 Mechanisms 
 
Source mechanisms can be calculated using a time-domain approach whereby P-wave first motion amplitudes and 

polarities are inverted for the moment tensor. This can then be displayed in the Mechanism Visualiser. 
 
The configuration parameters for the algorithm are given in Figure 5-57. The Technical Appendices section 5.1 

discusses these in further detail and describes the inversion technique used. If only single component (one axis) 
available, the Uniaxial only is available, otherwise rotated P-waves or the rotated P, SH and SV waves can be used for 
three-component geophones (tri-axial sensors). 

 
If you wish to use uniaxial when you have an array with mixture of triaxial and uniaxial, you can disable the other 

axis you wish in the “edit default receiver array”. Then if you right-click on the events and update their receivers, the 
uniaxial option will then be applicable (see details in Source Mechanism Tool). 
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Figure 5-57: The configuration parameters on the Mechanisms Property Sheet. 

 
The sensor polarity and coupling weight corrections should be configured on the Channel Properties Dialog Box or 

Receiver Properties Dialog Box. If applying a coupling weight, Cwk, then this should be included in the Gain, g, setting 
using this equation. The waveform amplitude will then be adjusted appropriately. 

 

gcorrected = g.Cwk 

 
The following approach is recommended to produce the best possible source mechanism solutions:  
 

1. Events should be carefully chosen for inversion. These should have a good focal coverage of sensors and a 

majority of arrivals with clear onsets. The focal coverage depends on how well the sensor array is distributed 

around the source location and can be assessed using the 3D Visualiser before inversion and in the Mechanism 

Visualiser after inversion. 

2. The event must be manually picked for P-wave first motion arrivals and amplitudes. The event should then be re-

located using these arrival times to give as accurate a location as possible. 

3. The amplitudes to be used in the inversion should be carefully assessed. Poorly constrained amplitudes (i.e. where 

signal to noise is low or the first motion is uncertain) should be initially dropped from the inversion. This will 

provide an inversion that the user has more confidence in, but is possibly less well-constrained due to fewer 

amplitudes being used. Amplitudes can be easily dropped by right-clicking on the pale-blue cursor in the Waveform 

Visualiser - the dark blue cursor, being the first arrival, will remain. 

4. Amplitudes with lower confidence should then be introduced into the inversion. This is performed by selecting the 

pale-blue cursor from the Channel Processing Bar and moving the cursor to the appropriate position on the 

waveform. Through an iterative procedure of adding poor amplitudes to the inversion, and re-inverting each time 

to visualise the results, the user can produce a solution they remain confident in. 

5. The error results should be carefully studied after inversion of a number of events to assess which events  have 

the best solutions in the data set. Poor solutions should then be re-visited. 
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5.9.11 Optimised Picking 
 
The Optimised-Picking Properties sheet (Figure 5-58) contains the configuration controls for optimised picking 

functions. The routines can be run either through auto-processing (from the auto-processing Dialog or in the InSite 
Leach during real-time operations) or manually in the Waveform Visualiser. Many of the functions can be visualised 
and manually run in the Waveform Moveout View. 

 
 
 

 
Figure 5-58: The configuration parameters on the Optimised Picking Property Sheet. 

 
 
Optimised picking methods include least-squares moveout curve fitting with guided re-picking (abbreviated to 

WaveLSQ) and waveform stacking with iterative cross-correlation and re-picking (abbreviated as WaveXC). The Optimised 
Picking sheet allows the user to select any combination of the two routines for each of the P- and S-wave phases and also 
to set key parameters. 

 
The options selected on the Optimised Picking sheet can be run both manually and through the auto-processor. To 

run the options through the auto-processor there is a Use Optimised Picking check-box on the Auto-picking sheet 

(figure) that may be selected. To run options manually, there is an Optimise Picking button  on the right-hand button 
bar of the Waveform Moveout View. If none of the optimised picking routines have been selected on the Optimised 
Picking sheet, the Optimise Picking button is inactive (greyed-out). 

 
When the WaveLSQ and WaveXC routines are both selected the curve fit will always be run first. The WaveLSQ routine 

is intended to guide picking and increase the number of correct picks across the array, whilst WaveXC is a pick refinement 
algorithm. 

 
Existing picks are archived each time the Optimise Picking function is used. The previous picks can then be compared 

with the optimised picks in the Waveform-Moveout View. 
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Least Squares Curve Fit WaveLSQ 
 

The WaveLSQ routine is selected for each of the P- and S-wave phases using check boxes on the Optimised Picking 
sheet. Other parameters that are user controlled are: 

 
• Initial distance: Initial event-receiver distance parameter estimate to seed the least squares routine; 

 
• Initial velocity: Initial velocity parameter estimate to seed the least squares routine; 

 

• Outlier tolerance: The maximum distance, in sample points, that a phase pick may lie away from the calculated 

curve before being rejected as an outlier; 

 
• Re-pick front window length: The window length, in sample points, in front of the theoretical curve-fit arrival where 

a phase pick will be sought using the auto-picking routine; 

 
• Re-pick back window length: The window length, in sample points, behind the theoretical curve-fit arrival where a 

new phase pick will be sought using the auto-picking routine. 

 
The re-pick windows should be wide enough to allow for reasonable misfit of the curve to the data points but narrow 

enough to exclude other major phases. 
 
 

Waveform Stacking with Iterative Cross Correlation WaveXC 
 
The WaveXC routine is selected for each of the P- and S-wave phases using check boxes on the Optimised Picking 

sheet. Other parameters that are user controlled are: 
 

• Cross correlation front window: The window length, in sample points, in front of the phase pick that is used to 

calculate the cross-correlation value between the trace and the stack; 

 
• Cross correlation back window: The window length, in sample points, behind the phase pick that is used to 

calculate the cross-correlation value between the trace and the stack; 

 
• Maximum offset: The maximum offset, in sample points, between the trace phase pick and the stack phase pick at 

which to calculate the cross correlation - at all offsets between zero and the maximum offset in either direction 

from the phase arrival the cross-correlation value is calculated; 

 
• Re-pick front window length: The window length, in sample points, in front of the trace phase arrival where a 

phase pick will be sought on the final stacked waveform using the auto-picking routine; 

 
• Re-pick back window length: The window length, in sample points, behind the trace phase arrival where a phase  

pick will be sought on the final stacked waveform using the auto-picking routine; 

 
• Function: The function the WaveXC routine should be run on - there is a choice of four functions involving an RMS 

signal (of waveform amplitudes or the analytic envelope), or the product of the RMS signal with its picking  function. 

 
The cross-correlation window lengths should be adjusted to exclude the other major phase, i.e. the S-wave arrival 

should not fall within the P-wave cross correlation window and vice versa. The P-wave cross correlation front window 
should preferably be less than or equal to the P-S separation, while front and back windows should be reasonably close to 
equal. Similarly, the maximum offset should be adjusted to avoid interference between the two major phases. The re-pick 
window should be reasonably narrow, as the final stack pick should be reasonably close to the initial  picks. 
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5.9.12 Quality Control QC 
 
The QC comparison tool is configured via a tab on the InSite Processing Properties dialog (Figure 5-59). 
 
 
 

 
Figure 5-59: Quality control properties dialog 

 
When a QC comparison operation in carried out between two components in Data Visualiser, the selected matching 

tolerance determines the maximum allowed proximity in time between two compared events in order for a match to be 
made between them. 

 
An option exists to use the local time in a QC comparison operation 
 
The comparison events combo box shows four modes of operation that can be used for the QC comparison 

operation 
 

• All - show all events in results list 
 

• Located - show all located events in results list 
 

• Matched - show only matched events in results list 
 

• Matched and Located - show only matched and located events in results list 
 
When an item is selected from a comparison component for display in Waveform-Moveout view there is an option to 

either use the InSite velocity model or a user selected velocity model when plotting the comparison moveout curve.  
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5.9.12.1 QC Comparison in Data Visualiser 
 
The QC Comparison menu option is launched by selecting two components for comparison in Data Visualiser  and 

then launching the pop-up menu as shown in Figure 5-60. In a typical scenario one of the components will comprise 
events with associated waveforms while the other component comprises events imported from a CSV file which have 
no waveforms. 

 
 

 
Figure 5-60: Comparison of two components 

 
 
Following the operation, a new 'comparison component' is created showing the results of the comparison operation  

(Figure 5-61). In the events panel is a list of all the events that have been matched from the two selected components in 
chronological order. 

 
Events that have not been matched may also be listed depending on what settings have been specified in processing 

properties. 
 
Note that the label column shows the original component and event number for each result. The other columns,  with 

the exception of the number column, show identical content to the original event. 
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Figure 5-61: Comparison results of two components 

 
Note that comparison components are not saved to the PCF on exit from InSite. 
 
 

5.9.12.2 QC Comparison in Waveform Moveout View 
To compare 2 events in Waveform moveout view, select view waveforms from the pop-up menu as shown in Figure 

5-62. 
 
 

 

 

Figure 5-62: Comparison of two events 

 
 
The comparison moveout curves and T0 line are shown when the "Show QC Comparison overlay" button is selected 

in the overlays toolbar. These comprise red dotted lines as shown in Figure 5-63 and refer to the event matched with the 
one for which the waveforms are displayed. In addition, red dotted lines are shown in the SV plots and NEU 
hodograms. The moveout curves will be affected by what has been configured for the velocity model under the QC tab 
within processing properties. 
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Figure 5-63: Comparison results of two events 

 
 

5.10 Importing Event Parameters 
Event parameters can be imported into an existing component in the project. This function differs from the Data Import 

Dialog in that the events, into which the data are to be imported, must already exist in the component.  
 
The event data is indexed by number meaning that the user must ensure that the event numbering scheme used in the 

file exactly matches the event numbering in the component. InSite reads the data from the given file and adds it to the 
event, so any existing data in the event will be over-written. The data formats currently available are given in Table 5.8. 
After selecting the command from the Component List Menu the user will be asked to locate the file to import. The 
importation process is then automatic. 

 

Table 5.8: Data files available for importing event parameters. 

 

Data Type Description Format Reference 

RDB Event parameter data file from Queens University and ESG Canada 
Inc. 

Appendices section 
2.3 

SDR Client event parameter file. N/A 

SRC Event parameter data file from Queens University and ESG Canada 
Inc. 

Appendices section 
2.4 

QDB Event parameter data file from Queens University and ESG Canada 
Inc. 

 

EPF Event Parameters File (EPF) Appendices section 
2.13 

 
 

5.11 Event Discrimination Functions 
 
 

5.11.1 Enable and Disable Functions 
Components and events can be enabled or disabled from the Project. This allows the user to easily select events, 

or groups of events, for visualisation or processing. 
When a component is disabled the effect is the same as disabling all events within that component.  
 

• Disabled events are not displayed in the other visualisers. 

• Disabled events are not automatically processed. 
 

• Most export functions do not export the disabled data to file - the user is notified when this is the case. 
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• Disabled data are ignored in the event filtering and automatic extraction functions. 
 
 

5.11.2 Event Filtering 
 
One important interpretation tool in earthquake studies is the ability to select portions of a data set depending on the 

value of the event's parameters, such as time, location, uncertainties etc. This is performed in InSite by enabling or disabl ing 
events that fall outside of given criteria. These events are then removed from the visualisers, so aiding the  interpretation. 

 

 
 

 

Figure 5-64: The Event Filter Dialog box. 

 
The Event Filter Dialog Box (Figure 5-64) allows the user to select the parameters to filter on and provide the necessary 

criteria. Clicking on the Filter button causes the data set to be searched for events that fit the criteria. Events that do n ot 
fit the criteria are disabled. Only enabled components are searched allowing the user to remove sections of the data from 
the process if so desired. 

 
Events can be filtered by one or more of the following parameters: 
 

• Date and Time 

• Volume (NED Box) 

• Volume (triangulated volume defined by object in STL file format) 

• Volume (using DOF file) 

• Visualisation (shape in 3D visualiser) 

• Instrument Magnitude 

• Location Magnitude 

• Moment Magnitude 
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• RMS Location Error 

• Signal-to-noise ratio 

• Cluster Index 

• Interacting Neighbours 

• P Picks 

• S Picks 

• Angular Residual 

• Source Vectors 

• Confidence number 

• P-wave SNR 

• S-wave SNR 

• Number of arrivals used in location 

• Number of independent sensors used in location 

• Number of source vectors used in location 

• RMS residual time 

• Angular residual 

• S:P Ratio 

• RMS noise 

• Radiated Energy 

• Mean P/SH ratio 

• Mean P/SV ratio 

• Mean SV/SH ratio 

• Peak acceleration 

• Uncertainty (N, E, D) 

• Cluster label 

• Opening angle 
 
Up to four parameters, apart from spatial and temporal parameters, can be selected for filtering by selecting them from 

the drop-down lists.  
To filter using a Triangulated object defined by an STL file in the 3D visualiser, select the imported object from the drop-

down list. To use this option, it is necessary to define a point (in NED coordinates)that locates outside of the defined volume.  
To filter using a Drawing Object File (DOF) volume, use the browse button to select the required file which contains the 

planes describing the closed volume (for more information on creating DOF files). It is also necessary to define a point (NED 
coordinates) which locates outside of the defined volume. Note that the DOF file reference and information is not stored 
after the Event Filter Dialog Box is closed meaning that this function can only be used during manual filtering. 

 
Each of the event filters can be inverted, by checking the 'Invert Filter' box, or in the case of the Triangulated and DOF 

volume selecting either the inside or outside volume options. 
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5.11.3 Setting the Event Type 
Events can be split into three default types: 

• Event 
• Shot 
• Noise 

 
In addition, the user can create up to 90 event labels. This is done through the 'Edit User Defined Event Types' Dialog 

(Figure 5-65), launched from the Events menu in the Data Visualiser. The user can add an event type with any label name 
they choose. This name can be updated at any time using the edit option and the change is automatically applied to events. 
When the user highlights an event type and chooses 'Delete' a warning Dialog appears to inform the user that this action 
will reset all events of the selected type to 'Event' and asking the user to confirm that they wish to  continue. 

User event types can be assigned a symbol and colour for plotting in the 3D Visualiser. 
 

 

Figure 5-65: Dialogs associated with adding, editing and deleting user event types. 

 

 
Figure 5-66: Dialogs associated with adding, editing and deleting user event types. 
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Figure 5-67: Dialogs associated with adding, editing and deleting user event types. 

 
In the Data Visualiser each of the three default types has its own icon. All user event types have the same icon. This 

allows the user to mark and segregate the different events. The user can also perform functions on just a section  of the 
data set by enabling only events of a particular type. Some processing functions are only applicable to a particular 
event type and include the following: 

 
• Setting or editing of Shot/Transmitter Parameters can only be performed for a Shot type. 

 
• Velocity calculations, either for the pick velocity or for the cross-correlation velocity, can only be performed on a 

Shot type. 

 
All events that are designated by a user type label behave as an Event for processing.  
 
All Event functions such as source location, source parameter and source mechanism calculations etc. can be 

performed on Shots, thus allowing the user to perform calibration exercises.  
 
The event type is generally set from the Component List Menu or the Event List Menu (Visualiser Interface), although it 

can also be set from within the Waveform Visualiser, 3D Visualiser and through importing a LOG file. 
 
When a LOG file is imported InSite browses the file looking for particular event flags and matches the flags to events 

in the data set. 
 
 

5.12 Moving Events Between Components 
 
 

5.12.1 Manual Move and Copy Functions 
Events can be manually moved or copied from one component to another. This allows the user to manually sort the 

data by segregating events, similar to moving files between folders on a hard drive. The move and copy functions are found 
on the [Event List Menu] 

 
When the Move Event function is run, the user is asked to specify which component the events are to be moved to 

(Figure 5-68). The ESF files associated with the event(s) are then moved to this different component. In addition, if all of 
a component's events are moved to another component, the ESF subdirectory associated with the source component is 
removed provided it is empty. 

 

 
Figure 5-68: Destination Component Selection Box. 

If so desired the user can also select to re-number the events upon moving the data (default). This is advisable if data 
is going to be moved from more than one component into the destination component. The events are re -numbered 
sequentially after the maximum event number already existing in the component. 
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When an event that contains waveforms is moved then the ESF associated with the event is also moved on the hard 

drive into the component's storage directory. This is performed so that all the data remains within structured  file 
storage. 

 
Copy Event works similarly to Move Event except that it copies Events from one component to another or within the 

component itself. Note that if events are copied within a component the 'Re-number events' tick box must be selected in 
the Destination Component Selection Dialog. If copying between components, then the 'Re-number events' tick box can 
be deselected but it may mean warning messages appear (Figure 5-69), e.g. when there already existing events with the 
same event number in the destination component. 

 

 
Figure 5-69: Duplicate Event number warning message. 

 
 
Components can be merged, using the Merge selected components in the [Component List Menu]. The operation 

works by creating a new component with a default name. It then moves all events and their associated ESFs out of  
the selected components into the new component. The old components will be removed from the component list and 
their ESF subdirectories removed, provided they are empty. 

 
To operate on all events within a project, [The Events sub-menu] in the Data Visualiser contains functions to move, 

backup and purge all ESFs. Move All ESFs moves all ESFs to a new directory, whilst Backup All ESFs makes a copy 
of all of the ESFs in a new directory. Purge All ESFs deletes all ESFs in the component directories which are no longer 
referenced in the project. 

 
When running the move or backup functions, the user is prompted to select the directory to which the ESFs are 

to be moved via the standard Browse for Folder Dialog. Each component in the project is dealt with in turn. A check 
is first made to see if the destination component subdirectories contain any ESFs which clash with events and if so, 
the user gets a prompt whether or not to continue. If the component ESF subdirectories do not exist, they are 
created. As the move and backup operations can take quite a long time, a message box appears in the top left-hand 
corner showing the progress of the operation. 

 
When running the move operation, each component has its old directory removed, if it is empty, and its component 

directory property is updated. At the end of the operation, the ESF storage directory for the whole project is also updated. 
 
When running the purge function, the user is at first given a warning message about carrying out such an operation 

(Figure 5-70). Each component in the project is dealt with in turn. The components ESF subdirectory is interrogated 
to determine which ESFs are no longer present in the currently open PCFs components and they are then deleted. If 
the ESF subdirectory is empty at the end of the operation it will be removed. 

 
 

 
Figure 5-70: Purge Function warning message. 
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5.12.2 Automatic Extraction Functions 
The Auto-extract Surveys function automatically searches through the data set and finds all shots. These are then 

automatically split into surveys. Only enabled components and events are searched.  
 
A survey is defined as a group of shots occurring within a specified time period. These shots are then automatically 

extracted out of their existing components and into a new component automatically set up for that survey. The name of 
the component is defined by the date and time of the first shot to occur in the survey. The events are automatically 
numbered in date-time order. ESFs that are associated with the events are renamed and the files moved on the hard 
drive to accommodate the change in component. 

 

 

Figure 5-71: The Auto-Extract Survey Data Dialog box. 

 
When the function is run the Auto-Extract Survey Data Dialog Box is displayed (Figure 5-71). The user must define the 

Maximum Survey Time. This is the time, in minutes, for all of the shots in a survey to occur. All surveys within the data being 
searched must be restricted to the same time limit. Figure 5-72 shows an example study that contains five shots in each 
survey. All the shots in each survey were performed within a 40-minute time period stretching from the first shot in the 
survey. The surveys were separated (from the first shot of one survey to the first shot of the next) by at least a 90-minute 
time period. If the user selects a Maximum Survey Time in the range 40 to 90 minutes, then all the surveys should be 
correctly separated (assuming that the data set spans complete surveys). If a Maximum Survey Time greater than 90 
minutes is selected, then the surveys will always be incorrectly separated. Ideally, the time between the last shot on one 
survey and the first shot on the subsequent one should be greater than the Maximum Survey Time as this will always 
result in correct separation. 

 

 
 

Figure 5-72: Example shot time-line enabling splitting of shots into individual surveys. 
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5.13 Auto-Processing 
 
The Auto-Processing Dialog Box (Figure 5-73) allows the user to process any part of the Project's data set automatically. 
 
 
 

 
 

Figure 5-73: The Auto-Processing Dialog Box 

 
The processor operations are only performed on Enabled Events in Enabled Components thus allowing the user 

to process a selected part of the data set. Auto-processing accesses each event in turn, reading the ESF, and performing 
the chosen processes. The user selects the processes to perform from a list of available options shown in Table 5.9. The 
availability depends on whether the user has the appropriate permissions and whether the user has adequately 
configured the processing properties. Waveform pre-processing is automatically performed. 

 
It is very important that the user checks the accuracy and robustness of the processing functions for the set con - 

figuration parameters before attempting auto-processing. This should be done by manually processing a sample of the 
data in the Waveform Visualiser. 

 

Table 5.9: The processing options available in the Auto-processing Dialog box. 

Process Description Reference 

Cancel P Picks P-wave picks are removed from all 

channels in the event 

- 

Cancel S Picks S-wave picks are removed from all 

channels in the event 

- 

Auto-pick Event P and/or S-wave picks are 

automatically obtained for each 

event using the properties set on 

the Auto-picking Property Sheet.∗ 

Auto-picking 

Get Pick Velocities P and S-wave velocities are 

obtained from the "Time-of-flight 

method". Only active events are 

processed. 

Auto-picking 
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CCR Event Events are cross-correlated for 

arrival time differences using the 

properties set on the Cross- 

correlation Property Sheet. 

Cross-correlation 

Source Vectors Only Calculation of source vectors using 

the properties set on the Auto- 

picking Property Sheet. 

Auto-picking 

Locate Event Events are source located using 

picked P and S-wave arrivals. 

Locater 

Get Source Mechanism The source mechanism is 

calculated using the properties set 

on the Moment Tensor Property 

Sheet. 

Mechanisms 

Get Peak Amplitudes The maximum amplitude on each 

channel is obtained 

Configuration of Processing Properti 

Master-Locate Event Cross-correlation arrival times are 

used to calculate the source 

location 

Locater 

Filter on Parameters The event filtering criteria (set on 

the Event Filter Dialog) are used to 

automatically disable the event 

Event Filtering 

 Outputs ATFs as Raw 

(Unprocessed) for all enabled 

events. 

Appendices section 2.8 

AutoWrite to SEGY (Raw) Outputs SEGY as Raw 

(Unprocessed) for all enabled 

events. 

 

AutoWrite to SEG-2 (Raw) Outputs SEG-2 as Raw 

(Unprocessed) for all enabled 

events. 

 

AutoWrite to ATFs (Rot.SV) Outputs ATFs as rotated channels 

using measured source vector (SV) 

for all enabled events. 

Appendices section 2.8 

AutoWrite to SEGY (Rot.SV) Outputs SEGY as rotated channels 

using measured source vector (SV) 

for all enabled events. 

 

AutoWrite to SEGY (Rot.Theor.) Outputs SEGY as rotated channels 

using theoretical source vector (SV) 

for all enabled events. 

 

AutoWrite to SEED (Raw) Outputs SEED as Raw 

(Unprocessed) for all enabled 

events. 

 

AutoWrite to SEED (Corrected) Outputs SEED as corrected 
(station response removed) for all 
enabled events. 

 

Spectral Fit Perform spectral fitting for each tri- 

axial instrument in the event. Note 

that Spectral Fit must be manually 

performed before location. Other- 

wise, the source parameters can’t 

be calculated automatically after lo- 

cation. 

Source Parameters 

Waveform Parameters Calculate the waveform parameters 
for each trace in the selected 
event/s. 

Appendices section 7.4 

Export FFT Export the selected FFT type to file.  

Autopick Pick Amplitudes Automatically pick the amplitudes 

following a P or S pick. 
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Source Parameters (Req. 

Location) 

Calculate source parameters without 

relocating the event. Note: when the 

default receiver array is changed, 

the event receivers must be updated 

(Updating Sensor Information) to 

see the source parameter 

calculation take effect. 

 

Confidence Number (Req. 

Location) 

Calculate the confidence number 

for the event. 

Appendices section 7.5 

Location Uncertainty (Req. 

Location) 

Calculate the location uncertainty 

in North, East, and Down for the 

event. 

 

Mean Arrival Time Residual 

(Req. Location) 

Calculate the mean arrival time 

residuals for the P and S-waves 

for each event. 

 

Instrument Ray Parameters Calculate the ray length, ray 

azimuth, and ray takeoff angle for 

each instrument and the event. 

These can be viewed in the 

instrument data panel and 

exported/imported via the 

instrument csv file. 

Event View Data Panel Appen- 

dices 2.20 

Autopick of P, SH, SV 

amplitudes (Req. locations) 

Automatically rotate waveform to P- 

SH-SV channels based on its 

location and then pick amplitudes 

of P, SH, SV for moment tensor 

inversion. 

 

 

• Reference Components or Events, selected in the cross-correlation algorithm, are automatically missed. 
 
 
 
 
 

5.14 The InSite Leach 
 
 

5.14.1 Key Features 
The InSite Leach provides on-line data-capture facilities and direct acquisition-system control. The Leach is a 

modular interface that integrates with different hardware products importing data directly into InSite's data 
management system and applying 'on-line' processing functions. The Leach can operate in the background so that 
the user can still interact with InSite's visualiser suite whilst data is being acquired. The modular structure means that 
new functions are easily added for different acquisition hardware, so providing software continuity to the user. 

Further information on the Leach and compatible hardware can be obtained from Applied Seismology Consulting Ltd. 
Some of the key features are as follows. 

 
• The InSite Leach has been written as an integrated component of ASC's InSite Seismic Processor, thus providing 

one simple point of entry for the user and providing easy-to-use configuration and operation. This allows new data 

to be seamlessly imported as the data capture functions interact directly with the main data management systems. 

• The InSite Leach has been designed to be independent of seismic acquisition hardware and to operate as part 

of a stand-alone system. A flexible code framework has been developed so that the software can be easily 

updated to be compatible with any seismic acquisition hardware. This means that when a user changes to 

different hardware the InSite Leach can continue to provide the same data management systems and processing 

algorithms and hence provide project continuity. 

• Different functions within the Leach are run in a multi-threaded environment. This means that as the Leach 

operates, each function runs independently. This is key, for instance, when the user wishes to visualise what data 

have been acquired, as well as continuing acquisition and processing in the "background". The multi- threaded 
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environment also means that the Leach is well suited to a multi-processor machine. This is a big advantage when 

using the software in a high-data-transfer environment. 

• When new data is captured from the acquisition hardware it is automatically imported into InSite's data 

management system. During this process, the data are sent for automatic processing of seismic parameters such 

as locations and source magnitudes. The results are then instantly available for visualisation and as such provide 

'real-time' operations for the user. 

• Where possible, the Leach automatically extracts active events recorded from man-made sources, such as the 

transmitters in the ultrasonic arrays, and passive events associated with microseismic or acoustic emission activity.  

This allows the active events to be processed automatically for velocity information. 

 

5.14.2 User Interface 
Figure 5-74 shows the tabbed Dialog box that is the user interface for the Leach. Each tab represents a separate acquisition 
system module. The Dialog box is opened from the Data Visualiser menu in the main InSite program. Modeless means that 
the user can still interact with the main program while the Dialog box is open (an example is the "Find and Replace" Dialog 
box in MS Word). This is important; as one of the key requirements of the Leach is that while it is operating the user must 
be able to interact with the visualisers in the main program. The Dialog box is tabbed so that the Leach can be easily 
expanded for different acquisition systems. Furthermore, the user does not need to purchase the complete set of Leach 
tools but only the functions applicable to the available hardware. 

 

 

Figure 5-74: The InSite Leach window 
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5.14.3 Real-time Data Processing Functions 
 
During the InSite Leach import process the data is processed for the standard seismic parameters that InSite obtains 

when a user processes the data off-line and uses exactly the same functions. Using this approach, the software then 
provides a real-time processing system with results being immediately available for visualisation as soon as the data 
becomes available. 

 
The user has the option to switch on this real-time processing on the InSite Leach user interface. Any processing errors 

that are produced during the operations do not stop the successful completion of the Leach functions, but instead display 
messages to the Watch Dialog Box. 

 
'Passive' and 'Active' events are split apart in the data capture routines ('Active' events are created during ultrasonic 

surveys). The functions that occur during the real-time processing then include the following (these depend on the 
permissions available to the user): 

Passive Events: 
 

• Waveform pre-processing (e.g. waveform filtering) is performed. 
 

• P-wave arrivals are automatically picked. 
 

• S-wave arrivals are automatically picked. 
 

• Arrival times are inverted for source locations. 
 

• Waveform amplitudes are automatically processed for source parameters. 
 

• Waveform peak amplitudes and frequencies are obtained. 
 

• Events are filtered on their source parameters. 
 

 
Active Events: 
 

• Waveform pre-processing (e.g. waveform filtering) is performed. 
 

• P-wave arrivals are automatically picked. 
 

• S-wave arrivals are automatically picked. 
 

• Arrival pick velocities are calculated. 
 

• Arrival cross-correlation velocities are calculated. 
 

• Waveform peak amplitudes and frequencies are obtained. 
 
One of the pre-requisites for the design of the Leach has been the ability to interface to alternative data-acquisition 

hardware. This continues the design philosophy of the InSite Seismic Processor being hardware independent. The Leach 
does this by having a very simple code framework that allows additional tools to be added whenever an interface to new 
hardware is required. The processing functions operate on the InSite side of the interface, so that the data it sends out is 
an identical format regardless of the hardware. The advantage to the user is that if the software is required for an 
alternative acquisition system, or for a different site, then the software can be updated relatively  easily and with no effect 
on the processing algorithms employed. 

 
 

5.14.4 Split SEED/miniSEED for Streamer Leach 
SEED or miniSEED data usually record a long time period of waveform in each file depending on the acquisition 

settings. To avoid importing large files, users can launch “Split SEED/miniSEED file Dialog” to split the data streams 
into smaller blocks of data (Figure 5-75). Depending on the processing computer configuration, for example, users can 
split 1-hour data stream files to 600 second each file. It reduces the demand on computer memory.  
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Figure 5-75: InSite Split SEED/miniSEED dialog. User could choose to split all SEED/miniSEED files in a folder or 
select certain files. 

 
 
 

5.14.5 Streamer Leach Multiple Array Option 
 
In order to Leach through files acquired on different geophone arrays, a default receiver array must be created which 

contains channels across all the arrays that are required. This is set up in the same way as for the existing facility to split 
raw data into M-ESFs using the Multiple array file pre-process dialog, i.e. the imported SEN file must contain 3 
additional columns, the array name (which must correspond with what is configured below in Figure 5-77), plus 
instrument and channel numbers within the context of that array. 

 
To begin using the Streamer Leach in Multiple Array mode, the file format type dropdown list selection shown in 

Figure 5-76 is used. On selection of this directory browser in Search Directory group box becomes disabled. This is 
because the location of the raw data for multiple arrays is configured using a new dialog launched by pressing the Settings 
button within the data properties group box. 

 
Note: the instrument trigger setting will be greyed out and user must specify this parameter for each array (see 

description below). 
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Figure 5-76: InSite streamer leach dialog selecting multiple array file format 

 
When the Settings button is pressed the Multiple Array Streamer Settings dialog box is launched as shown in  Figure 

5-77. This allows the user to configure where the array data is located and its data type (SEGY, MIRF, SEG2 etc). In addition, 
two parameters can be configured to alter the behaviour of the streaming operation (see later). 

 
On selection of Add Array the following dialog is shown as indicated in Figure 5-78. 
 
 

 

Figure 5-77: Array data properties dialog 

 
The fields array name, array path and file type must be specified in the 'Array Raw Data Properties' dialog. In addition , 

the user can use the 'Enabled' checkbox to temporarily disable this array when it comes to performing the actual streaming 
operation. The trigger instrument sets the minimum number of instruments from this array. If any one of the arrays doesn't 
satisfy this triggering condition, no event will be triggered. 

 
On pressing OK the Arrays list-box gets filled in as shown in Figure 5-78.  
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Figure 5-78: List of arrays to search for data 

 
 
Below the list-box are the current settings for the highlighted list-box item plus an Additional Settings button. This is 

used to launch a dialog specifying additional settings pertaining to the file type concerned. An example is shown below in 
Figure 5-79. 

 

 

Figure 5-79: Additional settings for SEGY streaming 

 
When the streamer leach is operating for multiple arrays, InSite scans the multiple array locations to see what files are 

there and to sequence them in order by time/date. The software then starts at the earliest file (in whichever array) and 
begins to import data over a time interval beginning at that time/date. This interval is by default 1 minute but  can be 
changed by the user by using the File Search interval edit field in Figure 5-78. 

 
The data contained within the File search interval is split into temporary events or M-ESFs, these files are not stored to 

disk but kept in memory for performance reasons. Each M-ESF is by default 5 seconds long, this can be changed by the user 
in the File Split interval edit field in Figure 5-78. Note that if files from multiple arrays coincide in time they will be split into 
M-ESFs which combine channels from across all the arrays. 

 
Figure 5-80 shows the leach dialog when SEGY files are being processed from the time interval in question.   
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Figure 5-80: InSite streamer leach with SEGY selection 

 
 
After the M-ESFs for the time interval in question have been generated for the file search time interval in question the 

software scans through each one for triggers. Afterwards the M-ESFs are discarded and the software starts reading data 
from the next time interval in sequence. If a time gap occurs within the data, the software skips forward in time if necessary. 
The scanning continues forward in time until there is no more data to process. 

 
N.B. The Timed at combo-box choice in the streamer leach dialog (Figure 5-81) should be set to the same value as 

the File Search interval when leaching in real-time. In post processing mode it may be set to a lower value. 

 
Figure 5-81: Streamer leach search and import configuration 
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The multiple array streamer leach may involve significant demands on the memory of the computer if the File search 
interval is set too long. See comparison in Figure 5-81. However, a longer time interval can reduce the percentage of 
SEGYs that are re-read each time and the number of directory searches that are performed, improving efficiency. 

 
 

 
1 Minute file search interval 

 
10 Minute file search interval 

Figure 5-82: Streamer leach memory monitoring 

 
Beware of setting the File Split time interval too low as an "ERROR in Internal Triggering!" condition can be reported, 

in particular if the waveform length is set to a high value in the acquisition parameters group-box. However, setting the 
File Split time interval too high makes the operation less efficient as there is more re-reading of SEGY files and in any 
case, it cannot be longer than the file search interval. 

 
 

5.15 The InSite Calendar Map 
The InSite Calendar Map allows the user to visualise the data set by date. On opening the Calendar Map, data from all 

of the components are sorted by date. Dates that contain data are displayed in bold on the calendar. The user can  then 
select the date of interest, and the appropriate data is displayed. 

 

 
 

Figure 5-83: The InSite Calendar Map. 
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5.16 Summary of Processing Results 
This section provides a summary of the results produced from processing an event or channel. These results can 

be either visualised within InSite or output to ASCII text files. 
 

5.16.1 Event Data 
 

Table 5.10: Results produced from processing an event. 

 

Type Parameter Reference Visualiser File Notes 

General 
Paramet

ers 

Number of 

P waves 

picked 

 Data VVF RPT 
EPF CSV 

Total number of 
channels picked. 

Number of 

S waves 

picked 

 Data VVF RPT 
EPF CSV 

As above. 

Location 
Data 

Northing, 

Easting, 

Depth 

 Data 
Location 

VVF EPF 
RPT CSV 

Three- 

dimensional 

location quoted 

in distance 

units. 

RMS Error Appendices 

section 

3.5.2 

Data VVF EPF 
RPT CSV 

A distance un- 

certainty on the 

location quoted in 

distance units. 

RMS 
Residual 

" Data VVF EPF 
RPT CSV 

An rms residual 

calculated from 

all arrivals used. 

Error 

ellipsoid 

axes lengths 

" Location VVF EPF 
RPT CSV 

Length of axes 

A,B,C on 

ellipsoid. 

Error 

ellipsoid 

axes vectors 

" Location VVF EPF 
RPT CSV 

Three- 

dimensional 

directions of 

A,B,C axes. 

Arrival times 

used 

 Data VVF EPF 
RPT CSV 

Number of P- 

and S-wave 

travel times used 

by the algorithm. 

A single 

instrument can 

contribute two 

travel times (P 

and S). 

Independen

t sensors 

used 

 Data VVF EPF 
RPT CSV 

Number of 

Independent 

sensors used in 

the location. A P- 

and S-wave pick 

from the same 

sensor are 

classified as 

'dependent'. 
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Type Parameter Reference Visualiser File Notes 

 Location 

Magnitude 

Location 
Magnitude 

Data Location VVF EPF 
RPT CSV 

Simple relative 

magnitude 

calculated from 

channel rms 

amplitudes. The 

magnitudes are 

relative when 

compared across 

the same array and 

data acquisition 

settings. 

T0 time   VVF RPT 
EPF CSV 

Origin time with 

reference to the 

trigger time of the 

event. 

 
Source 

Paramet
er 

Instrument 

Magnitude 

Appendices 

section 4.2 

Data Location VVF EPF 
RPT CSV 

A true magnitude 

calculated from 

the ppV on each 

instrument. 

Seismic 
Moment 

Data 
Visualiser 

Data "  

Moment 
Magnitude 

" " "  

Radiated 

Seismic 

Energy 

" " "  

S-wave to P- 

Wave 

Energy Ratio 

" " "  

Source 
Radius 

" " "  

Apparent 

Stress 

" " "  

Static Stress 

Drop 

" " "  

Average P- 

wave Corner 

Frequency 

" " "  

Average S-
Wave 
Corner 
Frequency 

" " "  

 Six Moment 

Tensor 

Components 

Appendices 

section 5 

Mechanism VVF RPT 
EPF CSV 

 

Six Moment 

Tensor 

Uncertaintie

s 

" Mechanism VVF RPT 
EPF CSV 
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Type Parameter Reference Visualiser File Notes 

 Relative 

Seismic 

Moment 

" Data 

Mechanism 

VVF 
EPF 
RPT 
CSV 

A relative 

seismic 

moment 

calculated 

from the 

amplitudes 

used in the 

inversion. This 

is a true seismic 

moment if the 

amplitudes are 

displacements. 

Amplitudes 

used 

" Data 

Mechanism 

VVF 
EPF 
RPT 

CSV 

Number of 

amplitudes 

used by the 

algorithm. 

Condition 
number 

" Data 
Mechanism 

VVF 
EPF 
RPT 

CSV 

 

RMS Error 
Factor 

" Mechanism VVF 
EPF 
RPT 

CSV 

 

RMS 
Amplitude 

Residual 

" Data 

Mechanism 

VVF 
EPF 
RPT 

CSV 

 

Quality Index " Mechanism VVF 
EPF 
RPT 

CSV 

 

Isotropic, 

Double-←› 

Couple, CLVD 

percentages 

" Data 

Mechanism 

VVF 
EPF 
RPT 
CSV 

 

Isotropic, 

Double-←› 

Couple, 

CLVD 

coefficients 

" Mechanism RPT 
CSV 

 

F Parameter " Mechanism RPT  

T and k 
Values 

" Mechanism VVF 
EPF 
RPT 
CSV 

 

Errors in T 
and 

k Values 

" Mechanism VVF 
EPF 
RPT 

 

P, B, T 
eigenvalues 

" Mechanism VVF 
EPF 
RPT 
CSV 

 

P, B, T eigen- 

vector 

orientations 

" Mechanism VVF 
EPF 
RPT 
CSV 
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Fault plane 

solution 

nodal-plane 

orientations 

" Mechanism EPF 
RPT 
CSV 

 

Slip vector 
orientations 

" Mechanism EPF 
RPT 

CSV 

 

Fault plane 

solution from 

P-wave 

polarities: 

nodal-plane 

orientations. 

P,B,T vectors. 

Slip vectors. 

Rake 

 Mechanism RPT 

CSV 

 

 

 
 
 
 

5.16.2 Channel Data 
 

Table 5.11: Results produced from processing a channel. 

 

Type Parameter Reference Visualiser File Notes 

 

General 

Waveform 

RMS 

Amplitude 

Waveform pre-
processing 

Waveform TRF PED 
SSF 

 

Waveform 

Signal:noise 

" Waveform PED SSF  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Time-
domain 
Pick 

P-wave 

arrival Pick 

Autopicking  Waveform PED SSF  

P-wave 

amplitude 

pick 

" Waveform PED SSF  

P-wave 

amplitude 

"  PED DCF 
SSF 

DC to 

waveform 

amplitude at 

the 

amplitude 

pick. 

P-wave 

amplitude 

signal:noise 

 

Pick Data 

"   The P-wave 

amplitude 

divided by 

an RMS 

noise 

calculated 

from a pre-

signal 

window 

defined 

before the 

arrival pick. 

P-wave 

picking 

maximum 

amplitude 

"  DCF SSF The 

maximum 

peak-to-

peak 

amplitude 



5.1 Data Visualiser 163  

 

from the 

picking 

algorithm. 

P-wave pick 

velocity 

Pick Velocities Waveform DCF SSF The 'time-of-
flight' 
velocity 
calculated 
from the 
pick arrival 
time. 

S-wave 

arrival Pick 

Autopicking  Waveform PED SSF  

S-wave 

amplitude 

pick 

" Waveform PED SSF  

S-wave 

amplitude 

"  PED DCF 
SSF 

DC to 

waveform 

amplitude at 

the 

amplitude 

pick. 

S-wave 

amplitude 

signal:noise 

"   The S-wave 

amplitude 

divided by 

an RMS 

noise 

calculated 

from a pre-

signal 

window 

defined 

before the 

arrival pick. 

S-wave 

picking 

maximum 

amplitude 

"  DCF SSF The 

maximum 

peak-to-

peak 

amplitude 

from the 

picking 

algorithm. 

 
 
 

Type Parameter Reference Visualiser File Notes 

 S-wave pick 

velocity 

Pick Velocities Waveform DCF SSF The 'time-of- 

flight' velocity 

calculated 

from the pick 

arrival time. 

Waveform 

Peak 

Amplitude 

Peak Amplitudes Waveform PED SSF The 

maximum DC-

to-peak 

amplitude 

on the entire 

waveform. 
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Waveform 

Peak 

Amplitude 

Pick 

" Waveform PED SSF The time pick 

of the 

maximum DC-

to-peak 

amplitude 

on the entire 

waveform. 

Waveform 

Peak 

Amplitude 

Frequency 

" Waveform PED SSF The dominant 

frequency of 

the signal at 

the maximum 

DC-to-peak 

amplitude on 

the entire 

waveform. 

 CCR P-wave 

Arrival Time 

Appendices section 

6 

 DCF SSF P-wave arrival 

time measured 

by cross-

correlating the 

processed 

arrival with a 

reference 

arrival. 

CCR P-wave 

Arrival Time 

Difference 

" Waveform " Difference 

between the 

processed and 

reference P-

wave arrivals. 

CCR P-wave 

Velocity 

" Waveform " Velocity of the 
CCR P-wave 
arrival. 

CCR P-wave 

Velocity 

Difference 

" Waveform " Difference 

between the 

velocities of 

the processed 

and reference 

CCR 

P-wave 
arrivals. 

CCR P-wave 

Window 

Maximum 

Amplitude 

"  " The maximum 

DC-to-peak 

amplitude in 

the CCR 

window taken 

from the 

input 

waveform 

before any 

signal 

processing is 

performed. 
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Type Parameter Reference Visualiser File Notes 

 CCR S-wave 

Arrival Time 

"  " S-wave 

arrival time 

measured by 

cross 

correlating 

the 

processed 

arrival  with a 

reference 

arrival. 

CCR S-wave 

Arrival Time 

Difference 

" Waveform " Difference 

between the 

processed 

and 

reference S-

wave 

arrivals. 

CCR S-wave 

Velocity 

" Waveform " Velocity of 
the CCR S-
wave 
arrival. 

CCR S-wave 

Velocity 

Difference 

" Waveform " Difference 

between the 

velocities of 

the 

processed 

and 

reference 

CCR S-wave 

arrivals. 

CCR S-wave 

Window 

Maximum 

Amplitude 

"  " The 

maximum 

DC-to-peak 

amplitude in 

the CCR 

window 

taken from 

the input 

waveform 

before any 

signal 

processing 

is 

performed. 

 P-wave 

theoretical pick 

 Waveform  P-wave 

arrival pick 

calculated 

from the 

known 

source 

location and 

receiver 

position. 
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S-wave 

theoretical pick 

 Waveform  P-wave 

arrival pick 

calculated 

from the 

known 

source 

location and 

receiver 

position. 

P-wave 
automatic low 
frequency 

plateau∗ 

Appendices section 

4 

   

P-wave 
automatic 
corner 

frequency∗ 

"    

P-wave 
automatic 
energy flux 

"    

 
 

Type Parameter Reference Visualiser File Notes 

 S-wave 
automatic low 
frequency 

plateau∗ 

"    

S-wave 
automatic 
corner 

frequency\∗ 

"    

S-wave 
automatic 

energy flux∗ 

"    

Ray vector NED 

components∗ 
Appendices 

section 7.1 

Advanced 

Waveform 

PED Ray vector 

obtained 

from triaxial 

waveform 

Rotation 

Rotation 

Linearity∗ 
" " " Rotation 

linearity 
obtained 
from 
Montalbetti- 
Kanasewich 
waveform 
rotation 

Single-station- 

location 

distance\∗ 

" " "  

P-wave manual 

low frequency 

plateau∗ 

Frequency 

Functions 

section (6.4.3) 

" "  

P-wave manual 
corner 

frequency∗ 

" " "  

P-wave manual 
energy flux\∗ 

" " "  
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SH-wave manual 

low frequency 

plateau∗ 

" " "  

SH-wave 

manual corner 

frequency\∗ 

" " "  

SH-wave 
manual energy 
flux∗ 

" " "  

SV-wave manual 

low frequency 

plateau\∗ 

" " "  

SV-wave 

manual corner 

frequency∗ 

" " "  

SV-wave 

manual energy 

flux\∗ 

" " "  

 
• Parameters are produced on an instrument but replicated in each channel. 
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 Waveform Processing Tools 
 

Key Features 

Visualiser Interface 

Waveform Popup Window 

Event View in the Visualiser 

Instrument View in the Visualiser 

Channel View in the Visualiser 

Menu Systems in the Visualiser 

Processing and Visualisation Functions 

Waveform Moveout View 
 
 

6.1 Key Features 

• Provides visualisation and manual processing of waveform data. 

• Button bars provide data navigation and application of the different processing functions. 

• Displays waveforms from acquisition channels and grouped together as 'instruments' (up to four channels per 

instrument) where acquisition utilised sensors with more than one axis. The tool includes basic processing 

functions for these multichannel instruments to allow phase arrival picking. Advanced processing functions, 

required in some seismic studies, are included in an additional tool (Advanced Waveform Processing Tools). 

• Provides access to InSite's event processing functions (e.g. source location, advanced location, source 

mechanism, velocity analysis) depending on tool permissions. 

• Three views show waveforms from a) the event, b) an instrument, c) a channel. Processing functions are tailored 

to the view type and applied using point and click mouse actions. 

• Displays show waveform amplitude and time information, and processed parameters such as pick times. 

• Waveforms can be expanded and contracted in amplitude and time. 

• P- and S-wave automatic arrival picking using a front-to-back window method. Automatic picking parameters are 

user configurable. The picking functions are automatically displayed on the channel view to aid the user  in 

configuring the algorithm. 

• Picks can be manually adjusted by dragging picking cursors. Dependent variables are automatically updated. 

• Picking algorithms use an RMS (root-mean-square) signal for multichannel instruments. The instrument view 

displays the RMS signal to aid manual picking. 

• Time domain filtering using a user-configurable Butterworth bandpass filter. The filter can be applied automatically 

on event access or applied manually from the button bar. Filtering can use global parameters or use individual 

sensor settings. 

• Automatic time-domain waveform integration or differentiation to a user specified particle motion (i.e. 

acceleration, velocity, displacement). 

• Peak particle motion (e.g. ppV) and frequency-at-peak functions for use in peak ground motion studies. 

• Output of waveform text files for easy export of data to external software. 

• Access to Component, Event and Channel Property Dialogs for efficient update of data configuration parameters. 

• Frequency domain visualisation and processing functions are accessed for a particular channel. The InSite FFT 

Processor displays a Fast Fourier Transform (FFT) of user-selected data windows on the waveform. The 

windows include either: a) the whole waveform, b) a P-wave window, c) an S-wave window. Window 

dimensions are automatically set during picking and can then be manually adjusted by the  user. 
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• The FFT Processor can display the data on linear and logarithmic scales, perform frequency domain integration or 

differentiation and trim the FFT to sensor bandwidths. A frequency-domain Butterworth bandpass filter can also 

be applied. 

• Provides access to the Advanced Waveform Tool for advanced processing of multichannel instruments including 

waveform rotations and hodograms. 

 
 

6.2 Visualiser Interface 
The Waveform Visualiser contains three different view types (Figure 6-1): 

1. Event View 

2. Instrument View 

3. Channel View 
There are also a number of pop-up boxes containing function-dependent views. These are discussed in Processing and 

Visualisation Functions. 
The different views are accessed using the following functions: 

• Double-clicking on the background of a waveform box (white area) in the Event View opens either an Instru- 

ment View or a Channel View. 

• Double-clicking on the background of a waveform box in the Instrument View opens a Channel View. 

• Clicking on a return button  moves back to the previous view, as does double-clicking on the dark-grey 

background of the view. 

The presence of an Instrument View depends on whether the user has selected to Visualise and Process the data by 
Instruments. In this case groups of channels are combined to form an Instrument. For further explanation see Treatment 
of Multi-channel Sensors. 

 
 

 

 

Figure 6-1: The three different view types and how to switch between them. Upper: Event displays Instruments 
which are split into Channels. Lower: Event displays only channels. 

 
 
 
 

6.3 Waveform Popup Window 
 
The waveform visualiser can be launched in a popup window allowing the use of the other visualisers. Whilst in 

waveform visualiser, the popup window is launched from the menu bar under "New Window" (Figure 6-2). From here, 
either the default waveform (instruments) or moveout view can be launched. When selected, the current visualiser  will 
change to data management and then the new window will open with the selected waveform visualiser.  
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Figure 6-2: Launching waveform visualiser popup window 

 
 
With the waveform visualiser now in its own window, freedom is granted to view waveforms without leaving the 

current visualiser, whilst maintaining full functionality of the waveform visualiser. An example of this is shown in Figure 6-3. 
 

 
 

Figure 6-3: 3D location visualiser with waveform popup window 
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6.4 Event View 
 

6.4.1 Event View Structure 
The Event View displays waveforms from all the channels in the event in a number of waveform boxes. 
 

• There are two different display modes, selected on the [Event Initialisation] Property Sheet: 
 

1. In Channel Display Mode each channel is shown in individual waveform boxes; 

2. In Instrument Display Mode channels are grouped together as instruments and displayed in a single 

waveform box. 

 
• If channels are switched off, selected on the Receiver Properties Dialog Box, then they are not displayed. 

 
Figure 6-4 gives an example of an event recorded on 16 uniaxial sensors. The waveforms are shown in Channel 

Display Mode. Channel #10 has been switched off and so is not displayed.  
 
The Channel Label has the format "C=R(IN) - L" where R is the channel (receiver) number, I is the instrument 

number and N is the instrument axis (X, Y, Z or A). If the instrument is undefined then the label takes the format "C=R". 
If the channel has been used in the event location algorithm, then a " - L" is added. If the channel has been clipped, 
then a " - c" is added. 

 
Figure 6-4 gives an example of an event recorded on 12 triaxial sensors (36 channels) shown in Instrument Display 

Mode. Some of the channels have been switched off to give instruments containing a mixture of 1, 2 or 3 channels. The 
channel displayed in red is the top channel. This is the first channel in the ordered list of instrument axes X, Y, Z, A. The top 
channel, the first channel defined in the default receiver array (see Figure 5-19 a nd  Figure 5-20), overlays the other 
channels. The other channels are displayed in blue and then black. The vertical scale can be selected to be determined by 
event, instrument or channel. 

 
 

 

Figure 6-4: Example of the Event View with waveforms in Instrument Display Mode. The inset shows the same 
event with waveforms in Channel Display Mode. 

 
 
 

6.4.2 Event View Mouse Operations 

http://www.appliedseismology.co.uk/manuals/man308test.aspx


6. Waveform Processing Tools 173  

 

 
Each waveform box responds to the following mouse operations. 
 
 

• Left-mouse button click on a waveform box background and dragging performs a horizontal  expansion. 
 
 
 

 
 

Figure 6-5: Waveform Horizontal Zoom 

 

• Clicking on the vertical expansion buttons increases (red outer) or decreases (black outer) the amplitude scaling.  

 

 
Figure 6-6: Waveform Vertical Zoom 

 
Right-mouse button click on a waveform box background to bring up the Waveform List Menu. This gives the user the 

opportunity to add a P- or and S-arrival pick if one is not present. If a pick is already designated, then it will be reassigned 
to the chosen position. If the type discriminator of the event is 'shot', i.e. an active survey, then the T0 time can be assigned 
on all channels by selecting Add T0 Pick. If the 'Autopick Next P Arrival' or 'Autopick next S Arrival' option is chosen, the 
phase pick will be moved to the next (later in time) peak in the auto-pick function that meets the phase pick criteria. The 
'Filter Off' or 'Filter On' option can be used to remove or add the filtering (specified in the Channel Processing tab) on the 
waveform for that instrument. 

 

 
 

• Left-mouse button click on a cursor and dragging selects the cursor and moves it to a new location. 
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• Right-clicking on a cursor cancels the cursor and zeros the associated pick. 
 

• The time and amplitude of the mouse position in a waveform box is displayed on the status bar. The Amplitude 

has units set from either the Receiver Properties for this channel, or units set from the [Event Initialisation] 

Property Sheet. The Time has units set in the Channels Properties. The amplitude will go to NA when using 

normalized traces. 

 

 
 

• Double clicking on the waveform box background either the instrument or channel views. 
 
 
 
 
 

6.4.3 Event View Button bar Operations 
There are two button bars in the Event View. 
 
The Navigation Bar allows the user to navigate around the entire data set.  Events without waveforms cannot be 

accessed. Also, the navigation bar only makes available enabled components, events and instruments. The Processing 
Properties Dialog can be launched. Note that certain features are only available with the correct permissions (External 
Communications and Fracture Manager). 

 
 

 
 

Figure 6-7: The Waveform Visualiser Navigation Bar. 

 
The Navigation Bar remains available in both the Instrument and Channel Views allowing the user to switch between 

components, events and instruments whilst visualising the same instrument or channel. 
 
The Event Processing Bar (Figure 6-8) contains standard processing functions. These functions are described in Table 

6.1 and in Processing and Visualisation Functions. The Event Processing Bar remains available in both the Instrument  
and Channel Views although the data it applies to changes with the view. 

 
 

Figure 6-8: The Waveform Visualiser Event Processing Bar. Operations are described in Table 6.1 
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Table 6.1:Description of Event Processing Bar operations. 

 
 

Name Event View Instrument 

View 

Channel View Moveout View Reference 

Pre-processing Bar 

Filter Event Filters all 
Channels in the 
Event. 

As Event View As Event View As Event View Channel 
Processing 

Phase rotation Applies a phase 

rotation filter. 

As Event View As Event View As Event View Event View Mouse 
Operations 

Show Rotated 

Waveforms 

Applies 

waveform 

rotation 

As chosen 

In Advanced 

Waveform 

visualiser. 

As Event View As Event View As Event View Appendix 7.1 

Show N-E-U 

Waveforms 

Applies wave- 

form rotation 

to align to the 

North-East-Up 

co-ordinate 

system 

As Event View As Event View As Event View  

Processing Bar 
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Name Event View Instrument View Channel View Moveout View Reference 

Source Vectors Calculates 

source vectors 

for all 

instruments 

viewed. 

Calculates 

source vector 

for the 

instrument 

viewed. 

Calculates 

source vector 

for the 

instrument 

to which the 

channel viewed 

belongs. 

Calculates 

source vectors 

for all 

instruments 

viewed. 

Source Vectors 

Source Locate Source locates 

the Event from 

P and S-wave 

picks. 

As Event View As Event View As Event View Source Location 

Source 

Mechanism 

Calculates the 

source 

mechanism for 

the Event. 

As Event View As Event View As Event View Source Mechanis 

Master Locate Locate the 
master event 

   Appendices 

2.8 

Relative Locate Locate event 

relative to a 

master event 

location 

   Appendices 

3.8 

Display Mean 

FFT Waveforms 

for the Event 

Calculates an 

average FFT 

over all 

instruments 

and displays it 

in a pop-out 

window. 

As Event View As Event View As Event View Fast Fourier Trans 

Waveform 

Parameters 

Calculate the 

waveform 

parameters for 

the active event 

Calculate the 

waveform 

parameters for 

the active event 

Calculate the 

waveform 

parameters for 

the active event. 

Waveform 

parameters are 

only visible in 

this view in the 

data panel. 

Calculate the 

waveform 

parameters for 

the active event. 

Appendices 

7.4 

Picking Bar 

P Autopick Autopicks the 

P-wave arrival 

on all Channels. 

Autopicks the P-

wave arrival on 

the Instrument 

being viewed. 

Autopicks the P-

wave arrival on 

the Channel 

being viewed. 

Autopicks the P-

wave arrival on 

all Channels. 

Autopicking 

Auto-picking 

S Autopick Autopicks the S-

wave arrival on 

all Channels. 

Autopicks the S-

wave arrival on 

the Instrument 

being viewed. 

Autopicks the S-

wave arrival on 

the Channel 

being viewed. 

Autopicks the S-

wave arrival on 

all Channels. 

Auto-picking 

Cancel P Picks Cancels the P 
Picks on all 

Channels and 
deletes all 
associated data. 

Cancels the 

P Picks on the 

Instrument 

being viewed 

and deletes all 

associated 

data. 

Cancels the P  
Picks on the  

Channel being 

viewed And 
deletes all 
associated data. 

Cancels the P 
Picks on all 

Channels and 
deletes all 
associated 
data. 

- 
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Name Event View Instrument View Channel View Moveout View Reference 

Cancel S Picks Cancels the 

S Picks on 

all Channels 

and deletes all 

associated 

data. 

Cancels the 

S Picks on the 

Instrument 

being viewed 

and  deletes 

all associated 

data. 

Cancels the S 
Picks on the 

Channel being  

viewed and 
deletes all 
associated data. 

Cancels the 

S Picks on 

all Channels 

and deletes all 

associated 

data. 

- 

Peak 

Amplitudes 

Gets the Peak 

Amplitude on all 

Channels in the 

Event. 

Gets the Peak 

Amplitude on all 

Channels in the 

Instrument 

being viewed 

Gets the Peak 

Amplitude on 

the Channel 

being viewed. 

 Peak Amplitudes 

Optimised 

Picking 

No effect No effect No effect Apply optimised 

picking routines 

to all 

instruments in 

the 

event. 

Phase Pick 
Overlays 

Undo Optimised 

Picking 

No effect No effect No effect Return the 

phase picks to 

those stored 

before running 

the optimised 

picking routines. 

Undo Optimise 
Picking 

Pick amplitude Pick amplitudes 

for P and S 

wave picks. 

Pick amplitudes 

for P and S 

wave picks. 

Pick amplitudes 

for P and S 

wave picks. 

Pick amplitudes 

for P and S 

wave picks 

- 

Display Bar 

Event Zoom Changes scaling 

of waveforms 

on all 

Channels. 

As Event View As Event View Changes scaling 

of waveforms 

on all 

Channels. 

Event Zoom 

Lock Time 

Magnification 

Magnifies all 

instruments 

to the same 

width when 

zoom in on one 

instrument. 

No effect No effect No effect - 

Switch 

Visualisation 

Mode 

Expands 

instruments to 

see all channels 

for the event. 

No effect No effect No effect - 

Toggle Data 

Panel 

Shows or hides 

the data panel 

containing event 

and channel 

properties. 

No effect No effect No effect - 
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Name Event View 
Instrument 

View 
Channel 

View 
Moveout View Reference 

Show Stack 

Traces 

No effect No effect No effect Display event 

stacks. Traces are 

created that are 

linear stacks of all 

waveforms in the 

event, aligned on 

the P- or S-wave 

phase picks. 

Stack Traces 

Vertical expansion 

(Expand) 

No effect No effect No effect Increases the 
amplitude scaling 
of all waveforms. 

- 

Vertical expansion 

(Contract) 

No effect No effect No effect Decreases the 

amplitude scaling 

of all waveforms. 

- 

Toggle Waveform 

Spacing 

No effect No effect No effect Toggles the 

waveform spacing 

between equal 

distance and 

linear separation 

of the 

instruments. 

N/A 

Toggle RMS 

Mode 

No effect No effect No effect Toggles between 
the channel 
waveforms and 
the instrument 
RMS function for 
each receiver. 

RMS Mode 

Show or Hide 

Channels 

No effect No effect No effect Launches a dialog 

that allows the 

user to select 

which of the 

instrument 

channels (X, Y, Z 

or A) are visible. 

N/A 

Show Source 

Vector Plots 

No effect No effect No effect Toggles the 

display of source 

vector plots 

alongside the 

waveforms. 

 

Show Voltage Display wave- 

form scaled to 

raw voltage 

Display 

waveform 

scaled to raw 

voltage 

Display 

waveform 

scaled to raw 

voltage 

Display waveform 

scaled to raw 

voltage 

N/A 

Displayed Filled 

Waveforms 

Fills the positive 
deflection of the 
waveform 

Fills the 
positive 

deflection of 

the waveform 

Fills the 
positive 

deflection of 

the waveform 

Fills the positive 
deflection of the 
waveform 

 

Survey Bar 
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Name Event View Instrument 
View 

Channel View Moveout View Reference 

Pick 
Velocities 

Calculate pick 

velocities on 

all Channels. 

Calculate pick 

velocities on 

the instrument 

being viewed. 

Calculate pick 

velocities on the 

Channel being 

viewed. 

 Pick Velocities 

Cross- 

correlation 

Cross- 

correlates 

all Channels. 

Cross- 

correlates the 

instrument 

being viewed. 

Cross- correlates 

the Channel being 

viewed. 

 Cross-
correlation 

Export Bar 

ATF 

output∗ 

Outputs ATFs 

for all 

Channels in 

the Event. 

Outputs ATFs 

for all 

Channels in 

the Instrument 

being viewed. 

Outputs ATFs for 

the Channel being 

viewed. 

 Appendix 2.8 

SEGY 
output 

Outputs a 

SEGY file 

containing all 

processed 

data for the 

Event being 

viewed. 

Outputs a 

SEGY file 

containing all 

processed 

data for 

instrument 

being viewed. 

Outputs a SEGY 
file containing 
processed data 
for channel being 
viewed. 

  

SEG2 
output 

Output a 

SEG2 file 

containing all 

processed 

data for the 

Event being 

viewed. 

Output a SEG2 

file containing 

all processed 

data for the 

instrument 

being viewed. 

Output a SEG2 file 

containing all 

processed data 

for the channel 

being viewed. 

  

MSEED 
output 

Outputs a 

miniSEED file 

containing all 

processed data 

for the Event 

being viewed. 

Output a 

miniSEED file 

containing all 

processed data 

for the 

instrument 

being viewed. 

Output miniSEED 

file containing all 

processed data 

for the channel 

being viewed. 

  

Export 

Residual 

Locations 

Output a file 

containing all 

the residual 

location errors 

for the Event. 

Output a file 

containing all 

the residual 

location errors 

for the Event. 

Output a file 

containing all the 

residual location 

errors for the 

Event. 

  

Crop Event Captures the 

zoomed 

waveform 

section and 

creates a new 

event 

containing 

only the time 

cropped 

portion. 

No effect No effect   

Relative Location Bar 

Master 
Locate 

Source locates 

the Event 

from cross- 

correlation 

travel times. 

As Event View As Event View  Source 
Location 
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Name Event View Instrument 

View 

Channel View Moveout View Reference 

Relative Locate Source locates 

using 

differential 

arrival times to 

a chosen 

master event. 

As Event View As Event View  - 

Calibration Bar 

Edit Velocity 

Model 

No effect No effect No effect Launch the Sonic 
Logs View in order 
to adjust the 
velocity model 

Specifying an 
Initial velocity 
model 

Rotate 

Instruments 

User links the 

waveforms to a 

shot and 

instruments are 

oriented. 

As Event View As Event View  Rotate 

Instruments 

Invert Velocities     N/A 

Overlays Bar 

Show Picks 

Overlay 

No effect No effect No effect Display the P- 

and S-wave 

phase picks. 

Source Vector 
Plotting 

Show Windows 

Overlay 

Show/hide 

picking/noise/ 

windows 

Show/hide 

picking/noise 

windows 

Show/hide 

picking/noise 

windows 

Show/hide 

picking/noise 

windows 

 

Configure 

Overlay 

Open dialog to 

configure which 

overlays to 

show. 

Open dialog to 

configure which 

overlays to 

show. 

Open dialog to 

configure which 

overlays to 

show. 

Open dialog to 

configure which 

overlays to 

show. 

 

Show 

Theoretical 

Overlay 

No effect No effect No effect Display the 

theoretical P- 

and S-wave 

arrival time 

curves 

calculated for 

the event 

location (after 

running a 

location 

algorithm). 

Source Vector 
Plotting 

Show Archive 

Overlay 

No effect No effect No effect Display the P- 

and S-wave 

auto-picks 

archived before 

running the 

optimised 

picking routines. 

Source Vector 
Plotting 

Show Curve Fit 

Overlay 

No effect No effect No effect Display the 

curve(s) found 

using the 

WaveLSQ 

routine for 

either the P-, S-

wave or both 

arrivals. 

Source Vector 
Plotting 

 



6. Waveform Processing Tools 181  

 

 
 

 
 
∗ Ascii Trace Files (ATFs) are output to the ESF Storage Directory for the Event 
 

Name Event View Instrument 

View 

Channel View Moveout View Reference 

Show Shot 

Overlay 

No effect No effect No effect Display the 

theoretical P- 

and S-wave 

arrival time 

curves 

calculated for a 

selected 

calibration shot 

position. 

Source Vector 
Plotting 

Show User 

Position Overlay 

No effect No effect No effect Display the 

theoretical P- 

and S-wave 

arrival time 

curves 

calculated for a 

user-defined 

event position. 

Source Vector 
Plotting 

Specify 3D 

Event Position 

No effect No effect No effect Specify the 3D 

location of the 

theoretical 

event for which 

P- and S-wave 

arrival times will 

be calculated 

and plotted 

using Show 

User Position 

Overlay. 

Source Vector 
Plotting 

AE Dashboard Bar 

AE Dashboard 

Export 

Properties 

Opens dialog to 

select 

dashboard 

export file 

As event view As event view As event view Creating/Writing t 

Export Arrival 

Time to 

Dashboard File 

Export P, S1, and 

S2 arrival time 

to specified 

dashboard 

export file 

As event view As event view As event view AE Dashboard Ve 
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6.4.4 Event View Data Panel 
A data panel can be shown in the lower part of the Event View of the Waveform Visualiser. The panel can be toggled 

on and off using a button in the button bar (Figure 6-8). Information in the data panel includes phase pick and vector values 
for each instrument in the event. 

 

 
 

Figure 6-9: The data panel in the Waveform Visualiser. 

 
When the event traces are organised by instrument, the columns from left to right are: 
 
Instrument number, North, East, Down, P-pick time, S-pick time, S2-pick time, theoretical P-pick time, theoretical S-pick 

time, start time with respect to event, signal to noise ratio, P-wave source vector azimuth, P-wave source vector plunge, 
linearity, single station location distance, stored P-wave source vector azimuth, stored P-wave source vector plunge, stored 
single station location distance, rotated P-wave amplitude pick arrival time, rotated P-wave amplitude, P low frequency 
plateau, SH low frequency plateau, SV low frequency plateau, P-pick velocity, S-pick velocity, S-wave source vector azimuth, 
S-wave source vector plunge, stored S-wave source vector azimuth, stored S-wave source vector plunge, peak amplitude, 
Vs1 pick velocity, Vs2 pick velocity, P/SH amplitude ratio, P/SV amplitude ratio, SV/SH amplitude ratio, ray length, ray 
azimuth, and ray take-off angle. 

 
When the event traces are organised by channel, the columns from left to right are:  
 
Channel number, North, East, Down, P-pick time, S-pick time, S2-pick time, P-wave amplitude pick time, P-wave 

amplitude, P-wave noise, S-wave amplitude pick time, S-wave amplitude, S-wave noise, peak amplitude time, peak 
amplitude, peak amplitude frequency, theoretical P-pick time, theoretical S-pick time, start time with respect to event, P-
pick velocity, S-pick velocity, Vs1-pick velocity, Vs2-pick velocity, auto function P-wave, auto function S- wave, maximum 

voltage(∗), maximum decibel(∗), number of threshold crossings(∗), time duration(∗), rise time(∗), average 

frequency(∗), reverberation frequency(∗), initial frequency(∗), rise time to maximum amplitude ratio(∗), and energy 

(MARSE) (∗). 

 

Note: (∗) denote waveform parameter (Appendices 7.4). 
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6.5 Instrument View  
 

6.5.1 Instrument View Structure 
 
The Instrument View displays the waveforms for all of the channels that are associated with a particular instrument. 

These are shown in waveform boxes similar to that in the Instrument View. In this case, however, there are more controls 
available in each waveform box (Figure 6-10). 

 

• Each waveform box is labelled with the Channel Identification (described in Event View Structure). 
 

• The RMS waveform is displayed (Auto-picking). This aids in picking multi-channel sensors by better describing 

when the energy is first arriving across all the channels. 

 

 
Figure 6-10: Example of the Instrument View. The lower plots show examples of the P-wave and S-wave arrivals 

with associated cursors. 

 
Pick cursors are displayed on each channel and are linked together so that editing one results in changes on all of 

the channels. 
 
Amplitude and time expansion functions are linked together so that when the user closely examines a particular part 

of the waveform on one channel, the other channels are also viewed at the same scale.  
Source parameter and FFT window dimensions are displayed. The FFT windows can be manipulated.  
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6.5.2 Instrument View Mouse Operations 
 
The mouse operations contained in the Instrument View are the same as that described for the Event View in 

Event View Mouse Operations. Additional operations include the following. 
 
The FFT window size can be changed by clicking the left mouse button on the end triangle symbol of the FFT 

window control and moving it left or right. 
 
 

6.5.3 Instrument View Button Bar Operations 
 
The Instrument Processing Bar gives functions specific to this view. 
 

 
Figure 6-11: The Instrument Processing bar. 

 
 

• Return - returns from the Instrument View back to the Event View. 

• Previous Instrument - changes the instrument to the previous one (numerically) in the event. 

• Next Instrument - changes the instrument to the next one in the event. 

• Enter Triaxial - opens the Advanced Waveform Visualiser. 

• Enter Advanced Instrument - opens the Advanced Waveform Visualiser in spectrogram mode. 

• Check Triaxial - tests whether a given instrument satisfies the triaxial criteria. 

• Learn P-pick - enables the auto-picking parameters to learn from a user's manual phase P-picks. 

• Learn S-pick - enables the auto-picking parameters to learn from a user's manual phase S-picks. 

• FFT Entire Waveform - calculates the FFT for the full instrument waveform and plots in a pop-out window. 

• P-wave FFT - calculates the FFT for a waveform window around the P-wave pick and plots in a pop-out 

window. 

• S-wave FFT - calculates the FFT for a waveform window around the S-wave pick and plots in a pop-out 

window. 

 

 
Additional button bar operations are similar to the Event View and are described in Event View Button-bar Operations 
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6.6 Channel View  
 
 

6.6.1 Channel View Structure 
The Channel View displays the waveform from a chosen channel (Figure 6-12). The Channel View is obtained directly 

from the Event View when operating in Channel Display Mode, or from the Instrument View when operating in the 
Instrument Display Mode. 

 

• The Waveform Box has the same user controls described for the Instrument View (Instrument View in the 
Visualiser), with the addition of the P and S wave picking window (blue and green respectively). The 
increased size allows more accurate and easier manual picking to be performed. 

• When in Instrument Display Mode changes made here are linked to the other channels in the instrument. 

• The Channel Information Bar contains pertinent data relevant to this channel. 

• The Channel Auxiliary Box contains other functions generated for the waveform. These include the following. 

– The auto-picking functions for the P and S wave arrivals (blue is the P-wave, green is the S-wave). 

– The picking thresholds for the P and S wave (blue is the P-wave, green is the S-wave). 

– A cumulative amplitude function, which aids in picking arrivals from high noise waveforms. 

– Up to four graphs can be displayed for the AIC picking method: the characteristic function, the auto 

function, the refined AIC characteristic function and the refined AIC auto function. 

 
 

 
 

Figure 6-12: Example of the Channel View. 
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6.6.2 Channel View Mouse Operations 
 
The mouse operations contained in the Channel View are the same as that described for the Instrument View in 

Instrument View Mouse Operations (Instrument View Mouse Operations). 
 
 

6.6.3 Channel View Button Bar Operations 
The Channel Processing Bar gives functions specific to this view. 
 

 
Figure 6-13: The Channel Processing Bar. 

 

• Return - returns from the Channel View back to the previous view (either the Event View when in Channel 

Display Mode or the Instrument View when in Instrument Display Mode). 

 
• Channel Properties - opens the Channel Properties Dialog Box (Channel Properties) for this channel. 

 
• Previous Channel - changes the channel to the previous one (numerically) in the event or instrument. It turns to 

black after reaching the first channel. 

 
• Next Channel - changes the instrument to the next one in the event or instrument. It turns to black after reaching 

the last channel. 

 
• Add Manual Pick - adds a pick cursor in a default position on the waveform (no autopicking is performed). The 

drop-down menu gives the available cursors that can be used. 

 
• FFT Entire Waveform - runs the Fast Fourier Transform (FFT) function Fast Fourier Transform Processing - 

using the entire waveform as the input. 

 
• FFT P-wave Window - runs the Fast Fourier Transform (FFT) function - [Fast Fourier Transform Processing] 

 
– using the chosen P-wave window as the input. 
 

• FFT S-wave Window - runs the Fast Fourier Transform (FFT) function Fast Fourier Transform Processing - 

using the chosen S-wave window as the input. 

 
Additional button bar operations are similar to the Event View and are described in Event View Button-bar Operations. 
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6.7 Menu Systems in the Waveform Visualiser 
 

6.7.1 The Component Submenu 
 
 

 

 

Figure 6-14: The Component sub-menu. 

 
• Navigate (sub-menu) - performs functions on the Navigation Bar (Event View Button-bar Operations). for moving 

between components. 

 
 

6.7.2 The Event Submenu 
 

 
 

Figure 6-15: The Event sub-menu. 

 
 

• Edit Event Properties - opens the Event Properties Dialog Box for the current event. 

• Set Event Active - sets the event as active to make it easier to locate in 3D visualiser (Scene Object Menus) 

• Navigate (sub-menu) - performs functions on the Navigation Bar (Event View Button-bar Operations) for moving 

between Events. 

• Processing Functions (sub-menu) - performs functions on the Event Processing Bar (Event View Button-bar 

Operations) and contains references to keyboard activated functions (Keyboard Operated Functions). 

• Waveform Functions - is a sub-menu with the following items: 

– Edit Channel Properties - opens the Channel Properties Dialog Box for the current channel. 

– View Autopick Function - displays the auto-picking function in the Channel Auxiliary Box on the Channel View 

(default). 

– View Cumulative Amplitude - displays the cumulative amplitude function in the Channel Auxiliary Box on the 

Channel View. 
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6.8 Processing and Visualisation Functions 
 
 

6.8.1 Waveform pre-processing 
Before visualisation or processing waveforms undergo pre-processing functions. 
 
1. The DC offset is removed. A DC offset is a constant voltage offset that may appear on the waveforms due to the 

acquisition electronics. It is very important this is removed before doing many of the processing functions as large DC offse ts 
can introduce artefacts into the results. DC offset removal is performed by calculating the mean amplitude in a window of 
waveform data. This window should be on the constant signal preceding the waveform arrivals associated with the event 
and large enough so as to average out any noise. The configuration of the window dimensions is described in Channel 

Properties. 

 
The waveforms are band-pass filtered. This is an optional process and is described in Channel Processing.  
 

1. Parameters relating to the waveform signal amplitudes are calculated. These include the following (iii and iv are 

only updated if they have been previously calculated so as to consider any changes made to the waveform): 

i. RMS (Root Mean Square) waveform amplitude (see equation where Wi is the waveform amplitude at point 

i and N is the number of data points in the waveform) 

ii. Signal-to-noise ratio (see equation where LRMS is the RMS noise level calculated in the Pre-signal 

Window) 

iii. Waveform peak amplitude 

iv. Recalculates pick amplitudes if picks exist 

𝑊𝑅𝑀𝑆 = √
∑ 𝑊𝑖

2𝑖=𝑁
𝑖=1

𝑁
 

𝑆𝑖𝑔𝑛𝑎𝑙: 𝑁𝑜𝑖𝑠𝑒 =  
𝑊𝑅𝑀𝑆

𝐿𝑅𝑀𝑆
 

 
 

6.8.2 Event Zoom 
Event zoom has two states. 
 

• If the button is depressed (default) then the waveforms are displayed with their amplitudes automatically scaled 

to the peak amplitude on the waveform. 

• If the button is not depressed, then the waveforms are displayed with their amplitudes automatically scaled to the 

peak amplitude on the event. 

 

6.8.3 Source Vectors 
When the Source Vector button is pressed, the algorithm is applied to the instrument or instruments being viewed.  
 

• Two P windows and the linearity threshold must be set; the Rotation Back and Front windows on the Auto- picking 

tab of the Processing properties Dialog define the window used in the algorithm to calculate the source vector. 

This window however is not fixed around the P-wave pick but can move within a user-defined window around the 

P-wave pick. 

• The P-wave back and front windows defined in the FFT section of the Channel Processing tab in the Processing  

Properties Dialog. The P-wave rotation window is allowed to move within the defined FFT window to find the 

window with the maximum linearity. 

• A linearity threshold for auto-processing source vectors is also set on the Auto-picking tab, and if no window is 

found with a sufficiently high linearity then no measured source vector is stored for the instrument. 

 
S-wave Source Vector can also be calculated. The settings for this option are found by clicking the 'Further Source Vector 

http://www.appliedseismology.co.uk/manuals/man307test.aspx
http://www.appliedseismology.co.uk/manuals/man307test.aspx
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Settings' button on the 'Auto picking' tab of the Processing Properties window (Auto-picking). 
 

• To allow the calculation of S-wave source vectors the 'Use S-wave SV' option must be selected. 
 

• The front and back windows and linearity threshold options are similar to the P-wave source vector options. 
 

• The type of S-wave polarisation must also be selected. 
 

6.8.4 Cross-correlation 
The cross-correlation algorithm and configuration settings are described in Cross-correlation. The cross-correlation 

process depends on which view the user is currently visualising. 
 

• For the Event View each instrument or channel is interrogated and the cross-correlations automatically 

obtained. 

 
• For the Instrument View the RMS waveform is used and the Cross-correlation Pop-up Window is displayed 

with the results for each P and S arrival. 

 
• For the Channel View the waveform being displayed is used and the Cross-correlation Pop-up Window is 

displayed. 

 
For the algorithm to operate the user must provide the following. 
 

• The cross-correlation algorithm settings are correctly configured. 
 

• The reference event is adequately picked for the required P and S wave arrivals. 
 

• The event being processed is adequately picked. 
 

• Using the rise-time method each arrival must have first-break and amplitude picks. The front-to-back window 

method only requires first-break picks. 

 
The Cross-correlation Pop-up Window gives the results of the algorithm so that the user can judge its performance 

(Figure 6-16). 
 

 
 

Figure 6-16: The Cross-correlation Pop-up Window 
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6.8.5 Pick Velocities 
Pick Velocities are calculated for both P and S-waves on each channel from the 'time-of-flight' of the arrival using this 

equation: 

𝑣𝑝𝑖𝑐𝑘 =
𝑑

𝑇𝑝𝑖𝑐𝑘 −  𝑇0 − 𝑇𝐶
 

d is the ray path length between the shot/transmitter location (set for the event being analysed) and the receiver 
location set for the channel. A homogeneous-isotropic velocity structure is assumed giving a direct ray path from source to 
receiver. 

 

T0 is the user-defined 'Time Zero' for the channel being processed. 

 

TC is the user-defined arrival-time correction for the appropriate arrival on the channel being processed.  
 
Note that this usually results in a different signal velocity to that calculated using the cross-correlation algorithm as it 

is calculated directly from the pick. The cross-correlation algorithm obtains a velocity from the travel time difference 
measured by mathematically comparing the processed waveform arrival with the same channel on a reference event.  

 
In the Channel View the user can inspect changes in the pick velocity whilst moving the appropriate cursor. This allows 

the user to gauge how inaccuracies in the picking feed through to uncertainties in the measured velocity. 
 

6.8.6 Peak Amplitudes 
Peak Amplitudes are obtained for each channel by scanning through the waveform and finding the maximum amplitude 

(from DC to peak). If the channel measures the velocity component of ground motion, this then corresponds to a ppV (peak 
particle velocity) (Figure 6-17). 

 
A dominant frequency content for the waveform at this peak is also obtained. This is calculated by locating the 

previous DC cross-over and the next DC cross-over on the waveform. The time difference between the cross-overs is 

then ∆TC. The dominant frequency fdom is calculated by: 

 

𝑓𝑑𝑜𝑚 =  
1

2 ∙ ∆𝑇𝑐
 

 
This analysis is useful in ground-vibration monitoring applications. 
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Figure 6-17: Example of the peak amplitude (ppV) and dominant frequency analysis. 

 
 
 
 

6.8.7 Source Location 
 
An event's source location is calculated from the P and/or S-wave arrival times picked on the waveforms. The algorithm 

uses the configuration parameters set on the Locater Property Sheet (Configuration of Processing Properties). A Location 
Results Dialog Box is displayed detailing information on how the algorithm has performed (Figure 6-18). The results can be 
exported to a text file using the "Export" button; if the file does not exist it will be created, otherwise data is appended 
to the file.  
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Figure 6-18The Location Results Dialog Box. 

 
If the user has opted to produce [Source Parameters] automatically after the source location, then the results are also 

displayed in the Dialog box. Instruments may be removed by the algorithm resulting in messages being written to the Dialog 
box that contain codes detailing the reason for removal. 

 
c - instrument contains clipped waveforms 
 v - the instrument is classified as a voltage sensor 
nt - non-triaxial sensor (3 channels required) 
no - the triaxial axes are not orthogonal 
E - there was an error initialising the waveforms  
 
The Master-locate option (Locater) provides the same output. 
 
The Locater option provides the same output. 

 

The Advanced Location option provides the same output. 

 
 
 

6.8.8 Source Mechanism 
 
An event's source mechanism is calculated using the configuration parameters set on the Mechanism Properties 

Sheet (Mechanisms). After calculating the source mechanism, the Mechanism Results Dialog Box is displayed (Figure 
6-19). 

 
 

http://www.appliedseismology.co.uk/manuals/man601test.aspx
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Figure 6-19: The Mechanism Results Dialog 

 
The mechanism plot can be easily accessed by clicking on the Visualise Mechanism button. This opens the Mechanism 

Visualiser referencing the recently processed event. 
 
 

6.8.9 Fast Fourier Transform Processing 
 
The Fast Fourier Transform (FFT) algorithm obtains the frequency spectra of a signal. There are three types of waveform 

data that can be input to the algorithm. 
 

• Entire Waveform - builds a data array that contains the entire waveform 
 

• P-wave window - builds a data array based on a window of the waveform set around the P-wave 
 

• S-wave window - builds a data array based on a window of the waveform set around the S-wave 
Press et al. (1994) gives a discussion of an FFT algorithm. After calculation the frequency spectra is displayed in 

the FFT Processor window (Figure 6-20). The frequency scale that is plotted may be fit to the sensor settings (Channel 
Processing) so as to remove frequencies that are not of interest. 
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Figure 6-20: Example of an entire-waveform FFT displayed in the InSite FFT Processor. 

 
Various operations can be applied to the FFT. These are available on the FFT Processing Bar (Figure 6-21). 
 

 
 

Figure 6-21: The FFT Processing Bar. 

 
 

• Save FFT - stores an FFT format file 

• Linear-Linear Scale - changes plot scaling to linear amplitude versus linear frequency 

• Log-Linear Scale - changes plot scaling to logarithmic amplitude versus linear frequency 

• Log-Log Scale - changes plot scaling to logarithmic amplitude versus logarithmic frequency 

• Integrate - integrates the frequency spectra e.g. acceleration to velocity (the amplitude scale label changes) 

• Differentiate - differentiates the frequency spectra e.g. velocity to acceleration 

• Filter - applies a band-pass Butterworth filter 

• Trim Spectra - trims the plot down to the frequency bandwidth specified for the receiver or selected by the user, 

also trims the amplitudes to those of interest to the user. 

• Data Point Overlay - display the data point coordinate on the spectrum at the cursor position. 

• Lock to Cursor - display the coordinate for the cursor. 
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The FFT can be filtered in two ways. 
 

1. In the time domain before opening the FFT Processor. If this is performed, then the option to filter in the 

frequency domain is disabled. 

 
2. In the frequency domain, from within the FFT Processor, using the Filter option. 

 
The first option applies a Time-Domain Bandpass Filter described in Channel Processing. The second option applies 

a Frequency-Domain Butterworth Bandpass Filter of order 6. 
 
The frequency filter properties are set on the Spectra Property Sheet (Figure 6-22). These properties are updated 

automatically for the channel being processed each time the FFT Processor is run. The settings are produced from the 
configuration of the Channel Processing Property Sheet (Figure 5-48). 

 
 

 
 

 
Figure 6-22: The Spectra Property Sheet in the FFT Processor. 

 
Data point overlay allows the user to read the amplitude spectrum at the frequency coordinate of the cursor (Figure 

6-23). After enabling Lock to Cursor, the coordinate displayed on the upper right corner is the coordinate at the cursor only. 
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Figure 6-23: An example of fitting a spectral model in the FFT calculation 

 

6.8.10 Rotate Instruments 
The Rotate Instruments algorithm allows the user to calculate the orientations for the receivers in an array using the 

waveform information from a single event. The event must be set to type 'Shot' for the Rotate Instruments button to be 
active. Additionally, shots must be input using the Default Shots/Transmitters Array Dialog (Figure 5-24). 

 
When the Rotate Instruments button is pressed, a Dialog appears that asks the user whether or not to use only the 

azimuth information to calculate the instrument rotation (Figure 6-24). When the user has selected their response, the 
Shot/Transmitter Dialog is launched (Figure 6-25). The user should highlight the shot with which the waveforms should 
be linked and press OK. Note that this will overwrite any previous linking of the waveforms with shot details. The 
calculation will be carried out and the results will automatically be shown in the Processing Results Dialog box (Figure 
6-26). Clicking on the Store Rotations button in the Processing Results Dialog box will cause a pop-up window to appear 
asking if the user wishes to continue with copying the calculated rotated receiver array to the default receiver array 
(Figure 6-27). To apply the rotated receiver array to the waveforms the user will have to update receivers (Update 
Sensor Information) in any relevant Components/Events. 

 
The Rotate Instruments method uses the information stored for the waveforms' source vectors. 
 

 

Figure 6-24: Azimuth-only geophone rotation dialog box 
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Figure 6-25: The Select Shot/Transmitter Dialog box 

 
Figure 6-26: The Processing Results Dialog box that launches automatically to show the results of the Rotate 

Instruments algorithm. 

 

 
Figure 6-27: Pop-up window appearing after Store Rotations has been pressed 

 
 
 

6.8.11 Learn Picks 
 
The Learn P and S-Pick algorithms enable the auto-picking parameters to learn from a user's manual phase picks. This 

allows a user to optimise the auto-picking parameters by evaluating a set of parameters that provide the best-fit auto-pick 
to the user's manual pick. A Dialog box is then displayed that allows a user to easily update the settings of the auto-picker 
with these parameters (Figure 6-28). 

 
The education algorithm provides recommended values for the following parameters usually defined by the user on 

the Auto-picking tab in the Processing Properties Dialog box (Figure 5-41): 
 
 

1. The Front-window Length in the Moving-window Technique; 
 

2. The Auto-picking Threshold; 
 

3. The Minimum Peak-to-Peak Amplitude. 
 
 
A Back-window Length must be set by the user on the Auto-picking tab and is used in the algorithm to 'model' the best 

Front-window Length (i.e. by varying the ratio between the two window lengths to find the best fitting parameters). The 
Back-window Length averages the noise on the waveform and should thus be set 'long'; approximately 10x  the dominant 
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signal wavelength is recommended (or at least 2x a characteristic noise wavelength). 
 
The three parameters are evaluated for each of the P and S-wave arrival times on a picked instrument. The algorithm 

is initiated by clicking on either the Learn P-pick or Learn S-pick buttons in the Instrument View. The algorithm considers 
four different combinations of options that could be selected by the user: 

 
a. Advanced spectral auto-picking without Moving Window Technique - auto-picking on first peak in autofunc; 

b. Advanced spectral auto-picking without Moving Window Technique - auto-picking on maximum peak in autofunc; 

c. Auto-picking (Standard or Advanced) using Moving Window Technique - auto-picking on first peak in autofunc; 

d. Auto-picking (Standard or Advanced) using Moving Window Technique - auto-picking on maximum peak in autofunc; 

 
 
 

 
Figure 6-28: The Auto-pick Educator Dialog Box 

 
 
During advanced Spectral Picker the user has the option to process without the Moving-window Technique, in which 

case the Auto-picking Threshold and Minimum Peak-to-peak Amplitude parameters are only recommended. 
 
The option to auto-pick on either the first peak or maximum peak in the auto-picking function is selected by the user 

(for each phase) on the Auto-picking tab. In the case of picking on the first peak, the education algorithm described here 
must consider the amplitude of all other peaks in the function before the peak closest to the manual pick.  

 
The algorithm operates by using the following process: 

• The Front-window Length is stepped down from the user-defined Back-window Length to a minimum of 3 data 

points (in increments of one data point). 

• An auto-picking function is evaluated for each Front-window Length. When using advanced spectral auto- picking 
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the function is evaluated using the methods described in the previous section. 

• A phase pick is computed using either the first-peak or maximum-peak methods as selected by the user. The 

difference to the user's manual pick is calculated. This defines the 'residual'. 

• The Front-window Length with the minimum residual provides the auto-picking result that best fits the user's 

manual pick. 

• Recommended values of Auto-picking Threshold and Minimum Peak-to-Peak Amplitude are computed for the 

best-fit auto-picking function by analysing the phase and noise amplitudes. 

• The Autopick Educator Dialog box (Figure 6-28) is displayed to the user. The Dialog box allows the user to easily 

update the auto-picking parameters from the best-fit values obtained in the algorithm. For each parameter the 

user has the option to update the auto-picker setting directly (by clicking on Update to Best Fit), or to update it to 

the mean of the current setting and the calculated best-fit (by clicking on Update to Mean). When the Dialog box 

is closed the user has the option to re-run the auto-picking algorithm on the waveforms from that instrument. 
 

 
The education algorithm relies on the user to assess whether the best-fit result should be used in the auto-picker 

settings and requires the user to actively update the settings by selecting the appropriate button in the Dialog box. 
 

6.8.12 Keyboard Operated Functions 
There is a selection of functions that are operated from the keyboard to allow faster manual processing of data. The 

default hot keys are shown in Table 6.2. 
 
 

Table 6.2: Special keystroke functions contained in the Waveform Visualiser. 

 

Operation Keystroke Description 

Set as noise and 
advance 

Alt+V Sets the event type as Noise and advances onto the next event. 

This is useful if the data set contains many events that are 

associated with a noise source as the user can quickly move 

through them and flag them for later removal. 

Cancel and advance Alt+C Cancels any picks on the event and advances to the next event in 

the component. This is useful after manual picking with noisy data 

to quickly remove any poorly constrained events before locating. 

 
 
 
 

6.9 Waveform Moveout View 
 
The Waveform-Moveout View is an additional waveform visualisation view (Figure 6-29). It is accessed via the Launch 

Waveform-Moveout Plot button on the global button bar. It is enabled only when in the Event View of the Waveform 
Visualiser. The user returns to the Event View of the Waveform Visualiser by clicking the Launch Waveform -Moveout Plot 
button again. The view has much in common with other views in the Waveform Visualiser. 
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Figure 6-29: Waveform-Moveout View showing an example event. 

 
The Waveform-Moveout View displays waveforms from all channels in the event within a single plot window. Receivers 

are displayed in numerical order, and the vertical separation of the waveform traces is governed by the  linear separation 
of adjacent receivers (though this can be altered using one of the buttons in the button bar). This gives a more intuitive 
representation of the moveout of phase arrivals for the case where receivers are unequally spaced, or a receiver has been 
disabled. Receiver separations are adjusted to accommodate all available receivers for an event. The horizontal time scale 
is marked beneath the lowest receiver and grid lines are plotted. An example microseismic event recorded on 12 triaxial 
receivers (Figure 6-30). 

 
 

 
 

Figure 6-30: Examples of a microseismic event in the Waveform-Moveout View. Comparison of (A) and (B) 
demonstrates the control of vertical spacing by receiver separation. In (A) the receivers in the array have 

approximately uniform spacing. In (B) the lowest receiver has been given a position several feet deeper and is 
therefore plotted in this view with a greater separation from the next receiver. 
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6.9.1 Mouse Operations 
The waveform-moveout view responds to the following mouse operations: 
 

• Left-mouse button click on the waveform background and dragging sideways performs a horizontal expansion for 

all waveforms in the plot. When performed, a horizontal scroll bar appears so the waveform can be navigated by 

dragging the scroll bar left and right (Figure 6-31); 

 
• Left-mouse button click on the waveform background and dragging up or down performs a vertical expansion, 

limiting the instruments shown in the plot When performed, a vertical scroll bar appears so the instruments can 

be navigated by using the mouse wheel or by dragging the scroll bar up and down (Figure 6-31); 

 
• Double clicking in the waveform panel open the triaxial view for that instrument; 

 
• Left-mouse click on a phase pick cursor and dragging selects the cursor and moves it to a new location; 

 
• For the overlays displaying shot and user-defined event theoretical picks, the earliest arrival cursors can be shifted 

so as to manually best-fit the overlays to the arrivals. 

 
 

 
 

Figure 6-31: Waveform moveout view scroll bar navigation 

 
 

6.9.2 Menu Operations 
Right-clicking in the waveform-moveout view launches a menu to alter the view and phase picks. 

• Zoom Out Time - removes the horizontal expansion 

• Show All Instruments - removes the vertical expansion 

• Sort by Theoretical Times - sort the instruments by ascending theoretical arrival times 

• Add P Arrival Pick - adds P pick at the mouse cursor position (Event View Mouse Operations) 

 
• Autopick Next P Arrival - autopick the P wave arrival (Event View Mouse Operations) 

 
• Delete P Arrival Pick - remove the P wave arrival pick 

 
• Draw P Arrival Pick Moveout - add a P wave arrival pick to all the instruments by drawing a line across them 

(Draw Arrival Picks) 
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• Add S Arrival Pick - adds S pick at the mouse cursor position (Event View Mouse Operations) 

 
• Autopick Next S Arrival - autopick the S wave arrival (Event View Mouse Operations) 

 
• Delete S Arrival Pick - remove the S wave arrival pick 

 
• Draw S Arrival Pick Moveout - add a S wave arrival pick to all instruments by drawing a li ne across them 

(Draw Arrival Picks) 

 
 

 
 

Figure 6-32: Right-click menu in waveform-moveout view. 

 
 
 

6.9.3 XYZ Channels View 
 
In the display bar is the Switch visualisation mode button. This switches from having each component 

overlayed for on the same graph for the same station, to having each channel having its own graph (Figure 6-33). If rotated 
to ray-coordinate or N-E-D coordinate, P-SH-SV channels or N-E-D channels are displayed instead. 

 
 

 
 

Figure 6-33: The switch visualisation mode button 



6. Waveform Processing Tools 203  

 

∗ ∗ 

 
 

 
 

Figure 6-34: Each channel is on its own line. 

 
 

6.9.4 RMS Mode 
 
Using the Toggle RMS Mode button, the plotted waveforms can be switched between the channel signals and the 

calculated instrument RMS. For each instrument there will be as many waveforms as there are axes but only one RMS 
signal. The RMS waveform is calculated either using the raw channel signals or the envelope created using the analytic 
signal according to which is selected using the Auto-picking sheet in the Processing Properties dialog box (Auto-picking) 

 
 

 
 

 

Figure 6-35: Comparison of (A) and (B) demonstrates the different views obtained by toggling on and off the 
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Toggle RMS Mode button. In (A) the three channel waveforms are plotted. In (B) the instrument RMS waveform 
(analytic envelope signal) is plotted. 

 
 
 

6.9.5 Stack Traces 
 
The Show Stack Traces button controls the display of P- and S-wave stacks. Two stacks are created for an event, one 

by aligning the instrument RMS waveforms on the P-wave picks and one by aligning the instrument RMS waveforms on the 
S-wave picks. 

 
Figure 6-36shows an example event with the two stacks shown in the lower panes of the view. The P- and S-wave 

arrivals in the stacks will align with the arrivals on the highest numbered receiver that has a P- or S-wave pick. The 
mouse operation to expand the horizontal scale also alters the stack panels when plotted.  

 
 

 
Figure 6-36: Example microseismic event with the P- and S-wave stacks plotted in lower panels on the view. 

 
 
 

6.9.6 Source Vector Plots 
The Show Source Vector Plots button controls the display of P and S-wave source vector azimuths. Source vector 

azimuths are represented on a circular plot to the left of the waveform display. P-wave source vectors are shown on the 
left-hand column and S-wave source vectors on the right. Up to two lines may be drawn on each source vector plot, which 
are summarised in Table 6.3. To show the dynamic source vectors, the rotate waveforms button must be selected. Figure 
6-37 shows an example event with the source vector plots shown. To omit an instrument's P or S wave source vector when 
calculating the event location, right-click or double-click with the left mouse button inside the circle; omitted source vectors 
will have their plot turn grey. 
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Table 6.3: Source vector plot legend 

 

Column Line Colour Type 

P Az. Blue Stored P-wave 
vector 

P Az. Light blue Dynamic P-wave 
vector 

S Az. Green Stored S-wave vector 

S Az. Light green Dynamic S-wave 
vector 

 
 

 
 

Figure 6-37: Example microseismic event with the P-wave source vector azimuths displayed. 

 
 

6.9.7 Rotation Windows 
Each P, S1, and S2 pick has a rotation window drawn around it (Figure 6-38). Clicking inside this region will highlight it 

and display the hodogram on the right-hand side. If show "Show Rotated Waveforms" is selected, the hodogram attributes 
will be displayed below (linearity, planarity, azimuth, and dip). 
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Figure 6-38 Rotation window overlay 

 
 
 

6.9.8 Phase Pick Overlays 
A number of pick overlays can be plotted on the Waveform-Moveout View (Figure 6-39). 
 

1) Location picks: These are the P- and S-wave picks found using the auto-picking routine and used in the location 

algorithm. They are plotted as blue (P) and green (S) points on each trace connected by solid coloured lines. These picks 

can be manually altered by the user by left-clicking on the pick and dragging. As the P- and S-wave picks are manually 

altered, the waveform event stacks in the lower panels are automatically updated. 

 

2) Theoretical picks: These are the P- and S-wave theoretical arrival times calculated for an event occurring at the 

location found using the location algorithm. They are plotted as light blue (P) and light green (S) curves. They will only be 

available for plotting if the event has been successfully located. 

 

3) Archived auto-picks: When the optimised picking routines are run, the existing P- and S-wave picks are archived. 

These archived picks may be plotted as bright blue (P) and bright green (S) crosses. 

 

4) Curve fit picks: When the WaveLSQ routine is successfully run, theoretical curve fit picks are stored for each 

instrument. These may be plotted as purple (P) and turquoise green (S)  curves. 

 

5) Shot theoretical picks: If an event has been linked to a shot, theoretical arrival times can be calculated and plotted. 

These appear as dark purple (P) and green-brown (S) curves. In addition, a vertical gold-coloured cursor is plotted aligned 

with the earliest P-wave arrival. This cursor may be manually moved in time by the user by left-clicking on it using the 

mouse and dragging. This shifts the relevant P- and S-wave arrivals such that the earliest P-wave arrival aligns with the 

cursor. The relative separation of the P- and S-wave curves cannot be altered. 

 

6) User-defined event theoretical picks: If the user has defined a theoretical event position, arrival times can be 

calculated and plotted. These appear as purple (P) and mid-green (S) curves. A vertical gold-coloured cursor is also plotted 

aligned with the earliest P-wave arrival. This cursor may be manually moved in time by the user by left-clicking on it using 

the mouse and dragging. This shifts the relevant P- and S-wave arrivals such that the earliest P-wave arrival aligns with 

the cursor. The relative separation of the P- and S-wave curves cannot be altered. 

 
The shot and user-defined event theoretical picks (5 and 6) are calculated using the velocity structure information 

in the Locator sheet of the Processing Properties dialog box and can be calculated using either a homogeneous- 
isotropic velocity structure or a layered velocity structure using Tian ray-tracing. Calculations cannot be carried out 
using the WaveBuilder or Fast Sweeping Method algorithms. 
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P- and S-wave picks are also plotted on the stack traces as blue and green vertical lines. Lines are solid for the 
arrival related to the stacked waveform whilst the other arrival is plotted as a dashed line.  

 
The display of pick overlays is toggled on and off using the relevant buttons in the button bar. If an overlay is  unavailable 

because the relevant picks do not exist, the overlay button is inactive (greyed-out). 
 
 

 
Figure 6-39: Examples of the phase pick overlays: (A) location picks, (B) theoretical picks, (C) archived auto-picks, 

(D) curve-fit picks, (E) shot theoretical picks and (F) user-defined event theoretical picks. 
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6.9.9 User Specified Event Location 
The user may specify a theoretical event location for which arrival times are calculated and can be plotted using the 

User Position Overlay (Phase Pick Overlays). The event position may be selected either in the Waveform-Moveout View 
of the Moveout Visualiser or in the 3D Visualiser. 

 
In the Waveform-Moveout View the Specify 3D Event Position button launches a dialog box (Figure 6-40) with which 

the user can specify the 3D event position in North, East and Depth coordinates. 
 

 

Figure 6-40: Dialog box accessed through the 'Specify 3D Event Position' button. The user can input or edit the 3D 
event North, East and Depth coordinates. 

 

In the 3D Visualiser a new Insert Event Position button  is available in the navigation button bar (at the top of the 
view). When this button is selected, the user's next mouse click within the 3D Visualiser will place the event position at 
the mouse position and in the plane of view (Figure 6-41). A right-click on the user-defined event will open a drop-down 
menu (Figure 6-42) with options to see the properties of the event, delete the event or move its position. Clicking on 
properties opens the 3D Event Position dialog box as accessed in the Waveform-Moveout View. Clicking on Move causes 
the event to track the user's mouse movements around the 3D Visualiser view. A left-click on the mouse will then drop the 
event at the new mouse position. 

 
 

Figure 6-41Selection of a user-defined event position in the 3D Visualiser. The event position appears as a black 
'target'. 

 

 
Figure 6-42Dialog obtained by a right-click on a user-defined event. 
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6.9.10 Undo Optimised Picking 
When the user is manually utilising the optimised picking routines in the Waveform-Moveout View, there is also the 

option to undo the optimised picking and return to initial auto-picks. The Undo Optimise Picking button,  
, appearing on the right-hand button bar of the Waveform-Moveout View, resets the phase picks to be equal to the 

picks archived before the last time the Optimise Picking button was used. 
 
Picks are archived each time the Optimise Picking button is used. The undo optimise picking option will only return 

pick values to those in place before running optimised picking the last time. It cannot return to any previous values and 
repeated use will have no further effect. 

 

6.9.11 Visualisation of Results 
When the WaveLSQ and WaveXC routines are run, they create several variables that may be plotted in the Waveform-

Moveout View. Both routines directly alter the phase picks with other pick variables also being created. When the optimised 
picking routines are run, the original phase picks are stored as archived auto-picks. In the Waveform-Moveout View the 

auto-picks may be plotted by toggling on and off the Show Archive Overlay button,  

. The archived P-wave auto-picks are displayed as pale blue crosses and the archived S-wave auto-picks 
as bright green crosses ( 

Figure 6-43 A). 
 

The WaveLSQ routine, if it successfully finds a moveout curve, stores the theoretic curve fit arrival time for each 
instrument within an event. In the Waveform-Moveout View the curve may then be plotted, by toggling on and 

off the Show Curve Fit Overlay button,  . The fitted curve for P-wave arrivals is displayed as a purple line, 
and the fitted curve for S-wave arrivals as a turquoise-green line ( 

Figure 6-43 B). 
 

 
 

Figure 6-43 (A) Archived auto-picks, stored when running the optimised picking routines, are displayed in the 
Waveform-Moveout view as pale blue (P) and bright green (S) crosses. Display of the crosses may be toggled on 
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and off using the Show Archive Overlay button. (B) Moveout curves found using the WaveLSQ routine are 
displayed in the Waveform-Moveout view as purple (P) and pale green (S) lines. 

Display of the curves may be toggled on and off using the ‘Show Curve Fit Overlay’ button. 
 
 
 

6.9.12 Draw Arrival Picks 
 
This allows all the P or S wave arrival picks to be added in a single operation by dragging a straight line across the 

instruments. P or S wave arrival picks can be added by selecting either: 
 

• Draw P Arrival Pick Moveout 
 

• Draw S Arrival Pick Moveout 
 
Upon selecting one the above options, (Figure 6-44) click and hold the left mouse button at the first pick position (1), 

then drag the line across to the last pick position (2). When satisfied with the pick positions, release the left mouse butto n, 
and all the instruments with a line across will have the relevant pick added. The pick is automatically calculated using the 
selected picking method (Auto-picking) using the maximum peak in the autopick function between the front and back 
windows either side of the drawn line where it intersects the time axis of each instrument.  

 
 

 
 

Figure 6-44: Adding picks using draw arrival picks 

 
 

6.9.13 Display and Save Synthetic Waveform 
In the moveout view (Figure 6-45), under the menu “Event”, user can select “Show Synthetic Waveforms” to display 

ray- tracing based synthetic waveform if “Tian Raytracing” is selected. The synthetic waveform can be displayed with the 
field data in the same moveout view for phase identification. Clicking “Save Synthetic Waveforms” would save the synthetic 
wave as an individual event that could be used to test a variety of processing algorithms.  
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Figure 6-45 The menu to show and save synthetic waveforms. 

 
 
Please note that when a homogeneous model is used, the analytical waveform from a full homogeneous model is 

calculated. Its moment magnitude is empirically related to the user defined corner frequency (Figure 6-46). The 
synthetic waveform will be generated using the location from the observed microseismic event. To generate synthetic 
waveforms on used defined locations, please see Section 16.8. 

 
 

 
 

Figure 6-46: The parameter settings for synthetic waveform 
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 Advanced Waveform Processing Tools 
 

Key Features 

Accessing the Visualisers 

User Interface in the Advanced Waveform Visualiser 

Processing Functions in the Advanced Waveform Visualiser 

User Interface in the Advanced Instrument Visualiser 
 
 

7.1 Key Features 
The Advanced Waveform Tool performs advanced processing and visualisation functions unique to instruments where 

the full-waveform field is recorded (either 'triaxial' or 'quadriaxial'). 
 
The tool is split into two visualisers known as the Advanced Waveform Visualiser and the Advanced Instrument 

Visualiser. A quadriaxial (4-channel) instrument is automatically converted to a triaxial instrument when the user accesses 
either visualiser. 

 
The functions found in the Advanced Waveform Visualiser include analysis of waveform rotations (coordinate system 

transformations), hodograms and spectral amplitudes. Example screen captures of the user interface are shown in  Figure 
7-1. 

• Waveforms and processing information for a triaxial (3-channel) instrument are displayed. Point and click 

operations allow the user to change cursors and windows on the waveforms. Data linking between channels is 

performed automatically. 

• Waveforms can be rotated into alternative ray coordinate systems. These include N-E-U, P-S1-S2 and P-SH-SV. 

The ray vector can be switched between the back (towards source) and forward azimuths. 

• Waveform rotation is achieved through either an inverse or a forward approach. The inverse approach uses the 

method of Montalbetti and Kanasewich (1970). A 'Linearity Coefficient' is produced that defines the quality of the 

analysis. The forward approach uses a user-defined ray orientation by specifying the ray azimuth and plunge, a 

source position, or by using the event's location. 

• Rotated waveforms are displayed allowing picking of P and two S-wave phases. 

• Picking of P, SV and SH, can be performed in the triaxial view with the event defined rotation selected - useful for 

picking amplitudes of very clean, normally lab, data. 

• Particle motions for the P or S-waves can be displayed on 'Hodogram' plots. These are constructed from user- 

configurable windows on the waveform. The window size and extents can be changed through the analysis to 

assist in phase picking. A choice of four windows is provided. 

• Hodogram data within the specified window can be exported to a three-dimensional vertex set (i.e. for displaying 

3D hodograms) for import to external software (e.g. Gocad). 

• Displacement spectra can be displayed allowing automatic and manual picking of the low-frequency plateau and 

corner frequency, and calculation of the energy flux. 

• A single station location can be calculated from the geometry of the rotated ray-coordinate system and the P to S-

wave separation time. 

 
 
The functions found in the Advanced Instrument Visualiser perform two-dimensional spectral analysis on waveforms 

recorded on a chosen instrument (i.e. through both the time and frequency domains) and visualizes the resulting 
sonograms and polarisogram plots. Example screen captures of the user interface are shown in Figure 7-2. 

 
• Sonograms are displayed for each waveform in the instrument in the form of a colour density plot. A sonogram 

http://www.gocad.org/
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represents an analysis of the amplitude content of a signal with frequency within a moving window stepped 

through the signal. 

 

• A polarisogram is displayed for each triaxial instrument in the form of a colour density plot. A polarisogram 

represents the frequency-dependent polarisation of a signal recorded on a triaxial, or quadriaxial, instrument. The 

polarisogram plot can show the polarisation coefficient, the primary azimuth or the primary plunge. 

 

• The waveforms, sonograms and polarisograms are plotted in line with each other, allowing direct comparison of 

arrival information. Point and click operations allow the user to change the position of pick cursors on the 

waveforms. Data linking between channels is performed automatically. 

 

• Spectral analysis can be done with either the Fast-Fourier-Transform method or the Maximum-Entropy 

method. Hildyard and Hann tapers can be applied to the various waveforms in the pre-processing stage. The 

number of poles used in the Maximum-Entropy method can also be specified. 

 

• The step-size, gate-length and gate types can be easily changed. 
 

• Zoom functionality allows all of the plot types to be enlarged, giving the ability to zoom in on any particular time 

and/or frequency ranges. 

 

• Logarithmic frequency and amplitude ranges can be chosen. 
 

• Use of a common instrument amplitude range or individual channel amplitude ranges. 
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Figure 7-1:Screen captures of the Advanced Waveform Visualiser. Top: During hodogram visualisation. Bottom: During 

frequency visualisation 

 
  



216 7.1 Key features  

 

 
 

Figure 7-2: Screen captures of the Advanced Instrument Visualiser. Top: Polarisogram and Sonogram 
visualisation. Bottom: Zoom in on portion of the waveform. 

 
 
 

7.2 Accessing the Visualisers 
The two visualisers in the Advanced Waveform Tool are integrated into InSite's Waveform Visualiser but are only 

accessible when the user has valid permissions defined in their software key. The user therefore has the processing 
functionality that is available from within the Waveform Visualiser as well as the independent features of each additional 
visualiser. 

 
The Advanced Waveform Visualiser is accessed from the Instrument View in the Visualiser (5.5) using the ‘Enter Triaxial’ 

button on the Instrument Processing Bar (Figure 7-3). The Advanced Instrument Visualiser is accessed from the same button 
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bar using the Enter Advanced Instrument button. 
 
The term 'Instrument' refers to a seismic sensor that has between 1 and 4 'Axes'. Each axis physically consists of a 

receiver plugged into a channel on the data-acquisition hardware. The terms 'Receiver', 'Channel' and 'Axis' are 
interchangeable within InSite. Single-axis and three-axis sensors ('uniaxials' and 'triaxials' respectively) are commonplace 
in seismic monitoring; however, two-axis (a malfunctioning triaxial) and four-axis ('quadriaxial') sensors can also be used. 

 
InSite makes available the more basic processing functions, found in the Waveform Tool, to any type of instrument. 

The Advanced Waveform Visualiser allows a user to access more advanced processing functions to data from 
instruments where the full wave field is obtained (either a triaxial or quadriaxial). 

 
The Advanced Waveform Visualiser is available when processing a triaxial instrument that has its three receivers 

correctly configured, with orientation unit vectors that are mutually orthogonal, or when a quadriaxial instrument has been 
selected. The Enter Triaxial button will be disabled when this is not the case.  

 
The Advanced Instrument Visualiser is available when processing all instrument types, although some of the 

functionality (polarisograms) requires the full wave field, so this functionality is switched off if processing instruments 
with 1 or 2 axes. 

 
Data is recorded from a triaxial instrument on three mutually orthogonal axes. These axes define the instrument 

coordinate system. The orientation of each axis is entered by the user on the Channel Properties Dialog Box (Figure 

5-22) in N-E-D space, e.g. a vector [0.3536n, 0.3536e, 0.8660d] is orientated at an azimuth of 45◦ E of N and 

with 60◦ plunge down from the horizontal. 

 
A quadriaxial instrument has four axes, usually positioned equidistant in space. When one of the visualisers is accessed 

for a quadriaxial instrument the waveforms are automatically transformed to a triaxial instrument with axes orientated 

in the North-East-Up coordinate system. The transformation uses an inversion of the equation below, where [A, B, C, D]i 

are the amplitudes recorded on the four axes of the quadriaxial at time i and [X, Y, Z]i are the equivalent amplitudes on 

the triaxial axes. ακ, βκ, γκ, ∆κ are the direction cosines between the quadriaxial axes and the triaxial. 
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Figure 7-3: The Instrument View in the Waveform Visualiser for a correctly configured triaxial instrument. Clicking 
on the Enter Triaxial button will open the Advanced Waveform Visualiser. Clicking on the Enter Advanced 

Instrument button will open the Advanced Instrument Visualiser. 

 
 
 
 

7.3 User Interface in the Advanced Waveform 
Visualiser 

 
 
 

7.3.1 Overview 
 
The user interface consists of three output panels (Figure 7-4). 
 

• The Configuration and Results Panel contains controls that manipulate the display and perform processing 

functions. 

 
• The Waveform Panel contains views of each of the three waveforms. 

 
• The Processing Panel contains views of either Hodograms or Displacement Frequency Spectra. The views 

that are displayed depend on the Processing Mode chosen on the Configuration and Results  Panel.
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Figure 7-4: The user interface for the Advanced Waveform Visualiser. The Processing Panel is in Hodogram Mode. 

 

7.3.2 Configuration and Results Panel 
The results that have been obtained are displayed on the right-hand panels of the window. Depending on the user's 

screen resolution some of the panel's sections may be hidden from view. The user can scroll down the panel to view these 
sections. (Figure 7-5) 

 

Table 7.1: Description of the sections contained on the Configuration and Results Panel. 

 

Section Controls Displayed Information 

Instrument Information - Instrument Number formatted 
e.g. "3-L-c". The L indicates the 
instrument has been used in the 
event source location. The c 
indicates the instrument 
waveforms are clipped. Display of 
the location and axis orientations 
for the current 
instrument. 

Processing Mode A drop-down box allowing the 

user to switch between Hodogram 

and Frequency processing modes. 

- 
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Section Controls Displayed Information 

Hodogram Parameters A drop-down box allowing the user 

to switch between the four different 

hodogram windows. The availability 

of a window depends on whether 

the appropriate phase has been 

picked. The size, in waveform data 

points, of the automatic Hodogram 

windows. 

- 

Rotation Parameters A drop-down box allowing the user 

to switch between the three 

different ray-coordinate systems. A 

drop-down box allowing the user to 

switch between rotation algorithms. 

A button that opens the Rotation 

Properties Dialog box. 

- 

Rotation Results - Display of the rotation results 

including the orientation of the ray 

co-ordinate system. (Section) 

Single-station Location (SSL) 
results 

- Display of the source-vector 
orientation and the SSL. 

Stored source data - Display of the rotation data that 

the user has stored to the event 

data 

base. 

Phase Rotation Filter Angle A slider, controlled using the mouse 

or arrow keys, allowing the user to 

set the phase rotation angle at 

integer degree intervals. 

Display of the phase rotation 
angle. 
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Figure 7-5: The Configuration and Results Panel. 

 
 

7.3.3 Waveform Panel 
The Waveform Panel contains three waveform views. A waveform can be manipulated using mouse functions in the 

event view (Event View in the Visualiser). An example waveform view is shown with the available cursors and windows that 
can be manipulated by the user (Figure 7-6). Changing a cursor, or window, on one view automatically changes all views as 
the instrument channels are linked together. 

 
There are three arrival time cursors (vertical lines): 
BLUE - P arrival 
GREEN - S1 arrival 
GOLD - S2 arrival 
 
The waveform rotation functions split the S-wave into two orthogonal polarisations. It is then possible to pick two 

different S-wave arrivals. Two cursors are given, defined as S1 and S2, so that travel time differences can be analysed. When 
the S-wave arrival is initially picked TS1 is set equal to TS2 so that the gold cursor will be hidden by the green cursor. The 
green cursor represents the S-wave arrival time used in the Waveform Visualiser and by many of the processing algorithms 
(e.g. source location). 

 
There are four different Hodogram windows displayed towards the base of the waveform view: 
P (BLUE) - P window 
S1 (GREEN) - S1 window  
S2 (GOLD) - S2 window 
G (GREY) - General window 
 
Any of the windows can be manipulated by clicking on the triangle symbol and dragging to enlarge or shrink.  
 
FFT (Fast Fourier Transform) windows are displayed towards the top of the waveform view (labelled P and S). As 

these windows are usually set quite large a single S-wave window is used. 
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The 'R' window (BLACK) is the Rotation Window used in the rotation algorithm. 
 
For any of the windows to be displayed the corresponding phase arrival must be picked. This can be performed by  either 

using the automatic picking function (Event Processing Bar) or by entering the Channel View in the Visualiser ( Channel View 
in the Visualiser) and picking the arrivals manually. 

 
The waveforms that are displayed in the views depend on the ray-coordinate system chosen by the user on the 

Configuration and Results Panel. The four options include: 
 

• Unrotated - waveforms from the three acquisition channels are displayed 
 

• Rotate to N-E-U 
 

• Rotate to P-S1-S2 
 

• Rotate to P-SH-SV 
 
The waveform label (top-left) changes depending on the option that has been chosen. 
 
 

 

Figure 7-6: Example of a Waveform view showing available cursors. 

 
 

7.3.4 Processing Panel in Hodogram Mode 
 
The Processing Panel in this mode contains three hodogram views (Figure 7-7). Each hodogram displays the particle 

motion on the three orthogonal planes in the ray coordinate system being used. The data shown depends on the following 
options chosen by the user on the Configuration and Results Panel. 

 
a. The Hodogram Window. The user can select one of the following: 

 
• P 

 
• S1 (SH) 

 
• S2 (SV) 

 
• General 
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b. The Ray Coordinate System. The user can select one of the following: 

 
• Unrotated 

 
• Rotate to N-E-U 

 
• Rotate to P-S1-S2 

 
• Rotate to P-SH-SV 

 
The Ray Coordinate System option also determines what waveforms are displayed in the Waveform Panel. The 

particle motion is displayed in two colours. 
 

• Black is plotted up to the phase pick corresponding to the Hodogram Window that has been chosen. 
 

• Red is plotted after the phase pick (red is not used in the 'General' window type). 
 
The two buttons positioned above the hodograms move the chosen window left or right through the waveform, so 

allowing the user to observe how the particle motion changes. 
 

 
Figure 7-7: The Processing Panel in Hodogram Mode. 

 
 
 

7.3.5 Processing Panel in Frequency Mode 
 
The Processing Panel in this mode contains three frequency views. Each view contains a displacement spectrum 

calculated from the waveform data in an FFT window on one of the three waveforms in the Waveform Panel (Figure 7-8). 
When the ray coordinate system has been chosen as P-SH-SV then the three views correspond to the P-wave, SH-
wave and SV-wave displacement spectra respectively. In this case, a spectral fit will then be shown on each of the 
spectra if it has been picked. The fit can be manually manipulated by dragging the red symbol with the left mouse 
button. The blue line shows the displacement spectra for the signal window and the black line shows the displacement 
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spectra for the noise window. 

When a spectral fit is applied the values of low-frequency plateau, Ω0, corner frequency, f0, energy flux, J , and 

attenuation, Q, are shown on the view. 
 

 
 

Figure 7-8: The Processing Panel in Frequency Mode. The TOP, MIDDLE and LOWER correspond to the waveforms 
displayed on the Waveform Panel. 

 
 

7.3.6 Button Bar Functions 
 
The Triaxial-Processing Button Bar performs a variety of functions within the Advanced Waveform Visualiser 

explained in Table 7.2 . 
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Figure 7-9: The Triaxial-Processing Button Bar. 

 
Additional button bars that are available include the Navigation and Event-Processing Bars (Figure 7-9). The Event-

Processing Bar exhibits the same processing functionality as for the Instrument View in the Waveform Visualiser.  
 

Table 7.2: Description of functions found on the Triaxial-Processing Button Bar. 

 

Button Operation Description Availability 

Return Returns to the Instrument View in the 
Waveform Visualiser. 

Always On 

Previous Triaxial Changes to the previous triaxial 
instrument in the event. 

Always On 

Next Triaxial Changes to the next triaxial 
instrument 

in the event. 

Always On 

Lock Pick to Hodogram Moves the pick associated with the 
current hodogram window to the 
front of the window. 

In Hodogram Processing mode after 

selecting a Hodogram Window. 

Store Rotation Data Stores the current rotation results for 

this instrument into the database. 

After Rotation to P-S1-S2 or P-SH-SV. 

Clear Stored Rotation 
Data 

Clears any previously stored rotation 

results from the database. 

After Rotation to P-S1-S2 or P-SH-SV. 

Reverse Ray Vector Flips the ray vector between 'forward' 

and 'reverse' azimuths. (6.4.2) 

After Rotation to P-S1-S2 or P-SH- SV 

using only Monalbetti-Kanasewich 

algorithm. 
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Fit Spectral Model Fits a spectral model to the 

displacement spectra. (6.4.3) 

In Frequency Processing mode after 

rotating to P-SH-SV. 

Save Hodogram Vertices Saves the 3C particle motion displayed in 

the current hodogram window to a 

Gocad file. 

In Hodogram Processing mode. 

Switch rotation type Switch between rotation types 'P-SH-
SV' and 'N-E-U' 

Always On 

 

7.3.7 Rotation Properties Dialog box 
The Rotation Properties Dialog box contains parameters used in the rotation and single-station location algorithms. 

(Figure 7-10) 
 
 
 

 
 

Figure 7-10: The Rotation Properties Dialog box. 

 
 
 

7.4 Processing Functions in the Advanced Waveform 
Visualiser 

 
 

7.4.1 Hodogram Functions 
The type of Hodogram available for visualisation depends on whether the phase arrivals have been picked. If both the 

P and S phases have been picked, then the user will see all the hodogram windows displayed in the waveform views (Figure 
7-7). The user can then select the hodogram window to use from the Configuration and Results Panel Configuration and 
Results Panel. 

 
• P Window 

• S1 (SH) Window 

• S2 (SV) Window 

• General Window 
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A hodogram window is automatically set using the front and back window sizes positioned around the phase arrival. 
Changing the window sizes on the Configuration and Results Panel, or adjusting the phase picks, will automatically reset 
the hodogram windows. 

 
The user can adjust a hodogram window by clicking on a triangle symbol and dragging it. The user can also adjust the 

position of the window by using the Move Left or Move Right buttons on the Processing Panel. 
 
Through these functions the user can locate the exact onset of particle motion associated with a particular phase. The  

‘Lock Pick To Hodogram’ button can be used to automatically set the phase arrival to this onset. 
 

7.4.2 Rotation Functions 
Options defining the behaviour of the waveform rotation are located in the two drop down boxes found in the Rotation 

Parameters section of the Configuration and Results Panel. 
a. The Ray Coordinate System to use. The user can select one of the following: 

 
• Unrotated 

• Rotate to N-E-U 

• Rotate to P-S1-S2 

• Rotate to P-SH-SV 
 

b. The Rotation Algorithm to use. The user can select one of the following: 
 

• Source Vector 

• Source Position 

• Montalbetti-Kanasewich 

• Event-Defined Rotation 

• Stored Rotation Data 
 
The following rules apply regarding when these options can be used.  
 

• When the ray coordinate system is set to either Unrotated or Rotate to N-E-U then the rotation algorithm setting 

is not used. The drop-down box is therefore disabled. 

• When the ray coordinate system is set to Rotate to P-S1-S2 then the only rotation algorithm setting that is valid is 

Montalbetti-Kanasewich and so the drop-down box is again disabled. 

• All rotation algorithms are available when the ray coordinate system is set to Rotate to P-SH-SV. 
The algorithms use the rotation properties defined in the Rotation Properties Dialog Box (Figure 7-10). For the 

Montalbetti-Kanasewich algorithm a Rotation Window must be defined (Figure 7-7). The Rotation Window is set from the 
P-wave arrival using the front and back window sizes. The user can manipulate the window on any of the waveform views 
and the rotation is automatically updated. 

 
The ray-coordinate system defines the orthogonal axes onto which the waveform rotation is performed.  
 

i. N-E-U - the waveforms are rotated to the North, East and Up axes. 

 

ii. P-S1-S2 - a rotation is performed onto the Ray Vector (P) and two orthogonal, but arbitrary, vectors in the S-wave 

polarisation plane (S1 and S2). These vectors are defined by the eigenvectors from the Montalbetti-Kanasewich 

algorithm. 

 

iii. P-SH-SV - a rotation is performed onto the Ray Vector (P) and two orthogonal vectors in the S-wave polarisation 

plane (SH and SV). The P-SH-SV coordinate system is described further in the Technical Appendices Section 7.1.1. 

 
  

The rotation algorithm describes how the waveforms are to be rotated into the ray coordinate system. 
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i. Source Vector - the source vector is defined by the user (azimuth and plunge), pointing from the receiver to the 

source. The ray vector is then calculated. 

 

ii. Source Position - the user defines a source position in (N,E,D) coordinates. The source and ray vectors are then 

calculated from the known instrument location. 

 
iii. Montalbetti-Kanasewich - an inverse algorithm is used to obtain the direction of polarisation of the P-wave (an 

estimate of either the source or ray vector) from a window of data around the arrival. 

 

iv. Event-Defined Rotation - the source and ray vectors are calculated from the event's location. This method must 

be used to manually pick P-SH-SV amplitude for moment tensor inversion (Source Mechanism Tool). For example, to 

manually pick P-wave amplitude, you can right-click on the P, SH, or SV waveform and select “Add Rotated P-wave 

Amplitude Picks” (Figure 7-11). 

 

v. Stored Rotation Data - the ray vector is taken from the stored rotation data. 
 

 

 
 

Figure 7-11: The user interface for manual picking P-, SH-, and SV-wave amplitude used in moment tensor 
inversion. 

 
A Single-Station Location is obtained when using the Montalbetti-Kanasewich method knowing the source vector 

orientation, the instrument location and the P-S travel time. The source and ray vectors can be switched using the Reverse 
Ray Vector button. The geometry of the ray coordinate system and the single-station location are automatically 
recalculated. 

 
Once a rotation is obtained the user can store this information to the database using the Store Rotation Data button. 

The Stored Source Data section of the Configuration and Results Panel is updated. The data can be cleared using the ‘Clear 
Stored Rotation Data’ button. 

 
 
 

7.4.3 Frequency Functions 
Frequency windows are constructed around the P and S-wave arrival picks using the front and back window settings 

on the Channel Processing Property Sheet (Figure 5-48). The windows can then be manipulated on the waveform views. 
A Fast Fourier Transform (FFT) is produced from the data within the required window. This is performed in an identical 
fashion to the FFT Processor that can be accessed from the Channel View in the Waveform Visualiser. The FFT then 
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− 

undergoes the following processing functions (these are also available within the FFT Processor). 
 

• The FFT is automatically trimmed to the frequency bandwidth of the instrument. This is defined on the Receiver 

Properties. The user must ensure this is correctly configured. 

• The FFT is integrated to displacement, knowing the instrument response defined on the Receiver Properties. 

The frequency processing mode cannot be accessed if the instrument response is set to Volts. 

• The FFT is displayed on a Log-Log chart. 
 
No frequency domain filtering is performed. In order to apply a filter, the user should apply the time-domain filtering 

algorithms to the waveforms. 
 

A spectral model can then be fit to the spectra so as to obtain a low-frequency plateau, Ω0, and corner frequency, 

f0. At frequencies greater than the corner frequency the spectra is assumed to fall-off proportional to f −2. This 

operation can only be performed once the waveform data has been rotated to the P-SH-SV ray coordinate system. Spectral 
processing is discussed further by Collins and Young (2000). The fit is first performed automatically by minimising the 
differences between a best-fit model from Walter and Brune (1993) and the given spectra. The model is calculated using, 

 

|Ω(𝑓)| =  
Ω0

(1 + (
𝑓
𝑓0

)
2

)

𝛾
2

 

 

where γ = 2. 
The error minimisation uses a Simplex method, searching in the Ω0-f0 model space, for the solution that minimises 

the squares of the differences between the equation above and the spectra. The best-fit is displayed as a cyan- 
coloured curve. 

 
The red lines on the spectral plot show the low-frequency plateau and the corner frequency (circle symbol). The user 

can manually manipulate the fit by clicking on the symbol and dragging across the display. The fit can be cancelled by right-
clicking on the circle symbol. 

 

The Energy Flux, J , is calculated from the integral of the velocity spectrum using the equation below, where Vi 
is the velocity amplitude at data point i in the spectrum (i is associated with a frequency component fi in the 

discretised range of frequencies contained in the FFT). 
 

𝐽 = 2 ∙ ∑ 𝑉𝑖

𝑖=𝑁

𝑖=1

 

 
 

7.4.4 Storing Rotation Data 
 
The user has the ability to rotate the waveforms using different algorithms and into different ray coordinate systems. 

Resulting rotation data is only stored to the data base if the user manually chooses the Store Rotation Data function on the 
button bar (Figure 7-9). This is so that processed rotation data cannot be inadvertently over-written by unwanted rotation 
data. 

 
The rotation data and spectral model fits can be written to a text file using the Waveform Pick Results export function 

in the Export sub-menu. 
 
The 3C particle motion in the rotated waveform window can be stored in a Gocad file if the Save Hodogram  Vertices 

button is pressed on the button bar (Figure 7-9). 
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7.5 User Interface in the Sonogram Visualiser 
 

7.5.1 Overview 
 
The user interface consists of two output panels. (Figure 7-12) 
 

• The Configuration Panel contains controls that manipulate the display and perform processing functions. 

• The Waveform Panel contains views of each of the waveforms in the instrument and their respective sonograms.  

If the instrument is triaxial, then a polarisogram will be displayed at the top of this panel. 

 
 
 

 
 

Figure 7-12: The user interface for the Advanced Instrument Visualiser. 

 

7.5.2 Configuration Panel 
 
The Configuration Panel (Figure 7-13) contains a number of sections with controls for manipulating the display and 

processing functions and displaying the results (Figure 7-14). The display is summarised in Figure 7-13. 
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Figure 7-13: Configuration Panel in the Advanced Instrument Visualiser. 

 
 
Depending on the user's screen resolution some of the panel's sections may be hidden from view. The user can 

scroll down the panel to view these sections. 
 

Table 7.3: Description of the sections contained on the Configuration Panel. 

 

Section Controls 

Instrument Information Instrument 

Processing  
• Power Spectrum Estimation Method 

• FFT/MEM Step Size 

• FFT/MEM Gate Length 

• Number of poles used in MEM 

• FFT/MEM gate type 

• FFT/MEM taper type 

• Polarisogram type 
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Section Controls 

Display  
• Frequency Range 

• Logarithmic Frequency 

• Logarithmic Amplitude 

• Amplitude Range 

Results  
• Rotation Parameters 

• Rotation Properties 

• Rotation Results 

 

7.5.3 Waveform Panel 
 
The Waveform Panel contains waveform views for each channel with its respective sonogram view. If the instrument is 

triaxial, then the top view is a polarisogram. A waveform can be manipulated using mouse functions ( Event View Mouse 
Operations). An example waveform view is shown in Figure 7-14 with the available cursors and windows that can be 
manipulated by the user. Changing a cursor, or window, on one view automatically changes all  views as the instrument 
channels are linked together. 

 
There are three arrival time cursors (vertical lines):  
BLUE - P arrival 
GREEN - S1 arrival  
GOLD - S2 arrival 
 
There is one data window used to calculate the waveform rotation (vertical lines).  

 
 

Figure 7-14: Example of Waveform and Sonogram views showing available cursors 
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7.5.4 Sonogram Processing Parameters 
A sonogram can be produced using either the Fast-Fourier-Transform method, or the Maximum-Entropy Method. 

Choose one of the "Power Spectrum Estimation Method" radio buttons to select the method.  
 
The step size and gate length refer to the position and length of each power spectrum window in the waveform (Figure 

7-15). 
 
 

 
 

Figure 7-15: Definition of step size and gate length 

 
 
 
The selected power-spectrum-estimation method is performed on each window. The data from each power- spectrum-

estimation is then combined in order to produce a sonogram. The gate from the waveform that was used to produce the 
power spectrum estimation can either be forward looking, centred on the posting time or backward looking. (Figure 7-16) 

 

 
Figure 7-16: Example of gate configuration. 

 
Choose a gate type from one of the "FFT/MEM gate type" radio buttons. 
 
A taper is applied to each gate taken from the waveform. This is either a Hildyard or Hann taper according to the 

"FFT/MEM taper type" radio button chosen (Key Features). 
 
The number of poles used in the Maximum Entropy Method can also be adjusted by changing the value in the "No 

Of Poles Used In MEM" text box. See the Technical Appendices section 7.2.2 for more information on the Maximum 
Entropy Method. 
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7.5.5 Polarisogram Processing Parameters 
 
A polarisogram can only be produced using the Fast-Fourier-Transform method. Therefore, if the Maximum-Entropy 

Method is used, a polarisogram will not be displayed. Choose the "Fast Fourier Transform" radio button from the 
"Power Spectrum Estimation Method" group. 

 
There are three different types of polarisogram that can be displayed. Select the type of polarisogram that you wish to 

display from the "Polarisogram Type" drop down list. 
 
 
 

7.5.6 Sonogram and Polarisogram Display Parameters 
 
The "Frequency Range" text boxes allow the user to set the minimum and maximum frequencies displayed in a 

sonogram/polarisogram. Once the sonograms/polarisograms have been generated, then the user can zoom in on a certain 
time window. This is done by selecting the start time from either the waveform or sonogram views, using the  left mouse 
button, and then releasing the left mouse button at the end time. 

 
 
The frequency and amplitude can be displayed using logarithmic scales (Figure 7-17). Select the "Logarithmic Frequency 

Axis" check box to display the frequency using a logarithmic scale. Select the "Logarithmic Amplitude" check box to display 
the amplitude using a logarithmic scale. 

The amplitude range can be either common to the instrument or auto scale on each channel. To make the scale common 
to the instrument select the 'Instrument' radio button from the 'Amplitude Range' group. To make the scale  auto scale on 
each channel, select the 'Trace' ratio button from the 'Amplitude Range' group.  

 

 
Figure 7-17: Examples of various display options for sonograms and polarisograms 

 
  



7. Advanced Waveform Processing Tools 235 

 

 

 

7.5.7 Rotation Parameters 
 
The "Rotation Parameters" box pane includes options defining the behaviour of the waveform rotation (Rotation 

Functions). These include: 
 

a. the ray coordinate system to use; 

b. the rotation algorithm to use; 
c. a button for accessing the Rotation Properties Dialog box. 

 
 

7.5.8 Creating and viewing the Sonograms and Polarisograms 
 
Once the processing and display parameters have been set up then the sonograms can be generated by pressing the 

'Generate' button. Each sonogram has an amplitude key (Figure 7-18). 
 

 
Figure 7-18: Examples of generated sonograms. 

 
 
If the mouse pointer is currently hovering over a sonogram/polarisogram, then the amplitude/polarisation-parameter, 

frequency and time that the mouse position refers to will be displayed in the mouse information.  
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 Advanced Location Tools 
 
 
Key Features 

Wavebuilder Overview 

Tian Raytracing Overview 

Traveltime Modelling in Wavebuilder 

Traveltime Modelling in Tian Raytrace 

VTI Tian Raytracing Overview 

Collapsing Grid Search 

Travel Time Grid Method 

Source Scan Method 

 
 

8.1 Key Features 
The term "Advanced Location" is defined here as a seismic source-location process requiring travel times to be modelled 

through an inhomogeneous (or "complex") media. That is the media consists of interfaces across which there is a velocity 
contrast. InSite's "standard" location algorithm is restricted to homogeneous-isotropic and transversely- isotropic media 
where interfaces cannot be defined. 

 
The Advanced Location Tools have two principal functions: 
 

1. It provides the ability to model P- and S-wave travel times through user-defined "complex" media using a "ray-

tracing" technique; 

2. It provides the ability to locate events within a three-dimensional (3D) volume using the modelled travel times. 
 
The Advanced Location Tool pack is an independent tool-pack within InSite and requires the relevant permissions 

in the user's software key. 
 
The user has two options to model travel times: 
 

1. Wavebuilder: travel times are calculated by propagating wavefronts through complex velocity  models. 
 

2. Tian Raytracing: Indicated for real-time processing in horizontally layered media. Travel times are calculated by 

propagating rays through horizontal layered velocity models. 

 
The travel-time modelling is performed through "ray tracing", referenced here as a generic term for calculating the 

travel time between two positions by considering wave propagation across interfaces that include velocity contrasts. Note 
that in addition to travel times other ray parameters can be calculated through this method, in particular the ray-vector 
orientation - the azimuth and take-off angle of the ray connecting the two positions. 

 
Seismic source location within complex media provides challenges that are not observed in more standard seismic 

prospecting. 
 

• Source location is an inverse procedure whereby the "best" source position is computed within a 3D location 

volume (defined by northing, easting and depth limits) through an error-minimisation procedure i.e. measured 

travel times recorded on an array of seismic instruments are numerically compared to travel-times calculated 

throughout the volume in order to find the position that minimises the difference between the two. The accuracy 

of this procedure depends on the number and spatial distribution of the instruments. 

• The objective of travel-time modelling must therefore be to define the P- and S-wave travel times from the array 

of instruments to any position within the 3D location volume. 

• The travel-time modelling must be "reversed", in that ray tracing must be performed from a given instrument out 

into the general 3D volume, not from a single source position to the instrument. The instrument is thus considered 

as a "source" for the ray tracing and reciprocity must be assumed (i.e. waves travelling from any given 3D position 

to the instrument follow the same path as that modelled). 
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• Each instrument has a unique position within the volume, which means that the waves propagating through the 

3D volume away from the instrument follow different paths through the same velocity model. Unique travel-time 

modelling must therefore be performed for each instrument in the monitoring array. 

• Both P- and S-wave travel times are used in source location, each with a different velocity model. Thus, unique 

travel-time modelling must also be performed for each phase on every instrument in the monitoring array. 

 
Advanced Location within InSite using the Wavebuilder algorithm is split into the two processes defined above because 

the travel-time modelling (1) is a computationally exhaustive procedure that is identical for every seismic event processed. 
This means that if data files are used to store the travel-times within the 3D volume, then the modelling need only be 
performed once for a particular monitoring configuration. The travel times are simply read from the files for each event 
processed and an error-minimisation procedure (2) performed. A "Collapsing Grid- search" algorithm is used to perform 
this procedure. For the case of horizontally layered media (Tian Raytrace), current PC processor specifications allow the 
raytracing process to be performed in time ranges that permit the sequestration of both processes for real-time processing. 

 
 

8.2 Wavebuilder Overview 
 
For this option of the advanced location tool, the user accesses the travel-time modelling through the WaveBuilder 

software utility run from within ASC's InSite Seismic Processor. This utility has three primary objectives: 
 

1. Compute travel times across a given 3D location volume using a velocity structure defined by the user; 

2. Format travel times in such a manner that they can be efficiently used in a source location algorithm; 

3. Provide a platform through which future code development will allow increasingly complex media to be modelled.  

 
The travel-time modelling uses a "dynamic" Wavefront Construction (WFC) technique in two-dimensions (2D), based 

on Vinje et al. (1993). Further details on the algorithm can be found in the Technical Appendices section 9. Modelled travel 
times are stored to a set of binary files that can then be used for source location. The location algorithm is integrated with 
InSite's regular processing framework and as such can be used for manual, automatic or real-time processing in exactly the 
same manner as the conventional location algorithms in InSite's Location Tool. Some of the key features of the tool are as 
follows: 

 
• The module splits the ray-tracing operations away from the source location operations: a) ray-tracing is per- 

formed before processing of any events so that the travel-time modelling can be first optimised for the volume 

under investigation; b) travel-time grids are stored to binary files so as to be memory efficient and allow high- 

resolution ray tracing over large seismic arrays; c) batch-processing of events using the same array geometry 

uses the same travel-time grids stored to file thus travel-time modelling need only be performed once for a 

particular monitoring project; 

• The WaveBuilder algorithm produces grids of P- and S-wave travel times and ray-vector orientations from 

every seismic instrument used in a project and then provides calculation of these parameters to any position 

within the full 3D location space defined by the user; 

• A Collapsing Grid-Search algorithm provides source location within the modelled travel-time grids down to a 

resolution defined by the user; 

• The efficiency of the ray tracing and source location has been optimised for use together and depends primarily on 

the resolution of the travel-time grids, which in turn depends on the resolution of the velocity model input by the 

user; 

• The WaveBuilder algorithm currently allows WFC through horizontal layers providing a discontinuous velocity 

structure i.e. a "smooth" media is not required as in classical ray-tracing or finite-difference eikonal-solvers; 

• The WaveBuilder algorithm allows rays travelling in any orientation, not only down - i.e. essential for 

mine/petroleum operations where the instruments are within the monitored volume; 

• The WaveBuilder algorithm allows future extension to more complex media (such as inclined layers and 

voids), inclusion of "secondary" arrivals (either earlier or later reflections, refracted head waves, diving rays 

etc), tying of P and S-wave time grids so as to allow mode conversions to be transferred between grids, and 

amplitude modelling for source mechanism analyses. 
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8.2.1 User Interface 
 
The user interface for the WaveBuilder software utility is shown in Figure 8-1. The Dialog box is opened from the 

Data Visualiser in the main InSite program; the user should select the Tool menu item (Figure 8-2), then Launch 
WaveBuilder. 

 
The Dialog box consists of the following controls: 
 

• Check boxes to select whether the velocity model will be defined by an external file (alv) or through the Frac 

Manager; 

• A "Browse" button in order to define the location of the velocity-model; 
 

• Buttons for loading the velocity model and processing the time grids; 
 

• A check box to select to process the location grids; 
 

• A "Status View" displaying information on the current processing run. 
 

 
Figure 8-1: Example of the WaveBuilder user interface. 

 

Figure 8-2: Launching of the WaveBuilder software utility is performed from the Tool menu in the Data Visualiser. 
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8.3 Tian Raytracing Overview 
For this option travel times are computed during the source location operations. Travel-time modelling uses a two- point 

ray tracing method applied to horizontally layered velocity models expanded from Tian and Chen (2005). This method 
provides stable and rapid convergence making it suitable for real-time processing. In this method, travel times are 
calculated for the ray paths of direct reflected and critically reflected (head waves) waves for each source and receiver 
position for a given layered velocity model. Further details on the algorithm can be found in the Technical Appendices 
Section 3.9.2. Modelled travel times are stored in memory and are then used for source location. The location algorithm is 
integrated with InSite's regular processing framework and as such can be used for manual, automatic or real -time 
processing in exactly the same manner as the conventional location algorithms in InSite's Location Tool. Some of the key 
features of the tool are as follows: 

• The Tian Raytrace algorithm computes grids of P- and S-wave travel times and ray-vector orientations from 

every seismic instrument used in a project and then provides calculation of these parameters to any position 

within the full 3D location space defined by the user; 

• A Collapsing Grid-Search algorithm provides source location within the modelled travel-time grids down to a 

resolution defined by the user; 

• The efficiency of the ray tracing and source location has been optimised for use together and depends primarily 

on the resolution of the travel-time grids, which in turn depends on the resolution of the velocity model input by 

the user; 

• The Tian Raytrace algorithm allows rays travelling in any orientation, not only down - i.e. essential for 

mine/petroleum operations where the instruments are within the monitored volume. 

 
 
 

8.4 Traveltime Modelling in Wavebuilder 
 
Modelling of travel times through complex media is performed in the WaveBuilder algorithm. The algorithm produces 

grids of P- and S-wave travel times and ray-vector orientations from every seismic instrument used in a project. It has been 
designed so as to allow future developments for greater complexity in the velocity media and has a general processing flow 
(Figure 8-3). 

• Travel-time grids are computed over a 2D plane using a 2D Wavefront Construction (WFC) technique based on  

Vinje et al. (1993). As the location volume is 3D, this means that the velocity model is restricted to horizontal 

strata. 

• The velocity model is input by the user through an ALV file that is described in more detail below. 

• A travel-time grid is computed using WFC for each P and S phase on every instrument defined in InSite's 

Default Receiver Array in the project. 

• A set of binary ALT, ALP and ALL files are output from the algorithm for each travel-time grid. These are used 

for seismic source location in the Collapsing Grid-search algorithm discussed further below. 

• If the travel-time grid contains fewer than 100,000 nodes then an ASCII TXT file is produced that allows 

plotting of the grid in third-party software (e.g. Microsoft Excel). Two examples of travel-time grids produced 

by the WaveBuilder algorithm are provided (Figure 8-4). 
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Figure 8-3: General processing flow for travel-time modelling in the WaveBuilder algorithm. IDRA is InSite Default 

Receiver Array. 

 
 

 
 

Figure 8-4: Example travel-time grids produced by the WaveBuilder algorithm: a) through a homogeneous-
isotropic velocity structure; b) through a three-layer model (velocities increasing with depth). The velocity models 

are provided by ALV files. The two wavefronts highlighted are at 0.075s and 0.150s respectively (left to right). 

 
 

8.4.1 Formatting the ALV File 
 
 
As a pre-requisite for data processing the user must format an ALV file that defines the configuration of the 3D location 

volume, the source-location grid search and the velocity model. Two examples for the file format are shown in Figure 8-5. 
The file contains the following header parameters: 

• Version - the version number for the file format (current version = 1); 

• FieldType - the type of velocity field included in the file (currently only 1D is applicable); 

• TimeGridNorthMin through to TimeGridDepthMax - definition of the 3D volume to compute travel times; 

• TimeCellIdealDimension - the ideal spatial dimension for each time pixel on the 2D time grid; 

• LocationGridNorthMin through to LocationGridDepthMax - definition of the 3D location volume; 

• GridSearchStartDimension - the starting cell dimension (Dc1) for the initial "coarse" 3D grid search; 

• GridSearchResolution - the final location resolution the user wishes to obtain in the grid search; 
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• GridSearchCollapsingBuffer - the grid-search collapsing buffer; 

• VelocityModelMaxDepth - the maximum depth the input velocity model extends down to. 
All spatial dimensions in the file can be in either feet or metres. Velocities must be in the same units. Instrument 

positions are defined on the Default Receiver Array within the InSite Project and must also be in the same units. All 
instruments must be within the 3D location volume. 

 
The grid search parameters are discussed further in Collapsing Grid Search. 
 
The Cell Dimension parameter defines the ideal spatial dimension for each time pixel on the 2D time grid - that is 

the ideal distance between two time nodes on a ray path or wavefront. The actual distance between time nodes will 
vary from one position to another on the grid depending on the local velocity, geometrical spreading and ray bending. 
The Cell Dimension can be considered as the maximum distance between two adjacent time nodes, and the 
separation distance is unlikely to get considerably less than this. 

 
The Cell Dimension must be at most 0.5x the dimension of the smallest velocity inhomogeneity (layer thickness in the 

FieldType=1D case). This ensures that there is a minimum of three time nodes per inhomogeneity and thus retains 
resolution and accuracy. 

 
The computation time for a travel-time grid depends on the Cell Dimension relative to the size of the defined 3D location 

volume (and thus implicitly depends on the size of the smallest velocity inhomogeneity).  The examples given in Figure 8-5 
produce travel-time grids of approximately 60,000 nodes (considered to be mid resolution) with a  computation time of 
approximately 2 minutes per travel-time grid on a 3GHz PC. 

The computation time for source location using the collapsing grid search depends on both the Cell  Dimension and 
GridSearch parameters. Over a 10-geophone array (20 grids), the examples given in Figure 8-5 takes approximately 5 
minutes per event. In general: 

 
• The smaller the CellDimension, GridSearchStartDimension and GridSearchResolution the more searching 

required in the grid search; 

 
• The larger the GridSearchCollapsingBuffer the more iterations required in the grid search to collapse to the 

GridSearchResolution. 

 
The parameters therefore require some tuning in order to optimise the processing time. 
After the header parameters in the ALV file, the user must format the velocity structure defined using data blocks. Each 

block has the format, e.g.:\ [HorizontalLayer] 
TopDepth=8000 
PVelocity=15000  
SVelocity=8500 
 
The descriptor [HorizontalLayer] indicates the block type. 
 

• TopDepth - upper depth of layer; 
 

• PVelocity - P-wave velocity in the layer; 
 

• SVelocity - S-wave velocity in the layer. 
 
The deepest extent of the model is given by the header parameter VelocityModelMaxDepth. A single layer ( Figure 8-5 

a) is effectively a homogeneous model. Multiple layers (Figure 8-5 b) are constructed by including multiple blocks with 
increasing TopDepth parameters - each TopDepth being the bottom of the previous layer. 

 
 
For the FieldType=1D case, the user must ensure the velocity model encompasses the entire depth range of the 3D 

location volume. 
 
The travel-time grids for these two examples are provided in Figure 8-4. 
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Figure 8-5: Examples of suitably formatted ALV files defining velocity models for the WaveBuilder algorithm. 

 
 

8.4.2 User Operations 
The WaveBuilder software utility consists of the Dialog box user interface (User Interface2). The purpose of the utility 

is to compute modelled travel times across the given 3D location volume using a complex velocity model defined by the 
user in the ALV file. The travel times are stored to the file formats described earlier. The files are then utilised during the 
source location process described in the following section. 

 
The user must perform the following operations to successfully model travel times using a velocity model defined using 

an external file: 

• Format the ALV file as described in the previous section; 

• Open the WaveBuilder Dialog Box; 

• Check the button External File; 

• Click on Browse and locate the ALV file on the hard drive - the WaveBuilder files will be stored to this directory 

so the user should ensure sufficient drive space is available; 

• Click on Load Velocity Model - the ALV information will be checked for consistency and the hard drive space 

available is compared to a predicted space required for the WaveBuilder files; 

• The user can select the option to Process Location Grids - in this case the 3D location grid is computed with the 

2D travel-time grids; 

• Click on Process Time Grids - the user is provided a Dialog box indicating progress, with the option to cancel the 

processing run, and further information is output to the Status View. 

 
Note that if the Process Location Grids option is not selected then no location grids are computed, and the data cannot 

be used in the Location Algorithm described in the following section. This option is provided so that the user can more 
efficiently compute time grids alone and quality check the resulting time output in the TXT files, before computing the 3D 
location grids (which tend to be computationally intensive). 

 
If the user has the Frac Manager tool and is using this to define a velocity model for Wavebuilder, the following 

operations should be performed: 
 

• Open the WaveBuilder Dialog Box; 

• Check the button Frac Manager; 
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• Complete the boxes to define the time and location grids as well as the cell dimension, start dimension, resolution 

and collapsing buffer; 

• Click on Browse and locate the velocity model in the Frac Manager; 

• The user can select the option to Process Location Grids - in this case the 3D location grid is computed with the 2D 

travel-time grids; 

• Click on Process Time Grids - the user is provided a Dialog box indicating progress, with the option to cancel the 

processing run, and further information is output to the Status View. 

 
 
 

8.5 Traveltime Modelling in Tian Raytrace 
 
Modelling of travel times through horizontally layered media can be performed in real time using the Tian Raytrace 

algorithm. The algorithm produces grids of P- and S-wave travel times and ray-vector orientations from every seismic 
instrument used in a project. 

 

• Travel-time grids are computed over a 3D volume using a two-point raytrace technique based on Tian and Chen 
(2005). 

 
• The velocity model is input by the user through a Microsoft Excel Comma Delimited (CSV) file that is described in 

more detail below. 

 
• A travel-time grid is computed using two-point raytracing for each P and S phase on every instrument defined in 

InSite's Default Receiver Array in the project. This grid is used for seismic source location in the Collapsing 

Grid-search algorithm discussed further below. 

 
 

8.5.1 Formatting the CSV File 
 
As a pre-requisite for data processing using Tian Raytracing the user must format a CSV file that defines the 

configuration of the 3D location volume, the source-location grid search and the velocity model. An example for the file 
format is shown in Figure 8-6. 

 
The file contains the following parameters: 

• Depth Top: Depth level of the upper horizon of each defined layer.  

• Vp: P-wave propagation velocity of each layer. 

• Vs: S-wave propagation velocity of each layer. 

• VpVs: Vp/Vs ratio. 

• Depth Base: Depth level of the lower horizon of each defined layer. 
 
All spatial dimensions in the file can be in either feet or metres. Velocities must be in the same units. The Depth Top 

of the upper layer and the Depth Base of the lower layer must be such that the vertical range of the Sensor Array and 
the Grid Search volume is comprised within the modelled depth range. 
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Figure 8-6: Example of a suitably formatted CSV file defining a horizontally layered velocity model for the Tian 
Raytrace algorithm. 

 
 
 

8.6 VTI Tian Raytracing Overview 
 
This option approximates the travel time in VTI medium based on the isotropic Tian Raytracing method.  Travel-time is 

calculated in two steps. It first uses a two-point ray tracing method applied to horizontally layered isotropic velocity models 
expanded from? and then the travel time is corrected for the VTI model assuming the phase direction in the VTI  media is 
identical to the ray path in the isotropic media. 

 
This method takes the advantage of the stable and rapid convergence of isotropic Tian Raytracing method described in 

the previous section and thus make it suitable for real-time processing. Similar to isotropic Tian Raytracing, travel times 
can be calculated for the ray paths of direct reflected and critically reflected (head waves) waves for each source and 
receiver position for a given layered velocity model. Further details on the equations used to modify the isotropic two-point 
ray tracing algorithm can be found in the Technical Appendices. Modelled travel times are stored in memory and are then 
used for source location. The location algorithm is integrated with InSite's regular processing framework and as such can 
be used for manual, automatic or real-time processing in exactly the same manner as the conventional location algorithms 
in InSite's Location Module. Please note that due to the approximation employed in the algorithm, VTI Tian Raytracing is 
best suit for weak anisotropy (see definition of weak anisotropy in?) and the error in the travel time is less than 10 ms. 

 
 
 

8.6.1 Traveltime Modelling in VTI Tian Raytrace 
Modelling of travel times through horizontally layered VTI media can be performed in real time based on the Tian 

Raytrace algorithm. The algorithm produces grids of P- and S-wave travel times and ray-vector orientations from every 
seismic instrument used in a project. 

• Travel-time grids are computed over a 3D volume using a two-point raytrace technique based on Tian and 

Chen (2005). 

• The velocity model is input by the user through a Microsoft Excel Comma Delimited (CSV) file that is described in 

more detail below. 

• A travel-time grid is computed using two-point raytracing for qP and qSH phase on every instrument defined in 
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InSite's Default Receiver Array in the project. This grid is used for seismic source location in the Collapsing Grid-

search algorithm discussed further below. Although qSV travel time is also calculated, it is not normally picked 

in practical situations. 

 

8.6.1.1 Formatting the CSV File 
 
As a pre-requisite for data processing using VTI Tian Raytracing the user must format a CSV file that defines the 

configuration of the 3D location volume, the source-location grid search and the velocity model including Thomsen 
parameters. An example for the file format is shown in Figure 8-7. 

 
The file contains the following parameters: 
 

• Depth Top: Depth level of the upper horizon of each defined layer. 

• Vp: P-wave propagation velocity of each layer. 

• Vs: S-wave propagation velocity of each layer. 

• VpVs: Vp/Vs ratio. 

• Depth Base: Depth level of the lower horizon of each defined layer. 

• Density: the density of each layer. Currently NOT used for travel time. 

• Epsilon: The Thomsen's parameter ( η) 

• Gamma: The Thomsen's parameter ( γ)  

• Delta: The Thomsen's parameter ( δ). 
 
The details about the Thomsen's parameters can be found in Thomsen (1986). 
 
All spatial dimensions in the file can be in either feet or metres. Velocities must be in the same units. The Depth Top 

of the upper layer and the Depth Base of the lower layer must be such that the vertical range of the Sensor Array and 
the Grid Search volume is comprised within the modelled depth range. 

 
 

 
 

Figure 8-7: Example of a suitably formatted CSV file defining a horizontally layered VTI velocity model for the VTI 
Tian Raytrace algorithm. 
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8.7 Collapsing Grid Search 
 

8.7.1 Computation of a Source Location 
The computation of a source location is a seismological technique utilised in InSite and is described extensively in 

other sections of this manual. The "Standard" method is performed as part of the functions made available in the 
Location Tool. Source location can be performed manually using the Event Processing button bar in the Waveform 
Visualiser and can be performed automatically for a set of Events using the Auto-processing Dialog Box. A collapsing 
grid search algorithm, using a single-velocity (homogeneous) model, is implemented within InSite's Location Tool and 
is extended for use in this Advanced Location Tool. 

 

8.7.1.1 CSV Voxel exclusion file 
 
Volumes where no events should locate, e.g. voids, can be excluded from the search so that no potential solution falls 

in them. The excluded volume can be imported into InSite saved as 3Dvoxels in a.csv file that includes the coordinates of 
the top NW corners of the voxels to be excluded and its dimensions along the E, N and vertical axes. The . An example 
exclusion volume file is shown in Error! Reference source not found.. 

 

 
Figure 8-8: Example .csv file for the import of the exclusion volume for gridsearch in InSite. The fields required  
 

8.7.2 Using Complex Velocity Media Advanced Location 
There are two differences between the standard and advanced location approaches: 
 

• The collapsing grid search algorithm is configured from an ALV file formatted by the user, rather than using the 

settings defined on the Location Algorithm Properties Dialog; 

• The algorithm searches modelled travel times computed using the WaveBuilder software utility and complex 

velocity media defined in the ALV file, rather than computing travel times 'on the fly' using direct rays and 

homogeneous media. 

 
It must be noted that the configuration parameters in the ALV file are also to define the grid volumes during travel - 

time modelling, which must be the same as those used in the gridsearch of the resulting modelled travel times.  
The general processing flow is shown in Figure 8-9and can be summarised as follows: 
 

• The algorithm is configured using the information provided in the ALV file selected in the WaveBuilder Dialog; 

• The set of ALT files are imported into memory - (1) note that if these grids are excessively large then the algorithm 

accesses them from the Hard Drive rather than from memory (the threshold is set to 100,000 time nodes  per grid), 

meaning that the computation time is substantially increased; 

 
• A new location-algorithm pass is performed in which the ALP and ALL files are initially used to search the course 

3D location grid of travel times - the 3D grids are calculated during the travel-time calculations; 

 
• The 3D location grid is collapsed as described in the previous section - after collapsing, the algorithm searches 

directly within the travel-time grids (ALT data) for the required data at a given position; 

 
• The process of searching within the ALT data has been optimised - the computation rate may initially start slow 

(the efficiency depends on the size of the time pixels in relation to the size of the course 3D grid cells, i.e. the 

greater the number of time pixels per cell the more searching that is required) but then increase as time pixels 

are found within the grid cells being examined; 
 

• The algorithm continues to collapse until it reaches the user's desired resolution, whereupon it will perform a test 

of the travel times for outliers lying outside the user's pre-defined time residuals (as in the standard location 

algorithm) and a new location algorithm pass may then be performed. 
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Source parameters such as magnitude, seismic moment, source radius etc. are calculated after location. The 

algorithm uses the average velocity structure provided in the Transmission Medium Properties Dialog (Figure 8-10), so 
the user should ensure this provides meaningful input values. 

 
Figure 8-9: General processing flow for source location using travel-time grids in the Advanced Location Tool. 

Numerals indicate notes in the text. 

 
 

 
Figure 8-10: The Transmission Medium Properties Dialog - the average velocity structure provided here is used in 

the source parameter calculations.
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8.8 Travel Time Grid Method 
 
This option allows the user to pre-calculate travel times using either the fast sweeping method for 3D heterogeneous 

model or the Tian Raytracing method for 1D layered model. In scenarios where velocity model is available prior to data 
acquisition, this method can significantly speed up the data processing by offsetting part of the computation time. The 
details about the fast sweeping method can be found in Appendices 3.9.3. 

 
 

8.8.1 Fast Sweeping Method User Interface 
 
In some monitoring projects, the reservoir or the structure of interest has been previously developed and  complicated 

velocity models are available in addition to well logs. The velocity models are generally heterogeneous in 3D and honouring 
well logs, if any, at the borehole location and consistent with other observation elsewhere. As an example, the model shown 
in Figure 8-11 varies laterally and vertically. It matches the well logs along the borehole (red line) and is supported by 
other data (e.g. 3D seismic survey) elsewhere. 

 
 

Figure 8-11: Visualisation of complex 3D velocity model 

 
 
The 'Fast Sweeping Method Travel Time Builder' is accessed through the 'Tool' menu in data visualiser and selected 

'Launch Fast Sweeping Method Builder'. This Figure 8-12 shows the builder dialog. This is used to calculate travel time table 
as well as source vectors. The input files are the binary velocity files for the P and S waves along with the volume and lookup 
table volume parameters. The output file is in hdf5 format with ".h5" appendix. The hdf5 files can be viewed with a third 
party software, hdf5viewer from: 

http://www.hdfgroup.←› org/products/java/release/download.html 

http://www.hdfgroup.org/products/java/release/download.html
http://www.hdfgroup.org/products/java/release/download.html
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Figure 8-12: Fast sweeping method travel time builder dialog 

 
 
To build the travel time grid: 

• Press the 'Browse' buttons and select the desired P-wave velocity binary file and the S-wave velocity binary file. 

• Enter the velocity volume parameters. The size must be divisible to the cell size and must be consistent with your 

binary file. 

• Enter the look up table parameters. The look up table is defined in terms of the index. The index must be a 

positive integer and starts from zero. 

• Enable parallel processing by checking 'Enable PPL' to decrease computation time. 

• Press the 'Start Build' button' to build the travel time grid file. Depending on the size of the model, the 

computation time varies between 1 and 10 hours. 

 

8.8.2 Binary Velocity Files 
The velocity of both P and S wave is saved in binary format. In order for InSite to recognise the velocity files, you 

must convert your velocity files to binary. The binary file has no header and starts from Vp[0,0,0]. The X-axis varies the 
fastest and the Z-axis the slowest. The C code snippet in Figure 8-13 describes the order of the binary file. 

P-wave velocity binary file 

S-wave velocity binary file 

CSV velocity file 

Lookup table 
parameters 

Report window 

Velocity volume 
parameters 

Build the grid file 

Enable parallel 
processing 
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Figure 8-13: C code snippet for creating the binary velocity files 

 

8.8.3 CSV Velocity File 
 

3D velocity models can be imported into InSite saved as 3Dvoxels in a.csv file. The grid is expected 
to be regular in all 3 dimensions and smooth, i.e. no voxels should be blank or with zero velocity 
value as this would be interpreted as a void and result into reflection or non-propagation of rays 
through them. The velocity model grid must include all the volume where the location search will be 
performed. An example velocity model file is shown in Figure 8-14. 

 

 
Figure 8-14: Example .csv file for the import of a 3D velocity model in InSite. The fields required are the position of 

the centre of the voxel, Vp, Vs and Vp/Vs. 

 
 

 
 

8.8.4 Lookup Table Builder Interface 
For layered model, the travel time can also be precalculated. In the 'Processing Properties' dialog, in the 'Locater' tab, 

set the velocity structure to 'Complex (Tian Raytracing)', 'Complex (VTI Tian Raytracing)', or ‘Complex (VTI Raytracing)'. 
 
The 'Lookup Table Builder' is accessed through the 'Tool' menu in data visualiser. Figure 8-15 shows the builder 

dialog. The travel time table as well as source vectors are also stored in h5 format. The input file is simply the CSV 
files for the P and S waves (see 7.3). The interface only defines the lookup table volume parameters. 
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Figure 8-15: Lookup Table Builder dialog. 

 
 

8.8.5 Using Travel time Grid Method 
 
The travel-time grid method is only available when using the 'Collapsing Grid Search'. In the 'Processing Properties' 

dialog, in the 'Locater' tab, set the velocity structure to 'Complex (Travel Time Grid Method)'. The travel-time table can then 

be imported into memory from Project -> Import Traveltime Data. 
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8.9 Source Scan Method 
This option allows the user to locate an event without manual picking. The source scan method is a global grid 

search method by evaluating the possibility of every grid in the search volume as the source position. The grid point that 
can maximize the stacked energy is considered the most likely source position. For computation efficiency the travel 
time for each grid point must be imported from a pre-calculated travel-time lookup table, i.e. LUT (see Travel Time 
Grid Method). 

 

8.9.1 Source Scan Parameter Setting Interface 
In Settings after select “Source Scan Method”, user should define the autofunction windows size used for P-wave and 

S-wave (Figure 8-16). In general, the window size can be different to account for the high frequency in P-wave and low-
frequency in S-wave. Users can enter Channel View to select the appropriate time window for both P- and S-wave. 
Empirically the Window Size should include one-half to one wavelength of the signal. The autofunction that is selected for 
auto-picking is used to calculate stacked energy. Depending on the signal quality, the modified AIC and the STA/LTA 
autofunction are recommended. 

 
Source scan is to search in three-dimensional space axis and in one-dimensional time axis. For computation efficiency, 

Gaussian Particle Swarm Optimization (GPSO) technique is used (see Appendix 3.9.4). Increasing the number of particles 
will increase the probability to detect the global maximum in a small number of iterations. The combination of large number 

of particles (>1000) and a small number of iterations (5-10) are effective for source scan problems. In scenarios where 
some first arrivals can be picked by a processor, those picks will enhance the optimization. However, the incorrect first 
arrivals will degrade the optimization process. Thus, manual picking is recommended. 

 
When there are no P and S first arrival picks, the source scan uses a built-in 3-pass algorithm designed to run 

GPSO 3 times to increase the likelihood of matching the waveform moveout of both P and S. When users provide 
some P or S first arrivals, the GPSO runs once. Thus expect 3 times more processing time when no picks are 
provided. 

 

 
 

Figure 8-16: The Source Scan parameter setting interface 

 
The CCR Repick is a cross-correlation based technique to refine the theoretical picks after GPSO. Each trace is cross  

correlated with the stacked trace following the arrival time. The shifting is applied to each trace iteratively. It is optional 
for P- or S-wave. The stacked energy space is usually not as smooth as the travel-time based error space. To avoid local 
minima, a conventional grid search can be followed to locate the event using the theoretical arrivals based on the 
location from GPSO (Figure 8-16). The half dimension specifies the volume centred around the location. 
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Figure 8-17:The parameters that are used by Source Scan include P- and S-wave source vector, if ‘azimuth only’ is 

used and the maximum angular residual 

 
 
The source scan can still take into account the source vector to reduce the angular uncertainty. P and/or S source 

vector can be included as a weighting factor in addition to the semblance weight (see Appendix 3.9.4 for more details). 
The source vector parameters shall be turned on and set in the tab of source vector under Processing Settings. Only 
the linearity threshold, front window and back window are effective for source scan.  

 
Note as there are no picks in source scan, "Fix Rotation Window to Pick" has no effect.  
 
 

8.9.2 Using Source Scan Method 
 
The source scan method is one option in the “Inversion Algorithm”. In the ‘Processing Properties’ dialog, in the ‘Locater’ 

tab, set the Inversion Algorithm to ‘Source Scan’. Click Settings for the Inversion algorithm, users can set the source scan 
parameters. The event can be located without any first arrival picks. For events that have first arrival picked, the picked 
time can improve the location accuracy. After locating, the theoretical arrivals from the most likely grid point are used as 
the first arrival picks. If “Source Scan Into Grid Search” is checked, a conventional grid search within the volume 
surrounding the location is performed. 
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Figure 8-18: Select Source Scan method and set parameters 

 
 
The following parameters provide more control on the source scan performance: 
 

1. Use P-wave source vector in Location Algorithm Properties to turn on polarization weight on the stacked energy. 

2. Similarly, Restrict to X-Y plane use azimuth only instead of the 3D source vector. 

3. In addition, the Max. Ang. Residual (deg.) is used as a threshold on the polarization weight. The instrument is 

excluded from stacking when the angular residual is beyond this threshold. 

4. In Auto-picking tab, the Back-window length and Front-window length can affect the autofunction when using 

RMS Amplitude. 

5. When AIC method is selected, AIC parameters and AIC Modified parameters can affect the shape of the 

autofunction. 

 
To process events using the source scan method the following stapes must be followed:  
 
1. Generate the lookup table. First step is creating the HDF5 file containing the theoretical travel-times and source 

vectors modelled for each point in the search volume using the selected velocity model. In order to do this Collapsing 

Grid Search algorithm must be first selected in the Locater tab of the Processing properties menu. 

The velocity model and Grid search volume must be defined here. 
Once the velocity model is selected, lookup table generation is launched from 'Tools>Launch Lookup Table Builder...' 

This opens the window shown in with options for configuration of the search volume and storage of the file.  
 



256 3D Visualiser  

 

 
Figure 8-19 Generate Lookup Table menu for Source Scan 

 
 

1. Load lookup table Once the lookup table file is generated, source scan must be selected as the location 

algorithm in the Locater tab of the Processing properties menu. Once this is selected, load the 

created lookup table by launching Project>Import Travel Time Table... 

2. Locate the event(s) 
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     3D Visualiser 
 
 

Launch 3D Visualiser 

Key Features of Location Tools and Visualiser 

Interface 

Menu Systems 

Scene Properties 

Toolbar 

Drawing Objects Browser 

Scene Properties Dockable Pane 

Scene Objects in the Visualiser 

Time Functions in the Visualiser 

Two-Dimensional Cross Section Plots 

Scene Construction in the Visualiser 

Overview of the Advanced Visualiser Scene 

Drawing Objects Legend 

Density Plane 

Grid Search Box 

Hot Planes 

Frac Orientation Ellipsoid Cylinders and Cuboids 

Spatial Markers 

Uncertainty Analysis 

Stimulated Volumes 

Microseismic based Discrete Fracture Network generator MSDFN 
 
Shake maps 

 

9.1 Launch the 3D Visualiser 
 
The 3D Visualiser is launched by selecting View Location Visualiser in the View menu (Figure 9-1) or from the global 

button bar.  

 

Figure 9-1: Launch of 3D Visualiser from InSite menu. 
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Figure 9-2: 3D Visualiser Button Bar. 

 
 
The 3D visualiser has two modes; standard and advanced. Standard has the appearance of a 3D scene painted on 

a 2D canvas and the advanced (default) uses OpenGL to create a more fluid and realistic 3D scene. Both modes share 
common controls, but the standard mode has certain controls disabled which are marked in Toolbar. By default, the 

toolbar button   is checked on the 3D visualiser button bar (Figure 9-2), enabling the advanced view. 
 
 
 

9.2 Key Features of 3D visualiser 
 

• The '3D visualiser' displays the event locations in a three-dimensional scene. The user can rotate, pan, magnify and 

fly through the scene. 

 

• Events can be displayed in colour and size scales by time and multiple source and event parameters, and plotted in 

different symbol types. Shaded or wireframe error ellipsoids can be displayed for the events. 

 
• A '3D-Grid' can be displayed alongside event locations and scene objects to provide an estimate of scale. 

 
• Receiver and Shot positions are automatically displayed from the default arrays included in the project. 

 
• An 'Information Bar' displays the magnitude scale and orientation of the scene. A histogram plot shows the time-

dependency of the events. The time bins are user configurable and the user can click and drag through the 

histogram where long time spans are used. 

 
• A playback mode allows the user to scan through the time-dependency of the events. 

 
• 'Hot planes', geometrical objects and automated fitted shapes (fracture box and iso-surface) can be inserted 

and manipulated in the scene to analyse lineation (fracture) and seismically active volumes. Hot Planes can be 

output to text file for insertion into external software. 

 
• Boreholes, Borehole Logs and 'Complex' 3D objects (such as tunnels and surfaces) can be imported using text 

file formats. 'Complex' 3D objects can also be constructed from AutoCad DXF format drawing files or 

stereographic .STL files. 

 
• Boreholes can be defined using different types represented by different colours. Available types include 

Exploration, Instrumentation, Gas Injector, Water Injector and Producer. 

 
• All scene objects include a user-configurable time dependency. In playback mode only active objects are displayed 

allowing the growth of an installation or petroleum field to be mapped with the event locations. 

 
• All properties of scene objects are available through point and click actions. Links between the tools allow the user  

to swap from the Location to Waveform and Mechanism Visualisers to aid processing and interpretation. 

 
• Multiple camera positions can be set so that the user can easily flip between different views of the scene. 

 
• A collapsing algorithm enables potential structures (e.g. faults) to be defined and visualised. The algorithm uses an 

iterative shifting of event locations within defined error ellipsoids. 
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9.3 Interface 
The main features of the 3D visualiser Window are shown in Figure 9-3. 
 

• Function toolbar - from here the user can access the full functionality of the 3D visualiser. 
 

• Mode selector toolbar - these icons are used to select the 'Mode' of operation. Move the mouse over each icon 

and a small help window informs the user of its use. 

 
• Event window - this is the main window for viewing the events. A wire-frame box defines the reference frame 

(View-box). The centre of the viewing area is defined as the 'Centre of Attention' (CoA) and is marked as a 

black dot. The CoA controls how the scene is viewed by the user. 

 
• Info bar - this provides the user with information about the current scene. The magnitude scale shows the colour 

key for the magnitude range defined by the user. The event histogram bar shows the data that is currently shown 

on the screen in terms of events binned in time. This bar is important when using the 'Play Events' mode. If the 

whole histogram is not displayed, then the user can left-click on the bar and move the histogram through time. 

The current view is defined by a set of viewing parameters shown in the centre of the Info bar. Further explanations 

of how these parameters define the current view are presented in the Camera Model.  

 
 

 

 
 

Figure 9-3: Screen capture of the 3D Visualiser 

 
 
 
 
 

9.4 Menu Systems 
 

9.4.1 Scene Sub-Menu 
The scene sub-menu allows access to the following (Figure 9-4): 
 

• Properties - opens the Scene Properties Dialog 

• Edit Scene Objects - opens the Scene Objects Editor. 
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• Playback - initialises playback mode. 

• Camera - see the Camera Sub-menu. 

• Edit User Cameras 

• Drawing Object File 

• Import Grid File - import grid file created using array analysis. 

• Import Stimulated Reservoir Volume - import iso-surface file created using stimulated reservoir volume. 

• Collapse Events 

• Import Tomography File (future release)- 

• Direction Indicator - select between North/East/Down and X/Y/Z labels 

• Hide COA - Hide/Show the centre of attention (COA) in the centre of the screen 

• Show All Sensor Axes - show any valid X/Y/Z axes for all the instruments in the scene 

• Screen Capture - save a bitmap image of the scene (Images saved in a folder named 'Screenshots' in the same 

directory as the pcf. If the pcf does not exist, screenshots are saved on the desktop.). Default hot key is Ctrl + 

Space. 

• Import Image file -import a BMP image file to be displayed in the viewer. 

• Import DFN - import discrete fracture network to be displayed. It uses the 3DEC .dat asci format. 

• Velocity Model Plane - add a 2D plane to show the velocity model. You can decide the position along the 3rd-axis 

using the options in Figure 9-5. Once it has been imported you can right-click on the plane to set colour and 

transparency from the properties page. 

 

 
Figure 9-4: Scene sub-menu. 
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Figure 9-5: Changing the extent and location of the velocity model plane. 

 
 
 
 

9.4.2 Mode Sub-Menu 
The mode sub-menu (Figure 9-6) allows the user to choose which operation to apply to the Scene in order to manipulate 

the user's view. These are described in Manipulating the View in the Visualiser. 

 
Figure 9-6: Mode sub-menu 

 
 
 

9.4.3 Scene Object Menus 
The various Scene objects have menu systems associated with them. These can be obtained by right-clicking on the 

object. 
 
The right-click menu for an event has the following options: 
 

• Properties - launches the event properties Dialog. 

• View Waveforms - switches to the Waveform Visualiser for the selected event 

• View Mechanisms - switches to the Mechanism Visualiser for the selected event 

• Delete Location - deletes the location stored to the event 

• Disable Event - disables the selected event 
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• 180◦ Relocation - constructs a new grid search, 180° round the monitor array and reruns the location 

algorithm (only valid for use with a single linear monitoring array) 
 

• Set Active - sets the event as active, changing its appearance in the view 
 

• Select as Centroid - sets the event location as the centroid for certain location algorithms 
 

• Select as User 3D Position - sets the user event position at the same point as the selected event or shot 
 

• Mark to Show Distance - select for a distance calculation in the scene 
 

• Show Distance - show the distance relative to another selected object in the scene 
 

• Mark to Show Vector - select for a vector calculation in the scene 
 

• Show Vector - show the vector between two objects in the scene 
 

• Set as COA - set as the centre of attention for the scene 
 

• Show Error Space Plane - displays uncertainty space using density planes 
 

• Event Type... - change the event type (shot, earthquake, noise) 
 

• Show Sensor Axes - display any valid X/Y/Z axes of an instrument 
 

• Show Ray Traces - show rays for the selected event (only works for Tian layered velocity model) 
 

• Show Source Vectors - show the source vectors from each instrument to the selected event (three options: full 

3D, azimuth only, or azimuth and plunge) 

 
• Log Properties - Select the type of log to display and the colour scale type if disk mode enabled 

 
• Log Display Mode - Select whether to display the log as a wave or as coloured disks 

 
Most of the other objects in the scene have only some of these options available in the right-click menu. 
 
 

9.5 Scene Properties 
The scene properties Dialog can be launched using the  button on the 3D Visualiser toolbar. The scene properties 

dialog (Figure 9-7) contains five tabs to configure the following: 
 

• Events 
 

• Time 
 

• Camera 
 

• Colours 
 

• 3D grid 
 

• Objects 
 

• Collapsing 
 

• Clustering 
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Figure 9-7: Scene Properties dialog. 

 
The appearance of the events, shots (perfs), and sensors that are displayed on the screen can be altered by accessing 

the 'Scene -> Properties' item from the menu bar and clicking on the Events tab as shown in Figure 9-8. Here the user can 
choose what type of symbol is displayed in the visualiser. 

 
The following options are available for 'Symbol Type': 
 

• Sphere 
 

• Error Ellipsoid 
 

• Component Symbol - events are plotted according to the symbol selected for the component in the Data Visualiser 

(Component List Menu) 

 
• Event Type Symbol – events are plotted according to the type (Event, Shot, Noise, or User defined) in the 

Event type (Setting the Event Type). 

 
• DFN Plane – Events that have MSDFN (MSDFN) calculated and stored in the ESF file can be displayed as square 

planes. The size of the plane is proportional to the source radius. 

 
• DFN Disk – Events that have MSDFN (MSDFN) calculated and stored in the ESF file can be displayed as ellipsis. 

The short axis of the ellipsis is proportional to the source radius. The long axis is in parallel to the rake diction. 

 

• Beach Ball – Events that have MSDFN (MSDFN) calculated and stored in the ESF file or have moment tensor 

solution calculated (Source Mechanism Tool) can be displayed in 3D beach balls. When both the MSDFN and 

moment tensor solution are calculated, the fracture plan from the MSDFN result is used to rend the beach 

ball. The moment tensor solution beach ball shall be viewed in the mechanism view (button F in Table 5.1). 
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Figure 9-8: (left) Event Symbol Type. (right) Event Size Scale dropdown menu. The same parameters can also be 

used to define the symbol colour. 

 
 
When DFN Plane or DFN Disk is selected, and when there are multiple fault planes from the moment tensor 

decomposition, user can select either one fault plane for display to manually adjust the general orientation of all  DFN 
planes or DFN disks see Figure 9-9 below. Note that MSDFN only provides a single set of DFN and thus after MSDFN 
calculation this option of switching between two fault planes become unavailable.  
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Figure 9-9: Right click on any DFN plane or DFN disk, when a second fault plane is available, the option‘Fault 

Plane 2’ in the menu will be available. 

 
The colour of the events can also be varied in the 'Colour Scale' drop-down box: 

• Location Magnitude 

• Instrument Magnitude 

• Constant Colour - all events are shaded in red. 

• Time - events are shaded by time according to the range specified in the 'Time Tab'. 

• Component Colour - events are shaded according to the colour selected for the component in the Data Visualiser 

(Component List Menu). 

• Defined in Frac Manager Stage - for Frac Manager tool 

• Moment Magnitude 

• Seismic Moment 

• Source Radius 

• S:P Ratio 

• Number of P-wave picks 

• Number of S-wave picks 

• Number of arrivals used in the location 

• Number of independent sensors used (in the location) 
 



266 9.5 Scene Properties  

 

• RMS residual time 

• RMS location error 

• Event radiated energy 

• Apparent stress 

• Static stress drop 

• Cluster index 

• Cluster label 

• Number of neighbours 

• Signal-to-Noise Ratio 

• RMS noise 

• Angular residual 

• Confidence number 

• P signal to noise ratio 

• S signal to noise ratio 

• Uncertainty North 

• Uncertainty East 

• Uncertainty Down 

• Mean P/SH: averaged amplitude ratio of P and SH. 

• Mean P/SV: averaged amplitude ratio of P and SV. 

• Mean SH/SV: averaged amplitude ratio of SH and SV. 

• [Data name] in Pumping Chart: Only visible when pumping chart is created and parameters have been selected in 

the pumping chart Dialog (see example of "Treating pressure in Pumping Chart" in Pumping Data). 

The user can also select the relative size of the events in the visualiser and the limits of the magnitude shading. The 
magnitude shading can also be deactivated from this window. When using the RMS residual time and RMS location error 
options for colour scale, the user also has the option to 'Reverse scale' using the check box. Selecting "User defined limit" 
locks the minimum and maximum limit values and deselecting it reverts to the auto limits. 

 
The symbol radius can be adjusted to control the size of objects (events, sensors, shots etc.) in relation to the whole 

scene. It is important to choose a larger value if the events are too small to be seen or to choose a much smaller value  if 
the events are so large, they cannot be distinguished from each other. 

 
The symbol quality governs how accurately the objects are represented in the scene.  If there are a very large number 

of events it is advisable to select a lower symbol quality otherwise the scene may take a significant length of time to appea r 
on the screen. 

 
The symbol type drop-down box works in the same way as on the existing Events Dialog page. The user should select 

'Filled Circle' or 'Open Circle' to show all the events as spheres. To display the events as error ellipsoids, select either 
'Wireframe Error Ellipsoid' or 'Shaded Error Ellipsoid'. The size of error ellipsoids can be controlled using the Ellipsoid D isplay 
Multiplier control. To display the events according to the component symbol, select 'Component Symbol'. 

 
Note that events are drawn as shown for each component symbol: 
 

• Square 

• Disk or Circle  

• Cross  

• Diamond  
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Options for varying properties associated with time are located in the 'Time' tab. This gives the user the option of what 
events to display; showing all the events or limiting to the User-set minimum and maximum ranges displayed below. See 
Time Functions in the Visualiser for further details. 

 
When first entering the 3D Visualiser window, the default camera view is from directly above the plane representing 

the Earth's surface down onto the data set. This represents the 'default' camera position. As well as moving the camera 
around the scene using the mouse functions, the user can manually select the Camera's position and orientation from 
the scene properties in Figure 9-11. This is useful if an exact view of the scene is required. The amount of perspective 
applied to the scene can also be changed from here. A lower perspective decreases the feeling of depth applied to 
scene objects. 

 
The 'Colours' tab identifies the default colours used for shading the 'Borehole-Types' used in InSite. Further 

information about this can be found in Boreholes and Wells. The colours tab also provides controls for the colour of the 
scene background, the 3D grid, the text and the grid search box for users that have permission for the Advanced 3D 
Visualiser mode. 

 
 

 
Figure 9-10: The Colours tab in the Scene Properties sheet. 
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The '3D-Grid' tab shown in Figure 9-12 is used to set the parameters for a grid displayed in the 3D visualiser. 
This can be turned on or off using a check box. The size of the box is set up using the 'Limits' and 'Grid Increment'.  
 
 

 
Figure 9-11: The Camera Properties tab in the Scene Properties sheet. 
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Figure 9-12: The 3D Grid Properties tab in the Scene Properties sheet. 
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The 'Objects' tab shown in Figure 9-13 contains options for scene objects. 
 
 

 
Figure 9-13: The Objects tab in the Scene Properties sheet 

 
The 'Collapsing' tab (Figure 9-14) shows the input parameters for the collapsing events algorithm. 
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Figure 9-14: The Collapsing tab in the scene properties sheet 

 
The 'Clustering' tab (Figure 9-15) shows the input parameters for the event clustering algorithm. 
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Figure 9-15: The Clustering tab in the scene properties sheet 
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9.6.1 Hot Planes 

 
 

The InSite package allows the user to define and view other screen objects, not just events. These objects can be given 
'start' and 'end' times so that they become active and passive in the playback mode. 

 
Hot Planes can be used to indicate where fractures are occurring within a cluster of events. 
 

To add a hot plane, select the  button from the toolbar and then "draw" a hot plane by left-clicking within the 3D 
scene and dragging the mouse before releasing it. By subsequently right-clicking on the new hot plane created, it is possible 
to perform a series of different operations via the pop-up menu which appears. For instance, selecting the 'Properties' 
option allows the colour of the plane to be altered while selecting 'transparent' allows the plane to  be made to appear 
realistically transparent with respect to the other objects in the scene (Error! Reference source not found.). Note that t
hese operations can also be performed by selecting the hot plane within the Drawing Objects Legend.  

 

 

 

Figure 9-16: Transparent Hot Plane 

 
 
 

1.1.1 Adjust Hot Plane Position Size and Orientation 
 
Adjusting the position, size and orientation of a hot plane can be performed using the pop-up menu option "Adjust", 

which launches a Dialog (Figure 9-17). 
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Figure 9-17: Adjust Hot Plane Dialog box. 

The slider controls can be used to adjust the azimuth and dip of the hot plane. Also, the hot plane can be moved using 
the Northing, Easting and Depth slider controls. Finally, the hot plane's size can be changed using the height and width 
slider controls. Updates will take effect immediately within the 3D scene. The 'Reset' button can be used to centre the 
slider controls again. 

 
 
 

9.6.2 Play Events Mode 

 

The Play Events Mode allows the user to visualise the events in time. 
Clicking on this button resets the horizon to be horizontal in the current view. This is useful after the user has employed 

'fly' mode and may have left the view at a skewed angle. Effectively this resets the 'wing-tips' on the camera orientation 
marker to be horizontal. 

 

9.6.3 Reset Volume 

 
This is useful in situations where the user becomes disorientated and perhaps all the events or other screen objects are 

out of the viewing window. This function will reset the viewing reference frame back to a default setting around the events. 
The camera orientation will be such that the user sees a plan view of the volume. 

 

9.6.4 Remember Camera Position 

This option is useful if the user wishes to store a particular view of the data. On clicking this function, the user 
is prompted to enter a name for the particular view. The view position and camera settings for this view are then stored so 
that the user can instantly jump to the particular view by selecting from the view list of the 'Reset camera' option described 
below. A maximum of 10 views can be stored in this way. 
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The 'Edit user cameras' option on the Scene Menu allows the user to edit or delete the different views that have been 
stored. 

 

9.6.5 Reset CameraView List 

Clicking on this function resets the current view to the top view in the 'view list'.  The user can access any of 
the saved views by clicking on the arrow and selecting from the drop-down menu. 

 

9.6.6 Collapse Events 

 
This function collapses the events within their error ellipsoids. This is useful for interpreting finer-scale structures 

within the data as scatter in the locations is reduced. The catalogue of the collapsed events is saved as a different 
component in the PCF project. After collapsing, clicking this icon can switch between the original and collapsed 
locations. Any modification of the parameters or event locations would require another calculation of collapsed 
events. The procedure used in the collapsing algorithm is described in the Technical Appendices Section 3.7. Settings 
are configured from the 'Collapsing' tab on the Scene Properties Dialog box. 

 
 

9.6.7 Manipulating the View in the Visualiser 
There are 4 modes that allow the user to manipulate the current view of the data. These can be accessed from the 

'Mode' option on the function toolbar or from the icons on the mode selector toolbar. Once selected, the user can use the 
mouse or keys or a combination of the two to manipulate the scene. The main Modes of operation are:  

 
 

9.6.7.1 Rotate Scene 

 
This rotates the camera with respect to the centre of attention. This opens up a slider bar for rotating the scene, 

alternatively while holding down the left-hand mouse button drag the pointer in the direction you wish the scene to move. 
Note that the camera position and current direction of the view will change, but the distance to the CoA will remain 
constant, as will the viewing volume. This mode is useful when changing the orientation of the view for the scene. In this 
mode the horizontal orientation is always maintained as the scene is rotated. 

 

9.6.7.2 Pan 
 

This mode moves the camera position across the scene but maintains the current viewing direction with 
respect to the CoA. This has the effect of moving the CoA relative to the scene. Chose this mode and then, while holding 
down the left mouse button, move the pointer in the direction you wish the camera to move. Note that in this mode the 
camera position (and CoA) will change, but the current View parameters and viewing volume will remain the same. This 
mode is useful for changing the position of the CoA with respect to the events.  

 

9.6.7.3 Magnify 

 

 
This mode is used to provide an increased or reduced view of the scene. Choose this option and, while holding down 

the left-hand mouse button, move the pointer up (to zoom out) or down (to zoom in). In this mode the CoA remains 
constant and the camera moves towards the CoA along a vector defined by the current view orientation.  The distance 
between the camera and the CoA and the distance to the front and rear of the viewing volume is altered in this mode. This 
mode is useful for changing the size of the field of view on the screen. 

 
 

9.6.7.4 Fly 



276 9.6 Toolbar  

 

 

 
This mode is provided to allow the user to 'fly' through the data volume. In this mode, movement is controlled by both  

the mouse and the keyboard. Select this mode from the toolbar as before and then: 

• The mouse rotates the CoA with respect to the camera position. Click and hold on the left-hand mouse button and 

drag the pointer in the direction you wish the CoA to rotate around the camera. This can be considered equivalent  

to a 'yaw' (change in azimuth) or 'Pitch' (change in climb/dive angle) when flying an aircraft. 

• Keys Q/W - using these keys the operator can rotate the scene around a vector joining the camera position with 

the CoA. The camera position, CoA and viewing volume remain the same, the horizon simply changes with respect 

to the horizontal. This can be considered equivalent to a 'roll' when flying an aircraft. 

• Keys S/X - using these keys the user can fly in and out of the scene, and even 'through' the scene if required. In 

this operation the relative position of the CoA and the camera remains the same. The user effectively 'flies' 

along a vector defined by the line connecting the camera and the CoA. 

• Keys A/D - using these keys the user is able to pan left and right across the view (this behaves in the same way 

as moving the mouse pointer left and right in PAN mode). 

 
Keys F/V - using these keys the user is able to pan up and down across the view (this behaves in the same way as 

moving the mouse pointer up and down in PAN mode). 
 

9.6.7.5 AutoRotate Scene 

 
This function sets the scene rotating, by moving the camera around the COA in a horizontal plane.  
 

9.6.8 Pressure Graphs 

 

 
For pumping data visualization. See Frac Manager. 
 

9.6.9 Plan Views 

 
Clicking on this function launches the two-dimensional cross-section plots. 
 

9.6.10 Display Legend 

 

 
This button toggles the display of the Stages object legend. 
 

9.6.11 Toggle Object Labels 

 

 
Toggles the labels of objects in the 3D Visualiser on and off. 
 

9.6.12 Insert Event Position 
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This button allows the user to add a theoretical event position in the 3D Visualiser (User Specified Event Location). 
 
 

9.6.13 Show Events 

 
Toggles on and off the display of events in the 3D Visualiser. 
 

9.6.14 Show Receivers/Shots 

 
Toggles on and off the display of receiver and shot objects in the 3D Visualiser. 
 

9.6.15 Show Hidden 

 
Causes any objects that have been 'hidden' to be displayed in the 3D Visualiser. 
 

9.6.16 OpenGL Mode 

 

 
Launches the Advanced 3D Visualiser Module (figure). 
 

9.6.17 Insert Ellipsoid 

 

 
Active only in Advanced 3D Visualiser Tool (Figure 9-2) this button inserts a fracture ellipsoid (). The ellipsoid properties 

can be manipulated from the legend. 
 

9.6.18 Insert Cylinder 

 

 
Active only in Advanced 3D Visualiser Tool (Figure 9-2) this button inserts a cylinder (figure). The cylinder properties can 

be manipulated from the legend. 
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9.6.19 Insert Cuboid 

 

 
Active only in Advanced 3D Visualiser Tool (figure) this button inserts a cuboid (figure). The cuboid properties can be 

manipulated from the legend. 
 

9.6.20 Fit All Objects 

 

 
This function will reset the viewing reference frame back to a default setting around all objects in the scene.  The COA 

is set to the vertical centre of the objects and the view orientation is set to horizontal, though the azimuth remains  
unchanged. 

 

9.6.21 Fit All Events 

 

 
This function will reset the viewing reference frame back to a default setting around all events in the scene. The COA is 

set to the vertical centre of the events and the view orientation is set to horizontal, though the azimuth remains unchanged.  
 

9.6.22 Show Density Plane 

 

 
Active only in Advanced 3D Visualiser Tool (figure) this button launches the event density plane (figure). 
 

9.6.23 Set Orthographic Projection 

 

 
Active only in Advanced 3D Visualiser Tool (figure) this button sets the visualiser to an orthographic projection of the 

scene. 
 

9.6.24 Uncertainty 
 

 
Launch  the dialog to configure the visualisation of location uncertainty for located events.  

9.6.25 Stimulated Volume 

 

 
Active only in Advanced 3D Visualiser Tool (figure) this button launches the stimulated volume Dialog. 
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9.6.26 Launch Array Analysis 

 

 
This button launches the Array Analysis Dialog. 
 

9.6.27 Cluster Index 

 
Calculate the cluster index for all located events. 
 

9.6.28 Cluster ID 

 
Define the cluster ID. 
 

9.6.29 Cancel Cluster ID 

 
Cancel the cluster ID. 
 

9.6.30 Toggle Pulsate Active 

 

 
When an event is set as active, either by relocating or right-clicking on the event and selecting 'Set Active', this button 

causes the event to pulsate. 
 

9.6.31 AutoProcessor 

 
Open the auto-processor dialog. 
 

9.6.32 Filter Events 
 

Opens the event filter dialog. 
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9.6.33 MSDFN microseismic discrete fracture network 

 
Opens the dialog to calculate discrete fracture network. The details are shown in Stimulated Volumes. The fracture 

network planes can be displayed as squares or ellipses, the size of which corresponds to the fracture radius. When 
displayed as ellipsis the orientation of the long axis represents the rake. 

 

9.7 Drawing Objects Browser 
The drawing objects browser is a dockable pane (Figure 9-18) that shows all the objects in the 3D visualiser. It can 

be shown and hidden by using "View -> Drawing Object Browser" menu option. Right clicking on any object in the 
browser retains the full menu options as right-clicking on the actual object in the scene and serves as a way of selected 
objects that are small on the screen (e.g. grid search box). 

The browser lists the objects displayed in the scene (excluding events) in the form of a tree structure. Each object 
is categorised as either: 

 
• Complex Object 

• Borehole 

• HotPlane 

• Sensor 

• Ellipsoid 

• Cylinder 

• Cuboid 

• Distance Marker 

• Vector Marker 

• Direction Indicators 

• Well Object 

• Grid Plane (array analysis grid) 

 
• Component 

• Fracture Box 
 

• Stimulated Reservoir Volume 

• Ray Paths 
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Figure 9-18: 3D Visualiser Drawing Objects Browser tab. 
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The mouse can be used to launch a pop-up menu (Error! Reference source not found.), appropriate to the type of o

bject, by right-clicking on the object in the tree. This menu is the same one as described earlier, available when an object 
is selected from the scene itself using the mouse. If an object has previously been hidden, then selecting it within the tree 
enables it to be shown again in the scene. For example, in the example scene shown in Figure 9-19 a Hot Plane object is 
currently shown but by using the pop-up menu indicated it is possible to hide,  move or delete  the object in the 
scene. The menu also allows the properties Dialog to be launched. 

 

Figure 9-19:3D Visualiser Drawing Object Pop-Up Menu. 
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9.8 Scene Properties Dockable Pane 
 
The scene properties dockable pane provides a quick way to adjust the appearance of certain objects in the scene 

without having to open the scene properties. It can be shown and hidden by using "View -> Scene Properties" menu 
option. Using any of the combo boxes or sliders will adjust the corresponding objects in the scene. Affected objects 
include: 

 
• Event symbol type 

 
• Event colour scale 

 
• Event size scale 

 
• Event radius 

 
• Sensor radius 

 
• Perf radius 

 
• Borehole radius 

 
• Borehole log radius 

 
 

 
Figure 9-20:  Scene properties dockable pane 
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9.9 Scene Objects in the Visualiser 
The Scene Object Editor Boreholes and Wells Hot Planes 
Complex Screen Objects Menu to Edit Drawing Objects 
Importing and Exporting Screen and Drawing Objects Exporting HotPlane Drawing Objects 
 

9.9.1 The Scene Object Editor 
The Scene Object Editor (Figure 9-21) allows the user to manage 3D objects that appear within the Scene. 
 
Click on the 'Add' button to import a new scene object. There are three types of object that can be imported.  
 

9.9.2 Boreholes and Wells 
A useful feature is the ability to display wells and boreholes in the plot. This is important for understanding the 

relationship between injection and production wells and the pattern of seismicity. Well data is imported from the 'Scene - 
Edit scene objects' menu (see diagram below). Choose 'Add' and select the scene object type as 'borehole'. The user is then 
prompted for a file containing the well data in ascii format ( .dat). 

 
The ascii well files are in a standard spread-sheet format. The files consist of 5, space delineated columns. Each 

line specifies a point on the well/borehole. Some well files may contain a large number of data points. A few lines from 
an example file are shown below: 

 

 
 
The program only reads in the last 3 columns. These are height (depth) measured in feet, positive is upwards. The 

fourth and fifth columns are latitude and longitude respectively. 
 
Boreholes and Borehole Logs can also be imported using the DOF format explained in Importing and Exporting 

Drawing and Screen Objects (Exporting 'HotPlane' Drawing Objects). 
 
On plotting, the well is shown as a line extending from a triangle (the top of the well). Once imported, the way the 

borehole is plotted can be changed from the 'properties' menu. This includes whether or not a label is plotted and the 
start and end date for the operation of the well. The well can also be hidden in the same way as a plane by right-
clicking with the mouse and choosing 'hide'. This is returned using 'scene-camera-show hidden' as before. The 
well/borehole is also colour-coded to indicate its current use. The default colours are given in Table 9.1. If log data has 
been imported, you can also right-click on the borehole use log display mode to choose whether to display the data 
as disks or a wave. The log properties show which log data is represented by the disks/wave and which by the colour. 

 
Well objects can also be added from the Frac Manager (Well Objects). Times for these well objects can be adjusted by 

right-clicking on them and selecting properties. 
 

Table 9.1: Default colours used for the different types 

 

TYPE COLOUR 

Exploration black 

Instrumentation brown 

Gas Injection green 

Water Injection blue 

Production red 

Inactive (all types) grey 
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The user can change these default colours by selecting 'scene-properties' from the function toolbar and selecting the 

'colours' tab. The red:green:blue colour mix of each borehole type can then be altered to meet the user's  requirements. 
 

 

Figure 9-21: The Scene Object Editor Dialog Box. 

 

9.9.3 Hot Planes 
Hot Planes, and their manipulation, are discussed further in Hot Planes. In this function a default plane is inserted with 

a vertical orientation through the centre of the 'view-box' volume. 
 
 

9.9.4 Images 
 
 

Images can be imported into the 3D Visualiser to aid in the interpretation of the spatial distribution of seismic events. 
Images are imported by clicking on Scene->Import image File… (Figure 9-22). Images saved as bitmap files (.bmp) are 
projected onto a plane that can be oriented, translated and sized using a dialog launched by right-clicking on the imported 
image (Figure 9-23). 

 
Figure 9-22: Import of .bmp image files into the 3D visualiser. 
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Figure 9-23: Imported .bmp image and image properties and display dialog menu. Bitmap image from Google Maps  

(2021)[Shrewsbury, UK][Satellite map] (https://www.google.co.uk/maps/@52.7077231,-
2.7542356,2018m/data=!3m1!1e3) accessed 20.01.2021. 

 

 
Figure 9-24: Display editing for imported bitmap images. 

 

9.9.5 Complex Scene Objects 
 
The program has the ability to add complex screen objects from an stereolithography CAD files (.stl) or an Autocad 

drawing exchange file (.dxf). In this way, digital topography or geological structures can be imported if these are 
available in STL or DXF formats. The user is asked to locate the appropriate STL or DXF file and this is then automatically 
imported. After selecting an STL or DXF file to import, the import options dialog (Figure 9-25) will open. The X, Y, and 
Z axis options provide a way to align the STL/DXF XYZ coordinate system with the project NED coordinate system, 
similarly with the distance units parameter, converting between STL/ DXF distance units to project units. All entities 
within the STL /DXF will, by default, be added to a single complex object within InSite. If the 'Split by Layer' option is 
checked, a complex object will be created for each layer within the file. If the align to point option is checked, the centre 
point of the imported complex object will be translated to the specified point. 

 
Right-clicking on the object opens a dialog that allows editing the display properties of the object (Figure 9-26). This 

allows changing the position of the object, colour, transparency and temporal properties of the object.  
  

https://www.google.co.uk/maps/@52.7077231,-2.7542356,2018m/data=!3m1!1e3
https://www.google.co.uk/maps/@52.7077231,-2.7542356,2018m/data=!3m1!1e3
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Figure 9-25: DXF and STL Import Options dialog 

 
Figure 9-26: Visualisation editing options dialog for STL Complex objects opened by right-clicking on the Complex 

object 
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9.9.6 Menu to Edit Drawing Objects 
Right-clicking on any object in the 3D Visualiser scene will open a menu with different options depending upon the 

object. Typical menu items (Figure 9-27) allow the user to access object properties, hide the object, calculate and show 
relative distances and set the object as the Centre of Attention (COA) of the scene. 

 

 
Figure 9-27: Right-click Menu to Edit Scene Objects 

 
The distance between two drawing objects can be shown in the 3D Visualiser scene (NOT the Advanced 3D 

visualisation). Right-click on each object and select 'Mark to Show Distance', then right-click on the first object again and 
select 'Show Distance'. A line connecting the two objects will then be plotted along with the distance between them in 
the 3D Visualiser scene (Figure 9-28). Right-clicking on the new distance marker generates a menu allowing the user to 
hide or delete the marker or to reveal further properties. The distance markers are shown in the 3D Visualiser legend and 
can also be manipulated through the legend interface. 

 

 
 

Figure 9-28: Example of object distances shown in 3D Visualiser scene 
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9.9.7 Importing and Exporting Screen and Drawing Objects 
 
In order to allow the user to save sets of screen objects for inclusion in other data sets, the program is able to import 

and export its own file that specifies screen objects. This is a Drawing Object File (DOF)  format. 
The user can create their own DOF files using a standard editor and thus import combinations of planes, sensors, 

boreholes and complex objects into any InSite scene. 
 
 

9.9.8 Exporting HotPlane Drawing Objects 
 
Selecting "Export HotPlanes" will save all the HotPlane drawing objects to a Drawing Object File (DOF), using the 

format described above. These can then be easily imported into another InSite Project through the "Import" function.  
 
 
 
 
 

9.10 Time Functions in the Visualiser 
 
The 'Playback' mode allows the user to view temporal trends in a data-base of seismic events. This mode can be 

selected from the icon in the 'mode selection toolbar' or from 'Playback' in the Scene menu in the function toolbar. This 
will open the Playback toolbar from which the user can control how the data is displayed. This is shown in the  diagram 
below (Figure 9-29). In general use, the events associated with a particular time bin are displayed and then replaced by 
the events in the next time bin and so on. 

 
 

 

 

Figure 9-29: Playback controls. 

These controls can be thought of as working in the same way as a Media Player and the user is able to play 
continually or step through the events (frame-by-frame) as desired. The events are distributed into bins. The user can 
define the number of events in these bins and the way in which the bins of data are displayed in 'Playback' mode from 
the 'scene properties' menu. This is accessed by selecting 'Scene' and then properties from the function toolbar and 
selecting the 'time' tab. Within this window the user can select which events from the enabled components to display 
and to window these events with a minimum and maximum time. To change the way the events are displayed in the 
'Playback' mode the user can alter the 'Histogram/Playback Parameters' as follows: 

 
Number of Time Bins the time period defined by the minimum and maximum time limits is divided into this number 

of bins. The corresponding time interval is displayed under this box. In other words, each time bin then represents that 
amount of time. 

 
Playback Rates this defines the number of bins that are displayed in any 1 second. Increasing this number increases 
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the speed with which the events are displayed. Time Bins Behind this allows the user to define a number of bins before 
the current one that are left displayed as the playback steps forward. Time Bins in Front this allows the user to define a 
number of bins ahead of the current one that are displayed as the playback steps forward.  

 
The event histogram bar displays the number of events in each bin for the full period of time specified by data in  the 

currently active components as a series of blue bars. The events that are currently displayed on the screen (the 'active bins') 
are highlighted in the grey region and the bins themselves turn red. During playback mode, or when 'paused' the user can 
quickly scan through the data by clicking with the mouse on this highlighted region and dragging  back or forward through 
the dataset. This can be enlarged by extending Information Bar pane. 

 
 

 

 

Figure 9-30: Event histogram. Red bars indicate the time period displayed. 

 
 

9.11 Two-Dimensional Cross Section Plots 
 
 

The toolbar button  in the 3D Visualiser is used to launch one of five possible cross section plots. The user is 
required to select from one of the view orientations (Figure 9-31). The Auto Set Frac Orientation button is checked on the 
first occasion that this Dialog appears. It is used to specify that the best-fit frac ellipsoid is calculated by the system rather 
than being selected manually by the user. This takes the form of a horizontal ellipsoid which can be manipulated  on two 
separate plots. An example cross section view (East-North orientation) is shown in Figure 9-32. 

 
A cross section plot shows a 2D representation of the same objects that are visible in the 3D visualiser, these being the 

well track, well log, calibration shots, geophones and events. In addition, the distance between the well head positions is 
shown along with an ellipse which can be manipulated using the mouse to select the fracture plane.  The ellipse dimensions 
are shown in the top left-hand corner (if appropriate) and in the bottom right hand corner a legend is shown specifying the 
colour associated with Frac Manager stages. The ellipse appears on the East-North and View onto Fracture Plane plots. 

 
 
 

 
Figure 9-31: Cross-section View Selection Dialog 
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Figure 9-32: Example East-North Plot (includes ellipse, well-head distances and labels). 
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9.11.1 Properties Dialog 
 
On selection of the Properties menu (Figure 9-33) option it is possible to change the size and layout of the plot. The Fit 

axes by combo box allows the user to select the size of the plot such that either: a) all objects are visible, b) all the eve nts 
are visible or c) user-defined limits are applied. 

The Y->X button is used to update the X minimum or X maximum values based on edits made to the Y minimum  

and Y maximum values, whilst the X->Y button is used to update the Y minimum or Y maximum values based on 
edits made to the X minimum and X maximum values. 

The checkboxes at the bottom can be used to turn on/off various items in the cross-section plot which may or may not 
be required for display. Note these options are also available on the toolbar. 

 
The cross-section view after the Dialog box selections have been applied is shown in Figure 9-34. 
 
 

 
Figure 9-33: Fracture Viewer Properties Dialog. 
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Figure 9-34: Modified Cross-section View (does not include ellipse, well-head distances or labels). 

 
 

9.11.2 Manual Selection of the Fracture Plane Ellipsoid on the East-North Plot 
Manual selection of the horizontal position, length, width and azimuth of the fracture plane ellipsoid can be performed 

using the ellipse which appears on the East-North plot. 
 
To reposition the ellipse, use the mouse to select the filled black circle at the centre of the ellipse then drag it with  the 

left button pressed down as shown in this Figure 9-35. 
 
To rotate the ellipse, select one of the two filled black circles on the edge of the ellipse then drag it in the tangential 

direction. 
 
To increase or decrease the size of the major or minor axis of the ellipse, select one of the two filled black circles on the  

edge of the ellipse then drag it along that axis. 

 
Figure 9-35: Ellipse and filled black circles used to select the fracture plane with the mouse on the East-North plot. 
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9.11.3 Manual Selection of the Fracture Plane Ellipsoid on the View onto 
Fracture Plane Plot 

Manual selection of the depth and height of the fracture plane ellipsoid can be performed using the ellipse which 
appears on the View onto Fracture Plane plot. 

 
To reposition the ellipse, use the mouse to select the filled black circle at the centre of the ellipse then drag it up or 

down with the left button pressed down as shown in Figure 9-36. 
 
To increase or decrease the vertical size of the ellipse, select the filled black circle on the edge of the ellipse then drag 

it up or down. 

 
Figure 9-36: Ellipse and filled black circles used to select the fracture plane with the mouse on the View on to 

Fracture Plane plot. 

 
 

9.11.4 Auto Refresh 
By selecting File->Start Timer on the cross-section view, the plot will automatically refresh every five seconds so that 

new events can be automatically displayed. This auto refresh mode is cancelled by selecting File->Kill Timer. Note: The 
fracture plane should not be adjusted if any of the plots are in auto refresh mode. 

 
 

9.11.5 Toolbar Options 
The toolbar contains the following buttons: 

 
The Insert Text Box button allows the user to annotate the cross plot with text (Figure 9-38) and connecting lines. 

Buttons are also provided to easily enable or disable items on the cross plot such as the object labels and the  legend. 
 
 
 

9.11.6 Insert Text Box 
In order to insert a text box, the Insert Text Box button can be selected from the toolbar and the mouse positioned at 

an appropriate item on the plot that requires additional explanation via a text box. The left button should be held down 
and repositioned to where the text box is required. A line is then drawn between the current mouse position and the new 
position. When the mouse button is released a Dialog (Figure 9-37) appears allowing the user to enter some text. On 
pressing the OK button, the text box appears on the cross plot as shown in Figure 9-38. 
  

Insert Text Box 
 
Toggle Object Labels 
 
 
Toggle Legend 
 
Toggle Ellipse 
 
 
Toggle Well Head Distances 
 
Toggle Maximum Viewing Distance 
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Figure 9-37: Dialog to enter contents of a text box (can include carriage return/line feed). 

 

 
Figure 9-38:East-North Plot with Text Box. 
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9.11.7 Edit Text Box 
It is possible to edit, delete and move the text box that has previously been inserted. To do this the mouse must be 

placed within the text box rectangle and the right mouse button clicked; a pop-up menu then appears (Figure 9-39). 

 
Figure 9-39: Text Box Pop-Up Menu. 

 
 
By selecting Edit Text a Dialog appears (Figure 9-37), allowing the user to modify the text. By selecting Delete the 

text box is removed from the plot, subject to user confirmation. By selecting Move the text box can be subsequently  
moved in conjunction with a move of the mouse. The left mouse button should be pressed when the new position  has been 
reached. Note that the point at the opposite end of the connecting line from the text box rectangle remains fixed in a Move 
operation. If, however, it is desired that the text box and the connecting line are both moved together then the Move 
(Translate) option should be selected instead. 

 
 
 
 

9.12 Scene Construction in the Visualiser 
 
 

9.12.1 The Camera Model 
 
 
InSite uses a camera model that allows the user to view the scene from any orientation and to control the amount  of 

information and its relative position, within the event viewing window. In order to control the appearance of the current 
view, it is helpful for the user to have an understanding of how the view is controlled by InSite. 

 
Figure 9-40 provides a schematic overview of the main components of a particular view. The key positions are the 

camera and Centre of Attention (CoA). The camera position corresponds to the point from which the observer is viewing 
the scene. The centre of attention sits at the centre of the current view. It is represented by a small black dot in the centre 
of the viewing window. The viewing direction is defined as the line joining the current camera position and the CoA.  

 
The viewing volume is defined from the camera position, CoA and the current perspective. The distance between 

the camera and the CoA (labelled d) defines the depth-of-field of the current view. This extends from the 'front view 

plane' (defined as d/100) to the 'rear view plane' (defined as d x 100). The width of the current view is controlled by 
the perspective setting (set from the 'camera' Dialog box in the scene-properties sub-menu). This can range from 10 
(narrow) to 130 degrees (wide angle). 

 
 
The user is provided with information relating to the current view from a list of parameters within the info bar at the  

bottom of the viewing window (examples are shown in Figure 9-41). 
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Figure 9-40: Overview of the InSite camera model showing the key components 
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• POS - the current position of the 'camera' in terms of the Cartesian co-ordinate system, (North, East and Down). 

NOTE: the co-ordinate system has a positive sense in the North, East and Down directions, i.e. increasing depth 

translates to a more +ve value in the down coordinate. 

 
 

• VIEW - the current direction in which the observer is viewing the scene with respect to the CoA. The values  are 

azimuth (the direction in which the user is looking), plunge (the angle down from the observer to the CoA) and 

distance (the distance between the viewer's position and the CoA. 

 
 

• VIS - this defines the front and back planes of the viewing volumes. The first number is the distance to the front 

plane of the viewing volume and the second number is the distance to the back plane of the viewing volume. Only 

events and scene objects that lie between the front and back viewing planes are displayed in  the event window. 

 
A camera orientation marker shows the current orientation and view relative to the horizon (this operates much like 

the 'artificial horizon' in an aircraft). The horizon is horizontal when the 'wings' are level. If the view is inverted, then the 
marker turns red. A description of these features is given in the diagram below. 

 
 

Figure 9-41: 3D Visualiser Viewing Parameters: Examples of the viewing parameters specified in lower information 
bar. 

 
 
 

The user can control the 'perspective' of the view by selecting 'scene -> properties' from the menu toolbar and clicking 
the 'camera' tab. The slider bar can be used to alter the perspective. Effectively this alters the cameras Field of View (FOV). 
A wider FOV (higher viewing angle) gives greater perspective. The user can also manually set the Centre of Attention (COA), 
distance from camera to COA and camera view from this Dialog box. Used in conjunction with the 'remember camera' 
option below, the user can set and save any desired view. 

 

9.12.2 The Camera Sub-Menu 
 
The camera sub-menu contains various functions that change how the user views the Scene or what objects appear 

within the Scene.  
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Figure 9-42: The Camera sub-menu. 

 
• Remember Camera - remembers the current view settings. 

• Reset Camera - resets the view back to the user's top view. 

• Reset Volume - resets the volume settings to a volume defined by the events. 

• Reset Horizon - resets the current view's horizon. 

• Show Events - switches the display of events on or off 

• Show Receivers/Shots - switches the receivers and shot locations on or off 

• Show Labels - switches text labels displayed on the scene on or off 

• Show hidden - redisplays all hidden scene objects 

• Auto-rotate scene - rotates the scene around its centre of attention. 
 

9.12.3 The Drawing Object File Sub-Menu 

 
 

 
Figure 9-43: The Drawing Object File sub-menu. 

 
 

• Import - imports a Drawing Object File (DOF). 

• Export - exports HotPlanes to a DOF formatted file. 
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9.13 Density Plane 
The 3D Visualiser includes colour density plane display for a variety of source parameters including Event Density, 

Radiated Energy, Cluster Index, Seismic Moment, S:P ratio, Source Radius, Signal-to-Noise Ration, Confidence level, 
RMS Residual Time, Fault Plane orientations (strike, dip, rake). In the example shown (Figure 9-44) the 3D volume of 
signal-to-noise ratio is shown as a colour coded map across a particular plane in 3D space. A clipping box is defined in 
order to specify a volume of interest and within this it is possible to display a plane in one of three possible orientations. 
The plane can be moved (in a N/S direction in this example) within the clipping box by the user to show a variation in 
the density map with position. This is performed using a 'play' toolbar within the Plane Colour Scale legend as shown. 
Note that the arrow keys can also be used to move the plane when the user has set the focus on the 3D scene. The 
colour density map is created by dividing the plane in to a grid. At each grid point a cell whose volume is configurable 
is used to perform the calculation. If multiple events are found in a given cell volume, the average is used as the value 
at this cell grid point. 

 

 

Figure 9-44: The example of the Density Plane and Right Click Menu 

 
 

9.13.1 Configuration 
To configure the Density Plane it is necessary to launch the scene properties Dialog, using the 3D Visualiser toolbar 

button  , the density plane properties dialog is then launched (Figure 9-45).  
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Figure 9-45: Density Plane properties tab in the Scene Properties Dialog 

 
The clipping box limits are initialised to the same limits used for the view box.  They can be altered here as well on the 

plot itself (see later). The orientation specifies how the plane is oriented within the clipping box and can be "North -East", 
"North-Down" or "East-Down". Up to three orthogonal density planes can be simultaneously included in the scene. 

 
The 'Density Type' selection allows the method used to generate the density map to be altered. By default, the 

density type is set to "Event density", this means the density is calculated to be the number of events per cubic metre 
(if the scene units are set to metres) for each cell. The other options specify particular event parameters which are 
used to weight the calculation accordingly. 

 
When the density map is created a pixel map is generated using an interpolation algorithm which is subsequently 

shown on the plane. This pixel map resolution can be altered to vary the quality of the density map image. Note that 
higher resolution images take longer to generate. 

 
The cell volume itself is defined using the cell north, cell east and cell down entry fields. The cell dimension 

determines the size of meshes used to discretize the clipping box volume, and thus the number of grid points used in 
calculating the density map, e.g. if the clipping box is 100x100x100 metres in size then a cell dimension of 5 in north, 
east and down directions will give rise a grid with dimensions 20X20X20. The cell dimension affects how many events 
are included in the cell volume. Select a larger cell depth to include more events within the vicinity of the plane and 
patterns are smooth. 

 
The Min. and Max. Density entry fields are used in the generation of the colour map. Default values are filled in for 

these fields when the density type is changed. The colour map varies from dark blue for values at or near the min. density 
to red for values at or near the max. density via the colours of the spectrum. Note that a log scale can be selected by click ing 
the checkbox where indicated. 

 
The colour scheme is determined by the colour-map chosen on the Advanced tab of the scene properties (figure). The 

density plane can be exported to a bitmap file by right-clicking on the density plane and selecting 'Export' from the menu.  
 
 
 

9.13.2 Adjust Clipping Box Dimensions 
As well as specifying the clipping box limits within the scene properties Dialog, it is possible to adjust them using the 

mouse in the visualiser view. To do this it is necessary to right-click on the density plane or the outline of the clipping 
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box and select the 'Properties' option on the pop-up menu that appears; a Dialog appears (Figure 9-46). 
 

 
Figure 9-46: Advanced 3D Visualiser Density Plane Clipping Box Dimension Adjuster 

 
The slider controls can be used to adjust the dimensions of the clipping box and changes will immediately take effect 

within the 3D scene. The 'Reset' button can be used to centre the slider controls again. 
 

9.13.3 Density Plane Right-Click Menu 
 
Right-click on any one of the density planes, a drop-down menu appears (Figure 9-47). 
 

 
Figure 9-47: Density plane right-click dropdown menu 

 

• Property - open the property dialog for parameter adjusting. 
 

• Adjust - adjust the clipping box dimension. The 3D volume of the density field will be different after adjustment.  
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• Export - export the density plane as bitmap 

 
• Set Focus - set one plane at focus such that the plane can be shifted by click arrows on the keyboard. 

 
• Delete - delete the current density plane. Note that the 3D volume of the density field will be deleted as well. 

The 3D volume is used to generate iso-surface. 

 
• Show Isosurface - render an iso-surface at the medium value of the density field. The iso-surface value can be 

adjusted after generation (Figure 9-48). Note that the iso-surface cannot be adjusted after deleting or adjusting 

the density plane. 

 
 

 
Figure 9-48: Isosurface right-click dropdown menu. The surface colour is consistent with the colourbar by default 

and can be overwritten by the user 

 
 
 

9.14 Grid Search Box 
 
The Grid Search Box is normally configured from within the Locater tab of the Processing Properties  Dialog. However, 

its limits can also be adjusted using the mouse from the 3D Scene. Ensure that the "Show Grid Search Box" checkbox has 
been selected from the View Box page within scene properties, then right-click on the outline of the grid search box to 
bring up a pop-up menu (Figure 9-49). Select 'Adjust' to bring up a Dialog (Figure 9-50) to adjust the grid search dimensions. 
Select 'Properties' to launch the Location Algorithm Properties Dialog where the user can adjust the cell dimension, 
resolution and collapsing buffer as well as the grid search dimensions. 
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Figure 9-49: Advanced 3D Visualiser Grid Search Box 

 

 
 

Figure 9-50: Adjust Advanced 3D Visualiser Grid Search Box 

 
The slider controls can be used to adjust the dimensions of the grid search box and changes will immediately take effect 

within the 3D scene. The 'Reset' button can be used to centre the slider controls again.  
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9.15 Frac Orientation Ellipsoid, Cylinders and Cuboids 
 
The user can insert ellipsoids, cylinders and cuboids into the 3D scene to aid interpretation and analysis. Their position 

and properties can be updated using Dialogs launched from the legend or right-clicking on the object.  
 
The volume of the shape is given on the Properties Dialog. 
 

 
 

Figure 9-51: Frac Orientation Ellipsoid 

 
 

 
Figure 9-52: Shape properties Dialog. 
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9.16 Spatial Markers 
 
 
The 3D Visualiser provides a way of displaying markers showing the relationship between two objects or vector 

information for a single object. The markers displayed include distance between two objects, vector between two objects, 
instrument orientation, event source vectors, and event ray paths. 

 
 
 

9.16.1 Distance Markers 
 
 
To add a distance marker right-click on an object and select ‘Mark to Show Distance’, then right-click on the next 

object and select Show Distance. The distance will be shown above a line joining the two objects and listed in the 
legend. 

 
Figure 9-53: Distance Marker. 
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9.16.2 Vector Marker 
 
 
A vector marker can be used in two ways; a vector between two objects or as the axes of a receiver. To add a vector 

marker between two objects right-click on an object and select Mark to Show Vector, then right-click on the next 
object and select Show Vector. To display a sensor vector, right-click on the sensor and select Show Sensor Axis (to 
show the axes of all the sensors in the scene, select "Show All Sensor Axes" from the scene menu). The vector is 
indicated using arrows and the azimuth and plunge measurements. These are also listed in the legend. To remove the 
sensor axes, right-click on "Vector markers" in the Drawing Objects Browser or on the sensor name under "Vector 
Markers" and select "Delete" in the pop-up menu. 

 

 
 

Figure 9-54: Vector Marker 



308 9.16 Spatial Markers  

 

 
 
 
 

 
Figure 9-55: Sensor Axes 
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9.16.3 Ray Traces 
 
 
The ray traces (Figure 9-56) for an event can be shown by right-clicking on an event and selecting "Show Ray Traces". 

This will display all the ray paths from each instrument to the event. This only works when the velocity model is set to 
Tian ray tracing. 

 
 

 
Figure 9-56: Event ray trace visualisation 
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9.16.4 Source Vectors 
 
The source vectors for an event can be shown by right-clicking on an event and selecting "Show Source Vectors" 

and choosing one of the following three options: 
 

1. Full3D - show a single source vector for each instrument that includes both the azimuth and plunge (Figure 
9-57). 

 

2. Azimuth Only - show a single vector for each instrument that contains azimuth information only (Figure 
9-58). 

 
3. Azimuth and Plunge - show two source vectors for each instrument, one for azimuth and one for plunge 

(Figure 9-59). 

 
 

 
 

Figure 9-57: Event full 3D source vector visualisation 
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Figure 9-58: Event azimuth only source vector visualisation 

 
 

 
Figure 9-59: Event azimuth and plunge source vector visualisation 
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9.17 Uncertainty Analysis 
Three main features are available: the calculation and visualisation of location uncertainty by posterior probability 

distribution (referred to as confidence isosurface), the calculation and visualisation of angular uncertainty of all 
events, and the display of error space planes for a specific event. 

 
The confidence isosurface can be launched for each individual event in 3D visualiser or batch processing using 

autoprocessor (Location Uncertainty (Req. Location)). The confidence level is set at 68% by default corresponding to 
the first standard deviation from the mean (Figure 9-60). Users are allowed to change the percentage. 

 
 

 
Figure 9-60: The confidence isosurface display for posterior location uncertainty. The confidence level 68% is used 

 

The visualisation of angular uncertainty can be launched using the uncertainty button  on the analysis toolbar 
(Figure 9-61). The error space plane can be launched by right-click on a specific event. 
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Figure 9-61: The user interfaces for Uncertainty Analysis. Top: Uncertainty visualisation dialog launched from the 

‘Uncertainty’ button. Bottom: Error Space Plane visualisation for a specific event 
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9.17.1 Location Uncertainty 
 
 
The location accuracy is determined by many factors including velocity, arrival time, and source vector (polarisation in 

single borehole monitoring cases). The uncertainty is thus best quantified by the posterior probability distribution given 
the a priori probability (the confidence we have) for P&S-wave velocity, P&S-wave arrival picks, and P&S-wave source 
vector. As a result, the higher confidence we have, the smaller the uncertainty in the location. The location uncertainty 
function is to calculate the full probability distribution of location. The grid method is used to calculate the probability in 
the volume defined by the half dimensions (Figure 9-62). The cell size controls the resolution of the isosurface. The 
smaller it is, the smoother the isosurface at the cost of additional computation time. 

 

 
Figure 9-62: The user interface to launch location uncertainty calculation and visualisation. 

 
For best practice, we recommend using the default value for most borehole monitoring projects. In situations, for 

instance, where the velocity can't be accurately calibrated, the velocity uncertainty can be increased accordingly. For low 
sampling rate (e.g. surface monitoring), the arrival time error can be set to one or multiple sampling intervals. When source 
vector is not used, the text box shall be greyed out. If not, please check the processing settings (Source Vectors). To speed 
up the computation for many events, the traveltime grid method can be used instead of raytracing. The computation 
requires the event has been located. Whenever the location parameter is changed, it is recommended to relocate the 
event before performing location uncertainty analysis. 

 
The calculated probability volume is stored in the ESF and PCF for sharing. When only PCF is shared, a different 

user can only alter the confidence level for all events. However, users must have the ESF files to recalculate the 
probability. 

 
The size of the isosurface is stored in the column of LErr.N., LErr.E., LErr.D. 
 
 

9.17.2 Angular Uncertainty 
 
 
Enabling the option for 'Error Visualisation' plots the angular uncertainty for each event in the visualiser. The user 

can select to show the angular uncertainty for each instrument used in event location, or for the RMS value only. The 
angular uncertainty is depicted by an arc, tangential to the ray joining the receiver and event location and with a width 
given by the angular uncertainty of the final location solution. 
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Figure 9-63: Example of angular uncertainty displayed in the visualiser. 
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9.17.3 Error Space Plane 
 
The error space plane is a depiction of the difference between theoretical and measured arrival time and source vector 

information. The Dialog gives the user the option to plot up to three orthogonal planes: East-North, North- Down and East-
Down. The user also specifies the height and width of the planes, in the working distance units of  the project (metres or 
feet), the cell width which gives the resolution quality of the plotted plane, the bitmap resolution and colour map. In 
addition, the user can specify whether the limits of the colour-scale used to plot the error space will be automatically 
calculated or user-defined. 

 
Once the user has configured the settings in the Dialog, error space planes can be created and plotted for an event by 

right-clicking on it in the 3D Visualiser and selecting Show Error Space Plane (Figure 9-64). Once plotted, the planes can be 
deleted, exported and edited by right-clicking and selecting items from the menu. The export option can be used to export 
the information to a bitmap (.bmp) file. The properties option launches an additional Dialog showing the colour scale for 
the error space planes. The limits and colour map for the colour scale can be edited in the properties Dialog to update the 
plot (Figure 9-65). 

 

 
 

Figure 9-64: Error space plane option in the right-click menu for an event in the 3D Visualiser. 
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Figure 9-65: Example error space plane display for an event in the 3D Visualiser. 

 
 
 
 
 

9.18 Stimulated Volumes 
The user can calculate a stimulated reservoir volume (SRV) using the events located within the project. There are 

two methods of calculating the volume: 
 

1. Fracture Box - fit a wireframe cuboid around the events to determine the volume and azimuthal direction of a  

fracture. 

 
2. Iso-Surface - calculate the density volume for a group of events for a given event density. 

 
 
The stimulated reservoir volume Dialog (Figure 9-66) allows the user to change parameters used in the calculation of 

the SRV. 
 

• Mode - Select the type of volume to calculate (Fracture Box or Iso-Surface). 
 

• Search Properties 

 
– Limit By Frac Manager Stage -Only use events that belong to a particular stage or select "All Stages" 

from the dropdown box to batch process all the stages. 

 

– Fracture Box 
 

* Remove Outlying Events - Apply a standard deviation factor to remove outlying events. This 

works by fitting the box around the events and then calculating the standard deviation in the X, Y, 

and Z axes (local box axes) then shrinking the box based on the factor. For example, if a factor of 2 

is entered, events with a location less than 2 standard deviations from the mean will be used. 
 

* Std Dev multiplier - Multiplying factor for the standard deviation. 
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– Iso-Surface 
 
 

* Event Density Iso Level - Density value from which the surface is created i.e. each point on the 
surface will have a value equal to the iso level. 

 

* Grid Resolution - Determines the fineness of the grid. Decreasing this value increases the number of 

voxels in the density volume and increases the number of faces in the iso-surface. The lower the 

resolution the better the accuracy of the iso-surface. 
 

* Radius - Used in the calculation of the event density volume. The event density at each point in the 
grid is the number of events within a sphere centred around each grid point. 

 

* Alpha - Determines the transparency of the final iso-surface (0 = transparent, 1 = opaque). 

* Storage Directory - Storage directory for the iso-surface files. 
 
 

• Grid Volume - the grid volume is set in two ways, either taken from the 'Grid Search Algorithm' parameters by 

pressing the 'Apply Grid Search' button or entered manually by the user. 

 

 
Figure 9-66: Stimulated reservoir volume Dialog. 
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9.18.1 Fracture Box 
Figure 9-67shows a fracture box around a group of stage events and Figure 9-68 shows the same group of stage events 

but with a standard deviation multiplying factor of 2 applied to remove outlying events. 

 
 

Figure 9-67: Fracture box fit to stage events 

 

 
 

Figure 9-68: Fracture box fit to stage events using standard deviation multiplying factor of 2 

 
 

9.18.2 IsoSurface 
 
Figure 9-69 shows an example iso-surface. When the iso-surface calculation is run, there are four stages; calculating the 
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event density volume, calculating the iso-surface using marching cubes, validation of the iso-surface, and writing the final 
surface to file. Right click on this surface will allow for turning off/on the lighting effects.  

 
 

Figure 9-69: Iso-Surface of stage 3 events (Iso-Level = 3, Grid Resolution = 5, Radius = 20) 

 
 
 

9.19 Microseismic-based Discrete Fracture Network 
generator MSDFN 

 
 
MSDFN searches in the space of (Strike, Dip, and Rake) to find the best fracture plane that fits the observed amplitude 

ratios (P/SH, P/SV, SV/SH) of all enabled events in the 3D visualiser. You can select the search volume by defining the 
minimum and maximum values for strike, dip, and rake. The grid cell determines the resolution and you  may lock any 
dimension to a specific angle. 
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Figure 9-70:  MS DFN properties box 

 
The users are given three different calculations method with different level of assumption on the ray path take-off 

angle, which is defined as the angle between the vertical axis (down) and the ray vector leaving the source towards the 
receivers. 

 
• Method 1: Single take-off angle for all events - a single value take-off angle averaged across all source- 

receiver pairs is used. 

 
• Method 2: One take-off angle for each event - the take-off angle averaged across the receiver array for each 

event is used. 

 
• Method 3: One take-off angle for each event-receiver - one take-off angle for each pair of source and receiver is 

used. No averaging is performed, and this method takes more processing time than other two methods. 

 
To speed up the calculation, you can choose to use parallel processing by ticking the Use PPL box. 
 
The velocity can be set using the velocity settings (Figure 9-71). You can choose to use either from a file or from frac 

manager (if available) in the same way as in section7.5. Pressing run would start the optimization. After this you may view 
the amplitude ratio chart. It displays the optimized curve with the observed amplitude ratio and allows you to view all local 
minima and the misfit plane in order to decide the best orientation of the fracture plane (Figure 9-72). 
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Figure 9-71: The velocity settings. 

 

 
 

Figure 9-72: Amplitude Ratio Chart. 

 
To use MSDFN, you can enter the property box from the 3D visualizer. When you click MSDFN, it will use all events that 

are displayed. You may want to select high-quality events by event filtering. For example, you can only display events with 
less location error, or high moment magnitude, etc. 

 
In the MSDFN Dialog, you may choose method 3 for a small number of events as each pair of source-receiver will 

contribute one data point. This is most accurate in theory, but also incorporated more uncertainty from the data. In 
practice, therefore, method 1 or 2 is not necessarily less accurate than method 3, particularly when you already have 
many events to work with. After calculation, you can visualize the result by clicking “Show Amp. Ratio”. The Dialog (Figure 
9-72) will pop up displaying the global minimum, which is not necessarily consistent with the local geology due to 
uncertainties. If the stress regime is known a priori, you browse the first few minima and choose the most appropriate 
one. Click “Save Local” will save the strike, dip, rake angles to the ESF files and can be displayed as DFN Plane/Disk or 
Beach ball (see Scene Properties). “Save global” is simply to save the global minimum to the ESF files. After that, you 
may return to the 3D visualiser and select a different group of microseismic events for MSDFN analysis. 
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9.1 Shake maps 
 

Shake maps plot the ground motion (Peak Particle Velocity, PPV or Peak Particle Acceleration, PPA) caused by a seismic 
event over a surface monitored by calibrated seismic stations with a known response. The maps are created through the 
interpolation of the values of peak motion recorded at each station. The PPV and PPA are calculated each time a shake map 
is displayed, using the settings configured in the ‘Ground motion’ tab of the InSite Processing Properties menu (Figure 9-73). 
The peak motion values are calculated using one of the following options: 

• Station peak RMS amplitude; 

• X channel peak amplitude; 

• Y channel peak amplitude; 

• Z channel peak amplitude; 

• Horizontal peak amplitude (X-Y channel). 

 

 
Figure 9-73: Configuration of PPV and PPA calculation in the InSite Processing Properties menu. 

 
To display the shake map corresponding to the chosen event, right-click on the event to display the dialog shown in 

Figure 9-74, and select the ground motion to display on the map. 
 
The shake map will display as a horizontal plane positioned at the average depth of the seismic stations with valid P-

wave picks (Figure 9-75). The extent of map is hard coded and covers the horizontal extent of the stations used in its 
calculation. 

The scale limits and colour map can be edited using the dialog launched from the ‘Edit’ menu in the colour scale bar 
(Figure 9-76). 
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Figure 9-74: Dialog shown on right-clicking over the chose seismic event with the option to display the Shake 

Map.Configuration of PPV and PPA calculation in the InSite Processing Properties menu. 

 
 
Figure 9-75: Display of a Shake map showing the distribution of PPA measured by a surface array. 
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Figure 9-76: Scale bar and Edit dialog window. 
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 Source Mechanism Tool 
 
Key Features 
Parameter Setting Interface  
Visualiser Interface 
Menu Systems in the Visualiser 
Selecting Data for Display in the Visualiser  
Mechanism Analysis Window in the Visualiser 
 

10.1 Key Features 

• Source mechanism analysis using a Moment Tensor inversion of P-wave and/or S-wave time-domain amplitudes. 

The algorithm assumes a homogeneous-isotropic transmission medium to calculate the theoretical P- and/or S-

wave amplitude. 

• The incident angle from the source to the receiver is calculated by ray-tracing in user defined layered velocity 

model. 

• The Moment Tensor is decomposed into eigenvalues and eigenvectors representing the principal axes (pressure, 

null and tension) of the source. Percentage isotropic, double-couple and CLVD (compensated-linear- vector-dipole) 

components are calculated, along with orientations of the fault plane solution. 

• The eigenvalues also result in a deviatoric (T) and an isotropic (k) representation of the source. 

• An error analysis is included in the inversion and decomposition method. 

• Fault plane solution calculated from the distribution of P-wave first break polarities. 

• The 'Mechanism Visualiser' displays the source mechanism results. The P-wave radiation pattern and fault- plane 

solution for an individual event are displayed on a lower-hemisphere ("beach-ball") plot. 

• The station locations can be displayed on the lower hemisphere, either using the sensor numbering, or by P-wave 

motion type. 

• Links between the Mechanism and Waveform tools allow the user to switch easily during processing. 

• A T-k diagram displays mechanisms from all events so that distributions of event types can be analysed. 

• Mechanism error ellipses can be plotted on the T-k diagram so as to visualise uncertainties in the data set. 
 

10.2 Parameter Setting Interface 
Figure 10-1 shows the inversion parameter setting interface. From here user can select the inversion velocity model 

(currently support effective homogeneous model only) and the waveform amplitude. When the default receiver  array 
includes three-component stations (tri-axial sensors), “Rotated P-wave Time Domain” and “Rotated P-SH-SV Waves Time 
Domain” options are available. To use “Uniaxial Only” method, user must use single axis sensors in the default receiver 
array. To force using a single channel, users must first deactivate 2 channels of the three- component stations and then 
update the receivers in the events to be processed (see Setting Sensor Array). 
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10.2.1 NOTE 
 
When using “Uniaxial Only” method, and applying free-surface amplification correction, both P-wave and S-wave 

velocities are required. Please make sure the velocity for Shear wave is in a reasonable range. If vs is unknown, the 
empirical equation vs = vp/1.732 can be used. 

 

 

Figure 10-1: The layout of the mechanism inversion parameter setting screen.
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10.3 Mechanism Visualiser Interface 
 
 
Figure 10-2 shows the layout of the mechanism visualiser interface window. From here the user can access information 

about the event source mechanism for any event for which such a mechanism has been computed. The user can configure 
the mechanism display in a number of ways to meet their exact requirements. 

 
TIP: Right-clicking the mouse within the Mechanism Display Window allows the user to display the waveforms for  that 

event. 
 
 

 
 

Figure 10-2: The layout of the mechanism visualiser screen. 

 
 
The main features of the mechanism visualiser interface are: 
 

• The Menu Bar, from where the user can select menu items to configure the mechanism display and navigate 

between different parts of the InSite program. 

• The Solution Type selector, from where the user chooses the calculation method for the mechanism: Moment 

tensor, Fault Plane solution from first-arrivals or both. 

• The View selector, from where the user chooses the type of plot for the mechanism data. 

• The Component Selector, from where the user selects which data component to display. 

• The Event Selector, from where the user selects which event mechanism to display. 

• The Mechanism Analysis Window, providing the user with a comprehensive list of parameters associated with 

the processing of the mechanism. 

 

• The Fault Plane Analysis Window, providing the user with a comprehensive list of parameters associated with 

the processing of the fault plane solution. 

• The Mechanism Display Window, showing a graphical representation of the mechanism (or mechanisms) for the 

currently selected event or component. When displaying the focal sphere plot for a particular event, this window 

also shows the data, time and ID number of the currently selected event, as well as the decomposition of the 

moment tensor.
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10.4 Menu Systems in the Visualiser 
 
 

10.4.1 Visualiser Properties Sub-Menu 
 
 

 

 

Figure 10-3: The Visualiser Properties Sub-Menu. 

 
The Visualiser Properties Dialog box allows the user to configure the characteristics of the mechanism display. An 

example of this Dialog box is displayed in Figure 10-4. 
 
 

 
Figure 10-4: Visualiser Properties Dialog Box. 
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The Dialog box is split into two sections, the top one dealing with the options for focal sphere plots and the lower one 

dealing with the Hudson T-k type plot. The options in the upper pull-down menu control the way that station information 
is shown on the focal sphere. The user has the choice of one of the following options: 

 

• Don't show stations; 
 

• Show stations using Markers: filled circles are compressional (+ve) first motions, empty circles are dilatational 

(-ve) first motions; 

 
• Show stations using label: the station name is printed, together with a '+' if the first motion is a compression and 

a '-' if the first motion is a dilatation. 

 
The lower section of the Dialog box gives the options for the Hudson T-k type plot. The user can select two check-boxes. 

The upper one turns event plotting on and off. If the box is not ticked the event mechanisms will not be plotted on the T-k 
plot. The lower check box allows the user to select highlighting of the currently selected event. If this option is chosen, t he 
selected event is coloured blue while the other events in the component are coloured red. Below these check boxes a drop-
down menu allows the user to select how the mechanism data are presented on the T-k plot. These can be either circles 
(open or filled) or ellipses (open or filled). The ellipse geometry is defined by the 'estimated uncertainties' in the moment 
tensor solution shown in the Mechanism Display Window. 

 
 
 

10.5 Selecting Data for Display in the Visualiser 
 
The user can select which data to display from the three selector menus on the top of the Mechanism analysis  window 

(Figure 10-5). 
 

 
Figure 10-5:  The three selector menus used in the mechanism visualiser. 

 
The top selector is for choosing between focal sphere and Hudson T-k plot. The second selector is for selecting the 

component to display. The third selector is for choosing between all events in the component for which a mechanism is 
available. When the 'Focal sphere plot' option is selected from the top menu, the visualiser will show the mechanism and 
analysis for the currently selected event. When the 'Hudson T-k' plot option is selected, the mechanisms for all 'enabled' 
events in the currently selected component are shown. The currently selected event is highlighted (in blue) if the option to 
do so has been selected (Figure 10-6). Examples of the focal plot and T-k plot types are shown in Figure 10-6. 
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Figure 10-6: Examples of the focal sphere and T-k plot types for a set of events. On the left-hand side the focal 

sphere for an event is shown. This includes the orientation of the nodal planes, position of P, T and B axes and the 
regions of compression (shaded) and dilatation (clear) for P-waves. The diagram on the right-hand side shows the 
T-k plot for a data component containing 5 events. The event that is currently selected is shaded blue. The rest of 

events are colour-scaled by time. In this case the user has chosen to plot the event positions as error ellipses 
whose size and orientation reflects the uncertainty in the derivation of the mechanism from the moment tensor 

inversion. 
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Figure 10-7:  Example T-k plot showing the density of events and interpretation labels.. 
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10.6 Mechanism Analysis Window in the Visualiser 
 
Parameters displayed for focal mechanism plots  
Parameters displayed for Tk type plots 
 
The Mechanism Analysis Window is displayed on the left-hand side of the screen and contains information about 

the current mechanism plot. The information varies depending on the type of plot that has been selected. These 
are summarised in the tables below. More information about these parameters and how they are derived is given in 
the Technical Appendices. 

 
 

10.6.1 Parameters displayed for focal mechanism plots 
 

Table 10.1: Parameters displayed for focal mechanism plots. 

 

Parameter Notes 

Seismic Moment The value of the scalar seismic moment computed from the moment 
tensor inversion. 

 
 

Parameter Notes 

Moment Tensor (Euclidean 
Norm) 

The best-fit, unconstrained, moment tensor (normalised) for the 

currently displayed event. The components are displayed in the following 

order: 

 

 
Below this tensor, the estimated uncertainties in each component are 

given. From these, the full range of mechanisms compatible with the data 

can be computed. These can be plotted as uncertainty ellipses on the T-

k plots. 
 
Condition Number  

The condition number from the mechanism inversion procedure. This 
value is equal to the ratio of the largest to smallest term in the singular 
value decomposition matrix used in the inversion. The inversion is 
considered to be 'ill-conditioned' if this value is too large (i.e. the 
reciprocal the condition number approaches the floating point precision 
of the computer). 

Mean Amplitude Residual This is the mean value of the difference between the theoretical 

amplitude derived from the moment tensor at each station and the 

actual normalised amplitude measured at that station. This is a measure 

of 'goodness of fit'. 

Mean Error Factor The error factor measures the difference between the amplitude residual 

and the estimated uncertainty in the original amplitude measurement. 

Large error factors (>>1) are often observed for stations close to a nodal 

plane, or where the amplitude of the signal is small. 

Inversion Quality Index This is a measure of the quality of the inversion based on the 6x6 

covariance matrix. It depends on the Green's functions used, rather than 

the amplitudes. It is computed from the sum of the squares of the 

elements of the covariance matrix. A large number suggests a poorly 

constrained solution and is often indicative of poor focal sphere 

coverage. 

MT Decomposition Results: Notes 
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Eigenvalues These are the values derived from the elements of the diagonalised 

moment tensor. From theory, the largest +ve value represents the T or 

tension axis, the largest -ve value the P or compression axis and the 

intermediate value represents B. These are listed in the order P, B and 

T. 

Eigenvectors Each eigenvalue has an associated eigenvector that represents the 

orientation of the P, B and T axis in coordinate space. 

Axis Azimuth The azimuth of each axis, measured clockwise from North. 

Axis Plunge The plunge of each axis measured down (+ve) from the horizontal. 

Model Components The components of the moment tensor decomposed into isotropic 

(volume change) double-couple and compensated linear vector dipole 

(CLVD). 

Deviation of source from DC A measure of the deviation of the source mechanism from a pure 

double- couple (shear-type) mechanism. F=0 when the source is a 

pure double couple. 

Decomposition (%) The decomposition of the source into isotropic, double-couple and 

CLVD types in terms of a percentage. 

T-k decomposition The source decomposition in terms of T and k parameters. 

Description of source 
mechanism 

A text description of the source. 

Nodal plane data Resulting nodal plane data for the best fit double couple source. For 

each of the two nodal planes, the values for the strike, dip and rake 

are given, together with the azimuth and plunge of the corresponding 

slip vector on each nodal plane. 

 

14.5.1 Parameters displayed for Tk type plots 
 

Table 14.2 Parameters displayed for T-K type plots. 

 

Parameter Notes 

T-k 
decomposition 

The source decomposition in terms of T and k parameters. 

Decomposition 
% 

The decomposition of the source into isotropic, double-couple and CLVD types in terms of a 

percentage. 
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 Stream Visualiser 
 
 
 

11.1 Key Features 
 
The aim of the Stream Visualiser is to view an entire Streamed data set in both the time and frequency domains, 

and to allow a user to zoom into the data so as to study small changes in the data properties. ASC’s Richter system  
acquires a continuous data stream at high-frequency sampling rates (up to 10MHz) and is used in rock mechanics 
experiments to record the complete failure process. The data quantity produced equates to approximately 1.3 billion 
sample points (2.6 Gbytes of data) for each channel, for approximately 5 minutes of recording time. The aim of the 
Stream Visualiser is to view this data, or other long continuous data records, on a standard PC monitor. 

 
 

• The complete time-series data are displayed as a waveform. The user can amplify the signal and zoom 

into the waveform around a selected point. The zoom functions operate down to individual data 

points. 

 

• The complete frequency-series data are displayed on a sonogram. The sonogram can be updated for 

the zoom level and waveform window selected. 

 

• The user can change various display parameters. These include the amplitude and frequency scales 
plotted. 

 
 

 
 

Figure 11-1:  The Stream Visualiser User Interface. 
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11.2 User Interface 
The Stream Visualiser user interface (Figure 11-1) is opened within the InSite Seismic Processor from the InSite 

menu (Figure 11-2), using the 'Stream Visualiser' option. The user must have the appropriate permissions to allow 
this. 

 
 

 

 
 

Figure 11-2: The InSite menu allowing selection of the Stream Visualiser. 

 
 
The user interface is split into two panes. The left-hand pane contains user controls that manipulate the data 

and visualisation. The right-hand pane contains the graphical output of the visualisation, including a waveform 
describing the time-series data and a sonogram describing the frequency series data. 
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11.3 File Formats 
There are three file types that InSite uses to display data in the Stream Visualiser. 
 

1. The Giga Waveform File (GWF) 

2. The Giga Time Summary file (GTS) 

3. The Giga Frequency Summary file (GFS) 
 
Data from ESG's Gigarecorder is stored in a set of RCBUFF format files (often numbering thousands). These are 

written in a sequence of sample point 1 for each channel, sample point 2 for each channel etc up to the last recorded 
sample point. 

This is then repeated for N Events (e.g. N=100) whereupon the data storage is moved to the next file.  While this is 
efficient when raw data is written to file, it is not efficient when attempting to process an individual giga channel as the 
data is split up across the hard-drive, causing significant delays when reading from hard disk to memory. For the Stream 
Visualiser to operate effectively it must access the data in the most efficient method possible.  For this reason, the raw data 
must be reformatted into a set of GWFs. Each GWF contains a continuous binary data stream from a single recording 
channel and thus allows the optimal reading of data directly to a segment of memory from any section of the time series 
data. 

During the GWF formatting process (Formatting the Raw Time-Series Data) a GTS file is also created. This contains a 
summary of the time-series data at different zoom levels allowing the visualiser to display the entire time series  on the 
view and the user to magnify sections of the waveform down to the data point level. 

A GFS file is created when the user builds a sonogram. This contains a map of data used to display the sonogram 
at each zoom level. 

 
The files are stored in a Giga-data Storage Directory selected on the Giga-data Formatting Dialog box (figure). 

When importing RCBUFF data, the files have a naming structure that contains a 'Basename' and the recording channel 
the data corresponds to, for example Gigadata_01.gwf. In this case: Basename = "Gigadata"; Channel = 1.  

 

11.4 The Giga Waveform View 
When the Stream Visualiser is first opened the user must select a data file to visualise. The available files in the 'Giga -

data Storage Directory' are shown in the left-hand pane of the visualiser (Figure 1-3). If no files are present, then the user 
must either select a valid directory or format some raw data. 

 
 

 

Figure 11-3: Example of the Available Files List. 
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The giga-waveform will be displayed when one of the files is clicked on. Different data sets can be stored in the 

same directory and accessed quickly. The data sets are differentiated by the basename.  
 
The giga-waveform display (Figure 11-4) is contained in the upper half of the visualiser interface. The time-location bar 

shows the whereabouts of the waveform window being displayed on the entire giga-data series. 

 
 

Figure 11-4:  The Giga-Waveform Display 

 
 
 

11.5 Formatting the Raw Time Series Data 
In order for the user to visualise the giga-data it must be formatted into GWF and GTS files. The following steps are 

recommended to perform this task. 
 

1. Click on the 'Data Formatting' button in the GigaVisualiser. This opens the Giga-data Formatting Dialog as 

shown in figure. 

2. Select the 'Import Directory'. This is the directory that contains the Giga-recorder raw RCBUFF, SRM, HDF5, 

MIRF, or SEGY files. It can also be the directory above this in the directory structure,  so that the RCBUFF or 

SRM files can be split into sections (as produced by the Giga-recorder). The Import Directory can contain any 

number of files. The 'Format Data?' section will show the number of DAT files found and the predicted space 

required for formatting. 

3. Select the 'Giga-data Storage Directory'. This is the location where the InSite files will be stored. 
 

4. Type a Basename for the output data. [RCBUFF data only.] 
 

5. Set the maximum zoom level to be used in the output GTS file. [SRM data only.] 
 

6. Select whether to automatically remove noise spikes. This function detects when high-amplitude noise spikes 

occur. 

 
7. Select whether to delete the raw file after formatting and whether to overwrite existing output files. 

 
8. Click on 'FORMAT!'. The Format Progress section will feed back information to the user regarding the status of the 

functions. The STOP! button will be enabled allowing the user to stop the functions at any time. This will 

automatically delete data that have already been processed. 
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Figure 11-5: The Stream data Formatting Dialog Box. 
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11.5.1 Datamap.exstream File 
Alternatively,  SRM data can be imported  the import directory must also contain a datamap.exstream file (Figure 11-6). 

This file holds information about the files to be imported, which have a naming format source.SRMBasename.0000 for both 
the .srm and .wve files. The SRMBasename defined at the top of the file is the second part of the raw data file name. 
The source name is the second field in the lines in the file (e.g. SRC1). The final part of the file name gives the waveform 
section number, and all files with the same source and SRMBaseneame will be collated to form a single data stream in 
the order dictated by the final waveform section number. The final field in the lines in the datamap.exstream file gives 
the data location. A check is carried out by the Stream Visualiser to ensure the SRMBasename is consistent between 
datamap.exstream and the raw data file names. 

 

 
Figure 11-6: Example of the datamap.exstream File. 
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11.6 Manipulating the Giga Waveform 
 
 
The Giga-waveform View will initially show the entire giga time series at ZoomLevel=0. The view is set to 800 pixels 

width. The time series is constructed by splitting the entire giga waveform into data point bins and calculating the 
minimum and maximum amplitude values in each bin. This is called a 'summary waveform' and is stored in the GTS file. 
The number of giga-data points within each bin (summary point) is displayed on the view. 

The user can zoom to the next level by left-clicking the mouse on the view. Right-clicking the mouse will zoom out to 
the previous level. The up and down arrow keys can also be used to zoom in and out respectively. Available zoom 
levels are controlled by the information in the GTS file (see example in Figure 11-7). 

 
 

 
Figure 11-7: Example of Time Expansion on a Giga-Waveform. 
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The zoom function is a x4 magnification with each zoom level stored as a summary waveform: the waveform at 

ZoomLevel=1 has a length of 3200 summary points (800x4) etc. At a certain zoom level the summary waveform becomes 
sufficiently long, and the number of giga-data points per summary point becomes sufficiently low, that it is no longer 
efficient to store a summary waveform in the GTS file but instead process in real time. This zoom level threshold is currently 
defined as 100 giga-data points per summary point. The user can then keep expanding until a threshold of two giga-data 
points within one summary point is reached. This is the maximum magnification that a summary waveform can be  
processed. 

 
A slider bar, positioned along the bottom of the waveform window, allows the user to quickly scan through, or precisely 

navigate, the entire giga-data time series. The time-location bar, positioned above the waveform window shows the current 
window location in respect to the entire giga-data series. 

 
Right Click Menu Options 
 

11.6.1 Right-Click Menu Options 
Right-clicking in the waveform display area brings up the menu in Figure 11-8. 
 

• Zoom In - Zoom into the waveform 
 

• Zoom Out - Zoom out of the waveform 
 

• Add Cursor - Add a cursor to the view 
 

• Add FFT Noise Window - Display a Fast Fourier Transform window 
 

• Export - Export the current displayed waveform as either CSV, GWF, or WAV file 
 

• Play - Automatically play through the waveform 
 

• Stop - Stop playing through the waveform 
 

• Save As Image File - Export the current displayed waveform as an image file 
 

 

Figure 11-8: Giga waveform right-click menu options 
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11.7 GigaWaveform Scaling Functions 
 
The following options can be applied to scale the waveform within the window. These are available from the drop-

down box in the 'Data Visualisation' section. 
 
 

• Full Scale - scaled to full amplitude range of Giga-recorder 
 

• Waveform Maximum - scaled to maximum amplitude on the Giga waveform 
 

• View AutoScale - auto scaled to the maximum amplitude in the current view 
 

• User Defined - scaled to a maximum amplitude range set by the user 
 
 
The waveform amplitude is then displayed using the following scaling parameters:  
 

• Full-scale Volts - the voltage range used by the Giga-recorder 
 

• Amplitude scaling - an optional multiplication scaling factor 
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Figure 11-9: Waveform scaling options available on the GigaVisualiser 

 
 
When 'User Defined' option is selected then the 'User Maximum Amp.' parameter defines the amplitude range to view. 

The vertical-amplification buttons automatically modify this parameter. If one of these buttons is clicked on by the user, 
then the 'User Defined' option is automatically set. 

 
The time scaling displayed is set using the parameters 'Sampling Time' and 'Units'. For a 5MHz sampling frequency these 

parameters should be set as shown in Figure 11-9. The time scaling also affects the frequency limits used on the sonogram 
display. 

 
 

11.8 The Giga Sonogram View 
An example of the giga-sonogram display is shown in Figure 11-10. This display represents moving amplitude- 

frequency spectra through the entire giga-data time series. It thus has time along the horizontal axis, frequency along 
the vertical axis and log10 (amplitude) as a colour density function. 

 
The plot is constructed ('Built') from the Sonogram Processing Dialog using the following steps: 
 

1. The entire giga waveform is split into data point bins similar to those used in constructing the summary waveform. 

The number of points in each bin depends on the Zoom Level selected (e.g. at Zoom←› Level=0 then the number of 

bins is 800, thus the number of data points within the bin is GigaWaveform←› Length/800). 

 
2. In each bin, a moving FFT (Fast Fourier Transform) is applied to the waveform section. The FFT uses a length of 

waveform window (e.g. 4096 data points) and a stepping parameter (e.g. 512 data points) specified by the 

user. The FFT produces an amplitude spectrum for the waveform window at each step. All of the FFTs 

produced from one bin of data are then averaged. This produces a 'summary FFT' that is stored in the GFS 

file. 

 
3. Each summary FFT at the selected Zoom Level represents the colour to plot along one vertical line of screen 

pixels. Thus, the GFS file contains a set of pre-processed sonograms to display. The log of the amplitude is 

used so as to represent a wide range of amplitude values in the spectra. 

 
As with the summary waveform, at a certain zoom level the sonogram information to store in the GFS becomes 

sufficiently large, and the number of giga-data points per FFT bin becomes sufficiently low, that it is more efficient to 
process the sonogram in real time. This zoom level threshold is currently defined as 10 FFTs per bin. 
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Figure 11-10: The Giga-Sonogram Display 

 
 
 

11.9 Building the Giga Sonogram 
Once the Giga-recorder raw data files have been formatted into GWF and GTS files it is then possible to build the 

sonogram information. The following steps are recommended to perform this task.  

1. In the Stream Visualiser select a data set to process by clicking on the data basename in the Available Files 

List, or a single .gwf file. This will enable the 'Build Sonogram' button. 

2. Click on the 'Build Sonogram' button to display the Sonogram Processing Dialog box (Figure 11-11). 

3. Select the FFT window lengths and step sizes. The longer the window length then the greater the amount of hard 

disk space required. The shorter the FFT step the longer the processing will take to complete and the  more zoom 

levels that will be stored to file (so larger disk required). 

4. Click on 'Build'. The Build Progress section will feed back information to the user regarding the status of the 

functions. The 'STOP!' button will be enabled allowing the user to stop the functions at any time. This will 

automatically delete data that has already been processed.  

A longer window length means that higher resolution (and thus magnification) can be achieved on the frequency scale.  

 

 

Figure 11-11: The Sonogram Processing Dialog Box 
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11.10  Giga Sonogram Scaling Functions 
 
The sonogram can be scaled in the frequency, time and amplitude domains. The user sets the frequency and amplitude 

scales in the left-hand pane of the visualiser (Figure 11-12). 
 

The frequency scale must be within the range 0 to FNyquist Hz, where FNyquist is the Nyquist frequency for the 

acquisition: 
 
 

 
∆T is the sampling time for the acquisition specified in the Data Scaling section (Figure 11-12). 

The amplitude scale (colour range) can be defined using the following options selected from the drop-down box. 

• Sonogram Limits - use the amplitude range on the current sonogram that is displayed. 

• User Defined - use an amplitude range set by the user. 
For the 'User Defined' option the Min. and Max. Sonogram Amplitude parameters define the range to use.  

 

Figure 11-12: The Sonogram Scaling Parameters in the GigaVisualiser 
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11.11 Refreshing the Giga Sonogram 
The Giga-sonogram plot follows the zoom level and time section selected by the user on the waveform display 

(Formatting the Raw Time-Series Data), hence allowing the user to view different sections of the sonogram at different 
magnifications. 

 
As the sonogram display can take a noticeable time to update then the user must refresh the sonogram to redisplay  it 

by clicking on the 'Refresh Sonogram' button. An example of the expansion function is shown in Figure 11-13. 
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Figure 11-13: Example of Sonogram Expansion. 
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11.12 SRM to HDF5 File Conversion 
 
 
HDF5 is a file format that eases the management of extremely large and complex data collections.  
 

To start the SRM to HDF5 file conversion tool in InSite select Tools>Launch Convert SRM Files Dialog (Figure 11-14). 
 

 
Figure 11-14: SRM to HDF5 Conversion tool 
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In the SRM to HDF5 File Conversion window, press the "Add" button. This will open the "Data Mapping Entry"  window 

(Figure 11-15). The window requires the user to enter the SRM system name and Data Path. The system name will be the 
name of the computer in which the SRM data was acquired (e.g. ICL-Richter-1, now ASC-Richter-1). The Data Path will be 
where the SRM data is stored. Once complete press 'Ok'. If there is more than one computer acquiring  data then simply 
repeat these steps for each Richter unit. 

 
Enter the SRM basename (e.g. data) and the output directory (folder) where the SRM to HDF5 converted files will  be 

stored (Figure 11-15). 
 

 
Figure 11-15: SRM to HDF5 File Conversion window 

 
Select the output directory (folder) where the HDF5 files are to be saved by clicking "Browse" next to the Output Folder 

field. Select the compression type and compression level (for the LZF and LZ4 filters) and set the chunk size. The chunk size 
in the size of each data block written to the HDF file and is limited to between 1 and 1048576 (default is 65536). Select 
"Start" to begin the conversion process. Once started the details of the conversion will appear above the progress bar. The 
number of files left to process will also appear in the files left to process window. 
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11.13 Visualising the Continuous Data Streams 
 
The aim of the Stream Visualiser is to view an entire data stream in both time and frequency domains, and to allow a 

user to zoom into the data so as to study small changes in the data properties. The Richter DAQ system acquires a 
continuous data stream at high-frequency sampling rates (up to 10MHz) to hard drive and is used in rock mechanics 
experiments to record the complete failure process. The aim of the Stream Visualiser is to view this data,  or other long 
continuous data records, on a standard PC monitor. 

 
• The complete time-series data is displayed as a waveform. The user can amplify the signal and zoom into 

the waveform around a selected point. The zoom functions operate down to individual data points. 

 
• The complete frequency-series data are displayed on a sonogram. The sonogram can be updated for the 

zoom level and waveform window selected. 

 

• The user can change various display parameters. These include the amplitude and frequency scales plotted. 
 

 
The stream visualiser can be opened by pressing the Stream button on the InSite global button bar window ( Figure 

11-16). 
 

 

 
Figure 11-16: Stream Visualiser Button 
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Figure 11-17: Stream visualiser window 

In order for the user to visualise the stream data it must be formatted into GWF and GTS files.  The following steps are 
recommended to perform this task. Having opened the Stream Visualiser and clicked on the "Data Formatting" button, 
this will open the Data Formatting Dialog as shown in Figure 11-5. Select the Raw Data Type located in the "Format 
Data?" section (Figure 11-18). 
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Figure 11-18: Raw Data Type drop down box 
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Now click on the Streamed Data Sources button. The Stream Data Mapping window will now open as shown in 

Figure 11-19.  
 
Clicking on the "Add" button will open the Data Mapping Entry window. For each Richter unit being used, insert 

the computer name (e.g. ASC-Richter-1) and the data path to the directory containing the continuous data for import 
(Figure 11-20).  

 
If multiple Richters are being used, i.e. using a Master-Slave configuration, ensure the Master Richter is at the top 

of the list. The blue arrows can be used to move systems up and down in the list.  
 
 The SRM basename is by default data. This will depend on the name used by user when saving the continuous 

data in eXstream16.  
 
The Survey File (TXT Format) is usually available from Milne Leach. It is in ASCII format. For example,  each row 

could be "2014-01-03T17:33:57.021/2014-01-03T17:33:58.031" corresponding to the beginning and the end time of 
one ultrasonic survey.  

 
Multiple survey times can be stored in multiple rows. When such a survey file is used, the data stream within the 

defined time window is ignored to avoid unnecessary triggering time on active survey data, which is available from Milne 
data storage. 

 

 
Figure 11-19: Stream Data Mapping Window 
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Figure 11-20: Data Mapping Entry Window 

Next select "Browse" on the "Stream-data Storage Directory" field and select where the GWF and GTS files are to be 
stored. 

 
Set the maximum zoom level to be used in the output GTS file. (HDF5 and SRM data only). Select whether to 

automatically remove noise spikes. This function detects when high-amplitude noise spikes occur. Click on 'FORMAT!'. 
The Format Progress section will feed back information to the user regarding the status of the functions. The "STOP!" 
button will be enabled allowing the user to stop the functions at any time. This will automatically delete data that have 
already been processed. 
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 Database Tool: InSiteDB 
 
Key Features 
Installation of InSiteDB  
General Usage of InSiteDB  
InSiteDB Transfer Operations 
Acquisition and Display of Measurements and other Graphical Data 
Installation of SQL Server Express Edition  
Event Server Architecture Overview 
Event Server User Operations 
Event Server Event Transfer Process 
 

12.1 Key Features 
 
The Database Tool allows users of InSite, working on networked PCs, to download data to their PC from a remote  

data base managed by InSite on a server computer. The tool's versatility allows the networking to be tailored to the 
organisation's particular requirements. Many databases can be stored on a single centralised computer so that a team 
of users can easily access them (Figure 12-1). Alternatively, individual users can share data between the projects on 
their computers. 

 
InSiteDB is installed under SQL Server and has the following primary objectives:  
 

• To provide a means by which new events generated by the Leach can be automatically transferred from the InSite  

project to another computer running InSite, or an external application with appropriate permissions; 

• To provide a means by which events can be centrally managed in conjunction with an ESF repository; 

• To provide a means for storing data acquired from an external application, which can then be displayed on a real 

time graphical plot within InSite. 

The Event-Server has the following objectives and functionality: 
 

• Any licensed user of the tool can transform their InSite software into an InSite Event-Server (for sending data) 

and/or an InSite Event-Client (for receiving data). 

• The Event-Server and Event-Client communicate across the network using DCOM (Microsoft Distributed 

Component Object Model), allowing event parameter information and event waveform data to be transferred 

between the 'instances' of InSite. 

• InsiteDB runs concurrently with the rest of InSite. Thus, a user working on the Event-Server will not be disturbed 

by an Event-Client viewing or downloading event data from their system. The InSiteDB Dialog box contains a 'Show 

Watch' dialog where the transfer operations can be viewed. 

• The software allows more than one Event-Server or Event-Client to run concurrently in the same instance of InSite 

and in other instances of InSite on the same PC. 

• When the user of an Event-Client logs onto a PC running one or more Event-Servers they are shown a list of 

all the Event-Servers running on that PC and the event information that each contains. 

 

• An Event-Client user sees the events on a server ordered by date and time. They can also see whether their current  

project already contains the Event Parameters/Waveform data held on the Event-Server. 

 
• An Event-Client user can choose which event files, from a selected Event-Server, they wish to download and 

whether to download just the event parameters or both the event parameters and waveforms. The user is then 

updated on the progress of the data download. 
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Figure 12-1:  Example of an InSite data management structure employed at a mine. A centralised computer 
contains seismic databases captured from acquisition systems installed underground. Users on the surface 

network can then visualise the acquired data and download it to their PCs. 
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12.2 Installation of InSiteDB 
 
InSiteDB is installed under SQL Server. These are available in multiple editions including the Express Edition, a 

scaled down, free edition of SQL Server. 
 
It is the use of SQL Server Express which is discussed in this manual in Installation of SQL Server Express Edition. 
 
InSiteDB should be installed AFTER completing an installation of SQL server. An installation program is available for 

installing InSiteDB and the program folder contains the following files: 

• AlterTables.sql 

• Script.sql 

• Setup.exe 
 
Open the folder and run setup.exe  
 
A wizard appears (Figure 12-3); click 'Next' on the first page. On the next page it is necessary to specify the server 

name associated with the SQL Server installation. For a SQL Server Express installation this will typically consist of the 
computer name followed by "\\SQLEXPRESS". If the Express edition is not being used it should suffice to just enter the 
computer name on its own. Click 'Next' three times to progress through the pages. 

 
InSiteDB should now be ready to use from any client PC that can 'see' the computer hosting the database. Note 

that the firewall software should be configured such that clients on the network can establish TCP/IP and/or named 
pipe connections to the database server. 

 
N.B. a default login has been created for using InSiteDB from InSite: 

Login name: InSiteLogin 

Password: a1b2c3d4E 
 

The password can be changed from within SQL Server Management Studio Express by selecting Security->Logins-

>InSiteLogin->Properties from the object explorer. 
 
Note that this login has been assigned an 'Administrator' role on the InSite database. A user who logs on with this 

role can read, write, create, replace and delete objects in InSiteDB. Other database roles are 'Geophysicist' and 'User'. 
A Geophysicist can read, write and create objects in InSiteDB but not replace and delete objects, whilst a 'User' can 
only read objects from InSiteDB. 

 
In addition, other logins can be created for use by InSite using either SQL Server or Windows Authentication. A 

database user must be created with each login and a role membership assigned. To do this select Databases->In←› Site-

>Security->Users->New User from within object explorer. Note that an easier method to do this is available by using 
the Create InSiteDB Users Dialog from within InSite (Add Extra InSiteDB Users). 

Note that carrying out these operations requires System Administrator privilege. 
 
See General Usage of InSiteDB for information about how to launch SQL Server Management Studio Express.  
 
Occasionally an error is reported during the installation that the file InSite.mdf cannot be created because it already 

exists. If this occurs, it is necessary to navigate in Windows Explorer to the directory where this file is located and rename 
it to another file name. Do the same also for the file InSite_log.ldf. Once this is complete retry the installation.  
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Figure 12-2:  InSiteDB Installation Wizard 
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Figure 12-3: InSiteDB Installation Wizard. 
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12.3 General Usage of InSiteDB 
 
View in SQL Server 2008 Management Studio Express 
Configuration in InSite 
Add Extra InSiteDB Users 
 

12.3.1 Prerequisites 
 
Before using InSiteDB, the following must be checked: 

1. The relevant SQL server must have the TCP/IP protocol enabled (Figure 12-4). 
2. Check the relevant SQL server is running (Figure 12-5). 

 
 

 
Figure 12-4: Ensure TCP/IP is enabled in SQL Server configuration manager. 

 

 
 

Figure 12-5: Ensure the relevant SQL Server is running in ‘Services’. 
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12.3.2 View in SQL Server 2008 Management Studio Express 
 

Select Start->All Programs from the Windows Desktop and look for the Microsoft SQL Server 2008 folder. Expand 
the folder and select SQL Server Management Studio. 

 
A Dialog appears as shown in Figure 12-6; enter the appropriate credentials and press 'Connect'. 
 
From the object explorer (Figure 12-7), expand the Databases folder, expand the InSite folder and finally expand the 

Tables folder. 
 
It is possible to view the contents of a table in the database by right-clicking on it, then selecting the Open Table menu 

on the pop-up menu that appears. The contents of the table then appear in the right-hand panel as shown in Figure 
12-8. 

 

 

 

Figure 12-6: InSiteDB Connection Dialog. 
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Figure 12-7: InSiteDB Object Explorer. 
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Figure 12-8: InSiteDB Object Explorer Query. 
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12.3.3 Configuration in InSite 
 
 

From the InSite Data Visualiser select Tools->Launch InSiteDB Events. The modeless Dialog appears (Figure 12-9). 
There are two modes to work with InSiteDB: Server and Client. Both modes can be used in the same PC, and it is 
possible to work with multiple instances in each mode. 

 
The first step is connecting to the database. Select the button 'Configure Connection' to bring up a Dialog as shown in 

Figure 12-10. 
 
Select the Server name either by typing it in or by selecting it from the dropdown list. Note there may be a significant 

time delay between the moment the down arrow button is pressed, and the dropdown list becomes populated. 
 
Enter the appropriate credentials to connect to the InSiteDB Database and press 'Test Connection'. A message will 

appear either stating that connection was successful or the reason for the connection failing.  
 
If the connection is successful, InSite is ready for use with the database. Note that the system will store the login details  

and use them as and when it needs to connect to the database. 
 
The following steps are specific to an instance of InSIte working in Server mode (Figure 12-11): 

1. Specify the InSiteDB Project 
2. Specify the folder that will serve as ESF repository 
3. Click ‘Enable Auto Upload’ to connect to the database 

 
The following steps are specific to an instance of InSIte working in Client mode (Figure 12-12): 

1. Select the Server InSiteDB Project 
2. Point Insite to the ESF repository 
3. Specify a local ESF storage Directory 
4. Specify a local index file storage 
5. Select the options to download waveforms or index files. If not selected, only processed results will be updated 

in the local project 
6. Autorefresh will update the project automatically as changes are found in the central repository.  
7. Update Existing Events will overwrite any processed events in the local project.  
8. Click ‘Online’ to connect to the database  

 
The watch window in Figure 12-13 can be launched clicking ‘Show watch’ to monitor the operations performed by 

InSiteDB. 
 
Note that the database connection Dialog can also be launched from the Graphical Display Selection Dialog (Figure 

12-19), accessible via Tools->Launch InSiteDB Measurements. 
 
The InSiteDB configuration data is stored in the PCF file. 
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Figure 12-9: InSiteDB Transfer Operations Dialog. 

 

 
Figure 12-10: InSiteDB Connection Configuration. 
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Figure 12-11: InSiteDB Transfer Operation in Server mode. 

 

 
Figure 12-12: InSiteDB Transfer Operation in Client mode. 
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Figure 12-13: Watch window to monitor InSiteDB operations. 
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12.3.4 Add Extra InSiteDB Users 
 
It is possible to add extra InSiteDB Database users into the database but in order to do this it is necessary to logon to 

the server as a system administrator, i.e. using the "sa" account with SQL Server Authentication or using a Windows 
Administrator account on the computer. 

 
Press the 'Create User' button to launch the required Dialog (Figure 12-14). 
 
Users can be created to either Windows Authentication or SQL Server Authentication; a password is required in 

the latter case. The role of the new user must also be selected as indicated before pressing the 'Create' button. 
 
 

 
Figure 12-14: InSiteDB Create User Dialog. 

 
 
 
 
 
 
 

12.4 InSiteDB Transfer Operations 
 
Intended Hardware Platform 
Leaching Event Data into the SQL Database Repository Automatic Uploading  
Automatic Refreshing of Events 
Interactive Use of the InSiteDB from Data Visualiser 
 
 
 

12.4.1 Intended Hardware Platform 
 
The diagram in Figure 12-15 shows how the InSiteDB Database is intended for use. A master acquisition system 

running the leach transfers event data to the database and an associated ESF repository, which may or may not reside 
on the same machine. These can then be accessed by one or more users on the network.  

 

• Such users can make updates to the database/repository and be kept up to date with changes made by other 

users. 

 
• One of the user PCs may be left unattended to automatically download new events stored in the database as 

they become available. 

 



12. Database Tool 373  

 

 
 

Figure 12-15: InSiteDB Schematic. 

 

12.4.2 Leaching Event Data into the SQL Database Repository Automatic Uploading 
 
When using the leach on the master acquisition system to acquire new events in real time, it is desirable to be able 

to store these in the database and to store their associated ESFs in a central repository. To do this the Database 
Transfer Dialog (Figure 12-9) must be launched and the ESF Repository selected via the 'Browse' button in the Upload to 
Database group box. 

 
The ESF repository must be a directory which is shared with other users on the network and is accessible to them. 

Events are stored in the database under a project assigned the same name as the InSite project being used to 
leach data. The ESFs associated with these events are copied to a project folder within the ESF repository. 

 
The setting of the 'Automatically Synchronise to InSiteDB' checkbox is crucial to how the synchronisation between 

InSite and InSiteDB behaves when the 'Enable Auto Upload' button is clicked. If the setting is switched off, the InSite 
project is considered to be the 'master' and all events in InSiteDB are refreshed from the project when the button is 
pressed. However, if the setting is switched on then InSiteDB is considered to be the 'master' and all events in the InSite 
project are refreshed from InSiteDB when the button is pressed. Only an 'Administrator' can operate the button if the 
'Automatically Synchronise to InSiteDB' setting is off. This is because of the inherent risk of losing important data stored 
in InSiteDB and the ESF repository if this setting is selected. 

 
An 'Administrator' or a 'Geophysicist' can operate the button when the 'Automatically Synchronise to InSiteDB' is 

switched on. Note that if a project has not already been created in InSiteDB and the setting is on, this will not mean that all 
the events in the InSite project get cleared. Instead, a new project will be created in InSiteDB and events will be created 
there from the InSite project, however InSiteDB will subsequently be the 'master'. The system will also refresh the InSite 
project from InSiteDB at regular intervals depending on the setting of the Refresh Rate. 

 
Press the 'Enable Auto Upload' button to make the system ready to send data to the SQL database and ESF 

repository. The button label then changes to 'Disable Auto Upload'. 
 
An index file is written in an Index subdirectory of the ESF repository project folder as events are inserted. This file 

provides a list of all the full pathnames of the ESFs that have been inserted for each component. 
 

12.4.3 Automatic Refreshing of Events 
A machine on the network running InSite, other than the master acquisition system, may be required to automatically 

download new events from the database (and if necessary, the ESF repository) as they are inserted. To do this the 
Database Transfer Dialog (Figure 12-9) must be launched and the necessary details entered in the Download from 
Database group box. The project name must be selected from the combo box at the top of the Dialog to indicate which 
project on the database is going to be referenced. 
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The 'Include Waveforms' checkbox must be selected if ESF waveform files are required on the client machine. In this 
case the ESF repository must be specified at the top of the Dialog; it may be necessary to map a drive from the remote 
computer to the local machine to access the remote folder. The ESF Storage Directory is used to specify where the ESFs 
are to be stored locally. 

 
The 'Write Index Files' checkbox indicates whether to store Index files in the Index File Directory. This file provides 

a list of all the full pathnames of the ESFs that have been inserted for each component. The Index File Directory is 
used to specify where the Index files are stored. 

 
The 'Auto Refresh' checkbox must be selected if the user wishes to regularly poll the database to obtain new events, in 

which case polling is performed at a rate determined by the Refresh Rate specified at the top of the Dialog. 
 
The 'Update Existing Events' checkbox enables the existing events to be refreshed when they are updated in the 

database by another instance of InSite (changes to updated events in the user's local PCF will be automatically lost  in this 
case). 

 
 
To start the automatic download of new events arriving in the database press the 'Online' button. The button label then 

changes to 'Offline'. New events are then imported automatically as they become available in the database. If the  
connection is lost at any stage, the system will automatically attempt to re-establish the connection. 

 
 
 
 

12.4.4 Interactive Use of InSiteDB from Data Visualiser 
Any user on the network with appropriate access credentials can use the database interactively to update events 

to/from the database. To do this the Database Transfer Dialog (Figure 12-9) must be launched and the necessary 
details entered in the Download from Database group box. The project name must be selected to indicate which 
project on the database is going to be referenced. The 'Include Waveforms' checkbox must be selected if ESF 
waveform files are required. The ESF Storage Directory is used to specify where the ESFs are to be stored locally. To 
begin interactive use of InSiteDB, press the 'Online' button with the Auto Refresh checkbox unchecked. The 
button label then changes to 'Offline'. Now return to Data Visualiser. 

 
In the Data Visualiser (Figure 12-16), a column labelled "DB" indicates which events are under database 

management. The DB column will be set to one of four symbols: 
 

• A tick  indicates that the event matches the database; 
 

• A greater than sign  indicates that InSite has changed more recently for that event; 
 

• A less than sign  indicates that the database has changed more recently for that event;  
 

• A blue cross indicates that the event cannot be matched with any entry in the database. If the user is not 

online with the database, all the events have their DB column indicated by a blue cross. 

 
To update one or more events from Data Visualiser, right-click and expand the InSiteDB operations sub-menu (Figure 

12-17). The four options enable events to be updated to/from the database, deleted from the database or the events to 
be completely overwritten from the database. Only an 'Administrator' will be able to delete events from InSiteDB whilst a 
'User' will only be able to update/overwrite events from InSiteDB. Note that if there are waveforms for an event these are 
copied to/from the central ESF repository that was configured at the master acquisition system. The progress of the 
operation is shown in the Database transfer Dialog. 

 
To update one or more components from Data Visualiser, right-click and expand the InSiteDB operations sub-menu 

(Figure 12-18). The four options enable whole components to be updated to/from the database deleted from the database 
or whole components to be completely overwritten from the database. Only an 'Administrator' will be able to delete 
components from InSiteDB whilst a 'User' will only be able to update/overwrite components from InSiteDB. Note that if 
there are waveforms for events in the component these are copied to/from the central ESF repository that was configured 
at the master acquisition system. The progress of the operation is shown in the Database transfer Dialog. 

 
When all updates have completed successfully, the DB column should be updated to show a tick symbol for the 

relevant events. 
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Finally, it is possible to update the entire project from the database by selecting the 'Update Project' button in the 
Database Transfer Dialog. It will only operate when the user is online to the database. If the Update Existing Events checkbox 
is selected, then existing events will be updated as well as new ones imported. 

 

 
 

Figure 12-16: Data Visualiser InSiteDB Indicators. 

 

 
 

Figure 12-17: InSiteDB Operations Events Sub-Menu. 
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Figure 12-18: InSiteDB Operations Component Sub-Menu. 
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12.5 Acquisition and Display of Measurements and 
other Graphical Data 

Storage of Measurements in InSiteDB 
Graphical Display Selection 
Configuration of Stored Measurements 
Display of Real Time Graph Events Histogram Deselected 
Display of Real Time Graph Events Histogram Selected 
Display of Historical Graph Events Histogram Deselected  
Display of Historical Graph Events Histogram Selected 
 
 

12.5.1 Storage of Measurements in InSiteDB 
The database can be used by data acquisition software applications such as UStream to store data from up to 32 

channels. Each record in the database contains a time stamp, a voltage range, a test description and a set of 32-bit integer 
data values. 

In the case of measurements recorded using UStream, the corresponding voltage is given by the following formula:  
 
 

Voltage Recorded = (2 ∗ Data Value ∗ Voltage Range)/(224 − 1) − Voltage Range 

 
 

12.5.2 Graphical Display Selection 
On selection of the menu Tools->Launch InSiteDB Measurements from Data Visualiser, the Graphical Display Selection 

Dialog is shown in Figure 12-19. This allows the user to select which channels to use in a real time or historical graphical 
display. This is carried out by selecting entries in the list boxes and using the 'Add'/'Remove' buttons. 

 
In addition, a histogram of event occurrences can also be launched from here. 
 

 
 

Figure 12-19: InSiteDB Graphical Display Selection Dialog 
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∗ 

 
 
The Settings dropdown list identifies previous settings for this Dialog that have been saved using one of the 'Save 

Settings' buttons. This allows for quick re-selection of a set of channels and associated display parameters. 
 
The Acquisition Test dropdown list identifies which set of measurements to display on a historical or real time display. 

If 'All Tests' is selected, then no filtering by Acquisition Test will be done. This option is the only option available when no 
measurements have yet been recorded. 

 
For a real time plot the refresh rate and time span can be specified for the graph. The refresh rate specifies how often 

new data is retrieved from the database and the graph updated. The time span specifies the time duration over which 
results are plotted. 

 
For a historical plot the time interval over which results are shown can be specified.  This is done by selecting suitable 

to/from time/dates. These are set by default to the beginning and end times of the data provided by the Acquisition Test 
description. 

 
The 'Export' and 'Delete' buttons are used to export measurements to a CSV file or delete all the measurements for 

a given Test Description. Note that only an 'Administrator' can delete measurements. 
 
In addition to displaying measurements, it is also possible to show a histogram of events beneath the first plot. This 

is achieved by first clicking the Enable checkbox in the Events Histogram group box. Options exist to only show located 
events as well as to vary the number of bins on the plot. 

 
To store the settings for the Dialog, select the 'Save settings as' button. On pressing this, a simple Dialog appears 

prompting the user to enter a name for the settings. This will then be added to the settings drop down list.  To delete a 
Dialog settings entry, a 'Delete' button is available to the right of the settings drop down list. 

 
To update the existing Dialog settings, the 'Save Settings' button is used. 
 
On selection of one of the 'Plot' push buttons, a new pop-up window is launched showing the graph. 
 

12.5.3 Configuration of Stored Measurements 
On selection of the 'Configure' button from within the Measurements group box within the Graphical Display selection 

Dialog, the Measurements Configuration Dialog shown in Figure 12-20. This allows the channels recorded in the database 
to be configured. The tabs along the top can be used to change the range of channels to be edited. 

 
The conversion factor, default voltage and default measurement are used to calculate the actual values which will  be 

displayed from the data held in the database. The formula below shows how this is calculated: 
 
Value Displayed = (Voltage Recorded - Default Voltage) Conversion Factor + Default Measurement 
 
By selecting the 'Set Default Voltages' button, corresponding edit fields in the Dialog can be automatically set from an 

average of the last five recorded voltages in the database for each channel. 
 
By selecting the 'Set Zero Voltages' button, corresponding edit fields in the Dialog can be automatically set to zero for 

each channel. 
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Figure 12-20:InSiteDB Measurements Configuration Dialog. 
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12.5.4 Display of Real Time Graph Events Histogram Deselected 
 
 
 
The Real Time Graphical Display window is launched by pressing the 'Plot' push button located in the Real Time 

Plot group box within the Graphical Display Selection Dialog. 
 
When the real time graph is initialised, a request is made on the database to select measurements for the configured 

acquisition test over the configured time span up until the current time. A graph similar is displayed in Figure 12-21; in 
this example only channels 1 and 2 were selected for display. 

 
The graphical plot will scroll to the left in real time at a frequency determined by the configured refresh rate.  On each 

refresh, new measurements will be plotted on the right-hand side providing data is being recorded. If no data is currently 
being recorded, then no new data will be plotted on each refresh, but the plot will still scroll to the left. 

 
 

Figure 12-21: Example Real-Time Graph 

 
The time span and refresh rate can also be altered using the menu options shown under Properties. By default, the 

ones specified in the channel selection Dialog are used. A simple Dialog appears allowing the refresh rate or time span 
to be changed as desired. These new values will be used for the lifetime of the graph. 

 
The scaling on the vertical axis is determined automatically as results are plotted. It can however be manually adjusted 

by right-clicking to the left of the vertical axis. On performing this, a Graph Axis Configuration Dialog is shown. This allows 
the minimum and maximum vertical axis values to be adjusted, provided the radio button scaling selection  is set to 'User'. 
These values will then be used for the lifetime of the graph. 
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12.5.5 Display of Real Time Graph Events Histogram Selected 
 
 
If the events histogram is selected from within the Graphical Display Selection Dialog, the pop-up window shown 

when the 'Plot' push button is pressed is split into upper and lower parts. The upper part shows the measurements as 
described in the previous section and the lower half shows the histogram of events (located or otherwise) that have 
occurred over the time span defined in the previous Dialog. An example is shown in this Figure 12-22 with 30 histogram 
bins and the time span set to one minute. 

 

 
 

Figure 12-22: Example Real-Time Graph with Histogram 
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12.5.6 Display of Historical Graph Events Histogram Deselected 
 
 
The Historical Graphical Display window is launched by pressing the 'Plot' push button located in the Historical Plot 

group box within the Graphical Display Selection Dialog. 
 
When the historical graph is initialised, a request is made on the database to select measurements for the configured 

acquisition test over the time interval specified by the configured to/from time/dates in the previous Dialog. A graph 
similar is displayed in Figure 12-23; in this example only channels 1 and 2 were selected for display. 

 
The scaling on the vertical axis is automatically determined. It can however be manually adjusted by right-clicking to the 

left of the vertical axis. On performing this, a Graph Axis Configuration Dialog is shown. This allows the minimum and 
maximum vertical axis values to be adjusted provided the radio button scaling selection is set to 'User'. These values 
will then be used for the lifetime of the graph. 

 

 
 

Figure 12-23: Example Historical Graph 

 
 

12.5.7 Display of Historical Graph Events Histogram Selected 
 
If the events histogram is selected from within the Graphical Display Selection Dialog, the pop-up window shown 

when the 'Plot' push button is pressed is split into upper and lower parts. The upper part shows the measurements as 
described in the previous section and the lower half shows the histogram of events (located or otherwise) that have 
occurred over the time interval defined in the previous Dialog. An example is shown in Figure 12-24 with 10 histogram 
bins and the time interval set from 11:25 to 11:35 on 8/7/2008. 
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Figure 12-24: Example Historical Graph with Histogram 
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12.6 Installation of SQL Server Express Edition 
Software Prerequisites  
Installation  
Configuration 
 
 

12.6.1 Software Prerequisites 
Please check Microsoft’s website before installing SQL Server (https://www.microsoft.com/en-gb/sql-server/sql-

server-downloads) to check for the prerequisites for the latest edition of SQL Server Express. This guide was updated for 
SQL Server Express 2019 

 
 

12.6.2 Installation 
SQL Server 2019 Express Edition with tools is downloaded from the Microsoft website along with the accompanying 

SQL Server Management Studio Basic. 
 
The website can be found at: 
https://www.microsoft.com/en-gb/sql-server/sql-server-downloads 
 
A separate download is required to install SQL Server Management Studio (SSMS): https://docs.microsoft.com/en-

us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-server-ver15 
 
During the course of the installation of SQL Server Express the authentication mode is requested, select Mixed 

Mode rather than Windows Authentication Mode and enter a strong password for the sa account.  
 
 

12.6.3 Configuration 
 
 
Once installed it is necessary to ensure that SQL Server Express is configured to support remote connections. To 

do this select Start->All Programs->Microsoft SQL Server 2019->Configuration Tools->SQL Server Configuration 
Manager. The window shown in Figure 12-25 and Figure 12-26 will appear. 

 
Expand SQL Server Network Configuration in the object tree, click on Protocols for SQLEXPRESS (Figure 12-26) and 

ensure Named Pipes and TCP/IP are enabled in the right-hand panel as indicated. 
 
Click on SQL Server Services in the object tree (Figure 12-27) and ensure SQL Server (SQLEXPRESS) and SQL Server 

Browser are running and configured to start automatically. Configuration of each service is performed by right-clicking 
and selecting properties from the context menu that appears. The start mode is then configurable under the Service Tab 
in the Properties Sheet. 

 
Finally restart SQL Server (SQLEXPRESS) by selecting 'Restart' on its context menu. 

  

https://www.microsoft.com/en-gb/sql-server/sql-server-downloads
https://www.microsoft.com/en-gb/sql-server/sql-server-downloads
https://www.microsoft.com/en-gb/sql-server/sql-server-downloads
https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-server-ver15
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Figure 12-25: SQL Server 2019 Configuration 
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Figure 12-26: SQL Server 2019 Configuration Protocols 
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Figure 12-27: SQL Server 2019 Configuration Services 
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12.7 Event Server Architecture Overview 
 
 
 
Figure 12-28 shows the overall architecture of the Distributed Software Tool. Any number of InSite Event- Servers 

can be run on a 'Server Computer'. A user running an InSite Event-Client, on a 'Client Computer', can then access any 
of the available Event-Servers and download data across the network. 

 
 

Figure 12-28: The Overall Architecture of the InSite Distributed System 

 
There are three main software objects that the user interacts with. 
 

1. The InSite Event-Service (Figure 12-29) is a separate application running as a Windows Service. This 

application is controlled by the "Component Services" manager that comes as a part of Microsoft Windows. 

The Event-Service contains lists of available events in all the Event-Servers registered on the local PC. When 

an Event- Client logs onto that PC, it interrogates the Event-Service which then 'broadcasts' the available 

servers and data. 

 

2. The InSite Event-Server Dialog box (Figure 12-30), accessed within InSite, registers the Event-Server on the Event-

Service and sends a list of all the events within its project. The Event-Server then periodically updates this event 

information. The Event-Server is designed to remain continuously active, operating in the 'back-ground'. The 

Dialog box is modeless meaning that the user can still interact with all the normal functions used in  InSite. 

 

3. The InSite Event-Download Client Dialog box (Figure 12-31), accessed within InSite, is run by the user when 

wishing to inspect and/or download any of the events available on the Event-Servers. After selecting the 

appropriate Event-Server the user is given a calendar map (year-month-day) of all the data available. A list of events 

is displayed for the chosen day and the user can select any of the data required. This option therefore allows a 

user to easily investigate how much data has been recorded on a particular day. The user can then download the 

data to their own PC, either as a 'Whole Event Download' or an 'Event Parameters Download'. 
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Figure 12-29: The InSite Event Service running in the Component Services manager in Windows XP. 
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Figure 12-30: The InSite Event-Server Dialog box accessed from within the InSite Seismic Processor. 

 

 
 

Figure 12-31: InSite Event-Download-Client Dialog box accessed from within the InSite Seismic Processor. 
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12.8 Event Server User Operations 
Event Service Event Server 
EventDownload Client 
 

12.8.1 Event Service 
The InSite Event-Service is designed to operate in the background and is invisible to the general user of InSite.  However, 

there may be occasions when the system administrator has to restart the Service. To do this:  
 

1. Run the Windows 'Component Services' software from 'Control Panel'/'Administrative Tools'. 
 

2. Select the 'Services (Local)' icon. You should now find the 'InSite Event Service' in the list of services. 
 

3. Select the 'InSite Event Service' in the list, right-click and press the Restart link. 
 
 

 
 

Figure 12-32: Component Services program with Services shown. 

 
System administrators can configure the service using 'DCOM Config' in 'Component Service'. For more information on 

configuring the service, please consult the Microsoft web-site, or contact ASC for assistance. 
 
 

 
 

Figure 12-33: Component Services program with 'DCOM Config' shown. 
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12.9 Event Server Event Transfer Process 
Background Operations 
Event Transfer Rules 
 

12.9.1 Background Operations 
In the event transfer process, data is downloaded to the client from the server resulting in the user obtaining an image 

of the data set stored on the server. There is no transfer of information in the other direction (from the client to the serv er) 
so that the centralised seismic data base is safe from being inadvertently changed by the client users. When you choose to 
do a 'Whole Event Download' in the Event-Download-Client Dialog, the following operations occur: 

1. A Request containing all the events to download, from a specific Event-Server, is sent to the Event-Service 

which has a connection to the required Event-Server. 

2. The Event-Service redirects this message to the Event-Server which handles the request. 

3. When an Event-Server receives the request, it looks in the project for the requested events. When it finds an 

event, it gets the path to the ESF file which contains the event data. This file is opened and the contents of it 

are sent back, via the Event-Service, to your Event-Client. 

4. Once your Event-Client has received all the ESF files for the requested events, it imports these files into a 

Component which is named after the date on which these events occurred. 

 

When you choose to do an 'Event Parameters Download' in the Event-Download-Client Dialog, the following operations 
occur: 

1. A Request containing all the events to download, from a specific Event-Server, is sent to the Event-Service 

which has a connection to the required Event-Server. 

2. The Event-Service redirects this message to the Event-Server which handles the request. 

3. When an Event-Server receives the request, it looks in the project for the requested events. It then adds each 

event found in the project to a list. This list is then used to generate a VVF file (more details in the Technical 

Appendices (section 2.7), which contains the event parameters. The contents of this file are sent back, via the 

Event-Service, to your Event-Client. 

 

4. Once your Event-Client has received the VVF file for the requested events, it imports this file into a Component 

which is named after the date on which these events occurred. 

 
Every hour, the Event-Server updates the Event-Service with any new events. 
 

12.9.2 Event Transfer Rules 
The transfer of event data is governed by the following rules: 
 

• An Event-Server can only publicise those events for which it has waveforms. Therefore, only those events, in the  

project, which have a related ESF file containing the waveform-data, will be published. 

• An Event-Client cannot download events which are already contained in the Event-Client's project and contain 

the waveform data. If you wish to download the events, you must first delete them from the project. 

• When you choose to download Event-Parameters then only the event parameters will be downloaded. At a 

later time, you can choose to download the whole event, which will add the waveform data to the event 

parameter data in the project. 
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 Leach: Event Triggering and Detection 
 
Streamer Leach Key Features  
User Interface 
Streamer Leach User Interface  
BSF ESF and Waveform Settings  
Triggering 
RealTime Data Processing 
Recommended User Operation  
Automatic Reporting 
Leach Alerts 
File Formats and Directory Structures 
 

13.1 Streamer Leach Key Features 
The InSite Leach has the following key objectives: 

1. The InSite Leach has been written as an integrated component of ASC's InSite Seismic Processor, thus providing 

one simple point of entry for the user and providing easy-to-use configuration and operation. This allows new data 

to be seamlessly imported as the data capture functions interact directly with the main data management systems. 

2. The InSite Leach has been designed to be independent of seismic acquisition hardware and to operate  as part 

of a stand-alone system. A flexible code framework has been developed so that the software can be easily 

updated to be compatible with any seismic acquisition hardware. This means that when a user changes  to 

different hardware the InSite Leach can continue to provide the same data management systems and 

processing algorithms and hence provide project continuity. 

3. Different functions within the Leach are run in a multi-threaded environment. This means that as the Leach 

operates, each function runs independently. This is key, for instance, when the user wishes to visualise what data 

have been acquired, as well as continuing acquisition and processing in the "background". The multi- threaded 

environment also means that the Leach is well suited to a multi-processor machine. This is a big advantage when 

using the software in a high-data-transfer environment. 

4. When new data are captured from the acquisition hardware, they are automatically imported into InSite's data 

management system. During this process, the data are sent for automatic processing of seismic parameters such 

as locations and source magnitudes. The results are then instantly available for visualisation and as such provide 

'real-time' operations for the user. 

5. Where possible, the Leach automatically extracts active events recorded from man-made sources, such as the 

transmitters in the ultrasonic arrays, and passive events associated with microseismic or acoustic emission activity.  

This allows the active events to be processed automatically for velocity information. 

 

 

13.2 User Interface 
The user interface for the Leach is a tabbed Dialog box as shown in Figure 13-1. Each tab represents a separate 

acquisition system tool. The Dialog box is opened from the Data Visualiser menu in the main InSite program (Tools > 
Launch Leach) or opened by clicking "Triggering" button from the Global Button Bar.  
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Figure 13-1: The InSite Leach; a tabbed environment allowing interface with different acquisition hardware. 

 
Modeless means that the user can still interact with the main program while the Dialog box is open (an example 

is the "Find and Replace" Dialog box in MS Word). This is important, as one of the key requirements of the Leach is that 
while it is operating the user must be able to interact with the visualisers in the main program. The Dialog box is tabbed so 
that the Leach can be easily expanded for different acquisition systems. 

 
 

13.3 Streamer Leach User Interface 
Streamer Leach  
Leach Watch 
Audio Settings 
 

13.3.1 Streamer Leach 
The Streamer tab in the leach Dialog (Figure 13-2) allows the user to control the data capture and processing functions. 
 

• A set of communications and set-up parameters are defined that provide configuration of the system during data 

acquisition. 

 
• A 'Watch' displays messages relating to the triggering process. 

 
• Reporting parameters can be configured to write information in real-time about event rates (section 13.6). 

 
• Alerts can be configured to send emails when events are triggered, located or meet other criteria. 

 
Controls for triggering and processing functions are available through the InSite Streamer Leach (13.1). 
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Figure 13-2: Configuration parameters on the Streamer tab in the leach Dialog. 



396 13.3 Streamer Leach User Interface  

 

 

Table 13.1: Configuration parameters that can be set on the Streamer tab of the Leach tool. 

Parameter Label Description 

ESF Storage Home 
Directory 

Directory where the ESF files will be stored. 

BSF Storage Home 
Directory 

Directory where the BSF files will be stored. 

Directory Free Space 

Disk space Critical Level 
(MBytes) 

InSite Leach permanently monitors the free disk space level of the 

system. The user receives a warning message when the critical level 

is reached, and the Leach will automatically stop running. 

Acquisition Parameters 

Operation drop-down Choose 'No Waveform Storage', 'Autostore BSF Only' or 'Full Real- 

time Operations', which determines which files are created during 

event triggering. 

Trigger Method Select method used to determine if a trigger has occurred in the 

continuous data stream. 

Trigger Ratio The ratio of pre- to post-trigger data points in captured waveform. 

Options are 0.25, 0.375 and 0.5. 

Trigger Amplitude Amplitude threshold for a trigger. 

Trigger Instruments Number of instruments required to contain a trigger for event to be 

captured. 

Window Length Data window, in sample points, within which triggers must occur. 

Waveform Length Length of acquired waveform in sample points. 

 
 

Parameter Label Description 

Time/Date Window Allows the triggering of data within a specific time or date window 

Reset Date Time Index 
File 

When a specific time or date window is defined, a 

"DateTimeIndex.txt" ASCII file is stored in the same directory as 

the project file. Resetting is to delete this file instead of keeping 

appending content to this file. 

Search-Import Specifications 

Timed at (seconds) Time between each enquiry of the data structure to create the list 
of 

data files available to be leached. 

Split Components by Time interval for splitting of events into components during 

import. Options are Year, Month, Day, Hour and Minute. 

Autostore PCF at Automatically save the project configuration file at the specified 

time interval. This makes sure that the project settings and data 

map are regularly saved in case of PC failure. Options are None, 

1 Day, 12 Hours, 6 Hours, 1 Hour, 30 Minutes 15 Minutes, 10 

Minutes, 5 

Minutes, and 1 Minute. 

Data Properties 

File Format Type The user can select between MIRF, SEGY, SEG-2, SEG-D, 

GCF, SEISAN, SRM, HDF5, ESF, MiniSEED, ATR, and SAC 

raw data 

formats. 

Search Timeout (s) Period of time, in seconds, during which the acquisition routine will 

'pause' to wait for all of the expected raw data files to arrive if they 

are not initially present. [GCF file format only.] 
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Search Limit Time before present computer time, which defines the earliest data 

file time that will be leached. Options lie between 10 seconds and 2 

days. Data file time is taken from the file and directory names. Only 

used when 'Search all file since latest event on startup' check box is 

unchecked in additional 'Settings' Dialog. [SEGY file format only.] 

Search Delay (hrs) Period of time, relative to computer time, which should elapse 

before a file is processed. Times are taken from file name. [GCF file 

format only.] 

On-line Processing 

Automatically process 
data during import 

User-defined processing operations will be applied to the 
measurement and stored in the event file. 

Record hits to text file Automatically record trigger information to text file. 

Ignore invalid files on 
search-import 

When selected, the leach will skip invalid raw data files without 

aborting the leach run. 

Record events to CSV Automatically record trigger information to CSV file. 

Trigger Settings (Picking Method Trigger Settings) 

Back-window Length Back window length in sample points. 

Front-window Length Front window length in sample points. 

Picking Threshold Amplitude threshold in the picking function for trigger to occur. 

Sound on data capture Select 'No sound', 'PC beep' or 'MS sound'. The 'PC beep' option 

generates a standard PC sound when a trigger occurs. The 'MS 

sound' option, when a trigger occurs, causes the trigger 

waveform to be played as an audio stream. 

Configure Reporting Launch Dialog to configure reporting. 

Instrument triggers Configure triggering method for individual instrument, when the 

"←› Use instrument triggers" is the selected trigger method. 

Show Watch Launch leach 'Watch' window. 

Alerts Launch Dialog to configure email alerts. 

Manage BSFs Launch additional setting for BSF history and handling. 

 
 

Parameter Label Description 

Waveform Watch Launch watch window of continuous waveforms. 

 
 

13.3.2 Leach Watch 
The Leach Watch window (Figure 13-3) displays messages relating to the triggering process. Different file formats 

may lead to different messages being displayed in this window, for example during leaching of GCF files errors may 
be shown in the Watch window relating to the SENTABLE.txt file. 
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Figure 13-3:  InSite Leach Watch window. 

 
There is a limit to how many lines of message are shown in the Watch window, so for checking purposes the user may 

wish to save the Watch messages to a file. By default, this file is stored to C://WatchLog.txt, but the user can also select a 
different folder for storage. The filename will remain as WatchLog.txt. Setting a maximum size for the  file prevents more 
messages from being written to the file once it reaches the size limit. 

 
 

13.3.3 Audio Settings 
The Leach audio Dialog (Figure 13-4) allows the user to control audio features during data leaching and triggering. The 

'Data Capture' box controls the sound effects when a trigger is captured out of the continuous records and the user has the 
option of no sound, a small beep or a play of the microseismic record converted to audible frequencies.  The 'Continuous' 
box allows the user to listen to the continuous records, with controls for which instrument should be played through the 
right and left speakers (Right and Left Instrument number parameters), where in the record to begin playing and for how 
many samples, and the multiplier to use to convert the frequencies to audible range. 

 
Figure 13-4:  InSite Leach settings audio window. 
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13.4 BSF, ESF and Waveform Settings 
The streamer leach, for InSite versions 2.15b and onwards, contains flexibility for the method of waveform storage 

and whether event storage files (ESFs) are generated as well as backup storage files (BSFs). The use of BSFs improves 
the stability and memory management of the leach. Every new event triggered is stored in a BSF file which is held in 
the BSF Storage Home Directory. These BSF files can then be imported automatically into InSite. This same mechanism 
is being used to import data from other leaches such as the Milne leach, Omnibus leach and the AutoLeach. The BSF 
Storage Home Directory also acts as a backup directory for all the events triggered and can be copied to another 
computer where the data can be imported into another instance of InSite using the Import and Manage Data menu 
option. 

 
Configuration involves the drop-down box in the top right of the Streamer tab, setting a BSF storage directory and 

an additional Dialog launched from 'Manage BSFs'. The dropdown box contains three options (Figure 13-5): 
 

• No Waveform Storage - with this mode the events are not stored; instead they are just plotted to the Trigger 

Watch window. 

 
• Autostore BSF Only - this mode stores only backup files (BSFs) without automatically importing the events 

into the project. 

 
• Full Real-time Operations - with this mode events are automatically imported into the project (use this option to  

create a project and files as they would have been created in previous InSite versions). 

 
BSF and ESF storage directories must be selected by browsing to an appropriate location. 
 

 
Figure 13-5: Settings to control treatment of waveforms and BSFs during leaching. 
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Triggered events are first saved to BSF files and only if the user has selected the 'Full Real-time Operations' option 

will the events then be imported as ESFs. The BSF directory includes a tree of folders containing the BSF files, named 
using the date and time of acquisition (the directory structure is divided into year, month, day, hour, minute and 
second), and an index folder in which BIF files are stored containing a text index of the entire BSF data set. 

When starting the leaching of data, there are some additional checks made by the system. When operating in Full 
Real-time Operations mode, the user may be prompted to import new BSFs written since the last time the leach was 
started (Figure 13-6). It is advisable to select 'Yes' to avoid triggered events being missed, however further options are 
available through BSF management (Figure 13-7). 

 

 

Figure 13-6: Prompt to import BSFs previously triggered but not imported. 

 
When the streamer leach searches for pre-existing data files it not only omits the ones older than the last event in 

the project but also ones older than the most recent BSF (i.e. triggered event which may not necessarily have been 
imported) to avoid duplicate events being leached into the project. If InSite has crashed, or the user changes the 
waveform storage, the user can import any BSFs not yet in the project. 

 
Additional information and operations can be found by launching the 'Manage BSFs' Dialog (Figure 13-3). It is 

important to be aware of options available with this tool, particularly if events leached previously are deleted from 
the Data Visualiser, as the streamer leach will not automatically stream the original data files over again as BSFs may 
exist which can be re-imported instead. 

 
The left-hand panel shows the BSF Index files (BIF Files) and the right-hand panel the BSFs files to which each BIF 

file refers. At the top of the Dialog is the Auto Import BSF 'cursor position', this indicates the last read BSF file and where 
the auto import mechanism is to start from when it resumes. In the above example the last read BSF file  is #55 in 
20100827.bif i.e. \2010\08\27\12\07\22_2330.bsf. When the leach is started, the user will be 

prompted to import new BSFs if the cursor position is not at the end (in this case is #57 in 20100827.bif). By 

selecting 'No' the user is in effect moving the cursor position to the end without importing any BSFs. The blue crosses 
next to the last BSFs indicate that they are newer than all the events in the project and should be imported. The user 
can manually change the cursor position by selecting an entry in the right-hand panel and pressing the Set Last Read ESF 
button. If events have been deleted from the Data Visualiser, the number of BSFs with blue crosses by them may 
increase because the latest imported event may now be older. In this case it is worth bearing in mind that if BSFs require 
importing back in, it may be useful to set the cursor position to the last BSF with a green tick by it, as all the following 
ones can be automatically imported on the next start of the leach. 

 
The user can move the cursor position right back to the beginning by selecting the Reset button, meaning that all 

the BSFs can be auto-imported over again. 
 
It is possible to delete BIF files and all there corresponding BSF files by selecting an entry in left-hand panel and 

pressing the delete button. 
 
N.B. the BSF management Dialog is available in read-only mode when leaching is in operation. 
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Figure 13-7: Manage BSF Dialog. 
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13.5 Triggering 
Triggering Methods 
Amplitude Threshold Trigger Settings  
Picking Method Trigger Settings  
External File Trigger Settings  
Instrument Triggers Configuration  
Matched Filtering Configuration 
 

13.5.1 Triggering Methods 
The user can choose between a number of triggering algorithms, to control the way that 'events' are identified in the 

continuous data stream. 
The Acquisition Parameters shown in Figure 13-8 control the criteria for an event to be triggered out from the 

continuous data stream. The trigger method can be selected as one of the following:  
 

• None: For file types SEGY, SEG2, SEGD, MIRF and ESF the user can use the 'none' option to simply import files 

from the source directory without triggering. 

 
• Amplitude Threshold: A trigger occurs for an instrument when the root mean square (RMS) amplitude 

exceeds the user-set 'Trigger Amplitude'. 

 
• Picking Algorithm: The picking function is created using the front and back window lengths (in sample points) 

specified in the 'Trigger Settings (Pick Method)'. A trigger then occurs for an instrument when the picking 

function exceeds the 'Picking Threshold' set by the user. 

 
• External File: The triggers are pre-defined in an external file specified by the user. 

 
• Use Instrument Triggers: multiple trigger criteria are set for each instrument. 

 

• Use Matched Filter: One event or all events in one component can be used as a template or templates to detect 

repetitive but weak signals. The template trigger ratio is used, and user must specify the min. Matched Filters as 

the triggering condition. 

 
The remaining acquisition parameters to be set are: 
 

• Trigger Instruments: The number of instruments required to register a trigger, for an event to be captured from 

the continuous data stream. Unavailable for Matched Filtering triggering method. 

 
• Window Length: The window length, in sample points, in which the triggers from all of the trigger instruments 

must occur for an event to be identified. 

 
• Waveform Length: The length, in sample points, of the waveform triggered out for an event. 

 
 

13.5.2 Amplitude Threshold Trigger Settings 
 
The amplitude threshold trigger method (Figure 13-8) is the most straightforward technique. The root mean square 

trace of all channels belonging to an instrument is created and checked for peaks that exceed the Trigger Amplitude set by 
the user. 
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Figure 13-8: Parameter required when using the Amplitude Threshold trigger method. 
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13.5.3 Picking Method Trigger Settings 
 
 
The picking algorithm triggering method relies on the short-term average-long term average technique often also used 

for phase-picking (Auto-picking). A function is created from the RMS amplitude for an instrument;  for each data point the 
energy ratio in front and back windows, of user-specified length, is calculated. The window lengths, in sample points, are 
controlled in the Trigger Settings (Picking Method) group box (Figure 13-9). A trigger occurs when a peak in this function 
exceeds the 'Picking Threshold'. 

 
 

 
Figure 13-9: Parameter settings required when using the Picking Algorithm trigger method. 
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13.5.4 External File (RCD) Trigger Settings 
 
The continuous data files recorded in MIRF format can be leached using triggers defined in an external file. If 'External 

File (RCD)' is selected as the Trigger Method, when the 'Start Leaching Data' button is pressed, a Windows file search Dialog 
will be launched with file of type 'Comma Delimited Format)( .CSV)'  defined. 

 
The external file should have two header lines followed by the data lines. The data lines should consist of 5 fields: 

event, P-wave arrival time (after file start), S-wave arrival time (after file start), file number, instrument number. As 
waveform files are processed in the leach, the event label is compared with the file numbers stored in the CSV file. 
When matched, the data trigger point is specified as the average of the P-wave arrival times given in the file. 

 

13.5.5 External File Trigger Settings 
 
The continuous data files recorded any format can be leached using triggers defined in an external file following the csv 

format exported from InSite. If 'External File' is selected as the Trigger Method, when the 'Start Leaching Data' button is 
pressed, a Windows file search Dialog will be launched with file of type 'Comma Delimited Format)( .CSV)'  defined. 

 
The external file should follow the format from the CSV event catalogue file exported from InSite with at least the 

‘Basic’ information (date and time of the trigger). As waveform files are processed in the leach, the trace date and time is 
compared with the triggered catalogue stored in the CSV file. When matched, the data trigger point is specified as the 
time specified in the catalogue. 

 

13.5.6 Instrument Triggers Configuration 
 
If the trigger method is set to "Use Instrument Triggers" you can launch the Instrument Triggers Configuration (Figure 

13-10) from the Leech streamer tab. Here you can change the sensitivity of the trigger for each instrument. "Reset from 
instrument 1" will populate the other instruments with the same fields as instrument 1.  

 
 

 
 

Figure 13-10: Instrument Triggers Configuration. Only available if the trigger method is set to ‘Use Instrument 
Triggers’ 
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• Use individual amplitude threshold: Similar to "Amplitude Threshold" method, except the threshold can be set 

individually for each instrument (Figure 13-12). The threshold unit is m/s or g ( 9.8m/s2) for seismometers 

and accelerometers, respectively. 
 

• Use individual picking Algorithm: Similar to "Picking Algorithm" method, except the parameters can be set 

individually for each instrument (Figure 13-13). 

 
• Use mixed individual triggering settings: instruments can be triggered using either amplitude threshold, picking 

algorithm, neither, or both. For example, in Figure 13-14, instrument 1 (seismometer) is using velocity threshold, 

instrument 2 and 5 (both seismometers) uses different triggering parameters. Instrument 3 uses both velocity 

threshold and picking method. Instrument 4 is not used for triggering. 

 

 
Figure 13-11: The acquisition parameters group box on the Streamer leach Dialog. 
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Figure 13-12: Use individual amplitude threshold configuration dialog. 
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Figure 13-13: Use individual picking Algorithm configuration dialog. 
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Figure 13-14: Use mixed individual triggering settings Dialog. 
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13.5.7 Matched Filtering Configuration 
 
 
If the trigger method is set to "Use Matched Filtering" you can launch the Template Configuration ( Figure 13-15) from 

the Leach streamer tab. Here you can select the component or the event in a specific component as the template.  
 
 

 
Figure 13-15: Matched Filter Trigger Method Template Configuration. Only available if the trigger method is set 

to Use Matched Filter 



13. Leach: Event Triggering and Detection 411  

 

 
The number of template (or matched filter) is one if only one event is selected, or the total number of events in a 

component. During the harvesting, if one template detects one event (beyond the trigger amplitude), it is counted as one 
matched filter. When the min. Matched Filter is satisfied, the event is triggered. 

 

13.6 Real Time Data Processing 
During the InSite leach import process, the data are processed to calculate standard seismic parameters. These 

parameters are identical to those that InSite would obtain when a user processes the data off-line and uses exactly the 
same functions. Using this approach, the software then provides a real-time processing system with results being 
immediately available for visualisation as soon as the data become available. 

 
Certain waveform processing tasks will be carried out prior to, or as part of, the triggering process. Such processes 

include: 

• The application of filtering and other pre-processing options (e.g. as set in the Channel processing tab of the 

Processing Properties Dialog). 

• The picking of the maximum amplitude peak, P-wave arrival and S-wave arrival in the RMS waveform. 

• The calculation of the auto-picking function, using parameters defined in the leach Streamer tab. 
The user has the option to switch on full real-time processing on the Streamer tab of the InSite Leach user interface 

(Figure 13-16). Any processing errors that are produced during the operations do not stop the successful completion of the 
Leach functions, but instead display messages to the Watch Dialog box. 

 
The Streamer leach records 'passive' events and the functions that occur during the real-time processing then 

include the following (these depend on the permissions available to the user and all user defined settings in the 
Processing Properties Dialog): 

 

• Waveform pre-processing (e.g. waveform filtering) is performed. 
 

• P-wave arrivals are automatically picked. 
 

• S-wave arrivals are automatically picked. 
 

• Ray vectors are calculated for P and S waves (if picked). 
 

• Arrival times are inverted for source locations. 
 

• Waveform amplitudes are automatically processed for source parameters. 
 

• Waveform peak amplitudes and frequencies are obtained. 
 

• Events are filtered on their source parameters. 
 
The processing functions operate on the InSite side of the interface, so that the data it sends out are in an identical 

format regardless of the hardware. The advantage to the user is that if the software is required for an alternative acquisition 
system, or for a different site, then the software can be updated relatively easily and with no effect on the processing 
algorithms employed. 



412 13.6 Real-Time Data Processing  

 

 
Figure 13-16: Check box option to automatically process the captured events during import. 
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13.7 Recommended User Operation 
The following steps are recommended for using the Streamer leach tool:  
 

1. Ensure the raw data files are available on the operating system, and the directory structure is correctly con- 

figured. 

2. Open InSite and configure the Default Receiver Array and any required processing properties if real-time 

processing is being performed. 

3. Open the InSite Leach Dialog box and click on the Streamer tab. 
 

4. Select the appropriate waveform storage mode. 
 

5. Select the appropriate raw data 'File Format Type' in the Data Properties section. 
 

(a) If the file type is GCF, the user is also able to select a 'Search Timeout' value in seconds. This is the length of 

time that the acquisition routine will 'pause' for, to allow all of the raw data files to arrive in the 'Search 

Directory'. The expected number of files is determined, in the case of the GCFs, by the information in the 

SENTABLE.txt file. If all of the files are found during the initial file search, the search timeout function will not 

be used. 

(b) If the file type is SEGY or MIRF, the user is also able to make further selections to control the data to be 

leached. The 'Settings' button becomes active, and when pressed launches a Dialog (Figure 13-17). 

6. Select the Storage Directory of the raw data files by clicking on the 'Browse' button and selecting the appropriate 

directory. All files of the correct type will then be listed in the lower left panel. 

 

7. Select the ESF Home Storage Directory by clicking on the 'Browse' button and selecting the appropriate 

directory. The available space in the directory will be displayed. Ensure there is enough space for acquisition to 

proceed (recommended minimum is 100Mbytes). 

 
8. Select the BSF Home Storage Directory by clicking on the 'Browse' button and selecting the appropriate directory.  

 
9. Select how to split the components to be most appropriate to the data. 

 
10. Select the interval at which to 'Autostore' the PCF. 
 
11. Configure the acquisition and trigger settings parameters and trigger ratio, to control how events will be triggered 

from the continuous data stream. 

 
12. Switch on automatic processing if the data should be processed during import and capture. 
 
13. Open the leach 'Watch', by clicking on the 'Show Watch' button, and configure the sound setting, to control how  

much information the user receives during event triggering. 

 
14. Manage BSFs if needed. 
 
15. Press 'Start Leaching Data' to begin data triggering. This will initialise a search for files to be triggered; only 

files that have been recorded for a later time (time stamp as read for each different file type) than the most 

recent event already existing in the project (PCF) will be available for leaching. When the file search is 

complete, a window will pop up (Figure 13-18) giving the number of new files available to leach; pressing 'Yes' 

on this Dialog will commence triggering of the available files. This Dialog will not launch if the SEGY settings 

'Prompt before streaming new data' option is unchecked. 

 
16. The leach may be stopped at any time during triggering by pressing 'STOP LEACHING'. The leach may then be 

restarted by pressing the 'Start Leaching Data' button or closed using 'Shut Down' on the leach Dialog. 
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Figure 13-17: Further settings to control the SEGY data to be leached. 

 
 
 

 

Figure 13-18: Dialog launched after search for new files to leach is complete. Pressing 'Yes' begins the triggering 
process. 
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13.8 Automatic Reporting 
 
Several files, containing information about the data quality, triggering and events, can be automatically written during 

leaching. These capabilities are available for all data format types. 
System Reporting Event Reporting 
 
 

13.8.1 System Reporting 
 
If the Record hits to text file check box is ticked (Figure 13-19), the user-set automatic system reporting functions will 

be carried out during leaching. Checking the 'Record hits to text file' box causes the leach to write information to the text 
file 'Counter.txt'. This file will be stored to the 'ESF Storage Home Directory' by default. 

 

 

Figure 13-19: The 'Record hits to text file' check box should be selected if automatic reporting of the system is 
required. 
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The Counter.txt file (Figure 13-20) has a format as shown. The first two columns give the date (DD-MM-YYYY) and start 

time (HH:MM:SS) of the raw data file. After this there is one column per instrument, which gives the total number of triggers 
occurring in the file. The remaining columns, one per instrument, give the number of 'zero' data points in the file. The value 
given is an average over all channels belonging to an instrument. 

 

 

 

Figure 13-20: Format of the Counter.txt file. 

 
Further parameters are set by clicking on 'Configure Reporting' to launch a Dialog (Figure 13-21). This Dialog controls 

the writing of report files (IRF and ASL files) summarising each 24-hour period which are written at 6am each morning. The 
top search box allows the user to set an alternative location for the storage of the Counter.txt file.  The 'Report 
Configuration' box allows the user to select the directory where the additional report files will be stored. The drop box can  
be set to 'No Reporting' or 'Daily Report to 6AM'. If the latter is selected, the 'Do Test Report' button becomes active and 
allows the user to test the reporting facility. The remaining group box, 'System-check Configuration', is not relevant to the 
Streamer Leach processes. 
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Figure 13-21: Dialog box launched by 'Configure Reporting' with options for writing system information to text 

files. 
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An IRF file is written for each 24-hour period (starting and ending at 6am), from the earliest date in the project to the 

current day (from computer time), using the data in the Counter.txt file. An example is shown in  Figure 13-22, giving 
summary numbers of the triggered events, located events and hit counts. The data are also displayed divided into hour -
long periods. A single ASL summary file (Figure 13-23) is also written, giving the numbers of triggered events, located events, 
total hit counts and hit counts per channel per 24-hour period. 

 

 

 

Figure 13-22: Example IRF file. 

 

 
 

Figure 13-23: Example ASL file. 

 
 

13.8.2 Event Reporting 
 
If the Record events to CSV check box is ticked (Figure 13-24), the user-set automatic event reporting functions 

will be carried out during leaching. 
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Figure 13-24: The 'Record events to CSV' check box should be selected if automatic reporting of events is required. 
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Checking the 'Record events to CSV' box causes the leach to write information to a new or existing text file, de - 

pending on the settings on the Configure Reporting Dialog. The options for file writing are the same as those accessed 
for CSV Event Data files (see Technical Appendices section 2.19) through the Export menu of the Data Visualiser. 

 

 
Figure 13-25: Dialog box launched by 'Configure Reporting' with options for writing event information to a CSV 

text file. 
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13.9 Leach Alerts 
Email alerts can be automatically sent during leaching to notify a user of the occurrence of a trigger or when a  triggered 

event reaches certain criteria. The following options are available: 

• No alert will be sent 

• An alert will be sent when a trigger occurs 
– A minimum number of stations can be specified on which the trigger must be registered. This can be greater than the 

'Trigger Instruments' parameter on the leach so that emails are only sent for the strongest events. 

• An alert will be sent when an event is located 

• An alert will be sent when the location magnitude exceeds the user-defined threshold 

• An alert will be sent when the instrument magnitude exceeds the user-defined threshold 

• An alert will be sent when the moment magnitude exceeds the user-defined threshold 
Alerts can also be sent based on whether no new files are created in certain time window or whether an Instrument is 

empty. 
 
These capabilities are available for all data format types. 
Email alerts are configured through the Dialog launched from the 'Alerts' button (Figure 13-26). In addition to setting 

the alert criteria, the user must set up the email parameters including the 'To' recipients (a semi-colon delimiter should be 
used if multiple recipients are required) and the 'From' address for the email account from which the email is  sent. 

The email server can be an exchange or online email service, e.g. mailout.myserver.com. Options are available if the 
server requires authentication or a secure connection, with user fields to enter a username and password. 

 

 

 
Figure 13-26: The leach alerts Dialog. 
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The email sent as a leach alert (Figure 13-27) contains text determined by the alert settings. 
 

 
 

Figure 13-27: Example Leach alert e-mail 
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13.10 File Formats and Directory Structures 
When leaching raw data, the file and directory structures containing the data files must often be set-up in a particular 

way to enable the leach software to find the available files. The 'Search Directory' must then be set to the correct  level in 
the directory tree. Auxiliary files may also be required and placed at the correct level of the directory tree.  

MIRF SEG2 and SEGD 
SEGY 
GCF  
SEISAN  
SRM 
Additional SEGY and MIRF Leach Options 
 

13.10.1 MIRF SEG2 and SEGD 
The MIRF (.rcd), SEG2 and SEGD files simply need to be stored in a single data directory, which is set as the 'Search 

Directory'. All date and time information is read from the file. 
 

13.10.2 SEGY 
The current method for leaching of SEGY files involves SEGY files that contain all data for all instruments in the 

monitoring array. The directory structure can be set up in two ways. One method is shown below, with the 'Search 
Directory' set to any directory below and including the 'Top_Data_Directory' in this example: 
00 

- Top _Data _Directory 
- YYYY 
- MM 
- DD 
- HH 
- Filename.sgy 

Only files in the lowest directory (in this case HH) will be leached. The file extension can be set to .segy or .sgy 
(case insensitive). 

Alternatively, one directory containing all SEGY files may be used. Text Header 
 

13.10.2.1 Text Header 
The text header of the SEGY format contains 40 lines (3200 bytes in length, 80 characters per line) of textual 

information, providing human readable information about the data in the file. The following describes the optional text 
header data that can be read by InSite: 

 

Table 13.2: SEGY text header variables read by InSite 

Line Number Marker Description 

1 Millisec value of event time 
stamp 

Offset position of the event time decimal second in the 

trace header 

2 P-wave arrival (microseconds) Offset position of the trace P-pick in the trace header 

3 S-wave arrival (microseconds) Offset position of the trace S-pick in the trace header 

 

13.10.2.2 Additional SEGY and MIRF Leach Options 
An additional Dialog (Figure 13-28) is available to control leaching of SEGY and MIRF files. When the MIRF file format 

is selected, only one option is available in the settings Dialog. When the SEGY format is selected, several different 
options are available. The following options are available: 

 
• Select to use the latest event time in the project to limit the leaching file search, rather than the 'Search Limit' 

setting on the streamer leach Dialog. When checked, all raw data files dated later than the last event in the 

project will be leached. If no events exist in the project, all raw data files will be leached. When unchecked, 

the 'Search Limit' setting on the Streamer leach Dialog controls the length of time before current computer time 

that gives the earliest raw data time to be leached. However, even if unchecked, no data files earlier than the last 

event in the project will be leached. 

 

• Select to take date and time information from the directory structure and file name rather than file header. 

• Select to limit the search for new files to be leached to those with a file name alphanumerically later than the 

file name used to trigger the most recent ESF or BSF in the project. A warning appears when this option is 

selected to notify the user that if the alphanumeric ordering of filenames does not correspond to date/time 

order, some data may not be triggered. 
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• Select whether the user is prompted with a Dialog before new data is streamed or not. 

• Select which format is used for obtaining the channel numbers from the SEGY files, Sercel is selected rather 

than standard SEGY revision 1. 

• The 'Automatic data backup' box allows the user to select a directory where the SEGY files will be copied to, 

as a backup, during leaching. 

 
Note that the following data formats are supported for SEGY leach and import: 4-byte IBM floating-point, 4-byte two's 

complement integer, 2-byte two's complement integer and 4-byte IEEE floating-point. The user should also check the 
settings accessed through the Import and Manage Data Dialog for SEGY files before beginning leaching. 

 

Figure 13-28: Additional SEGY and MIRF leach settings Dialog. 

 
 

 
Figure 13-29: Warning when selecting filename searching option. 

 

13.10.3 GCF 
There are several possible directory structures available when leaching GCF files, depending upon the GCF file 

type written by the hardware. The most general format is now available using the data properties Dialog settings and 
SENTABLE.txt file (figure) setting 'GCFFormat=5'. 

GCF Format 5 and Settings Dialog GCF files written for each instrument 
GCF files written for each individual channel 
 

13.10.3.1 GCF Format 5 and Settings Dialog 
The Settings button launches a Dialog (Figure 13-30) that allows the user to configure the file and folder structure in 

which the data is stored. The option to use this Dialog information must be checked ('Use format string for GCF import') 
and the corresponding SENTABLE.txt file set to option 5. The correct radio button for whether a file is written per 
instrument (multi-channel) or per channel should be selected. The format string should be given following the rules given 
in Guralp's SCREAM! manual. The format specifier can contain the following characters: 

 
• YYYY or YY denoting the year 

 
• JJJ or RRR denoting the Julian day 

 
• MM or MMM denoting the month in numeric or alphabetic format 

 
• DD denoting the day 

 
• HH denoting the hour 

 
• NN denoting minutes 
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• SS denoting seconds 

 
• I denoting the instrument (this should relate to the sentable.txt instruments) 

 
• T, E and A for stream ID, serial number etc. These are not used by InSite 

 
• C to indicate the component (e.g. Z, N or E) 

 
The length of each field should match the length of the field in the folder or file names, apart from I.  

 
Figure 13-30: GCF import Dialog 
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13.10.3.2 GCF files written for each instrument 
 
 
The directory structure should be set up as shown below, with the 'Search Directory' set to 'Next_Data_Directory' in 

this example: 
00 

- Top _Data _Directory 
- SENTABLE.txt 
- Next _Data _Directory 
- STN00 
- STN01 
- YYYYMMDD 

- YYYYJJJTHHMMSSZ\_. .. Gcf 

 

Alternative formats of the SENTABLE.txt file are available to configure the data acquisition (Figure 13-31). 
 
'GCFFormat=3' (Figure 13-31 a) should be used if raw data files have uneven start and end times between 

instruments as data are padded to the same start and end times. Scream typically writes files with uneven start and 
end times as it works with discrete data packets. The 'Version' value should always be set to one. The directory 
structure requires a separate GCF file is written for each instrument. 'MaxLength' controls the length of the data array 
that will be created as a container for the raw data. 'SampRate' specifies the sampling rate of the data. If any of the 
data streams being leached has a different sampling rate to that specified it will be re-sampled to the user-specified 
sampling rate. The remaining lines in the file assign the channel numbers to the axes of each recording instrument; they 
are ordered N/E/Z. The code 'STN00' must be identical to the directory names used. 

 
An old format of the file is a short format (Figure 13-31 b). The lines assign channel numbers to the axes of each 

recording instrument; they are ordered N/E/Z. The code 'STN00' must be identical to the directory names used.  
 
In an alternative long format of the file (Figure 13-31 c) the 'Version' value should always be set to one. The 'GCFFormat' 

value is set to one for this directory structure, where a separate GCF file is written for each channel. 'MaxLength' controls  
the length of the data array that will be created as a container for the raw data. If the value set exceeds the maximum 
possible length of the raw data files, the whole data file is read in and triggered. If the value set is smaller than the len gth 
of a data file, the data within the file is read in and triggered sequentially in sections of the length specified. The remaining 
lines in the file assign the channel numbers to the axes of each recording instrument; they are ordered N/E/Z. The code 
'STN00' must be identical to the directory names used. 

a) 
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b) 

 
 

c) 

 
Figure 13-31: Alternative formats for the SENTABLE.txt file required for GCF data acquisition in InSite, where one 

GCF is written per instrument. 

 

13.10.3.3 GCF files written for each individual channel 
The directory structure should be set up as shown below, with the 'Search Directory' set to 'Next_Data_Directory' in 

this example: 
00 

- Top _Data _Directory 
- SENTABLE.txt 
- Next _Data _Directory 
- STN00 
- STN01 
- YYYYMMDD 
- NNNNe0 
- YYYYMMDD _HHMMSSe.gcf 
- NNNNn0 
- YYYYMMDD _HHMMSSn.gcf 
- NNNNz0 

- YYYYMMDD\_HHMMSSz.gcf 

 
The SENTABLE.txt file (Figure 13-32} is required to configure the data acquisition. The 'Version' value should always be 

set to one. The 'GCFFormat' value is set to one for this directory structure, where a separate GCF file is written for each 
individual channel. 'MaxLength' controls the length of the data array that will be created as a container for the raw data. If 
the value set exceeds the maximum possible length of the raw data files, the whole data file is read in and triggered. If 
the value set is smaller than the length of a data file, the data within the file is read in and triggered sequentially, in s ections 
of the length specified. The remaining lines in the file assign the channel numbers to the axes of each recording instrument; 
they are ordered N/E/Z. The code 'STN00' must be identical to the directory names used. 
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Figure 13-32:Format of the SENTABLE.txt file required for GCF data acquisition in InSite, where a GCF is written 
for each channel. 

 

13.10.4 SEISAN 
SEISAN data files for leaching are expected to be stored with the following directory structure:  
 

• Top_Data_Directory = Ringbuffer folder 
 
– Channel## 
 
Files can have any extension, but must have names with the format: R#####-YYYY-MM-DD-HHMM-SS-######-#- 

TRMP#-S Z. The year, month, day, hours, minutes and seconds are read from the file name. 
 

13.10.5 ATR 
 
For the Leaching of ATR data files the time information is obtained from the first part of the filename, it is expected this 

follows the format: YYYYJJJHHNNSSmmm with: 
 
•  YYYY denoting the year 
•  JJJ  denoting the Julian day 
•   HH denoting the hour 
•   NN denoting minutes 
•   SS denoting seconds 
•   mmm denoting milliseconds 
 
InSite carries out a recursive search, therefore it does not matter if ATR files are organised into subdirectories. 
 
 

13.10.6 SAC 
 
The time information for SAC data files is obtained from the first part of the file name, which must follow the format 

YYYYMMDD_HHNN, where: 

• YYYY denoting the year 

• MM denoting the month in numerical format 

• DD denoting the day 

• HH denoting the hour 

• NN denoting the minutes 
 
InSite carries out a recursive search, therefore it does not matter if SAC files are organised into subdirectories.  
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Figure 13-33: SAC file format import Dialog 

 
 
 
 
 

13.10.7 miniSEED 
 
For the Leaching of miniSEED data files, the user must specify the filename format in the settings dialog using a 

combination of the following: 

• YYYY denoting the year 

• JJJ or DDD denoting the Julian day 

• MM denoting the month 

• DD denoting the day 

• HH denoting the hour 

• NN denoting minutes 

• SS denoting seconds 

• ‘?’ characters can be used to fill in characters not used by InSite  
 

 
Figure 13-34: MiniSEED file format import Dialog 

 
 

13.10.8 DTA 
 
In order to import or leach data in DTA format (from MIstras acquisition systems) the following information must be 

input in the settings dialog: 

• Sampling time used in the acquisition 

• Expected maximum time difference (in the units specified in the dialog and used for the sampling time) 
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between files (hits at different receivers) corresponding to single AE event. 
 

 
Figure 13-35: DTA file format import Dialog 

 
 

13.10.9 TXT (AESoftland) 
 
Data streamed from AESoftland acquisition systems and exported in ASCII format can be leached in InSite by saving 

stream data and configuration files in the same input folder. Both files must have consistent names, e.g. XXXXX. txt and 
XXXXXconfig.txt. Relevant lines in the configuration file for InSite are: 

 

• Line 1: Date/time taken from the right-hand 20 characters 

• Line 2: Bit range taken from the number preceding ”bit” 

• Line 3: Sampling rate in megasamples per seconds taken from the number preceding the character “M”  

• Line 4: Channels used, taken from the numbers following each occurrence “CH”  

• Line 11: Start and end times taken from 2nd and 3rd values listed which must be appended with “S” 

• Line 12: Voltage range taken from values listed which must be appended with “V”  
 

 
Figure 13-36: Example TXT stream file from a 13-channel acquisition system 

 

 
Figure 13-37: Example TXT configuration file from an 8-channel acquisition system 
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1.1.1 Nanometrics 
 
This format allows the direct harvesting of events from a server managing surface stations instrumented with 

Nanometrics data loggers (https://www.nanometrics.ca/). In this data format it is necessary to specify the following local 
directories: 

• In ‘Search Directory’ select a local folder where imported raw data will be stored  

• Browse and select a local folder for storage of harvested waveform data (ESF files)  

• Browse and select a local folder for storage of backup waveform files (BSF)  
After selecting the local storage folders, InSite needs to be pointed to the server by specifying the server IP and data 

port in the ‘Data Settings’ dialog (Figure 13-38). 
 

 
 

Figure 13-38:Configuration of Nanometrics data server for event harvesting. 

 
  

https://www.nanometrics.ca/
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13.10.10 SRM and HDF5 
 
SRM files are produced by the Applied Seismology Consulting Ltd. Richter data acquisition system, written by the 

eXstream software. The SRM data should be stored in directories mapped using the settings dialog. See Richter User 
Manual for further details. 

 
Figure 13-39: SRM file format import Dialog 
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13.10.11 BDF 
 
BDF files are produced by the Elsys TraNet Acquisition system supplied by Applied Seismology Consulting Ltd., 

written by the AEXtream application.  
 
 

 
 

Figure 13-40: Settings for the harvesting of BDF files 
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 Parameter Visualiser 
 
Key Features 
Font Customisation 
Parameter Visualiser Launcher 
Event Frequency Chart 
Event Parameter Histogram Chart  
Event Parameter Scatter Chart  
Event Parameter Line Chart  
Bvalue Chart 
Stereonet Chart  
Velocity Survey Chart  
DValue Chart 
Cluster Analysis Histogram Chart  
Density Plane 
Pumping Data 
Cumulative Fracture Dimension 
 

14.1 Key Features 
The parameter visualiser provides a means to show various 2D charts concerning the active events and their parameters 

in the loaded InSite project. There are five different types of chart:  

• Event Frequency chart 

• Event parameter histogram chart 

• Event parameter scatter chart 

• Event parameter line chart 

• b-value chart 

• Stereonet chart 

• Velocity survey chart 

• D-value chart 

• Cluster analysis histogram chart 

• Density Plane 

• Pumping Data 

• Cumulative Fracture Dimension 
These charts can be configured appropriately according to the event data. The Event Frequency chart and Event 

Parameter Line chart are designed to operate in real time so that the x-axis will, for example, show the last hour of events 
which have been triggered and scroll to the left at regular intervals. 
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14.1.1 Launch Parameter Visualiser 
 
 
The parameter visualiser is launched by clicking the Charts at the button of the Global Button Bar or by selecting 

Launch Parameter Visualiser from the Tool menu. This launches the parameter Visualiser Launcher Dialog (Figure 14-1) 
where charts are managed. 

 



14. Parameter Visualiser 437  

 

 
 

 
Figure 14-1: Launch Parameter Visualiser from Tools menu. 
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14.2 Font Customisation 
 
 
Parameter visualiser has support for font customisation. The text in the chart title, x-axis, y-axis, and plot area/legend 

can be configured individually. The font dialog shown in Figure 14-2 can be opened in any of the parameter visualiser charts 
by selecting the font option from the edit menu. The font options are global and will affect all current and future parameter 
visualiser charts. 

 
 

 
Figure 14-2: Edit font dialog 

 
 
 

14.3 Parameter Visualiser Launcher 
 
The parameter visualiser launcher allows the user to manage charts. Options are available to:  
 

• add a new chart; 
 

• edit an existing chart; 
 

• delete an existing chart; 
 

• launch an existing chart. 
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Figure 14-3: Parameter Visualiser Launcher Dialog 

 
Selecting the Add button launches the chart selection Dialog where the user can select which of the six possible chart 

types to create. Once a chart type has been selected the user uses the OK button to launch a Dialog to configure the chosen 
chart type (Figure 14-4). 

 
 

 
Figure 14-4:  Parameter Visualiser ‘Add Chart’ Dialog 
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Figure 14-5: Parameter Visualiser add chart Dialog selection 

 
Once the user has created charts, they will be listed in the parameter visualiser launcher Dialog (Figure 14-6). 

Highlighting a chart and selecting the Edit, Delete or Launch buttons allows the user to alter the existing charts. The Edit 
button launches the Dialog control for the selected chart while the Launch button displays the chart. Double-clicking on 
one of the listed charts also launches it for display. 

 
 
 

 

Figure 14-6: Parameter Visualiser Launcher Dialog example 

 
 
 
 

14.4 Event Frequency Chart 
 
 
 
The event frequency chart is a histogram showing the number of events that occurred over a series of time intervals 

as shown in Figure 14-7. The cumulative number of events starting from the first ESF file or user defined time window in 
the real mode can be displayed as a line chart on the same window. 
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Figure 14-7: Event frequency chart 
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The configuration parameters for the above chart are entered on a Dialog which is launched in order to edit the chart 
configuration. The Dialog can be launched from the parameter visualiser launcher Dialog or by selecting Properties in the 
Edit menu on the chart window (Figure 14-8). The real time mode, histogram colour, and many other attributes can be 
controlled in this Dialog. 

 

 
Figure 14-8: Event frequency chart Dialog 



14. Parameter Visualiser 443  

 

 
When the chart operates in real-time mode, the number of event occurrences over the last period of user-designated 

time is shown in Figure 14-9. The earliest time window is the first ESF file in the PCF project file. 
 

 
 

Figure 14-9: Event frequency chart for real time 

The configuration parameters are entered via the same Dialog with the real-time mode selected. 
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14.5 Event Parameter Histogram Chart 
 
 
The event parameter histogram chart shows the distribution of events in the project over a particular range of values 

for a given parameter. The chart shown represents the number of events over a range of moment magnitude  intervals 
(Figure 14-10). 

 

 
 

Figure 14-10: Event parameter histogram 
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The configuration parameters for the above chart are entered on a Dialog which is launched in order to edit the chart 

configuration (Figure 14-11). The Dialog can be launched from the parameter visualiser launcher Dialog or by selecting 
Properties in the Edit menu on the chart window. 

 

 
Figure 14-11: Event parameter histogram Dialog 
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The user can select the following event parameters for the chart: 
 

• Location Magnitude 

• Instrument Magnitude 

• Moment Magnitude 

• Seismic Moment 

• Source Radius 

• Number of P-waves picked 

• Number of S-waves picked 

• S:P Ratio 

• Number of arrivals used in the location 

• Number of independent sensors used 

• RMS residual time 

• RMS location error 

• Radiated Energy 

• Apparent Stress 

• Static Stress Drop 
 

• Cluster Index 
 

• Cluster Label 
 

• Number of Neighbours 
 

• RMS Noise 
 

• Signal to Noise Ratio 
 

• Distance to Geophones 
 

• North/East/Down Coordinate 
 

• Radial Distance 
 

• Corner Frequency of P-wave and S-wave 
 
The user has the option to 'auto scale' the x-axis or to set limits. 
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14.6 Event Parameter Scatter Chart 
 
The parameter scatter chart displays two parameters plotted against each other in order to show the correlation 

between them as shown in Figure 14-12 . 
 

 

 

Figure 14-12: Event parameter scatter chart 

 
The configuration parameters for the above chart are entered on a Dialog which is launched in order to edit the chart 

configuration (Figure 14-13). The Dialog can be launched from the parameter visualiser launcher Dialog or by selecting 
Properties in the Edit menu on the chart window. 
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Figure 14-13: Event parameter scatter chart Dialog 
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The user has the option to 'auto scale' the x-axis or to set limits and also to change the colour-scale for data points 

between a user-selected colour, the component colour from the project properties or by event time. Events can also be 
plotted using the event component symbol. 

A line is plotted through the data points in the scatter chart and the gradient is displayed. Clicking on the line causes 
nodes to appear on the line that can be dragged to alter the position and gradient of it. The line is initially placed using a 
least-squares calculation. 

 
 
 

14.7 Event Parameter Line Chart 
 
The event parameter line chart allows one or two parameters to be plotted against time (Figure 14-14). 
 
 
 

 

 

Figure 14-14: Event parameter line chart 

 
The configuration parameters for the above chart are entered on a Dialog which is launched in order to edit the chart 

configuration (Figure 14-15). The Dialog can be launched from the parameter visualiser launcher Dialog or by selecting 
Properties in the Edit menu on the chart window. 
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Figure 14-15: Event parameter line chart Dialog 

 
When the chart operates in real-time mode, the parameters for event occurrences over the last period of user- 

designated time are shown in this Figure 14-16. Seismic moment, if selected, can also be plotted cumulatively by checking 
the cumulative tick box. 

 

 
Figure 14-16: Event parameter line chart in real-time mode (chart auto scrolls to the left). 
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The configuration parameters are entered via the same Dialog with the real-time mode selected. 
 
 

14.8 B-value Chart 
The b value (Figure 14-17) represents the frequency-magnitude distribution in a catalogue of seismic events (Gutenberg 

and Richter, 1944). A larger b-value implies more small magnitude events occur relative to larger magnitude ones. 
Conversely, a small b value implies that more large magnitude events occur relative to smaller magnitude ones. 

The b value is believed to be an indicator of the stress regime as this will influence the size of rupture, and thus the 
magnitude of an event. Schorlemmer et al. (2005) found a b-value above 1 for normal (extensional) faulting, b around 
1 for the strike-slip regime and b below 1 for reverse (compressive) types of stress regime. 

The Gutenberg-Richter relation usually shows a power law behaviour: 
 

log N (m > M ) = a − bM 

Where N (m > M ) is the number of events with a magnitude m greater than M . The gradient of the linear part of 

a graph of log10(N ) against magnitude M , gives -b. The b-value chart has three subtypes: 

 
• Event Magnitude: calculate the b-value for all enabled events in the project for a specified magnitude. 

 
• Temporal Linear Time: calculate the b-value for each time bin and plot the change over time (non-linear number 

of events per time bin). 

 
• Temporal Equal Bin Size: calculate the b-value for each bin of equal number of events (non-linear time span per 

event bin). 

 
 

 

Figure 14-17: Parameter Visualiser b-value chart 
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The configuration parameters for the above chart are entered on a Dialog which is launched in order to edit the chart 

configuration (Figure 14-18). The Dialog can be launched from the parameter visualiser launcher Dialog or by selecting 
Properties in the Edit menu on the chart window. 

 

 
Figure 14-18:  Event b-value chart Dialog. 
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14.9 Survey Stereonet Chart 
 
 
The stereonet chart (Figure 14-19) is designed for use with active survey information, plotting velocity or amplitude 

data according to the known ray-path direction information. The stereonet plots a lower hemisphere stereonet of the user's 
chosen attribute. The ray paths can be shown as indicated by the circular symbols on the figure below. Hovering over them 
displays information of the ray orientation, pulser and receiver ID, and parameter value (depending on the displayed survey 
parameter) 

 

 
 

Figure 14-19: Parameter Visualiser Stereonet chart 
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The configuration parameters shown in this Figure 14-20 for the above chart are entered on a Dialog which is launched 

in order to edit the chart configuration. The Dialog can be launched from the parameter visualiser launcher Dialog or by 
selecting Properties in the Edit menu on the chart window. 

 

 
Figure 14-20: Parameter Visualiser Stereonet Dialog 
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14.10 Velocity Survey Chart 
 
 
The velocity survey chart shows the velocity change over a specified time span for receiver pairs in a velocity survey. 

An example can be seen in Figure 14-21.  
 
From this chart, it is possible to export a .csv file with the Time Dependent Anisotropic Velocity Model based on 

the displayed enabled surveys. The model is automatically calculated using the maximum and minimum velocities 
from each time interval. Export is done from File->Export to Time Dependent Velocity Model… 

 

 
 

Figure 14-21: Velocity survey chart 
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The configuration parameters for the above chart can be edited using the dialog shown in Figure 14-22. The dialog is 

launched from the parameter visualiser launcher dialog or selecting properties from the edit menu.  
 

 
 
 

Figure 14-22: Velocity survey chart properties dialog 
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Four velocities can be plotted; P-wave velocity, S-wave velocity, CCR P-wave velocity, and CCR S-wave velocity. A P 

or S-wave pick must be present to plot the corresponding velocity. Up to twelve velocity series can be plotted by 
specifying the ray path source and destination (i.e. sensor to sensor). It is possible to launch multiple charts to show 
a larger number of raypaths 

 
 
 
 

14.11 D-Value Chart 
 
The D-value (Figure 14-23) is a statistical coefficient which reflects the spatial distribution and clustering of events 

Grassberger and Procaccia (1983). The D-value is equal to 0 if the events map onto a point, 1 for a linear distribution, 2 for 
a planar distribution and 3 for uniform volumetric distribution. 

 
The spatial distribution of event hypocentres can be studied through the correlation integral which computes the 

number of pairs of events N(R<r) separated by a distance R smaller than r Grassberger and Procaccia (1983). 
 

𝐶(𝑟) =
2

𝑁(𝑁 − 1)
𝑁 (𝑅 < 𝑟) 

 
where N is the total number of events. When plotting the integral value C(r) versus a range of distances r on a log-log 

plot, a part of the distribution appears linear. The gradient of this linear portion is the D value:  
 

𝐶(𝑟) ∝  𝑟𝐷 
 

 
 

Figure 14-23: D-Value Chart 
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− 

− − 

 
The D-Value chart properties are set in the dialog in Figure 14-24: 

 

Chart Sub Type: 
 

All Events: Using all enabled events, plots log10(Cr(r))(y axis) against log10(r)(x axis). The linear portion of this 

graph represents the D value. The D value can be determined by manually or automatically fitting a linear best-fit line to 

a portion of the graph. 

 
Temporal Linear Events: D-values are plotted over time, using a constant number of events (Events per bin) for each 

D-value calculated. The number of events between the start of each subset/bin of events can also be defined by  the user 
(step). The D value is automatically determined for each temporal bin, and changes in D-value are plotted over time. The 

resulting data points can then be exported in a text file (File->Export as Text File, on figure menu).  
 
Data Points: defines the number of data points over which a D-value is calculated. The data points are spaced equally 

across the values of log10(r). 

 

Axes Limits (Auto Limit, X Min, X Max, Y Min, Y Max): Allows automatic or manual setting of the minimum and 

maximum x and y axis values displayed. 

 

D-Value Plot Range (log10(r)): automatically or manually defines the range of the graph over which the D value is 

calculated (i.e. the linear portion). 

 

Manual definition of the range is by specification of the minimum and maximum log10(r)(x axis) values. 
 
Automatic determination of the linear range of the graph uses the sample correlation coefficient between x ( 

log10(r)) and y (log10(C(r))): 
 

𝑟2 =
𝑥𝑦̅̅̅̅ − 𝑥 𝑦̅

√(𝑥2̅̅̅̅ − 𝑥2)(𝑦2̅̅̅̅ − 𝑦̅2)

 

 
The algorithm assumes that the middle section of the graph falls within the required range (i.e. a linear portion  at one 

extreme that does not extend to the middle will not be considered). The function starts with a short range of datapoints in 
the middle section of the graph and calculates the r-squared value. The minimum and maximum extents of the range are 
then altered, and the r-squared value is calculated for different data ranges (N.B. The data ranges for which the r-squared 
values are calculated always include the initial range of datapoints in the middle section).  The data range which gives the 
highest value of r-squared is chosen as the linear portion of the graph.  " Min Points Used in Auto Linear Fit" defines the 
number of datapoints in the original section and is the smallest number of datapoints that will be used in a linear fit. 

 
Temporal (Events per bin, step): Temporal changes in D values are calculated by determining D-values for 

temporal subsets of events. For each subset, the D value is determined using the algorithm described above to 

automatically find the linear range of log10(r) against log10(C(r)). The temporal subsets are user-defined. " Events per 

bin" defines the number of events in each subset of data. The number of events between the start of each subset is defined 
by " step". The subsets will be overlapping if "step" is smaller than "Events per bin". 

 
Realtime: Refreshes the chosen graph type at the rate chosen from the refresh rate menu, to allow monitoring of 

changes as new data is read in. 
 
Display: alters the display of the plotted graph. 

 

Marker Colour: changes the displayed colour of the datapoints. 

 

Marker Width: changes the size of the plotted datapoints. 
 
D-Value Range Colour: changes the colour of the datapoints within the range over which the D-value is calculated. 
 
Line Thickness: changes the thickness of the linear fit from which the D-value is calculated. 

 

Gridlines: toggles the display of gridlines on/off. 
 
Legend: toggles the display of the data legend on/off. 

 

D-Value Properties: toggles the display of the best fit line and r-squared value on/off. 
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Figure 14-24: D-Value Chart Properties Dialog 
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14.12 Cluster Analysis Histogram Chart 
 
The cluster analysis histogram chart (Figure 14-25) shows the spatial non-randomness for all enabled events in the 

project. The events in the project are compared against a random distribution of events by using residual number of 
events in each histogram bin, where each bin contains the number of unique event pairs for that distance range. 

 

𝑁𝑜𝑛𝑟𝑎𝑛𝑑𝑜𝑚𝑛𝑒𝑠𝑠 =  
∑ ∑ 𝐵𝑖𝑛𝐶𝑜𝑢𝑛𝑡𝑃𝑟𝑜𝑗𝑒𝑐𝑡 𝐸𝑣𝑒𝑛𝑡𝑠 − 𝐵𝑖𝑛𝐶𝑜𝑢𝑛𝑡𝑅𝑎𝑛𝑑𝑜𝑚 𝐸𝑣𝑒𝑛𝑡𝑠

𝑖=𝑁𝐵𝑖𝑛𝑠
𝑖=0

𝑃
  

𝑃 =  
𝑁𝐸𝑣𝑒𝑛𝑡𝑠 ∙ (𝑁𝑒𝑣𝑒𝑛𝑡𝑠 − 1)

2
 

 
Where: 

NEvents is the number of enabled events in the project 
 

P is the total number of unique event pairs 
 

NBins is the total number of bins in the histogram (user defined) 
 

i is the bin index 

 
BinCountProject Events is the number of unique project event pairs in the ith bin 

 

BinCountRandom Events is the number of unique random event pairs in the ith bin 

Nonrandomness is the spatial non-randomness 

 

 
 

Figure 14-25: Cluster Analysis Histogram Chart 

 
The cluster analysis histogram chart properties are shown in Figure 14-26. 
 

Gridlines: Show gridlines on the chart. 

 

Show Random Event Distribution: Show the random event histogram values. 
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Legend: Show the legend on the chart. 

Project Event Colour: Bar colour for project events. Random Events Colour: Bar colour for random events.  

Realtime: Automatically refresh chart using selected rate. 

 

Historical Plot: Show events that only fit in the selected time span. 
 
 
 

 
Figure 14-26: Cluster Analysis Histogram Chart Properties Dialog 
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14.13 Density Plane 
 
The density plane chart allows the user to create a customisable view of a density plane output from array analysis 

(Array Analysis"). The chart can be exported as an image file for use in reports and presentations. Figure 14-27 shows the 
configuration options for the chart, which are summarised in Table 14.1. An example image output is shown in Figure 14-28. 

 
 

 
Figure 14-27: Density plane chart options 



14. Parameter Visualiser 463  

 

 

Table 14.1: Density plane chart options description 

 

Option Description 

Title The title for the chart 

Density Plane Select the density plane to view. Browse to the folder containing the density plane files 
you want to view, and then select one from the combo box 

Axes Show axes - Show/hide the axis labels  

Show distance markers - Show/hide the axis distance min/max values and increment 
markers Increments - Number of increment ticks to display on each axis X label - Set a 
custom X-axis label (leave blank for default label) Y label - Set a custom Y-axis label 
(leave blank for default label) 

Colour Scale Show colour scale - Show/hide the colour scale legend Show colour scale title - 

Show/hide the chart sub title 

Colour scale title - set a custom sub title (leave blank for default) 

Horizontal - Plot the colour scale horizontally below the chart (default is vertically to the 

right of the chart) 

Colour map - select the colour map type for the chart 

Limits Auto limits - use the min/max values of the density plane, otherwise the limits are user 
defined 

Window Size Set a custom size for the display window or allow the view to be resized 

Event Show/hide the user 3D event position set in 3D visualiser 

Boreholes Show/hide boreholes belonging to Frac manager (only boreholes visible in 3D visualiser 

will be shown) 

Sensors Show/hide the sensors in the default receiver array 

Perfs Show/hide perfs belonging to Frac manager 
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Option Description 

Transmitters Show/hide transmitters in the default transmitter array 

Aspect ratio If set, the aspect ratio of the density plane is maintained, otherwise it will be made a 

square (1:1) 

 

 
 

Figure 14-28: Density plane chart example 
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14.14 Pumping Data 
The pumping data chart displays the output from a treatment data CSV file. Figure 14-29 shows the chart dialog. To 

import the treatment data, browse for and select the desired CSV file and enter the number of lines before the header 
(these are the number of lines in the file that will be skipped before the column data starts), and then click "Import". This  
process may take a few seconds depending on the size of the file. The file must contain columns named "Date" and "Time" 
for date and time respectively. Once the import process has finished, any available data will be shown in the available data 
window along with the following event parameters from the project: 

 
• Location magnitude 

• Instrument magnitude 

• Moment magnitude 

• Seismic moment 

• Source radius 

• S:P ratio 

• Radiated energy 

• Apparent stress 

• Static stress drop 

• RMS noise 

• Signal to noise ratio 

• Event North location 

• Event East location 

• Event Down location 

• Radial distance 
Click on a data series or drag to select multiple series and press the add button, similarly to remove data series from 

the chart. Right click on any of the data series to change the colour. 
 
Chart options: 

• Play time line thickness - when the 3D visualiser is in playback mode, the current time is marked on the plot 

with a vertical line of this thickness. 

• Ply time line colour - set the colour of the 3D visualiser time position line 

• Data curve thickness - thickness of data series lines 

• Event radius - radius of the event circles 

• Auto Time Limit - choose whether to display data using the time limits set in the file or set a custom time window  

• Event Colour/Size in 3D Scene - choose whether to colour the event or scale the event by the engineer data here. 

Note that when colouring or scaling events by the engineering data, the time window of the engineering data is 

used automatically. Events occurred outside of the engineering data time window won't be displayed. See 3D 

scene property. 



466 14.14 Pumping Data  

 

 
Figure 14-29: Pumping Data chart dialog 
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Figure 14-30 shows an example pumping data chart. 
 

 
 

Figure 14-30: Pumping Data chart with 3D visualiser time position marked 
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Figure 14-31 shows an example pumping data csv file template opened as Excel Sheet (top) and as ASCII file 

(bottom). The first two columns must have column header “Date” and “Time”, and the format must be in dd/mm/yyyy 
and hh:mm:ss, respectively. The other columns can be your own engineer data such as slurry rate, well head pressure 
etc, and you can define the headers as you like. 

 

 
Figure 14-31: Pumping Data chart CSV template. The first 2 columns are fixed, and the rest are user defined. 
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Figure 14-32 shows an example of scaling and colouring events in 3D scene using pumping data. 

 
Figure 14-32:  Colour and scale events by pumping data. 

 
 

14.15 Cumulative Fracture Dimension 
Multiple fracture boxes can fit the located events at different time. As a result, the variation of the fracture centre, 

dimension, and azimuth can be displayed as a function of time (Figure 14-33). 

• Fracture centre: the North, East, Down coordinates of the fracture box centre. 
 

• Fracture dimension: the Length, Width, Height of the fracture box. 
 

• Fracture azimuth: the angle of the longest side of the fractur box. 
 
Two chart type can be selected: 
 

1. Temporal Linear Time: The time period is linearly divided into the number of bins. Each bin may have different 

number of events (see Figure 14-34). 
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2. Temporal Equal Bin Size: Events are grouped into sub-groups with the same amount. Thus, the time interval 

between bins may vary (see Figure 14-35). 

 

 
 

Figure 14-33: The cumulative fracture dimension Dialog. 
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Figure 14-34: The cumulative fracture chart showing the temporal variation of fracture centre (top), fracture 

dimension (middle), and fracture azimuth (bottom) using Temporal Equal Bin Size style. 
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Figure 14-35: The cumulative fracture chart showing the temporal variation of fracture centre (top), fracture 

dimension (middle), and fracture azimuth (bottom) using Temporal Linear Time style. 



15. Structure Analysis Tool 473 

 

 

− − 

 

 Structure Analysis Tool 
 
The structure analysis tool allows the display of preferential orientation described by all enabled events. The geometry 

of the fracture network is calculated using the three-point method (Figure 15-1). The method determines the dominant 

structure within a cloud of events by building planes fitting every group of 3 events, resulting in a total of  N (N 1)(N 2)/6 

planes (represented by their poles pointing to the south hemisphere), where N is the number of events in the cluster (all 
enabled events). 

 
 
 
 

 
 

Figure 15-1: Representation of the Methodology Followed in the Three Point Method. 
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The events fitted in each individual plane can be constrained spatially considering a minimum and maximum separation 

for each triad that should be set based on the location accuracy and the extent of the fracture zone.  
 
The obtained pole distributions are displayed projected onto the southern hemisphere (Figure 15-2). Areas of high 

densities in the stereographic plot indicate the existence of a preferential orientation.  
 

 
Figure 15-2: Stereograph representation of dominant trends as shown by the application of the three-point 

method. The diagrams represent the poles A, B, and C and their associated planes. Directions are taken from the 
East, with 90 degrees corresponding to the North. Dip angles are 0 degrees on the outer circle and 90 degrees in 

the centre (complementary angle, 90-dip, for associated plane). 
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The distribution can be normalised by the distribution obtained for random generated events within the study volume 

if it is required to remove artefacts imposed by event spatial filtering. 
 

15.1 Running structural analysis  
 
 
The following steps are required to operate the structure analysis: 
 

1. Disable all components and events that are not required as an input for the analysis. 
 

2. Launch the structure analysis tool (Figure 15-3): from the Data Visualiser go to Tools>Launch Structural 

Analysis Tool, which will launch the configuration menu. 

 

 
Figure 15-3: Tool Menu to Launch the Structural Analysis Tool. 

 

 

Figure 15-4: Structural Analysis Configuration Menu 

 

1. The following variables can be set in the Structural analysis confirmation menu shown in Figure 15-4: 

(a) Radius grid points: this sets the resolution in degrees of the stereograph. 

(b) Colour Map: this variable sets the colour scale in the density plot. 

(c) Event Separation Limits: sets the minimum and maximum inter-event separation between events grouped 

in each of the triads. 

(d) Colour Scale Limits: sets the minimum and maximum of the density colour scale. This is calculated 
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automatically by default to the minimum and maximum frequency values for all bins. 

(e) Normalisation: allows entering of the number of events used in the generation of random distribution to 

normalise the distribution to remove artefacts from spatial filtering. Note that the normalised value is scaled  

back to the original number of the planes. The basic workflow of normalisation is as follows: 

• (1) Generate user defined “Number of Events” in the space with uniform random distribution. 

• (2) Calculate the number of planes based on the random events. 

• (3) Normalize the number of planes based on real events by the one on random events. 

• (4) Scale the normalized value to the original number of planes. 
 

2. Once the variables are set in the Structural Analysis Configuration menu click OK to perform the calculation. The 

time for this process depends on the number of enabled events; a timer provides an estimate of this computation 

time (Figure 15-5). 

 

 

Figure 15-5:  Timer Showing the Estimated Computation Time. 

 

3. The density distribution is automatically displayed (Figure 15-6). The scale limits and the colour scale can be 

adjusted clicking the Edit option in the stereograph window bar. The dip and strike angles are displayed below the 

plot when the cursor is hovered over the steorenet. 
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Figure 15-6: Output with the results of the structural analysis of a sample population of events. 
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15.2 InterEvent Plane Separation Histogram 
 
 
The inter-event plane separation histogram shows the distribution of the distance between event plane centroids. So, 

each event plane is compared with all the other event planes to determine the distance between them. Each distance 
is then plotted on the histogram. An example is shown in Figure 15-7. 

 

 

Figure 15-7: Inter-event plane separation histogram 
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The histogram can be configured using the dialog shown in Figure 15-8. The dialog can be opened by selecting properties 
from the edit menu. The dialog allows the lower/upper separation boundaries, minimum/maximum dip and azimuth 
angles, and the number of bins to be set. 

 

Figure 15-8: Inter-event plane separation histogram properties dialog
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 Array Analysis 
 
Introduction 
Misfit Error Space 
Error Space: Absolute Location Uncertainties 
Magnitude Sensitivity 
Shadow Space 
Monte Carlo Simulation Location Uncertainty  
Misfit Sensitivity 
Synthetic Waveform 
 

16.1 Introduction 
The Array Analysis Tool allows the user to model the performance of a monitoring array ahead of a microseismic 

monitoring project by analysing the impact of the array geometry and instrument sensitivity on the convergence of the 
location algorithm, the expected location uncertainty and the general sensitivity. The distribution over the monitoring 
space of three parameters can be analysed: 

• Location misfit space 

• Location error space 

• Magnitude sensitivity 

• Shadow space 

• Monte Carlo Simulation 

The functions are launched from the menu bar in the Data Management Visualiser, by clicking on Tools>Launch Array 
Analysis Tool (Figure 16-1), or by clicking the Array Analysis shortcut button in the 3D Visualiser. The array analysis Dialog 
is split into tabs: 

 
• Grid Parameters - For all mode options, the parameters are calculated over the volume defined in the Volume 

pane, or throughout the Grid-search volume defined in the locator properties tab. This option can be selected by 

clicking the Apply Grid Search Volume button. (Figure 16-2). 

• Locator Properties - Contains all the input parameters for the location algorithm (Figure 16-3). 

• Magnitude Sensitivity 

• Misfit Space 

• Error Space 

• Shadow Space 

• Monte Carlo Simulation 

• Synthetic Waveform 



482 16.1 Introduction  

 

 
The run an analysis, set the desired parameters in the grid and locator properties tabs, then select one of the  analysis 

tabs, se the input parameters, and then press the start button. 
 
Results are output for a plane with the orientation selected in the Orientation drop-down menu and a value for the 

third dimension defined in Location along 3rd axis. The calculations are performed for a number of points along each 
axis defined in the Number of Grid Points box. 

 
The results are written to Output Grid files, with the name and location defined in the menu, which are defined in the 

menu and can be displayed automatically in the 3D Visualiser by checking the Auto Import to Scene box. Grid files can also 

be imported into the 3D Visualiser by clicking on Scene>Import Grid File. The grid file storage folder and base name must 
be defined before performing calculations. Multiple planes can be shown simultaneously.  

 
Array analysis processes can be run in batches, allowing for multiple processes to be queued up and run sequentially 

without further user input. To add a process to the list, press the 'Queue' button and it will appear in the list view on the 
right of the dialog. To view a process in the list, click on it, and the values in the dialog will show the parameters of that 
process. To remove a process or processes, click on one or hold the 'Ctrl' key and click on several processes to select multiple 
processes, and press the 'Remove' button. Click the 'Start' button to run all the processes in the list. A green tick will appear 
next to each process that has been completed. If the process list is empty, and the 'Start' button is pressed, the current 
parameters in the dialog will be used and added to the list and it will be processed. To remove all the processes that have 
finished, press the 'Clear Completed' button. The batch process list can be saved to the project by pressing the 'Save' butto n 
and restored by pressing the 'Load' button. By default, when the array analysis dialog is opened, the stored list of processes 
is not restored. If the process list is empty and a simulation is run, it will automatically be cleared from the list after it has 
been completed, only processes that have been queued will remain in the list. 

 
The following sections describe the specific calculations and user-defined parameters for each of the analyses. 
 

 
Figure 16-1: Menu bar drop-down menu for launch of the Array Analysis Tool. 
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Figure 16-2: Array analysis grid parameters tab. 
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1. Volume: The calculation is performed in a 3D volume defined in this panel. Usually the same volume for grid 

search is applied. 

 
2. Grid Parameters: The orientation of the 2D plane and its position along the 3rd axis must be defined. The 

number of Grid Points controls the resolution of the 2D plane. The Receiver Array and Velocity Model are fixed. 

 
3. Output Grid File: The generated 2D plane files must be stored on local drive. Check Auto Import to Scene to 

import the 2D plane into the 3D visualiser after generation. 

 
4. Enable Parallel Processing allows InSite to use more than one core for calculation. 

 
 

 
Figure 16-3: Array analysis locator properties tab. 

 
 
The processing parameters are identical to those in the Collapsing Grid Search section 
 
 
 

16.2 Misfit Error Space 
 
The misfit space for a given location within an array is an indicator of how accurately the array can locate an event at 

that location. The misfit at any point within the monitored volume is a function of the difference between the arrival times 
and P source vectors at the sensors from this point and the arrival times from the true location, defined in the Event Position 
options. The travel-time and source vector difference is calculated using the L1 or L2 norm. In source location algorithms a 
statistical approach is performed on measured arrival times to minimise the misfit and to calculate the best possible source 
location. The source vector weight value is a scaling value to equate units of time and angle and should be set appropriately 
(Figure 16-4). 

 
If the array design has good spatial coverage relative to the given location, then the misfit will be a smooth surface with 



16. Array analysis 485  

 

one single minimum centred on the true location (Figure 16-5). However, if the array design has poorer spatial coverage 
relative to the given location then the misfit will exhibit local minima in which the source location algorithm may get 
'trapped' and so yield erroneous results. 

 

The location algorithm and velocity model used in the calculations are defined in the Processing Properties>Locater 
menu. The results can be output in the 3D Visualiser (Figure 16-5). Selecting the option Show Ray Traces prior to 

calculation allows the user to also display the ray paths between the theoretical event position and the monitoring 
instruments in the 3D Visualiser (Figure 16-6). Right-clicking on a plane gives a menu with three options: delete, export and 
properties. Delete removes the plane from the visualiser scene. Export allows the user to create a bitmap file of the plane. 
Properties launches the colour scale Dialog if this is not already displayed. The limits and colour map used in the colour 
scale can be adjusted by clicking on Edit in the Colour Scale window and selecting values in  the configuration window 
(Figure 16-7). The transparency of the density plane can be adjusted by moving the sliding bar. Reset button will set the 
min and max value to the default. 

 

 
Figure 16-4: Configuration parameters for the misfit space analysis. 
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1. Norm for residual calculation 

 

2. Position of theoretical event 

 

3. Display ray paths from theoretical event position to all instruments 

 

4. Weight value to equate units of time and angle 
 

5. Close (saves parameters), Start process/s, Cancel (close without saving parameters) 

 
 

 
Figure 16-5: Example of the display of the misfit space, showing a minimum around the position of the theoretical 

event. 
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Figure 16-6: Example of the display of the misfit space, showing the ray paths from the theoretical event position 

to the monitoring instruments. 
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Figure 16-7: Menu for adjusting the colour scale in the density maps. 
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16.3 Error Space: Absolute Location Uncertainties 
 
An important measure of the performance of an AE, ultrasonic or microseismic array is the absolute location un - 

certainty that will result for an event located at any point within the monitored volume. The procedure involves 
generating a sample of user selected synthetic events at each point of a given grid (Number of Random Events). Travel 
times between each event and each sensor are calculated using forward modelling through the velocity model. 
Options are available in the Array Analysis Dialog (Figure 16-9). 

 
In practice the quality of the locations that can be obtained from a monitoring array are influenced by  many factors. 

These include: 
 

• Accuracy in the location of the instruments. 
 

• Accuracy of the velocity model. 
 

• Picking errors on the waveforms - due to attenuation of the signal, picking errors get larger as the source position 

moves away from the array. 

 

• Poor spatial coverage of the array (causing local minima in the misfit space). 
 

• Effectiveness and resolution of the location algorithm. In this study a collapsing grid search algorithm is 
used. 

 

• Effect of ray-paths perturbed by voids, back-filled and highly attenuating structures. 
 
The Travel Time Error (in sample points) at the Source and at the Critical Distance is used to estimate the uncertain- ties 

associated with these parameters. These values should be set up according to the expected picking accuracy. The Travel 
Time Error at the Source corresponds to the expected picking error for an event located close to the monitoring array 
(expected to be between 0 and 2 sample points). The Travel Time Error at the Critical Distance corresponds to the expected 
picking error for an event located beyond a user-defined distance from the source (expected to be higher, on the order of 
2-10 sample points). These uncertainties are used to perturb the arrival times associated with theoretical events and these 
arrival times are then used to calculate an 'event location'. The error at each analysed point within the monitored volume 
is then derived from the mean deviation of the random synthetic events from the known 't rue location'. These errors are 
contoured to provide the absolute location uncertainty on a section through the array. In total 6 grid planes will be output 
(and automatically imported into the scene) (). Plane 00 to 02 corresponds to the error along North, East, Depth directions. 
Plane 03 is the lateral error and plane 04 displays the absolute error in 3D. Plane 05 is simply the average location at depth, 
which usually varies in the neighbourhood of the true depth position. Note that the source vector is not used in the location . 
For single well monitoring, a Monte Carlo Simulation is recommended. 

 
Figure 16-8: Output grid files for the error space analysis. 

 
When Start is clicked a progress bar opens to show the progress of the calculation (Figure 16-10). The processing time 

will depend on the location algorithm, complexity of velocity model, number of grid points and number of random 
events chosen at each point. 
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Figure 16-9: Configuration parameters for the error space analysis. 
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1. Instrument sampling frequency 

2. Picking error in sample points for events located next to the instrument 

3. Distance between events and instruments beyond which large picking errors are expected 

4. Picking error in sample points for events located beyond the critical distance 

5. Number of simulations at each grid point 

6. Factor for the error in S-wave picking 

7. Close (saves parameters), Start process/s, Cancel (close without saving parameters) 

8.  

 
Figure 16-10: Progress window showing the status of the error space calculation. 

 

16.4 Magnitude Sensitivity 
This process calculates the minimum theoretical magnitude for an event to be detected at each point of the monitoring 

space. It is assumed that all sensors have an equal noise threshold. 
 
The analysis uses seismological theory, generalised scaling relations and waveform processing principles that are 

further described in the literature, e.g.Gibowicz and Kijko (1994) or Mendecki (1997). 
 

The Moment Magnitude, Mw, is a standard magnitude scale used to describe the size of an event and can be  
calculated using the following equation: 
 

𝑀𝑤 =  
2

3
𝑙𝑜𝑔10(𝑀0) − 6.1 

 
Other user-defined parameters for this calculation are: 
 

• Q factor: average attenuation factor for the medium between the seismic source (grid point) and the receivers. 
 

• Density: average density for the medium between the seismic source (grid point) and the receivers. 
 

• Velocity amplitude threshold: instrument noise level in velocity units. 
 

• Static stress drop (Brune stress drop). 
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Figure 16-11: Configuration parameters for the magnitude sensitivity analysis 
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In the case where wave propagation is purely elastic, the dominant peak in the velocity spectrum is equal to the corner 

frequency. When waves are propagating in an anelastic medium, energy is absorbed via various attenuation mechanisms 
and this has the effect of shifting the dominant velocity peak to a lower frequency. An example of this is presented in Figure 
16-11. 

 
For a certain source-receiver distance and input values for Q, stress drop, noise level, and density, InSite will 

determine the minimum detectable magnitude by comparing the noise floor to the value of the velocity spectrum at the 
dominant frequency. 

 
 

 
 

Figure 16-12:  Example of the display of the magnitude sensitivity space, showing the minimum detectable 
magnitude across two planes in the monitoring space. 

 
In this module the user can choose to find the minimum detectable magnitude for either P-waves or S-waves. For 

surface monitoring cases, the noise floor can be corrected for the effect of stacking on large arrays.  
 
This magnitude sensitivity can also be displayed by colour density planes in the 3D Visualiser (Figure 16-12). 
 
The iso-surface can be generated by right-click on the magnitude sensitivity plane and select "Show Isosurface" (Figure 

16-14).  
 
Note a 3D volume will be generated first, which is usually time consuming. For time efficiency, user can reduce the 

"Number of Grid points" under "Grid Parameter" tab. 
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Figure 16-13: Configuration parameters for the magnitude sensitivity analysis. 
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1. Minimum number of picks for an event to be detected 

 
2. Signal to Noise ratio 

 
3. Average rock attenuation factor (Q quality factor) 

 
4. Instrument detection (noise) level in units of velocity (m/s) 

 
5. Static stress drop (Brune stress drop) 

 
6. Magnitude resolution 

 
7. Average rock density 

 
8. Select between P and S waves 

 
9. Stack instruments 

 
10. Input units - choose whether to input units as metric or imperial 

 
11. Close (saves parameters), Start process/es, Cancel (close without saving parameters) 

 
 

Figure 16-14: Right-click on the magnitude sensitivity to generate iso-surface 

 
 
 

16.5 Shadow Space 
 
The shadow space calculation determines the number of sensors visible for each point on the search grid using  direct 

line of sight through solid material; hollow space is created using any of the drawing objects (8.18). An example of this is 
shown in Figure 16-15. Note: Only the common dialog parameters are required for the shadow space process. 
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Figure 16-15: Shadow space calculation for a vertical hole surrounded by three boreholes each with eight sensors 

 

16.6 Monte Carlo Simulation Location Uncertainty 
 
 
The Monte Carlo simulation analyses the impact of uncertainties in the velocity model on the event location. Theoretical 

trial event positions are input using the 'Default Shot/transmitter array'. For each of the defined trial positions, InSite 
calculates the theoretical travel times using the velocity model defined in the 'locater'. A user -defined number of 
simulations are then performed randomly varying P- and S-wave velocities for all defined layers with a variance defined in 
the 'array analysis' interface (Figure 16-16). Multiple 3D positions can be imported from a CSV file. Alternatively, the user 
defined 3D position can be used by checking the checkbox. The events are fitted by an ellipsoid to represent the error. 
Right-clicking on this ellipsoid and clicking on properties shows the dimensions of the ellipsoid, the axes  are two times the 
standard deviation. 
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Figure 16-16: Configuration parameters for the velocity sensitivity analysis. 
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16.7 Misfit Sensitivity 
 
The misfit sensitivity is an extension of Misfit Error Space to visualise the maximum error distribution for a user 

defined threshold. The misfit sensitivity is low for the well constrained monitoring geometry (Figure 16-17a), as the misfit 
drops significantly as moving away from the true position. Likewise, the misfit sensitivity is high for inadequately 
constrained monitoring geometry such as in a single well (Figure 16-17b). The misfit sensitivity is calculated for each 
grid point on a 2D plane using the misfit values in a cubic box. The configuration parameters are shown in (Figure 16-18). 
The Search Pixels are the total number of grid points along North, East and Depth directions. The Search Pixel Size 
specifies the grid interval in the same unit of distance as in the PCF project. As an example, using 10 pixels with 1-
meter grid interval, the misfit sensitivity is searched within a 10m x 10m x 10m box surround each grid point. Note 
that a small box with a large threshold, the sensitivity will be truncated at the edge of the box. Thus, a relatively small 
threshold and a relatively large box are recommended. The Misfit Error Space parameters are used to calculate the 
misfit error. Three 2D planes (appended with 00, 01, 02 sequence number) are the sensitivity sampled on a horizontal 
plane, along vertical axis and in 3D, respectively. 

 

 
 

Figure 16-17: Illustration of misfit sensitivity calculation for (a) a single well monitoring array with inadequate 
azimuthal coverage and (b) a well constrained monitoring array. The colour corresponds to the misfit value (blue is 

low and red is high). The black box scans through the misfit space in 3D and assign the maximum misfit error to 
each grid point. 
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Figure 16-18: Configuration parameters for the misfit sensitivity analysis. The Search Pixels are the total number 
of grid points along North, East and Depth directions. The Search Pixel Size specifies the grid interval in the same 

unit of distance as in the PCF project. 

 
 
 
 

16.8 Synthetic Waveform 
 
The synthetic waveform generate allows users to produce ray-based synthetic waveform for layered model or 

analytical waveform (the true solution) for homogeneous model in any locations defined in the 3D visualiser using icon 

 or specified in a CSV file. In addition to the location, the user can also specify the fracture orientation in terms of 
strike, dip, rake in degree unit (Figure 16-19). The synthetic waveform is stored as ESF files with first arrivals picked, 
which is equal to the theoretical arrivals from the known location. Users can test multiple location or moment tensor 
inversion algorithm using the synthetic waveform to further optimize the network geometry or choose the most 
appropriate the processing algorithm. The ESF files are stored under a new component. Note that the origin  time of 
the synthetic waveform is set as the pre-signal window length (Event Initialisation ) for performance purpose. Users 
can alter the pre-signal window length to have a different origin time (e.g., zero origin time) for the synthetic waveform. 
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Figure 16-19: Configuration parameters for the synthetic waveform generation. 
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1. Wavelet Properties: the dominant frequency is related to the moment magnitude. For any user defined dominant 

frequency, the empirically calculated moment magnitude is display as a reference when homogeneous model is used. 

For layered model, the true amplitude is not reserved, and P/S ratio specifies the amplitude ratio. For analytical 

waveform, only the 1st Gaussian Derivative is available as source time function. 

2. Wave Types: only direct waves (both P and S) are available for analytical waveform. Other options are for ray-based 

synthetic waveform for layered model. 

3. Radiation Pattern: User is allowed to define the fracture failure mode in terms of strike, dip, and rake in the unit of 

degree. This is ignored if (strike, dip, rake) are provided in 3D position file. 

4. Source Location: User can either use 3D Event Position for a single event or define a group of events in a CSV file. 

5. Recording Time: User must define the total recording time for all events. 
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 Frac Manager 
 
Introduction  
Managing Well Data  
Managing Stage Data 
Frac Manager Operations in the InSite Visualisers  
Calibrating the Velocity Model in the Waveform Moveout View  
Using the AutoLeach for Realtime Acquisition 
Calibration Shot Guide 
 

17.1 Introduction 
Principal Features User Interface 
Frac Manager Setup Wizard  
Coordinate Systems  
Processing Flow 
 

17.1.1 Principal Features 
The Frac Manager is a software utility run from within ASC’s InSite Seismic Processor. It has three primary objectives: 

1. To manage all data from a microseismic hydrofracturing project within InSite; 

2. To guide a geophysicist through the data acquisition and processing flow for microseismic  monitoring; 

3. To coordinate data output and integration with external user software through an accessible remote database. 
The Frac Manager is an independent tool within InSite and requires the relevant permissions in the user's software key. 
This manual gives a description of the software operations within the tool. Some of the key features of the tool are as 

follows: 

• The Frac Manager is an integrated component of ASC's InSite Seismic Processor, thus providing one simple point 

of entry for the user and providing easy-to-use configuration and operation; 

• Imported data seamlessly interacts with InSite's main data management systems; 

• Manages and integrates data across multiple wells and hydrofracture stages; 

• Integrates processing of waveform information from calibration shots (classically perforation or string shots); 

• Coordinates evaluation of geophone orientations and velocity structure from the calibration shots; 

• Automatically sets the required parameters to the InSite project for data capture and real-time processing using 

the InSite Leach; 

• Automatically configures data for three-dimensional visualisation functions; 
 

• Guides the user through the data acquisition and processing flow by enabling/disabling items on the menu 

systems; 

• Automatically exports configuration data to InSite's remote database built on Microsoft SQL (InSiteDB). 
 
 

17.1.2 User Interface 
Figure 17-1shows the user interface for the Frac Manager. The Dialog box is opened from the Data Visualiser menu 

in the main InSite program (Figure 17-2). The user should select Tools then Launch Frac Manager. 
The Dialog box is split into three parts: 
 

• The top part defines the reference position (origin) of the global coordinate system and the depth label; 
 

• The Well Data View displays information imported for the wells used in the project; 
 

• The Stage Data View displays information on the stages used in the project. 



504 17.1 Introduction  

 

 
A "well" is defined as a borehole with a single continuous trajectory. A well must have a trajectory defined by the user. 
A "stage" is defined as a single MS monitoring phase in which the geophone array is not re-positioned. A stage therefore 

has a single "Reference Receiver Array" used to monitor calibration shots, and an "MS Receiver Array" used to monitor the 
hydrofracture treatment. The only differences between these two arrays are the receiver orientations, which are computed 
from the calibration shots. 

 
The user can create multiple stages with the same receiver array if desired; i.e. if two or more hydrofracture  treatments 

are performed for the same static receiver array. 

 
 

Figure 17-1: Example of the Frac Manager user interface. 



17. Frac Manager 505  

 

 

 
Figure 17-2: Launching of the Frac Manager is performed from the Tools menu in the Data Visualiser. 
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17.1.3 Frac Manager Setup Wizard 
 
The frac manager setup wizard is designed to setup up a processing job in a simpler and quicker way. The wizard 

can be launched in one of two ways: 
 

4. Selecting a new project from the start page (Figure 17-3). 

 
Figure 17-3: Starting new project from start page 

 

5. Activating real time mode and selecting the frac manager from the global button bar (Figure 17-4) 

 

 
 

Figure 17-4: Launching frac manager wizard within an existing project 
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There are seven steps to setting up the Frac manager (Figure 17-5): 
 
 

1. Wells - Add monitoring, treatment, and offset wells. 
 

2. Tools - Add downhole arrays. 
 

3. Shots - Add downhole and vibe shots. 
 

4. Logs - Import sonic logs and edit velocity model. 
 

5. Well Objects - Import visual aids (formation tops, packers, sleeves, and plugs). 
 

6. Stages - Add and configure stages. 
 

7. Processing Properties - Configure filter and trigger parameters. 
 

 
 

Figure 17-5: Frac manager setup wizard interface 



508 17.1 Introduction  

 

 

17.1.4 Coordinate Systems 
Operating the Frac Manager is split into two distinct phases: 
 

1. The user inputs data into the Well Data View so as to create a database of wells used in the project; 

2. The user creates stages in the Stage Data View by selecting data from within the well database, and then 

processing calibration (perf) shots and MS waveform data. 

The user can input as many wells as required; for instance, there may be just a single well in which both monitoring and 
treatment is being performed, or there may be multiple monitoring wells and multiple treatment wells. The user manages 
the hydrofracture treatments within the stages. 

 
The primary reason for including two distinct phases is because hydrofracture engineering data is formatted in a one -

dimensional "Well Coordinate System", whereas MS monitoring is performed in a three-dimensional coordinate system 
defined by the geophone positions (termed here as the "Local Coordinate System"). 

The Well Coordinate System is simply Measured Depth (MD), being the distance recorded down the borehole trajectory 
from a pre-defined datum. 

 
The Local Coordinate System is a Cartesian 3D space with axes Northing, Easting and TVD (True Vertical Depth) relative 

to a pre-defined origin (Figure 17-6). The well trajectory is defined in 3D space by a survey of the well bore, termed here as 
the "Well Trak", relative to a 3D well-head position. 

 
Well-head positions are often described for a particular petroleum field in terms of a "Global Coordinate  System" 

referenced to geographical coordinates of a country or state. For MS monitoring it is often more convenient to work in 
coordinates that are referenced to a position local to the project such as a well head or treatment position in the field. 
The user can thus configure a Global Coordinates Reference Position in the Frac Manager, this being the origin of the 
Local Coordinate system in the Global Coordinate system. 

 
Note that all data in the Global Coordinate System must also be in a Cartesian system of Northing, Easting and 

TVD. 
 
Managing the wells in the Well Data View thus performs the important step of transforming the hydrofracture 

engineering data from the Well Coordinate System into the Local Coordinate System in preparation for processing of 
calibration shots and MS data managed by the Stage Data View.  
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Figure 17-6: Illustration of the coordinate systems used in the Frac Manager. 
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17.1.5 Processing Flow 
 
 
The general processing flow for a hydrofracture project is described in Figure 17-7. The general processing flow is 

structured as follows: 
 

a. A user defines the pre-requisite information such as Global Coordinates Reference Position, Well Tracks, 

Calibration Shot Positions and Geophone Positions (there may also be additional information such as well logs and 

formation tops); 

 

b. The pre-requisite information is transformed to local Northing, Easting and TVD coordinates automatically in the Well 

Data View in the Frac Manager; 

 
c. Waveforms are acquired for the calibration shots and processed for geophone orientations and velocity structure; 

 

d. Waveforms for MS events are acquired and processed for source locations and other source parameters such as 

magnitudes; 

 
e. Source location and source parameter data is displayed to the user; 

 

f. New hydrofracturing stages can be performed. 
 
Waveforms for calibration shots and MS events are automatically imported and processed using the InSite Leach.  
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Figure 17-7:  General processing flow for a hydrofracture monitoring project. 
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17.2 Managing Well Data 
 
The Global Coordinates Reference Position 
 Depth Label 
The Well Data View 
The Well Dropdown Menu  
Principal Well Functions 
 
 

17.2.1 The Global Coordinates Reference Position 
 
The Global Coordinates Reference Position (Figure 17-8) defines the origin of the Local Coordinate System within the 

Global Coordinate System (often referenced to a country or state). It only needs to be used if  the Well-head positions are 
to be defined in the Global Coordinate system and the user wishes to transform all position data to a more user-friendly 
Local Coordinate System defined for the project (see Table 7.1 for an example). 

 
The parameters should be left as 0.0 if the well-head positions are already in the Local Coordinate System that the user 

wishes to utilise. 
 

 
 

Figure 17-8 The Global Coordinated Reference Position on the Frac Manager Dialog. 

 

Table 17.1: Example of well head positions in the Global Coordinate System (GCS) and Local Coordinate System 
(LCS). In this example the origin (Global Coordinates Reference Position) of the LCS is at the Well A well head 

 

 
Well A well-head 

position (GCS) 

Well B well-head 

position (GCS) 

Well A well-

head position 

(LCS) 

Well B well-head 

position (LCS) 

Northing (feet) 

Easting (feet) 

TVD (feet) 

83,675,438.6 83,674,825.3 0.0 -613.3 

67,386,239.2 67,386,372.9 0.0 133.7 

-2769.1 -2783.5 0.0 -14.4 

 
 

17.2.2 Depth Label 
The Depth Label (Figure 17-9) defines how depth is labelled within the Frac Manager. An example of this would be 

TVDSS (true vertical depth subsea). Any changes made to this edit field take effect when the user clicks away from it. 
 

 
Figure 17-9: The Global Depth Label on the Frac Manager Dialog. 

 
 

17.2.3 The Well Data View 
The Well Data View (Figure 17-10) displays information on the wells imported into the project by the user. The wells 

provide a database of information from which the user can build stages, and which is used in three-dimensional 
visualisation using the 3D Visualiser. Each well appears as an item in a tree control (much like folders in Windows Explorer). 
The well can be "opened" so as to display different data items imported into the well, such as  the Well Trak, Calibration 
Shots and Receiver Arrays. The Well Data Pane displays information on the selected data item including imported 
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formation tops and well logs. 
 
 
 

 
 

Figure 17-10: Example of the Well Data View in the Frac Manager. 

 
 

17.2.4 The Well Dropdown Menu 
 
 
The Well Drop-down Menu (Figure 17-11) provides the facility for adding wells into the project and importing data 

items from text files. The enabled items on the menu are dynamic and depend on the data available. The following section 
describes the principal functions performed from the menu. 
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Figure 17-11: The Well Drop-down Menu in the Frac Manager. 
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17.2.5 Principal Well Functions 
Add New Well Data  
Add New Vibe Shot 
Import Calibration Shots  
Add Calibration Shot  
Import Receiver Array 
Importing Additional Well Data 
 Well Visualiser Objects 
Import Treatment Data 
 

17.2.5.1 Add New Well Data 
The Add New Well Data function displays the Well Trak Dialog box as shown in Figure 17-12. A new well is added 

to the project after successfully importing data using this Dialog and the user clicking on the OK button. 
 
The Well Trak Dialog can be used in two ways: 
 

1. The user can import a well trajectory from a survey data file; 
 

2. The user can add a vertical well. 
 
In case (1) a survey data file must first be located on the user's computer using the Browse function.  Files with .txt or 

.csv extensions are available for selection. An example is shown in Figure 17-13. The file can have any number of header 
lines above column-formatted, survey-data rows. The file can also have multiple data blocks, each with a set of header lines 
and survey-data rows. Each data row may contain any number of columns, but the trajectory must be defined using values 
in either of the two following parameter sets: 

 

• MD (Measured Depth), TVD (True Vertical Depth below well head), Easting (E) and Northing (N). 
 

• MD (Measured Depth), Inclination and Azimuth. 
 
These values define a three-dimensional trajectory for the well and are used to interpolate any provided MD to a 

(N,E,TVD) coordinate. It is best to only set the column assignments for the parameters you need to use. 
 
The user then adds the column specifications for the data to import, being the column number for each value in 

the file (starting from column 1 on the far left). The columns can be space or comma delimited. The user can then 
provide a well name and a well head position - these can be optionally changed at a later time but are used by the 
software when importing any data items into the well - therefore care must be taken that these are correct before 
progressing to importing further items. 

 
The "Import from Well Trak File..." check-box should remain checked and the user then click on the Import (or Set) 

Well Trak button. The imported well track should be viewed in the Well Data Pane in the Frac Manager and checked by 
the user for correct import. 

 
Selecting the Edit Well Properties function from the Well Drop-down Menu will re-open the Well Trak Dialog so that 

values for parameters can be changed or the well survey data re-imported. 
 
The survey file must exhibit the following rules: 
 

a. The keyword "Survey" must be used to differentiate the survey data rows from the text header; 

 

b. There must be two title lines (containing any text) between the keyword and the first data row; 

 

c. There cannot be any non-numeric characters in the data rows. 
 
The user can thus import many forms of raw survey data file by simply adding the keyword in the appropriate line and 

noting the column specifications in the file. 
 
In case (2) the user can set a vertical well without needing to import a survey file. In this case the maximum TVD of the 

vertical well is defined - the well then extends from the well-head position to this depth. The user should de-select the 
"Import from Well Trak File" check-box and click on the Import (or Set) Well Trak button. 

 
The user must also select the Well Type from the drop-down box (Exploration, Monitoring, Injector, Treatment or 

Producer). The well type defines the colour of the well displayed in the 3D Visualiser. 
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The user can override the default colour for the type of well selected by checking the corresponding check box and  

using the Set Well Colour button to choose a particular colour. 
 
 

 
Figure 17-12: The Well Trak Dialog. 



17. Frac Manager 517  

 

 

 

Figure 17-13: An example of a well survey file. 

 
 

17.2.5.2 Add New Vibe Shot 
The Add New Vibe Shot function displays the Vibe Shot Properties Dialog box shown in Figure 17-14. A new vibe shot is 

added to the project after the user clicks on the OK button. A calibration shot will be automatically inserted underneath 
the vibe shot object in the well data view. This calibration shot will have the same position as the vibe shot, however the 
position will be adjusted so that it is relative to the Global Coordinates Reference Position. 

 
Selecting the Edit Vibe Shot function from the Well Drop-down Menu will re-open the Vibe Shot Properties Dialog so 

that values for parameters can be changed. 
 

 
Figure 17-14: The Vibe Shot Properties Dialog. 

 
 

17.2.5.3 Import Calibration Shots 
 
The Import Calibration Shots function allows a perf file to be imported into the selected well. An example of the 

file is provided in Figure 17-15 and Figure 17-16. The file is comma delimited so that it can be easy visualised in 
Microsoft Excel. The file must contain three header lines followed by the data rows. The first four columns in the data 
row must contain respectively: Stage Number; Perf Number; Perf Gun Top MD; Perf Gun Bottom MD. The following 
columns can be any data the user wishes and are not imported. The Stage Number and Perf Number are for user 
reference only and are not used by the Frac Manager. The average of the perf gun top and bottom is used to calculate 
a (N, E, TVD) coordinate for each perf on import. 
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Figure 17-15: Example of a perf file displayed in Microsoft Notepad 

 

 
Figure 17-16: Example of a perf file displayed in Microsoft Excel. 

 
 

17.2.5.4 Add Calibration Shot 
As well as importing calibration shots it is possible to add them manually. The Add Calibration Shot function displays 

the Calibration Shot Properties Dialog box as shown in Figure 17-17. A calibration shot is added to the well object after the 
user clicks on the OK button. The calibration shot's position is automatically set such that it is relative to the Global 
Coordinates Reference Position. 

 
Selecting the Edit Calibration Shot function from the Well Drop-down Menu will re-open the Calibration Shot 

Properties Dialog so that the measured depth and name can be changed. 
 
Note that the calibration shot is shown in grey in the well data view until it has been configured to reference a set of 

waveforms. This referencing can be performed after the calibration shot has been added to the stage data view.  

 
Figure 17-17: The Calibration Shot Properties Dialog. 
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17.2.5.5 Import Receiver Array 
The Import Receiver Array function allows a receiver array to be imported into the selected well from a MIRF-format 

RCD file or an appropriate comma delimited CSV text file. The Dialog box that opens when Import Receiver Array is 
selected allows the user to browse to an appropriate file, and the 'Files of type' box can be set to either RCD or CSV 
as required. 

 
The RCD file is written by an Avalon acquisition software and contains the measured depths for each of the geophones 

in the string. The depths are used to calculate the (N, E, TVD) coordinates for each geophone on import. The geophone 
reference coordinate system is assigned to the three axes automatically. 

 
The CSV file must have a format similar to that shown in Figure 17-18. The file has columns for channel number, 

instrument number, axis type, measured depth, orientation (iE ,iN, iD), gain, sensitivity and VMax. The axis type X, Y, Z is 
respectively 0, 1, 2. If the gain, sensitivity and VMax columns are not included in the file they are assigned default 
values. 

 
Figure 17-18: Calibration Shot Dialog: Example of a receiver array CSV file. 

 
Imported receiver arrays can be edited using the receiver array Dialog. 
 
 

17.2.5.6 Importing Additional Well Data 
 
Additional well data can also be imported into the well objects. Data includes:  
 

• Import Well Log (GR = gamma ray, PS = P-wave sonic log, SS = S-wave sonic log) using a file as shown in 

Figure 17-19; 

 

• Import Well Objects (formation Tops, packers, sleeves or plugs) using file formats similar to that shown in Figure 

17-20 (note that one file can be used for many wells, but the well names used in the Frac Manager must be 

accurately described). 

 
Measured depths are converted to (N, E, TVD) coordinates on import. The gamma ray well log and formation tops are 

displayed with the well track in the Well Data View. 
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Figure 17-19: Example of a Well Log file for import into a well object. The file is comma-delimited containing two 

columns of measured depth and log values. The first line is a header line, the second column of which must be 
labelled GR for a gamma ray log, PS for a P-wave sonic log or SS for a S-wave sonic log. 

 
 

 
Figure 17-20: Example of a Formation Tops file. Each formation top is defined by a well name, the formation 

name and the measured depth in that well. 

 
For well objects, packers, sleeves and plugs require columns for Well label, packer name and MD in the well while 

packers and sleeves also require a column for length. 
 
 

17.2.5.7 Well Visualiser Objects 
 
Four different types of well visualiser objects can be added/imported: 
 

• Formation tops 
 

• Packers 
 

• Sleeves 
 

• Plugs 
 
 
To add an object, right-click on a well in the well data view and select "Add Well Objects ". Figure 17-21 shows the dialog 

to add a well object. Choose the owner well and type from the drop-down menus and enter the object properties. Press 
the "Add" button to add the well object to the well; if successful, a message will appear the text box. 
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Figure 17-21: Add well object dialog 

 
To import a well object, right-click on a well in the well data view and select "Import Well Objects ". All well object types 

belonging to any well can be imported from a single CSV file (Technical Appendix section 2.22). The time attribute of the 
well objects can be defined in the CSV file or adjusted individually in the 3D visualizer. It will be used in  the playback function 
to indicate the time period of operations (Time Functions in the Visualiser). 

 
 

17.2.5.8 Import Treatment Data 
 
The Import Treatment Data function allows the engineering treatment data to be imported into the selected treatment 

well from an appropriate comma delimited CSV text file. The Dialog box that opens when Import Treatment Data is 
identical to the pumping data chart in Parameter Visualiser. It allows the user to import and select certain engineering 
curve for display purpose. Note that the engineering data imported in frac manager can be used to scale and colour 
events in 3D visualiser as well. 

 
After importing, the treatment data are assigned to each stage that has the begin and end time defined. The treatment 

data can then be displayed. See Create a super stage function for details. 
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Figure 17-22: Import treatment data to the treatment well 

 
Imported treatment data can be displayed for individual stage. 
 
 

17.3 Managing Stage Data 
 
The Stage Data View 
The Stage Dropdown Menu  
Principal Stage Functions 
 Automatic Velocity Calibration  
Frac Processing Properties 
 
 
 
 

17.3.1 The Stage Data View 
 
The Stage Data View (Figure 17-23) displays information on the stages built by the user in the project. Each stage 

appears as an item in a tree control (much like folders in Windows Explorer). The stage can be "opened" so as to 
display different data items that have been added to it, such as the Perf or MS Receiver Arrays, or Calibration shots. 
The Stage Data Pane displays information on the selected data item. 
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Figure 17-23: Example of the Stage Data View in the Frac Manager. 

 
 

17.3.2 The Stage Dropdown Menu 
The Stage Drop-down Menu (Figure 17-24) provides the facility for adding stages into the project and managing data 

within them. In order to completely configure a stage, the user must follow a process that guides them through the field 
operations. The primary objectives of this process are: 

 

1. Configuring a project for calibration shot (e.g. perf shot) acquisition; 
 

2. Calculating an MS Receiver Array and Velocity Structure from data processed in the calibration shots; 
 

3. Configuring a project for MS acquisition having calculated (2); 
 

4. Managing data from the stages for display in the 3D Visualiser. 
 
The enabled items on the menu are dynamic and depend on whether each phase in the process has been completed 

successfully. The following section describes the principal functions performed from the menu. 
 
Note that stages in the Frac Manager can also be used to manage MS data and pressure data without needing to  
follow the field operation process. 

 
Figure 17-24: The Stage Drop-down Menu in the Frac Manager 
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17.3.3 Principal Stage Functions 
Adding and Configuring a New Stage  
Set Active Stage 
Set Project for Calibration Acquisition 
Processing Calibration Shots 
Calculating Stage Data from Calibration Shots  
Set Project For MS Acquisition 
Copying an MS Receiver Array between stages  
Set Velocity Model for Project 
Launch WaveBuilder 
Adding Additional Stage Data  
Create A Super Stage 
 

17.3.3.1 Adding and Configuring a New Stage 
The user can add a stage to a treatment well by selecting the Add New Stage function from the Stage Drop- down 

Menu. The function automatically displays the Frac Manager Stage Properties Dialog (Figure 17-25). Parameters include: 

• The Stage Name is used to identify the stage; 

• The ID is used to uniquely identify the stage; 

• The Max. Angular Residual is used in the averaging of receiver axial orientations processed from the 

calibration shots; 

• The Stage Colour is used to define the colour of MS events, geophones and calibration shots when displayed 

in the 3D Visualiser; 

 
• The Colour Scale determines the colour scheme used for MS events in the 3D Visualiser, e.g. by location 

magnitude. Note this only applies when the stage is set as the active stage. 

• The MS Symbol Type provides the symbol type used for MS events in the 3D Visualiser. 
 

• The Auto Set Time will set the start and end time of this stage by the earliest and the latest event time stamp, 

respectively. Manual input is needed if stages has no MS component. 

 
 
The stage properties can be edited at any time by selecting the Edit Stage Properties function from the Stage Drop-

down Menu. 
Treatment wells are automatically added to the Stage Data View from the well data defined previously.  
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Figure 17-25: The Frac Manager Stage Properties Dialog. 
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In order to follow the processing flow, the user must first add a "Calibration (Reference) Receiver Array" and a set of 

"Calibration Shots" after adding a new stage. Selecting either of the two respective functions on the Stage Drop -down 
Menu displays the Frac Manager Selection Dialog, given in Figure 17-26 or Figure 17-27, which shows the available data in 
the wells. The user can then select the appropriate data from the wells to add to the new stage.  Note that to add all the 
calibration shots from a well to the stage, the calibration shots folder may be selected in the selection Dialog. 

 

 
Figure 17-26: Well-data Receiver Arrays displayed in the Frac Manager Selection Dialog. 
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Figure 17-27: Well-data Calibration Shots displayed in the Frac Manager Selection Dialog. 
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17.3.3.2 Set Active Stage 
 
One of the Frac Manager Stages can be set as the "active stage". The significance of this is that when new events are 

leached into InSite the new Components are automatically assigned to the active stage. In addition, events in the active 
stage can be coloured in the 3D Visualiser according to the colour scale set up for that stage. 

 
To set the active stage use the Active Stage menu option in the stage tree pop up menu for the selected stage. 

Afterwards, the active stage has a green tick added to its tree icon as shown in Figure 17-28. 
To cancel an active stage, the Active Stage menu option can be selected again.  
 

 
Figure 17-28: Active Stage Indicator. 



17. Frac Manager 529  

 

 

17.3.3.3 Set Project for Calibration Acquisition 
 
Once the stage has been added and configured from the previous section, it can then be used to automatically 

configure the project for calibration shot acquisition using the Set Project for Calibration Acquisition function from the 
Stage Drop-down Menu. This function copies the Reference Receiver Array over to the project settings. The InSite  
Leach or InSite's Data-management Dialog can then be used to import the calibration shot waveforms into the project. 

 
 

17.3.3.4 Processing Calibration Shots 
 
A calibration shot is managed within InSite as an "event" displayed within the Data and Waveform Visualisers and 

consists of a set of waveforms (one recorded for each channel of acquisition). 
 
"Calibration Shots" can be any down-hole or surface shots performed for calibrating the geophone orientation and 

velocity structure. As such they can include perforation shots, string shots, vibe shots etc. For the purposes of the  Frac 
Manager the term "Calibration Shots" is used for any of these shot types. 

 
An example of InSite's Waveform Visualiser is shown in Figure 17-29. When a calibration shot's event is first processed 

by a user it should be linked to the calibration shot data in the Frac Manager by clicking on the button (i). This displays the 
Frac Manager Selection Dialog shown in Figure 17-30 containing all available calibration-shots added by the user to the 
stages. The user can then select the appropriate calibration shot for linking to. Data from the calibration shot, such as 
its position, are automatically set to the event. 

 

 
 

Figure 17-29: Example of waveforms recorded from a calibration shot displayed in the Waveform Visualiser.Blue 
cursors indicate the picked P-wave arrival. Inset shows expanded P-wave arrivals. (i), (ii) and (iii) indicate 

processing buttons discussed in the text. 



530 17.3 Managing Stage Data  

 

 

 
Figure 17-30: Stage-data Calibration Shots displayed in the Frac Manager Selection Dialog. 



17. Frac Manager 531  

 

 
The waveform data can then be processed for geophone rotations and velocity structure using buttons (ii) and (iii) 

respectively, shown in Figure 17-31. The processing provides results to the user in Dialog boxes as shown in Figure 
17-32 and Figure 17-33. When the user clicks on either of the two buttons Store Rotations or Store Velocities the 
results are then stored with the calibration shot data in the Frac Manager. The results can be viewed in the Stage Data 
Pane after re-opening the Frac Manager. 

 
 

 
 

Figure 17-31:Processing Results Dialog displayed after processing geophone rotations. 
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Figure 17-32: Processing Results Dialog displayed after processing for the velocity structure. 
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Figure 17-33: Processing Results Dialog displayed after processing for the velocity structure. 

 
 

17.3.3.5 Calculating Stage Data from Calibration Shots 
Once the calibration shots have been processed, the user can continue the processing flow in the Frac Manager. 

Selecting the Calculate MS Receiver Array from Calibration Shots function from the Stage Drop-down Menu averages the 
geophone rotations processed in each calibration shot and calculates a new "MS Receiver Array". The Reference and MS 
receiver arrays differ only by the geophone axial orientations, now calibrated by the calibration shots.  

 
The function that averages the array tests the geophone rotation from each calibration shot to check that the calculated 

axis orientation is within the Max. Angular Residual (defined on the Stage Properties Dialog) of the average axis orientation. 
If this is not the case then a warning is provided to the user, who should then check this rotation in the event waveforms. 
The average residual for each geophone axis is provided to the user in the Stage Data Pane. Through an iterative process a 
user can thus ensure that a thorough and accurate analysis of the geophone rotations is produced. 

 
Selecting the Calculate Velocity Model from Calibration Shots function from the Stage Drop-down Menu launches the 

Velocity calibration facility which is described in a separate section. 
 

17.3.3.6 Set Project For MS Acquisition 
Once the MS Receiver Array has been calculated, the stage can then be used to automatically configure the project  for 

MS acquisition using the Set Project for MS Acquisition function from the Stage Drop-down Menu. This function performs 
the following tasks: 

 
• copies the MS Receiver Array over to the project settings; 

 
• adjusts the simplex starting position to the average of the calibration shot positions in that stage; 

 
• if applicable, copies the processed velocity structure to the location algorithm's velocity model. 

 
The InSite Leach or InSite's Data Management Dialog can then be used to import the MS events from raw waveform 

data files into the project. Real-time processing of the MS data can be performed in the Leach. 
 
 

17.3.3.7 Copying an MS Receiver Array between stages 
 
To copy an MS Receiver Array from another stage, the user right-clicks on target stage then selects Copy MS 
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Receiver Array from Stage function. The user then selects the MS Receiver array from the Dialog shown in Figure 
17-34. 

 

 
Figure 17-34: Stage-data MS Receiver Array displayed in the Frac Manager Selection Dialog. 
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17.3.3.8 Set Velocity Model for Project 
 
The Set Velocity Model for Project function applies to a velocity model object in the stage data view and is used in 

the Tian Ray tracing or WaveBuilder. 
 
 

17.3.3.9 Launch WaveBuilder 
 
The Launch WaveBuilder function allows the WaveBuilder Dialog to be launched from the Frac Manager as well as from 

the Data Visualiser (under the Tools Menu item). The Dialog will be automatically initialised to use a velocity model from 
Frac Manager as opposed to one from an external ALV file. 

 
 

17.3.3.10 Adding Additional Stage Data 
 
Once the processing of MS data has been completed, the Frac Manager can be used to manage the MS 

Components created in InSite's event data structures (each Component is a set of events which can be visualised in 
the Data Visualiser). Components are added through a Frac Manager Listing Dialog after the user selects the Add MS 
Components function from the Stage Drop-down Menu. When the user exits the Frac Manager the colour and symbol 
type selected by the user in the Stage Properties Dialog is set to all events within the Component ready for visualisation 
in the 3D Visualiser. 

 
In version earlier than v3.14, pressure data is imported stage by stage. Starting from v3.15, the pressure data is referred 

to as Treatment Data and is imported once for all stages using the Import treatment function. 
 
If a stage has beginning and end time defined, the "Display Pressure Data" in Stage Drop-down menu becomes 

active. Selecting it will display the treatment data for that stage only (Figure 17-35). 
 

 
 

Figure 17-35: Graphical Presentation of Treatment Data Imported into the Frac Manager. 

 

17.3.3.11 Create A Super Stage 
A super stage can be created by combining multiple consecutive stages close in location. The main purpose is to enrich 

the catalogue for statistically robust analysis of the temporal-spatial pattern of microseismicity correlated with the 
repeated and thus similar treatment operations. 

 
The super stage will have a microseismic component combining all microseismic components from each individual 

stage. The component with the most microseismic events is defined as the reference component. All microseismic events 
in other microseismic components are shifted in position to match the centroid of the reference component. The stage 
associated with the reference component is defined as the reference stage. The beginning time of all other stages and the 
event occurrence time are shifting to align with the reference stage. 

 
The super stage microseismic component is created in the Data Visualiser at the same time when the super stage  is 

created. The default name of this new component is the concatenation of the all component name. It differs from Stack 
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selected components that the event time is not shifted. 
 
The treatment data for each stage and its super stage can be displayed (Figure 17-36). As shown below, Stage 2 

and Stage 3 are combined to create a super stage with default name "Default Superstage". Stage 3 is the reference 
stage as its microseismic component has more events than stage 2's microseismic component.  

 
The microseismic events are the combination from all stages and the treatment data is averaged across all stages.  
 

 

Figure 17-36: The microseismic events are the combination from all stages and the treatment data is averaged 
across all stages. 

 
 

17.3.4 Automatic Velocity Calibration 
 
Input to the Velocity Calibration Dialog  
Specifying an Initial Velocity Model 
Use of Sonic Logs to Pick an Initial Velocity Model  
Velocity Calibration Operation 
Moveout Plot 
Storage of a Velocity Model 
 
 

17.3.4.1 Input to the Velocity Calibration Dialog 
 
The velocity calibration operation is controlled from the velocity calibration Dialog as shown in Figure 17-37. 

Automatic velocity calibration is carried out using a Gaussian Particle Swarm Optimization search method (see Technical 
Appendices), varying layer velocities and Thomsen parameters within the user-specified bounds until a minimum 
misfit is found between theoretical and measured arrival times. Relative P-to-S and phase times across the array are 
used, so T0 (source time) does not need to be specified by the user. 

 
The Input group box allows settings for this Dialog to be saved to a text file using the Save As button. These settings 

can be subsequently restored using the Browse button. 
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Figure 17-37: Velocity Calibration Dialog 



538 17.3 Managing Stage Data  

 

 

17.3.4.2 Specifying an Initial Velocity Model 
 
The first operation to be performed is to specify the initial velocity model to be used as an input to the velocity 

calibration operation. This can be done in one of the three following ways:  
 

1. Load the initial model from an external csv file, an example of which is shown in Figure 17-38; 

 
2. Specify an equal thickness model - this is achieved by filling in the fields in the equal thickness model group 

box then pressing the Generate button; 

 
3. Select the layer model graphically from the sonic logs as described in the following section. 

 
When the initial model has been specified it is indicated in the velocity field as shown in  Figure 17-39. This model can 

be exported to a CSV file by selecting the Export Initial Model button. 
 

 
 

Figure 17-38:  Initial Velocity Model CSV File 

 

 
 

Figure 17-39: Initial model loaded into the Dialog. 

 
 
 

17.3.4.3 Use of Sonic Logs to Pick an Initial Velocity Model 
 
 
Clicking on the Select Layers Graphically button brings up the pop-up window as shown in Figure 17-40. There are by 

default three separate plots showing the P-wave and S-wave sonic log, the three Thomsen parameters (Epsilon s, Delta δ, 

Gamma γ), and the ratio between the two velocities. The red vertical line indicates the mean velocity for the sonic log.  
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Figure 17-40: Sonic Logs. 
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The toolbar buttons perform the following functions:  
Add Boundary 
Delete Boundary 
Delete All Boundaries Button  
Show/Hide Vp or vs plot 
Show/Hide Thomsen parameters plot 
 Show/Hide Vp/Vs Button 
Show/Hide Velocity Limits Button 

 
 
The first button is used to add a boundary between two layers. By pressing this button then moving the mouse on to 

the plot area, a cross hair is shown which can be used to pinpoint a depth at which that boundary should be placed. This is 
indicated in Figure 17-41. To fix the boundary the left mouse button can be pressed, and a boundary will appear as shown 
in this Figure 17-42. Here the boundary would divide the log into two layers each with a different mean velocity.  

 

 
 

Figure 17-41: Selection of Boundary Using the Cross Hair. 
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Figure 17-42: Display of New Boundaries. 
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The second button on the toolbar is used to delete a boundary. By pressing this button then moving the mouse  over 

the plot area, a cross hair appears. By clicking the left mouse button, the layer boundary nearest to the mouse position will 
be removed. 

 
The third button on the tool bar can be used to remove all the layer boundaries.  
 
The next three buttons are used to show or hide the Vp and Vs, Thomsen parameters, or Vp/Vs plots. If a button is 

indicated checked then that means the plot is shown. By hiding plots, it is possible to increase the horizontal resolution on 
those remaining. Figure 17-43 shows the sonic logs window with the Vp/Vs plot hidden. 

 

 
 

Figure 17-43: Vp/Vs plot hidden. 
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Note that to show just the Vp and Vs plot, the Vp/Vs button must first be unchecked.  
 
To the right of the toolbar buttons, the name of the well configured in Frac Manager from which the sonic logs are 

taken is indicated in a combo box. It is possible to select another well where available using this control.  
 
The right-hand button is used to switch on/off dashed lines either side of the velocity model graphs indicating the upper 

and lower limits for the velocity. These are shown in Figure 17-44. 
 

 
Figure 17-44: Velocity Limit Graphs. 
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The properties menu item is used to zoom in the vertical direction by specifying the upper and lower depths for the 

plots. In Figure 17-45, the user has selected 4700 and 5100 for these limits and in Figure 17-46 the sonic logs have been 
plotted as shown. 

 

 
Figure 17-45: New Minimum and Maximum Depths. 
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Figure 17-46: Sonic log redrawn with new minimum and maximum depths. 
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As boundaries are added or removed from the plots, the Initial Velocity Model, shown in the velocity calibration Dialog, 

will be automatically updated. The sonic logs window can therefore be closed when the boundary selection is all done 
without the need to explicitly save the changes made. 

 
It is possible to adjust the layer boundaries and velocities using the mouse. To do this, place the mouse at or near 

the red trace and press the left button. Keeping this pressed down, move the mouse to the new desired position for the 
new layer boundary or velocity. On releasing the left mouse button, the trace will be altered accordingly. 

 
The dashed red traces can be selected to adjust the minimum and maximum velocities in a similar manner.  
 
On adjusting the layer boundaries, the velocities in the above and below layers will remain unaltered. However, if 

the operation is carried out with the CTRL key held down then the velocities will instead be averaged to the sonic log 
trace over those layers. 

 
The Configure Layer Velocities Dialog can also be launched to specify more precisely the figures for the velocities at a 

particular layer as indicated in this Figure 17-47. To do this it is necessary to place the mouse within the layer to be 
configured and then click on the right button. The lower bound defines the difference between the velocity and the 
lower limit, whilst the upper bound defines the difference between the velocity and the upper limit.  

 

 
Figure 17-47: Configure Layer Velocities. 
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To aid the user in assessing which velocity layers within the model are most important to MS processing, the depths 

of receiver arrays, shots and formation tops can also be shown on the plot. The Settings menu item on the top of the 
sonic logs Dialog launches the Sonic Logs Data Source Settings Dialog. Figure 17-48 displays monitoring arrays and 
calibration shots that have been added to stages in the Frac Manager Dialog. The user can highlight objects in this 
Dialog for plotting in the sonic logs Dialog. In the sonic logs Dialog the user has buttons to control which arrays and 
shots are displayed: 

 
• FT - display formation tops, these must be added to frac manager wells 

 

• DA - default geophone array 
 

• DS - default shots/transmitters 
 

• FA - frac manager arrays, as selected in the Settings Dialog 
 

• FS - frac manager shots, as selected in the Settings Dialog 
 

• A legend button to toggle the display of the legend on or off 
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Figure 17-48: Settings to display instrument arrays, shots and formation tops on the sonic logs Dialog. 
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17.3.4.4 Velocity Calibration Operation 
 
The user can carry out automatic velocity calibration using multiple calibration shots.  Available shots are listed in the 

Calibration Shots panel and can be added or removed from the calculation using the buttons. Selected shots appear in the 
right-hand pane (Figure 17-49). 

 
 

 
 

Figure 17-49: Selection of calibration shots for velocity calibration. 
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To begin the velocity calibration, press the Start button. The operation may take a while depending on the inversion 

method used and the number of layers in the initial model. When it has completed, some graphical plots appear in separate 
pop-up windows detailing the outcome of the operation. These are described in separate sections below. In addition, 
buttons as shown in Figure 17-50 become enabled that allow for models and travel times to be exported to CSV files. 

 

 
Figure 17-50: Export to CSV Functions. 

 
 
 

17.3.4.5 Moveout Plot 
 
The Moveout Plots are shown after a velocity calibration has succeeded. 
 
One moveout plot relates to the P-wave arrival times while the other relates to the S-wave arrival times (Figure 17-51), 

if applicable. Additional moveout plots are shown if more than one calibration shot is used in the velocity calibration. Each  
plot shows two traces allowing for a comparison of the theoretical and actual arrival times vs. geophone depth.  
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Figure 17-51: Moveout plots following velocity calibration. 
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The properties Dialog (Figure 17-52) can be launched from the menu bar to change the min. and max. x and y axis limits. 
 
 

 
Figure 17-52: Moveout Properties Dialog. 

 

17.3.4.6 Storage of a Velocity Model 
 
 
It is possible to save a velocity model within the Frac Manager data structures. The following Dialog appears when the 

OK button is pressed on the velocity calibration Dialog box (Figure 17-53). 
 
 

 
Figure 17-53: Save Velocity Model Dialog Box. 

 
The velocity model will then appear in the stage tree view as shown in Figure 17-54. 
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Figure 17-54: Velocity Model in the Stage Data View. 
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17.3.5 Frac Processing Properties 
 
 
The Frac Manager Dialog has a button, Frac Processing Properties (Figure 17-55), which may be used to access the 

Frac Processing Properties Dialog (Figure 17-56). 
 
This Dialog provides a means to configure some of the most commonly used processing properties that are 

available via Project->Processing Properties in the InSite Data Visualiser. See the InSite Manual for more details. The 
Set Processing Defaults button may be used to set all the controls to pre-defined default values. 

 

 
Figure 17-55: Access to Frac Processing Properties. 

 

 
Figure 17-56: Frac Processing Properties Dialog 
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17.4 Frac Manager Operations in the InSite Visualisers 
 
Linking an MS Component to a Stage in the Data Visualiser  
Functions in the 3D Visualiser 
Two-dimensional Cross section Plots  
Export Pressure Data 
 
 

17.4.1 Linking an MS Component to a Stage in the Data Visualiser 
 
In the Data Visualiser a given Frac Manager Stage can be linked to a MS Component containing events by selecting 

the component and then selecting Frac Manager Operations->Set Stage from the pop-up menu as shown in Figure 
17-57. This option has been added so that it is easier to manage Components into the Frac Manager Stages when 
'offline'. 

 
A Dialog appears listing all the stages configured in the Frac Manager as shown in Figure 17-58. 
 
Note that only one stage is selectable and when OK is pressed the component colour will be changed to that defined in 

the stage properties. 
 
MS Components can be automatically added to an "active" Frac Manager Stage during the leaching process in  'real-

time' operations. 

 
 

Figure 17-57: Setting of Stage for a Component. 
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Figure 17-58: Selection of a Frac Manager Stage 
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17.4.2 Functions in the 3D Visualiser 
 
Popup Legend 
Editing Scene Properties  
Well Objects 
 
 
 

17.4.2.1 Popup Legend 
 
The colours and symbols of events and objects relating to each stage are indicated by a pop-up legend as shown in 

Figure 17-59. To turn this legend on or off the toolbar option, as indicated in Figure 17-60, should be selected. This pop-
up legend may be docked with the Global Button Bar and the Drawing Objects Browser. 

 

 
 

Figure 17-59: Display Legend Toolbar Option. 

 

 

Figure 17-60: Frac Manager Pop-up Legend. 
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17.4.2.2 Editing Scene Properties 
 
 
The colour-scale field for event symbols can be configured in a specific way when using the Frac Manager. This is 

accessible via the Events tab in the Scene Properties Dialog accessed from the 3D Visualiser (Figure 17-61). 
 

  

Figure 17-61: Selection of Colour Scale in Scene Properties. 



17. Frac Manager 559  

 

 
If Defined in Frac Manager Stage is selected this means that all events will be shown by their defined stage colour, 

except events for the active stage which will be colour scaled according to what has been configured for that stage  in the 
Frac Manager. 

 
Figure 17-62 shows how the 3D Visualiser appears when events in one stage is coloured by stage colour (blue) and the 

events in the active stage are colour scaled by location magnitude. An indication of which stages correspond with  each 
colour is provided by the pop-up legend. 

 
Note the colour scale in the lower-left corner refers to the scale type defined in the active stage and the number of  

events refers to the number of events in that stage. 
 

 
Figure 17-62: Frac Manager Pop-up Legend: Display of Events in Active Stage by Location Magnitude. 
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17.4.2.3 Well Objects 
 
Well objects (packers, sleeves, plugs and formation tops) are plotted in the 3D scene (Figure 17-63). 
 
 
 

 
Figure 17-63: Display of Well Objects in 3D Scene. 

 
The start and end time can be edited by right-clicking on a well object. The time attribute is used in 3D visualiser 

playback function (Play Events Mode). 
 
 
 

17.4.3 Two-dimensional Cross section Plots 
 
The tool bar cross-section button in the 3D Visualiser is used to launch one of five possible cross section plots as 

shown in Figure 17-64. The user is required to select from one of the view orientations as indicated. The Auto Set Frac 
Orientation button is checked on the first occasion that this Dialog appears. It is used to specify that the best-fit frac 
ellipsoid is calculated by the system rather than being selected manually by the user. This takes the  form of a 
horizontal ellipsoid which can be manipulated on two separate plots. An example cross section view (East-North 
orientation) is shown in Figure 17-65. 

 
A cross section plot shows a 2D representation of the same objects that are visible in the 3D visualiser, these being the 

well trak, well log, calibration shots, geophones and events. In addition, the distance between the well head positions is 
shown along with an ellipse which can be manipulated using the mouse to select the fracture plane. The ellipse dimensions 
are shown in the top left-hand corner (if appropriate) and in the bottom right hand corner a legend is shown specifying 
the colour associated with Frac Manager stages. The ellipse appears on the East-North and View onto Fracture Plane 
plots. 
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Figure 17-64: Cross-section View Selection Dialog. 

 

 

Figure 17-65: Example East-North plot (includes ellipse, well-head distances and legend). 
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17.4.3.1 Properties Dialog 
 
On selection of the Properties menu option it is possible to change the size and layout of the plot ( Figure 17-66). The 

Fit axes by combo box allows the user to select the size of the plot such that either a) all objects are visible b) all the events 
are visible c) user defined limits are applied. 

 

The Y->X button is used to update the X minimum or X maximum values based on edits made to the Y minimum  

and Y maximum values, whilst the X->Y button is used to update the Y minimum or Y maximum values based on edits 
made to the X minimum and X maximum values. 

 
The checkboxes at the bottom can be used to turn on/off various items in the cross-section plot which may or may not 

be required for display. Note these options are also available on the toolbar.  
 

 
Figure 17-66: Fracture Viewer Properties Dialog 
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Figure 17-67 shows the cross section view after Dialog box selections have been applied. 
 

 
Figure 17-67: Modified Cross-section View (does not include ellipse, well-head distances or legend 
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17.4.3.2 Manual Selection of the Fracture Plane Ellipsoid on the East-North plot 
 
Manual selection of the horizontal position, length, width and azimuth of the fracture plane ellipsoid can be performed 

using the ellipse which appears on the East-North plot (Figure 17-68). 
 
To reposition the ellipse, use the mouse to select the filled black circle at the centre of the ellipse then drag it with  the 

left button pressed down. 
 
To rotate the ellipse, select one of the two filled black circles on the edge of the ellipse then drag it in the tangential 

direction. 
 
To increase or decrease the size of the major or minor axis of the ellipse, select one of the two filled black circles on the 

edge of the ellipse then drag it along that axis. 

 
Figure 17-68: Ellipse and filled black circles used to select the fracture plane with the mouse on the East-North 

plot. 

 

17.4.3.3 Manual Selection of the Fracture Plane Ellipsoid on the View onto Fracture Plane Plot 
Manual selection of the depth and height of the fracture plane ellipsoid can be performed using the ellipse which 

appears on the View onto Fracture Plane plot (Figure 17-69). 
 
To reposition the ellipse, use the mouse to select the filled black circle at the centre of the ellipse then drag it up or  

down with the left button pressed down. 
 
To increase or decrease the vertical size of the ellipse, select the filled black circle on the edge of the ellipse then drag 

it up or down. 
 

 
 

Figure 17-69: Ellipse and filled black circles used to select the fracture plane with the mouse on the View on to 
Fracture Plane plot. 
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17.4.3.4 Auto Refresh 
By selecting File->Start Timer on the cross-section view, the plot will automatically refresh every five seconds so that 

new events can be automatically displayed. This auto refresh mode is cancelled by selecting File->Kill Timer. Note: The 
fracture plane should not be adjusted if any of the plots are in auto refresh mode. 

 

17.4.3.5 Toolbar Options 
The toolbar contains the following buttons: 

 Insert Text Box 
 
Toggle Object Labels 
 
Toggle Legend Toggle Ellipse 
 
Toggle Well Head Distances 
 
Toggle Maximum Viewing Distance 

 
The Insert Text Box button allows the user to annotate the cross plot with text boxes and connecting lines. Buttons 

are also provided to easily enable or disable items on the cross plot such as the object labels and the  legend. 
 
 

17.4.3.6 Insert Text Box 
 
In order to insert a text box, the Insert Text Box button can be selected from the toolbar and the mouse positioned at 

an appropriate item on the plot that requires additional explanation via a text box. The left button should be held down 
and repositioned to where the text box is required. A line is then drawn between the current mouse position and the new 
position. When the mouse button is released a Dialog (Figure 17-70) appears allowing the user to enter some text. 

 
On pressing the OK button, the text box appears on the cross plot (Figure 17-71). 
 

 
 

Figure 17-70: Dialog to enter contents of a text box (can include carriage return/line feed). 
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Figure 17-71: East-North Cross-plot with Text Box 
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17.4.3.7 Edit Text Box 
It is possible to edit, delete and move the text box that has previously been inserted. To do this the mouse must be 

placed within the text box rectangle and the right mouse button clicked. A pop-up menu then appears as shown in Figure 
17-72. 

 

Figure 17-72: Text Box Pop-Up Menu. 

 
By selecting Edit Text the Dialog appears allowing the user to modify the text. By selecting Delete the text box is 

removed from the plot subject to user confirmation. By selecting Move the text box can be subsequently moved in  
conjunction with a move of the mouse. The left mouse button should be pressed when the new position has been reached.  
Note that the point at the opposite end of the connecting line from the text box rectangle remains fixed in a Move 
operation. If, however, it is desired that the text box and the connecting line are both moved together then the Move 
(Translate) option should be selected instead. 

 
 

17.4.4 Export Pressure Data 
 
Pressure data can be recorded within InSite's remote database system, InSiteDB. It can then subsequently be 

exported via the InSiteDB Measurements Dialog and then associated with a Frac Manager stage. To launch this Dialog, 

select Tools->Launch InSiteDB Measurements from within the Data Visualiser. The operation of this Dialog is explained 
in the InSiteDB Manual. 

 
The appropriate pressure measurements and acquisition test description need to be selected before the Export 

button is selected in the Historical Plot box (Figure 17-73). On selection of this button the user is prompted to enter the 
File name of a CSV file containing the pressure data previously recorded in the database. When this has successfully 
completed, a prompt appears as in Figure 17-74. Selecting 'Yes' results in the Frac Manager Listing Dialog being 
displayed similar to Figure 17-75. The exported CSV file is then associated with the selected stage. 
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Figure 17-73: InSiteDB Measurement Dialog 

 

 
 

Figure 17-74: Prompt to associate pressure data with a Frac Manager stage. 
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Figure 17-75: Frac Manager Listing Dialog. 
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17.5 Calibrating the Velocity Model in the Waveform-
Moveout View 

 
Manual Calibration  
Automatic Calibration 
 
 
 

17.5.1 Manual Calibration 
 

In the Waveform Moveout View, a button on the button bar,  , allows the user to edit the velocity model through the 
Sonic Logs View. 

 
It is possible to adjust the velocity model using the Sonic Logs View and then observe the resulting changes to the shot 

and/or user event position moveout curves. The Sonic Logs View is discussed in more detail in the Velocity Calibration 
section. It is recommended that the sonic logs display is positioned and set up so that velocity model  can be compared 
directly against the desired moveout curve. Changes to the shape and position of the curve(s) can be then observed whilst 
adjustments are made to the velocity model using the mouse on the sonic logs view. Any changes made to the velocity 
model should be saved before exiting the sonic logs view, this is performed via the File menu as shown in Figure 17-76. 

 
The velocity model can also be saved to a CSV text file or to a Frac Manager Stage. The user will be prompted 

either to specify the folder into which text file is to be saved or in the latter case the Frac Manager stage followed by 
velocity model text string. 

 

 
 

Figure 17-76: Well Log Data Menu. 

 

17.5.2 Automatic Calibration 
 
The user can also carry out an automatic, layer-by-layer calibration for the viewed shot when in the Sonic Logs View 

and changes to the velocity model update the shot and/or user event position moveout curves.  
 
The upper and lower bounds should be configured by the user first, either using the mouse or by launching the 

Configure Layer Velocities Dialog as shown in Figure 17-77. To do this it is necessary to place the mouse within the layer 
to be configured and then click on the right mouse button. The lower bound defines the difference between the 
observed velocity and the lowest acceptable velocity, whilst the upper bound defines the difference between the 
observed velocity and the highest acceptable velocity. Similarly, boundaries are defined for the values of Thomsen 
parameters. There is also an option to constrain Thomsen parameters for all layers, keeping them proportional to the 
Gamma log or 1/Vp. 
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Figure 17-77: Configure Layer Velocities Dialog 

 
Individual velocity layers can then be automatically calibrated by double clicking next to the layer. This will calibrate P- 

and S-wave velocities and Thomsen parameters for the layer. The user can continue, layer by layer, with the calibration until 
happy with the result. 

 
 

17.6 Using the AutoLeach for Realtime Acquisition 
 
To improve processing speeds during real-time acquisition, the software can be run on two different computers. One 

computer can be dedicated to triggering events from the continuous raw data files using the streamer leach and 
writing triggered waveforms to BSF (or BSF and ESF) files. A second computer, with another copy of the software, can 
be used to import and process (e.g. locate) the events. 

 
The second copy of the software needs the 'AutoLeach' (Figure 17-78) which should be configured to poll the BSF 

directory where the first copy of InSite is writing out triggered events. This may be a mapped drive across a network. 
The user must also set an ESF storage directory where the event files will be written. As shown in Figure 17-78, 
additional options are available to the user: 

 
 

• Disk space Critical Level (MBytes) - InSite Leach permanently monitors the free disk space level of the system. The 

user receives a warning message when the critical level is reached, and the Leach will automatically stop running. 

 
• Split Components by - Time interval for splitting of events into components during import. Options are Year, Month, 

Day, Hour and Minute. 

 
• Autostore PCF at - Automatically save the project configuration file at the specified time interval. This makes 

sure that the project settings and data map are regularly saved in case of PC failure. Options are None, 1 Day, 

6 Hours, 1 Hour, 30 Minutes and 5 Minutes. 

 
• Automatically process data during import - User-defined processing operations will be applied to the measurement 

and stored in the event file. 

 
The user also needs to consider the settings for automatic event reporting and BSF Management.  
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Figure 17-78: AutoLeach Dialog. 



17. Frac Manager 573  

 

 

17.7 Calibration Shot Guide 
 
 
This wizard provides a step by step guide to rotating geophones. The calibration shot guide is launched from the 

data visualiser menu, under tools (Figure 17-79). 
 
 

 
 

 
Figure 17-79: Launching the calibration shot guide 
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Each button indicates whether the step has been completed (green tick) or not (red cross). For information on how  
to complete a step, click on the button and the information window on the right shows the relevant details ( Figure 

17-80). 
 

 
 

Figure 17-80: Calibration shot guide interface 

After completing all the steps up to and including "Calculate MS receiver array from calibration shots", we can compare 
the measured and theoretical plunge and azimuth angles for each vibe shot and receiver (Figure 17-81).  
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Figure 17-81: Calibration shot guide angle check 
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 Noise Detection Tool 
 
 
The noise detection tool looks at every enabled event in the project and flags them as either an event or as noise. It 

allows for the batch processing of events and provide an indication of whether it they are noise or not. To launch the tool, 

open data visualiser, and from the menu bar select "Tools -> Launch Noise Detection Dialog ". The dialog is shown in Figure 
18-1. 

 

 
Figure 18-1: Noise Detection Tool Dialog 

 
Events can be flagged as the standard noise type or as a user defined event type (Setting the Event Type). There are two 

methods of noise detection; amplitude threshold and moveout velocity. 
 
Amplitude threshold requires that the peak amplitude in the specified number of the channels must exceed the 

threshold to be classed as an event. 
 
Moveout (Apparent) velocity calculates the apparent velocity between all unique receiver pairs, using the pick arrival 

time, and if the median velocity falls outside of the defined limits, the event is flagged as noise.  
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 Acoustic Emission Monitoring Dashboard 
 
InSite's Acoustic Emission Dashboard is a streamlined tool specifically designed for users of Applied Seismology 

Consulting Ltd.'s laboratory testing equipment, providing real time feedback during acquisition and processing of acoustic 
emissions and ultrasonic surveys from laboratory rock deformation tests. 

 
 

Figure 19-1: Acoustic emission dashboard visualiser 

 
 
AE Dashboard Toolbar AE Dashboard Sub Views 
 

19.1 AE Dashboard Toolbar 
 

 

Figure 19-2: AE dashboard toolbar. 
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Table 19.1: AE dashboard toolbar legend 

1 Rotate mouse mode in 3D view 

2 Pan mouse mode in 3D view 

3 Magnify mouse mode in 3D view 

4 Fly mouse mode in 3D view 

5 Auto-rotate in 3D view 

6 Velocity view chart properties 

7 Event histogram viewchart properties 

8 2D plan view properties 

9 Font properties 

10 Manually refresh dashboard visualiser 

11 Update velocity model 

 
 

19.2 AE Dashboard Sub Views 
View 
Velocity View  
Plan View  
Histogram View 
 
 

19.2.1 View 
The 3D view allows full selection of the view by rotation, panning, and zooming (Manipulating the View in the 

Visualiser). 
 
 
 

19.2.2 Velocity View 
This view displays the results from velocity surveys according to the experimental setup, showing P, S1, and/or S2 wave 

transmission velocities. Waveform picks are imported from a separate InSite project devoted to ultrasonic acquisition 
(Figure 19-3). 

 
 

 
 

Figure 19-3: Flow chart of acquiring data to displaying data on the dashboard 

 
 

19.2.2.1 Velocity Chart Properties Dialog 
 
 
This dialog (Figure 19-4) allows the user to map the arrival times in the dashboard velocity file to the correct axis on 

the velocity survey chart. This grants the flexibility of picking any of the P, S1, and S2 in any of the shot receiver 
channels in waveform visualiser. 

 
The distance between shot and receiver can be finely adjusted per axis in the dialog, allowing for sample contraction 

and expansion. As can the time zero for each axis, as start times may be asynchronous. 
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Figure 19-4: AE Dashboard velocity chart properties dialog 
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19.2.2.2 AE Dashboard Velocity File 
The velocity file is created by exporting the pick data using the processing computer. It is created by, written to, and 

read from InSite, and should never have to be edited by the user, it merely servers as a method of transferring arrival times 
between computers whilst maintaining a historical record. The file consists of 8 columns which are described in Table 19.2. 

 

Table 19.2: AE Dashboard velocity file structure 

Column Index Description 

1 SurveyID - name of the component 

2 ShotID - number of the event 

3 ChanneID - channel number 

4 DateTime - 8 byte floating point number starting from 30/12/1899 midnight (Hours 

are represented by the absolute value of the fractional part of the number).  

5 Axis - 1 = X, 2 = Y, and 3 = Z 

6 P wave arrival time 

7 S1 wave arrival time 

8 S2 wave arrival time 

 
 

19.2.2.3 Creating-Writing to the Dashboard Velocity File  
 

The file is designed to work with InSite's survey format (for example, those created by the Cecchi system), where each 

survey has the same structure, that is each survey has the same number of shots, and each shot has the same number 

of receiver pairs (events). 

To create the file, enter waveform visualiser, and first add P ("Add P Arrival Pick"), S1 ("Add VS1 Arrival Pick"), and/or 
S2 ("Add VS2 Arrival Pick") picks by right-clicking on the trace and selecting the relevant menu option (Figure 19-5). Finer 
adjustment can be made to the pick by holding down the left mouse button and dragging the pick left or right. 

 

 

 

Figure 19-5: Adding P, S1, and S2 picks 
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To export the picks, click the export button on the AE Dashboard toolbar (Figure 19-2). If an export file has not been 

selected, the user will be prompted to select one. During the export, the arrival times for each receiver pairs are written to 
the file. If data for a survey already exists in the file, it will be replaced with the data pending export, and data belonging to 
a new survey will be appended to the file. 

 

19.2.3 Plan View 
 
This view shows a cross section of the sample along with event locations. The three available cross sections are X-

Y, X-Z, and Y-Z. The sample must be a 3D drawing object (cylinder, cuboid, and ellipsoid), which can be selected in the 
properties dialog (Figure 19-6), along with the orientation, event size and colour. Events can be uniformly coloured or 
coloured by a 3D visualiser parameter (Scene Properties). 

 

 
Figure 19-6: AE Dashboard 2D plan view properties dialog 
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19.2.4 Histogram View 
 
The event histogram can be customised (Figure 19-7) to display triggers or only located events as well as its 

appearance. Time scale and refresh rates can also be controlled by the user. 
 

 

Figure 19-7: AE Dashboard histogram view properties 
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 Stream Dashboard 
 
InSite's Stream Dashboard is a streamlined tool specifically designed for users of Applied Seismology Consulting Ltd.'s 

laboratory testing equipment, providing real time feedback during continuous acquisition of data from laboratory rock 
deformation tests. 

 
Configuration of Stream Dashboard is carried out using the Stream Dashboard Properties dialog which can be launched 

from the toolbar or alternatively the Tools menu. 
 
The hostname of the master or standalone Richter system must be specified along with the refresh rate which 

determines how often the Richter system is interrogated for data. 
 

 
 

Figure 20-1: Stream dashboard properties dialog 
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Figure 20-2: Stream Dashboard Configuration 
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From the Stream Dashboard Configuration (Figure 20-2), you can select whether you want continuous files or split file 

and other options relevant to data streaming. 
 
Stream Dashboard is now ready for usage as indicated by the enabling of the Play button in the toolbar and the addition 

of information about the master and slave systems used for recording continuous data in the Richter stats panel.  
 

 
 

Figure 20-3: Stream dashboard ready for usage 

 
Selection of the Play button sends a message to the master Richter system to begin recording data. This will be followed 

by regular updates to each chart which corresponds to a Richter channel. Shown in each chart is a summary of what is being 
recorded in the form of minimum and maximum voltage values detected during a sample of recorded continuous data. It 
is also possible to view RMS values, instead, if the Richter system is suitably configured. 

 
The Richter stats panel is regularly updated to show the write speed and remaining disk space for the master and slave 

systems. 
 
The Stop button is enabled to cease recording at any time. 
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Figure 20-4: Stream dashboard in operation 
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 Velocity Surveying Workflow 
 
You can do simple P-wave surveys for most lab set ups. You can also look at doing VTI time dependent velocity models. 

The workflows are similar, but both require some analysis outside of InSite (normally using excel or similar). 
 
 

21.1 P-wave only 
The P-wave only create a VTI velocity model using autopicking and manual analysis. 
 

Picking the events 

Please see Autopicking for details. 
 
The autopicking algorithm is only good up to a certain point after which for better or more accurate results, manual 

picking may be required. Manual picking is very subjective. The main advice is to be consistent where possible when picking 
the onset arrival times for each waveform. 

 

Get velocities 

The P-wave velocities from the P-wave picks can be automatically calculated by launching the auto-processor under 
the tools menu and selecting "Get Pick Velocities" from the available processes. Press "start" to begin. 

For details please see Autoprocessing. 
 

Export velocities 

The P-wave velocities can be exported by selecting "Survey Column Format" under the Export menu. Choose the "P-
Wave velocity from pick" for the data type to export. Select the default ray paths. The P-wave velocities will be written to 
a file with a ".dcf" extension. 

 

Calculate velocities 
Open the above ".dcf" file in MS Excel or equivalent package (e.g. Libre Office, Gnumeric, Open Office in Linux) and 

calculate the Maximum, Minimum and ratio of Min/Max (anisotropy value) for the direct line of sight ray-paths. Depending 
on how good the picks are, you may not have velocity values for all ray-paths. 

 

Locate Calibration Shots 
In the "Process Settings" under the Locater tab, choose a location algorithm, e.g. "Collapsing Grid Search" and for 

the "Velocity Structure" choose "Transversely Isotropic". In the settings, enter the maximum velocity value, and 
anisotropy values calculated above. 



924 21. Velocity Surveying Workflow 

 

 

 

21.2 Time Dependent P-wave velocity model 
 
This creates a velocity model for each survey that can be used to see how the velocities change with time. It uses the 

cross-correlation method to find differences in the picks between surveys automatically. 
 

Auto-Picking 

Run the auto-processor and Auto-pick Event on the other (non-reference) surveys. For the cross-correlation, the non-
reference surveys only need to be auto-picked and these picks do not need to be optimised, so manual tweaking of picks 
is not required. 

 

Cross-Correlate Events 

Enable the reference survey and run the auto-processor and CCR Event. Ensure that the Cross Correlation Settings 
in the "Processing Settings" are set such that the CCR Events are referenced to a Survey (Master  Component). 

 

21.2.1 Manual export of CCR P-Wave velocities 
The CCR P-wave velocities can be exported by selecting "Survey Column Format" under the Export menu. Choose 

the "CCR P-Wave velocity" for the data type to export. Select the default ray path options provided. The CCR P-wave 
velocities will be written to a file with a ".dcf" extension. 

 

Calculate velocities 

Open the above ".dcf" file in MS Excel or equivalent package (e.g. Libre Office, Gnumeric, Open Office in Linux) and 
calculate the Maximum, Minimum and ratio of Min/Max (anisotropy value) for the direct line of sight ray-paths. Depending 
on how good the picks are, you may not have veolcity values for all ray-paths. 

 
Create a time dependent velocity model with the max velocity values and anisotropy values for each survey. See 

Appendices section 3.1 for details. 
 

 

Figure 21-1: Example time dependent velocity file 

21.2.2 Automatic export of CCR velocities 
 
Alternatively, velocity models can be exported from the Velocity Survey Chart. Velocity model is calculated from the 

surveys displayed in the chart (up to a maximum of 6). The anisotropy factor is calculated from the ratio between the fastest  
and slowest measured velocities at each interval. The user can select whether to use the fastest or slowest as reference, 
which will be used as the refernce direction.  
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Figure 21-2: Export Time dependent velocity model from Velocity Survey Chart. 

 
Figure 21-3: Example Time dependent velocity model file exported from Velocity Survey Chart. 

 
 
 

 

21.3 Locate Calibration shots 
In the "Process Settings" under the Locater tab, choose a location algorithm, e.g. "Collapsing Grid Search" and for 

the "Velocity Structure" choose "Transversely isotropic time dependent velocity" and add the path to velocity file created 
above.





22. Hot Keys 591 

 

 

 Hot Keys 
 
Many of InSite's most common operations have an associated hot key assigned to them. This allows the operation to 

be performed using a keystroke or combination of keystrokes. 
 
Default Hot Keys  
Editing Hot Keys 
 

22.1 Default Hot Keys 
 

Table 22.1: A list of all the operations and their default hot key assignments. 

 

Item Description Default Hot Key 

3D Location Visualiser Open 3D visualiser Ctrl + L 

AE Dashboard Visualiser Open AE dashboard visualiser Ctrl + D 

Component Zoom Waveforms Open waveform vertical zoom type dialog Alt + Z 

Create Debug Box Open watch dialog Ctrl + Alt + D 

Data Visualiser Open data visualiser Ctrl + A 

Escape Escape Esc 

Event Calendar Open event calendar Ctrl + Alt + M 

Event Cancel and Advance Cancel picks and advance to next event 
in 

waveform visualiser 

Alt + C 

Event Parameter Get Histogram Event source parameter histogram Ctrl + Alt +H 

Event Set as Noise and Advance Set as noise and advance to next event in 

waveform visualiser 

Alt +V 

Help Open help F1 

Last Component Move to last component in waveform 
visualiser 

Ctrl + Alt + P 

Last Event Move to last event in waveform visualiser Alt + P 

Launch Database Management Open InSite database Ctrl + Alt + B 

Launch Frac Manager Open Frac Manager dialog Ctrl + Alt + F 

Launch Measurements Acquisition Open measurements acquisition dialog Ctrl + Alt + A 

Launch Parameter Visualiser Open parameter visualiser launcher 
dialog 

Ctrl + Alt + C 

Leach Open Leach dialog Ctrl + Alt + L 

Mechanisms Visualiser Open mechanisms visualiser Ctrl + M 

New Project Open a new project Ctrl + N 

Next Component Next component in waveform visualiser Ctrl + Alt + N 

Next Event Next event in waveform visualiser Alt + N 

Next Pane Next pane F6 

Open Project Open a project Ctrl + O 
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Item Description Default Hot Key 

Previous Pane Previous pane Shift + F6 

Print Print Ctrl + P 

Project Properties Open project properties dialog Ctrl + Q 

Save Project Save the project Ctrl + S 

Stream Dashboard Open stream dashboard Ctrl + E 

Stream Visualiser Open stream visualiser Ctrl + G 

Trace Menu Add P Pick Add P pick to the trace in waveform 
visualiser 

Shift + P 

Trace Menu Add S Pick Add S pick to the trace in waveform 
visualiser 

Shift + S 

Trace Menu Add VS1 Pick Add VS1 pick to the trace in waveform 
visualiser 

Shift + 1 

Trace Menu Add VS2 Pick Add VS2 pick to the trace in waveform 
visualiser 

Shift + 2 

Trace Menu Zoom out Zoom out of the trace Ctrl + 0 

Waveform Moveout Add P Pick Add P pick to the trace in waveform 
moveout 

visualiser 

Shift + A 

Waveform Moveout Add S Pick Add S pick to the trace in waveform 
moveout 

visualiser 

Shift + D 

Waveform Moveout Delete P Pick Delete P pick from the trace in 
waveform 

moveout visualiser 

Ctrl + Shift + A 

Waveform Moveout Delete S Pick Delete S pick from the trace in 
waveform 

moveout visualiser 

Ctrl + Shift + D 

Waveform Moveout Draw P Pick Draw P picks across the traces in 
waveform 

moveout visualiser 

Alt + Shift + P 

Waveform Moveout Draw S Pick Draw S picks across the trace in 
waveform 

moveout visualiser 

Alt + Shift + S 

Waveform Moveout Show All 
Instruments 

Sow all the instruments in waveform 
move- 

out visualiser 

Ctrl + 1 

Waveform Moveout Visualiser Open waveform moveout visualiser Ctrl + W 

Waveform Next Trace Next trace in waveform visualiser Down 

Waveform Previous Trace Previous trace in waveform visualiser Up 

Waveform Visualiser Open waveform visualiser Ctrl + Shift + W 

Array Analysis Clear Completed Clear completed processes from the 

batch process list in the array analysis 

configuration dialog (Array Analysis) 

Ctrl + Alt + X 

Array Analysis Queue Add the current array analysis 

settings as a process to the batch 

process list (Array Analysis) 

Ctrl + Alt + Q 

Array Analysis Remove Remove the selected processes from 

the batch process list in the array 

analysis con- figuration dialog (Array 

Analysis) 

Ctrl + Alt + R 

Array Analysis Update Update the selected process in the 

batch process list with the settings in 

the array analysis configuration dialog 

(Array Analysis) 

Ctrl + Alt + T 
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22.2 Editing Hot Keys 
All the commands listed in Table 22.1 can have their assigned hot key changed. Hot keys are stored to the registry in 

the current user section (HKEY_CURRENT_USER) when InSite is closed and restored when InSite is opened, so they 

persist between projects. 
 
To edit the hot keys, open Data Visualiser (File Sub-menu), and select the 'Edit Hot Keys' option, which opens the 

'Edit Hot Keys' dialog (Figure 22-1). 
 
 
 

 
Figure 22-1: Edit Hot Key Dialog 
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Select Item - Combo box showing all the commands that can have a hot key assigned. Keystroke - Shows the 

current keystroke assigned the selected item. 
 
Change - Click this button to change the keystroke of the selected item Remove - Click this button to remove the 

keystroke of the selected item. 
 
Default - Click this button to restore the default keystroke to the selected command. Note that if the default keystroke 

has been assigned elsewhere, a prompt will ask to clear it or chose another keystroke as duplicate keystrokes are 
forbidden. 

 
Restore All Defaults - Click this button to restore all the default keystrokes listed in Table 22.1. Note a prompt will ask 

to confirm the restoration to prevent accidental loss. 
 
OK - Click this button to confirm the changes. 
 
Cancel - Click this to discard any changes made. Note that if changes have been made, a prompt will ask to confirm the 

discarding of changes to prevent accidental loss. 
 
Certain commands can't have their hot keys changed or removed as they are generally universal defaults. These 

are Escape and Help commands. 
 
 

22.2.1 Change Hot Key Dialog 
When the change button is clicked, the 'Hot Key Entry' dialog (Table 22.3) will open. 

 
Figure 22-2:  Hot Key Entry Dialog. 

 
Clear - Click this button to clear the proposed hot key 
 
OK - Click this button to assign hot key to the command. Note that if the hot key is not valid or is a duplicate, a warning  
will pop up and the proposed hot key will be cleared. 
 
Cancel - Click this button to ignore any change and exit the dialog. 
 
The command for whose hot key is to be changed is shown in the text above the entry box. A hot key consists of a single 

key (Table 22.2) and any combination of modifier keys (Table 22.3). Certain keys are not allowed as they are generally 
universal defaults. These are Escape (exit out of dialog), F1 (help), F10 (open menu), and Enter (OK a dialog). 

 
 

Table 22.2: Valid Keystrokes 

Keystroke Descriptio
n 

Keystroke Description Keystroke Description 

A A 7 7 Caps Lock Caps lock 

B B 8 8 Space Space bar 

C C 9 9 Page Up Page up 

D D F1 Function 1 Page Down Page down 

E E F2 Function 2 End End 

F F F3 Function 3 Home Home 

G G F4 Function 4 Insert Insert 
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H H F5 Function 5 Delete Delete 

I I F6 Function 6 Num 0 Num pad 0 

J J F7 Function 7 Num 1 Num pad 1 

K K F8 Function 8 Num 2 Num pad 2 

L L F9 Function 9 Num 3 Num pad 3 

M M F10 Function 10 Num 4 Num pad 4 

N N F11 Function 11 Num 5 Num pad 5 

O O F12 Function 12 Num 6 Num pad 6 

P P F13 Function 13 Num 7 Num pad 7 

Q Q F14 Function 14 Num 8 Num pad 8 

R R F15 Function 15 Num 9 Num pad 9 

S S F16 Function 16 ∗ Multiply 

T T F17 Function 17 - Subtract 

U U F18 Function 18 . Decimal 

V V F19 Function 19 / Divide 

W W F20 Function 20 = Equals 

X X F21 Function 21 , Comma 

Y Y F22 Function 22 . Period 

 
 

Keystroke Description Keystroke Description Keystroke Description 

Z Z F23 Function 23 ; Semi colon 

0 0 F24 Function 24 / Forward slash 

1 1 Down Down arrow ' Apostrophe 

2 2 Up Up arrow [ Left bracket 

3 3 Left Left arrow \ Back slash 

4 4 Right Right arrow ] Right bracket 

5 5 Esc Escape # Hash 

6 6 Backspace Backspace ` Back tick 

 
 

Table 22.3: Valid Modifier Keystrokes 

 

Modifier Description 

Ctrl Control 

Alt Alt 

Shift Shift 
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 Export Report 
 
The export report feature creates a summary of the project setup and setting used during processing, and then save it 

as a text file. This accessed in data visualiser through the ‘File’ menu and selecting ‘Export Report’. Figure 23-1 shows the 
export report dialog, which allows the entry of client name, well pad, and location. Clicking ‘Export’ will prompt  for a 
filename and a location to save the file. 

 

 

Figure 23-1: Export report dialog. 

 
The following data is written to the file: -Client name -Well pad name -Location -Exploration well location - Observation 

well location -Treatment well location -Time of first event -Time of last event -InSite version -Tools - Default sensor array 
data and orientation -Processing properties -Filter types used -Auto-picking settings -Source vector settings -Locater 
settings -Source parameter settings 
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